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Thank you for purchasing the Daqstation DX2000 (hereafter referred to as “DX”).
This User’s Manual explains how to use the DX. To ensure correct use, please read this 
manual thoroughly before operation.
The following manuals are provided for the DX:

• Paper Manual
Manual Title Manual No. Description
DX2000 Operation Guide IM 04L42B01-02E Explains the basic operations of the DX. It is 

also provided in the CD-ROM.
Control of Pollution Caused 
by the Product

IM 04L41B01-91C Gives a description of pollution control.

• Electronic Manuals Provided on the Accompanying CD-ROM
Manual Title Manual No. Description
DX2000 Operation Guide IM 04L42B01-02E This is the electronic version of the paper 

manual.
DX2000 User’s Manual IM 04L42B01-01E Describes how to use the DX. The 

communication and network functions, 
custom display functions, and some of the 
options are excluded.

DX1000/DX1000N/DX2000
Multi Batch (/BT2)
User’s Manual

IM 04L41B01-03E Describes how to use the multi batch 
function (/BT2 option). 

DX1000/DX1000N/DX2000
Custom Display
User’s Manual

IM 04L41B01-04E Describes how to use the custom display 
function.

DX1000/DX1000N/DX2000 
Advanced Security Function 
(/AS1) User’s Manual

IM 04L41B01-05EN Describes how to use the advanced 
security function (/AS1 option).

DX1000/DX1000N/DX2000
Communication Interface
User’s Manual

IM 04L41B01-17E Describes how to use communication 
functions through an Ethernet or serial 
interface.

DX1000/DX1000N/DX2000 
EtherNet/IP
Communication Interface
User’s Manual

IM 04L41B01-18E Describes how to use communication 
functions through an EtherNet/IP interface.

DX1000/DX1000N/DX2000
PROFIBUS-DP (/CP1)
Communication Interface
User’s Manual

IM 04L41B01-19E Describes how to use communication 
functions through the PROFIBUS-DP 
interface (/CP1 option).

• DAQSTANDARD Manuals
 All manuals other than IM 04L41B01-66EN are contained in the DAQSTANDARD CD.

Manual Title Manual No.
DAQSTANDARD Data Viewer User’s Manual IM 04L41B01-63EN
DAQSTANDARD Hardware Configurator User’s Manual IM 04L41B01-64EN
DAQSTANDARD DX-P Hardware Configurator User’s Manual IM 04L41B01-65EN
Installing DAQSTANDARD IM 04L41B01-66EN

7th Edition: December 2010 (YK)
All Right Reserved, Copyright © 2005, Yokogawa Electric Corporation
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Notes
• The contents of this manual are subject to change without prior notice as a result of 

continuing improvements to the instrument’s performance and functions.
• Every effort has been made in the preparation of this manual to ensure the accuracy 

of its contents. However, should you have any questions or find any errors, please 
contact your nearest YOKOGAWA dealer.

• Copying or reproducing all or any part of the contents of this manual without 
YOKOGAWA’s permission is strictly prohibited.

• The TCP/IP software of this product and the document concerning the TCP/IP software 
have been developed/created by YOKOGAWA based on the BSD Networking Software, 
Release 1 that has been licensed from the Regents of the University of California.

Trademarks
• vigilantplant, DAQSTATION, Daqstation, and DXAdvanced are registered trademarks 

of Yokogawa Electric Corporation.
• Microsoft and Windows are registered trademarks or trademarks of Microsoft 

Corporation in the United States and/or other countries.
• Adobe and Acrobat are registered trademarks or trademarks of Adobe Systems 

Incorporated.
• Kerberos is a trademark of the Massachusetts Institute of Technology (MIT).
• Company and product names that appear in this manual are registered trademarks or 

trademarks of their respective holders.
• The company and product names used in this manual are not accompanied by the 

registered trademark or trademark symbols (® and ™).

Revisions
1st edition:  December 2005
2nd edition: October 2006
3rd edition:  April 2007
4th edition:  December 2007
5th edition:  November 2008
6th edition:  March 2010
7th edition:  December 2010
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DX’s Version and Functions Described in This Manual

The contents of this manual corresponds to the DX with release number 4 and style 
number 3.

DX’s Version and Functions
For the procedure to check the version, see section 2.5.

Edition DX Addition and change to functions Refer to
2 Version

1.11
(Added) German, French, and Chinese as display language. Section 2.6
(Added) Modbus client connection retry interval: 10 s, 20 s, and 

30 s.
Section 1.0 in IM04L41B01-17E

(Added) 24 VDC/AC power supply (/P1 option). IM04L42B01-02E
Version
1.21

(Added) Tab key on the USB keyboard corresponds to arrow 
keys.

Section 2.11

(Added) Operations to request and release network information. Section 1.3 in IM04L41B01-17E
(Changed) Modbus client: Function to connect a server with a unit 

number is changed. 
Section 1.10 in IM04L41B01-17E

(Added) Modbus client: Connection timeout value. Section 1.10 in IM04L41B01-17E
(Added) Modbus registers (floating point type for communication 

input data).
Section 6.3 in IM04L41B01-17E

(Added) A data output format (Skip or OFF channel data not 
output).

Section 3.7 in IM04L41B01-17E
CB command

(Changed) Error messages 105, 221, and 222 are added. Section 11.1

(Changed) Error messages 215, 218, and 536 are changed. Section 11.1

3 Release
number 
2
(Version 
2.0x)

(Added) Improvement to the operability on the historical trend 
display.

Section 4.3

(Changed) Displaying the date in the grid time of the trend display 
when the trend interval is greater than or equal to 1 
h/div.

Sections 1.3 and 2.4

(Added) Improvement to the display group setup operation. Section 5.1
(Added) Addition of the Upper and Lower settings to the bar 

graph base position.
Section 5.11

(Added) Addition of the relay action when alarm ACK is 
executed to the alarm output relay settings.

Sections 1.2, 3.5, and 3.8

(Added) Ability to reset the computed value during computation. Section 9.4
(Changed) Changes to how the data files are named. Section 1.4
(Added) Sorting the files by the update date/time. Sections 6.7, 6.8, and 6.9
(Added) Storage method for constantly retaining the most 

recent data files in the CF card (Media FIFO).
Sections 1.4 and 6.2

(Added) Progress display when saving all data of the internal 
memory.

Sections 4.8

(Changed) Changing the initial display selection menu. Sections 4.8 and 5.17
(Changed) Improvement to the data save operation to the USB 

flash memory.
Sections 2.12 and 5.17

(Changed) Retaining the state of the CapsLock and NumLock 
keys on the USB keyboard.

Section 2.11

(Changed) Changing the default setting of the web server function. IM04L42B01-02E,  
Section 1.5 in IM04L41B01-17E

(Added) Error messages, 513, 514, 515, and 516 have been 
added.

Section 11.1

Style 
number 2

(Added) The waterproof construction of the DX front panel 
complies with the NEMA4 standard.

Section 13.6

4 Same as 
edition 3

Added explanations. Fixed explanations. -
Changed the direction of the clamp input terminal (/H2 option). IM04L42B01-02E
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Edition DX Addition and change to functions Refer to
5 Release 

number 3
(Version 
3.0x)

Divided the setting mode displays with tabs. All setting displays
Added method for switching from setting mode to basic setting 
mode.

Section 2.14

Improved numeric input operation. Numeric input display
Added the ability to input the following characters: [ ] and :. Character string input display
Added new input type (GOST; /N3 option). Section 3.3
Increased measurement range for TC Type N. Section 13.5
Custom display. IM04L41B01-04E
Multi Batch (/BT2 option). IM04L41B01-03E
Alarm level display. Section 3.7
Alarm annunciator. Section 3.12
Common alarm (/F1 option). Section 2.9
32-character tag comments and 16-character tag numbers. Section 5.2
Faster display update interval. Section 3.1
Secondary trend interval changeable during recording. Section 5.3
Added 15-, 20-, and 30-minute event data sample rates. Section 6.1
Fine grid. Sections 4.2 and 4.3
Auto zone display. Sections 4.2 and 4.3
Indication that the DX is waiting for a trigger. Section 1.3
Decimal point types “Point” and “Comma”. Section 2.13
Added favorite key operations. Section 5.15
Data searching with date and time. Section 4.3
Historical trend relative time display, auto span display, and top 
channel display.

Section 4.3

Number of batch text fields changed to 24. Section 6.3
The start recording screen appears when you press the start key 
while using the batch function.

Section 6.3

Changed contents of the system and network information displays. Section 2.5
Limits on setting load function. Section 8.1
Event switch. Section 7.1
Added “CommentDisplay” and “FavoriteDisplay” actions to the event 
action function.

Section 7.1

Remote control contact input changed from operating on Close to 
operating on Open (/R1 and /PM1 options).

Section 7.1

Match time timer reset (/M1 and /PM1 Options). Section 7.1
Added “Year” to match time timer conditions (/M1 and /PM1 options). Section 7.1
Match time timer usable for TLOG computation (/M1 and /PM1 
options).

Section 9.1

Stacked bar graphs for report data (/M1 and /PM1 options). Section 4.10
Added recording condition variables to equations (/M1 and /PM1 
options).

Section 1.8

Added USB barcode reader support (/USB1 option). Section 2.11
Saving of data from the internal memory to USB flash memory or a 
CF card (/USB1 option).

Section 2.12

Added data searching, report layout display, a print button, and an 
FTP link to the Web server function.

Section 1.5 in IM04L41B01-17E

Modbus register map expansion and floating-point data writing. Section 6.3 in IM04L41B01-17E
Only send alarm e-mails when an alarm has occurred. Section 1.4 in IM04L41B01-17E
Added tag and channel number to alarm e-mails. Section 1.4 in IM04L41B01-17E
E-mail transfer authentication (Pop Before SMTP). Section 1.4 in IM04L41B01-17E
“°C” displayed in e-mails and the Web settings. Section 1.5 in IM04L41B01-17E
Added the ability to input the square and cube characters (² and ³) in 
communications (only for English, German, and French).

Appendix 3 in IM04L41B01-17E

Added FTP data transfer wait operation. Section 1.7 in IM04L41B01-17E
FTP server directory output format can be set to MS-DOS and UNIX. Section 1.6 in IM04L41B01-17E
EtherNet/IP. IM04L41B01-18E
PROFIBUS-DP (/CP1 option). IM04L41B01-19E

Style 
number 3

Changed the boot ROM. -

DX’s Version and Functions Described in This Manual
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Edition DX Addition and change to functions Reference
6 Release 

number 4
(Version 
4.0x)
Style 
number 3

Advanced security function (/AS1 option). IM04L41B01-05EN
Report template (/M1 and /PM1 options). Section 9.6
Added the “Seprt2” report file separation method. Section 9.5
Calibration management (/CC1 option). Section 3.13
Added functions and improvements to the custom display. The main 
changes are listed below.

IM04L41B01-04E

The status display section can be hidden.
Items have been added (system icons, group names, memory bar, date 
and time labels, batch group numbers, batch names, Modbus input).
Custom grids can be displayed on the trend display.
The bitmap data of the INTERNAL 1 to 3 screens is saved to internal 
memory.
Labels and tags can be displayed vertically.
Additional types of current value marks for the scale have been added.
The scale unit indication can be hidden.
Time can be displayed on all grids on the trend display.
Group switching can be stopped.

Added an alarm sound to the Web server function. Section 1.5 in IM04L41B01-17E
The DX outputs the Modbus input value specified in the custom display. 
The “E-M” command has been added for the Modbus client and master.

Sections 1.10 and 2.6 
in IM04L41B01-17E
IM04L41B01-04E

Authenticated e-mail transmission (Authentication SMTP). Section 1.4 in IM04L41B01-17E
A switch from on to off can be specified as an event. Section 7.1
The duration for which the reflash relays are deactivated can be set to 500 
ms, 1 s, or 2 s.

Section 3.5

Added new input type (Pt200(WEED); /N3 option). Section 3.3
Text fields can be input when the batch function is being used and 
recording starts.

Section 6.3

The length of the user password that can be registered with the login 
function has been extended to 20 characters.

Section 8.2

Operations can be assigned to the output relays (/F1 and /F2 options). Section 2.9
Models with 400 MB of internal memory have been added (internal memory 
size suffix code: “-3”).

IM04L42B01-02E 
MODEL and SUFFIX Code

7 Same as 
edition 6

Additions and improvements to explanations. -

DX’s Version and Functions Described in This Manual
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How to Use This Manual

Structure of the Manual
Read the Operation Guide first to familiarize yourself with the basic operation, 
and then read this manual. For a description of the communication function and the 
accompanying software program, DAQSTANDARD, read the respective manual.
This user’s manual consists of the following sections.

Chapter Title and Contents
1 Overview of Functions

Describes the functions of the DX.
2 Common Operations

Describes the procedure to set the time and the operating procedure using the 
remote control terminal (/KB1 or /KB2 option) and keyboard (/USB1 option).

3 Measurement Channels and Alarms
Describes how to set the measurement conditions and alarms.

4 Switching Operation Screens
Describes the operations on the operation screen.

5 Operations for Changing the Displayed Contents
Describes how to change the displayed contents on the operation screen and how 
to write messages.

6 Saving and Loading Data
Describes how to acquire and store the data. Also describes the procedure to 
load measured data/setup data on the CF card or the USB flash memory (/USB1 
option).

7 Customizing Actions Using the Event Action and Remote Control Functions 
(/R1 and /PM1 Options)
Describes how to carry out specific actions when a given event occurs, when a 
remote control signal is applied, and when the USER key is pressed.

8 Using the Security Function
Describes how to use the key lock function and the function that allows only 
registered users to operate the DX.

9 Computation and Report Functions (/M1 and /PM1 Options)
Describes how to use computation channels and how to create reports such as 
hourly, daily, weekly, and monthly reports.

10 External Input Channels (/MC1 Option)
Describes how to use external input channels.

11 Troubleshooting
Describes error messages and troubleshooting.

12 Maintenance
Describes periodic inspection and calibration.

13 Specifications
Lists the specifications of the DX.

Appendix Describes how to estimate the file size, the types of data that the DX can 
generated and how to use them, the data format of text files, etc.

Index

Note
• This user’s manual covers information regarding DX2000s that have a suffix code for 

language “-2” (English).
• For details on setting the display language, see section 2.6, “Changing the Displayed 

Language.”
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Conventions Used in This Manul

  

Unit
Denotes 1024.  Example: 768 KB (file size)
Denotes 1000.

Markings

WARNING

Procedure

Setup Screen

Setup Items

Explanation

CAUTION

Improper handling or use can lead to injury to the user or 
damage to the instrument.  This symbol appears on the 
instrument to indicate that the user must refer to the user’s 
manual for special instructions.  The same symbol appears in 
the corresponding place in the user’s manual to identify those 
instructions.  In the manual, the symbol is used in conjunction 
with the word “WARNING” or “CAUTION.”

Calls attention to actions or conditions that could cause serious 
or fatal injury to the user, and precautions that can be taken to 
prevent such occurrences.

Calls attentions to actions or conditions that could cause light 
injury to the user or damage to the instrument or user’s data, and 
precautions that can be taken to prevent such occurrences.

Calls attention to information that is important for proper 
operation of the instrument.

Note

Indicates character types that can be used.

Carry out the procedure according to the step numbers.
All procedures are written with inexperienced users in mind;
depending on the operation, not all steps need to be taken.
Explanation gives information such as limitations related the 
procedure.

Indicates the setup screen and explains the settings.  A 
detailed description of the function is not provided in this 
section.  For details on the function, see chapter 1.

Subheadings

A a # 1
A a #

1

Uppercase alphabet, lowercase alphabet, symbols,  
numbers.

Bold characters Denotes key or character strings that appear on the screen.
Example: Volt

K
k

How to Use This Manual
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1.1 Input Section

Measurement Channel
• Number of Measurement Channels and Scan Interval
	 The	DX	samples	the	input	signals	on	the	measurement	channels	at	the	scan	interval	

to	obtain	the	measured	values.	The	table	below	shows	the	relationship	between	the	
number	of	measurement	channels	and	the	scan	interval.

	 	 	

DX2004
DX2008
DX2010
DX2020
DX2030
DX2040
DX2048

25 ms

125 ms

125 ms
250 ms

2 s, 5 s

4
8
10
20
30
40
48

Fast Sampling Mode*Normal Mode

Number of 
Measurement
Channels

Model
Scan Interval

Integration time of the A/D 
converter 60 Hz/50 Hz/100 ms60 Hz/50 Hz 600 Hz (fixed)

*  Not available on models equipped with external input channels (/MC1 option) or 
 when the multi batch function (/BT2 option) is being used.

1 s, 2 s, 5 s

	 For	the	setting	procedure,	see	section	3.1.

• Integration Time of the A/D Converter
	 The	DX	uses	an	A/D	converter	to	convert	the	sampled	analog	signal	to	a	digital	

signal.	By	setting	the	integration	time	of	the	A/D	converter	to	match	the	time	period	
corresponding	to	one	cycle	of	the	power	supply	or	an	integer	multiple	of	one	cycle,	the	
power	supply	frequency	noise	can	be	effectively	eliminated.

•	 Because	100	ms	is	an	integer	multiple	of	16.7	ms	and	20	ms,	this	setting	can	be	used	to	
eliminate	the	power	frequency	noise	for	both	frequency,	50	Hz	and	60	Hz.

•	 In	fast	sampling	mode,	the	performance	of	eliminating	power	frequency	noise	is	worse	than	
in	normal	mode.	We	recommend	that	you	use	normal	mode	when	making	measurements	in	
an	environment	affected	by	power	frequency	noise.

	 For	the	setting	procedure,	see	section	3.1.

Input Type and Computation
You	can	make	measurements	using	the	following	input	types.

	 	

*1 Item sold separately.  For example, a 250-Ω shunt resistor is used to convert the signal 
 to 1 to 5 V for 4-20 mA input.
*2 /N3 option.
*3 /N1 option.
*4 /PM1 option.

Input Type Description
DC voltage Measures a DC voltage in the range of ±20 mV to ±50 V.
DC current A shunt resistor*1 is attached to the input terminal.  The current signal is converted

to a voltage signal and measured.  The measurable range is the range equivalent 
 to the “DC voltage” range indicated above after converting the current to the 
 voltage signal.
Thermocouple Measures temperature corresponding to each type: R, S, B, K, E, J, T, N, W, 
 L, U, and WRe3-25.  Measurement is possible on other thermocouples 
 such as PR40-20 and PLATINEL*2.
RTD Measures temperature corresponding to each type: Pt100 and JPt100.  
 Measurement is possible on other RTDs such as Cu10 or Cu25*3 and Pt50 or 

Ni100*2.
ON/OFF input Displays the contact input or voltage input signals by correlating them to 0% or 

100% of the display range.
 Contact input: Closed contact is ON (1).  Open contact is OFF (0).
 Voltage input: Less than 2.4 V is OFF (0).  Greater than or equal to 2.4 V is ON (1).
Pulse input*4 Counts the pulses.

Chapter 1 Overview of Functions
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The following input processing and computation are available.

DC Voltage 

DC current 
Shunt resistor 

1 - 5 V 
Burnout detection 

Burnout detection 

RJC

Square root computation

Thermocouple

RTD

Pulse

(/PM1 option) 

ON/OFF input 

Convert to number of pulses over 1 second 

Moving average Linear
scaling

Calibration
correction

(/CC1 option) 

Difference
computation

Low cut Measured
value

Dotted lines indicate that the function can be selected.

Measured 
value

Moving Average

External reference junction

Internal 
reference 
junction

Performs reference junction compensation on 
the thermocouple.

Reference Junction Compensation Burnout Detection
Detects and indicates a burnout in the sensor.

1 - 5 V
Detected on the 
1-5 V value.

Burnout

For the setting procedure, see section 3.2. For the setting procedure, see section 3.2.

For the setting procedure, see section 3.4.

Burnout

Indicated as 
Burnout.

Indicated as 
Burnout.

Thermoelectromotive 
force

1
2
3

10.0 mV
5.0 mV
0.0 mV

5.0 mV

15.0 mV
10.0 mV
5.0 mV

10.0 mV

10.0 mV
15.0 mV
10.0 mV

11.7 mV
Clear

nth time n + 1th time n + 2th time

Clear
(Moving average)

New sampled 
data

New sampled 
data

Operation example when the number 
of moving average data points is 3

Number of moving 
average data points: 2 to 400Sampling data 

in the buffer

Sampling

Eliminates noise.

DX

Thermocouple

Thermocouple

1.1  Input Section
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Difference computation 

Low-cut

Square Root Computation 

Calibration Correction (/CC1 Option) 

Input
value

Measured
value

Measured
value

Input
value

Input
value

Input
value

Input
value

Measured
value

Measured
value

Measured value on the reference channel 

–

The measured value of the channel is set to the
difference with respect to the measured value of the
reference channel. 

Converts the unit to obtain the measured value. Takes the square root of the input value and converts  
the unit to obtain the measured value. 

Corrects the input value with the characteristics
specified by segments to obtain the measured value. 

Number of break
points: Up to 16 

Pulse Input (/PM1 Option)

Linear Scaling 

10 V 

0 V 

300 °c

–100 °c

a

b

x

a b

B

B

X

A 

A 
X = (B – A) + A 

x – a

b – a

The contact changes from open to close. 
The signal level at the input terminal changes from high
to low. 

5 ms or more 

100 Hz or less 
Pulse

Contact

or

Open
collector

Pulse that can be counted Input to the DX 

Count on the DX 

Measured
value

Output
value

For square root computation, measured values below
the specified value are cut. 
For 1-5 V input, values below 0 % are cut. 

Result of square root 
computation

Low-cut value 

DX

For the setting procedure, see section 3.3. For the setting procedure, see section 3.3. 

For the setting procedure, see section 3.9. For the setting procedure, see section 3.3. 

For the setting procedure, see section 3.3. For the setting procedure, see section 3.10.

(               )

Note
 Difference computation is executed even if the input type or range is not the same between 

the difference computation channel and the reference channel. The difference is computed 
discarding the decimal place and unit, and the decimal place and unit of the difference 
computation channel are applied.
Example 1: If the input value of the difference computation channel is 10.00 and the 

measured value of the reference channel is 100.0, the computed result is  
10.00 – 100.0 = –90.00.

Example 2: If the input value of the difference computation channel is 10.00 V and the 
measured value of the reference channel is 5.00 mV, the computed result is  
10.00 V – 5.00 mV = 5.00 V.

Calibration Management (/CC1 option; release numbers 4 and later)
You can use this function to make sure that calibration is performed regularly.
When you enable calibration management, a screen (the calibration notification screen) 
appears to notify you in advance that the calibration due date is approaching.
For the setting procedure, see section 3.13.

1.1  Input Section
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1.2 Alarms

This function generates an alarm when the measured data meets a certain condition. Up 
to four alarms can be set for each channel.

Alarm Type
You can use the alarms shown below. The character inside the parentheses is the 
symbol denoting each alarm.
For the alarm setting procedure, see section 3.7.

High Limit Alarm (H)

Alarm value

Alarm output ON Alarm output ON

Alarm output ON Alarm output ON 

Alarm value

HysteresisMeasured value Measured value Hysteresis
Low Limit Alarm (L)

Alarm output ON Alarm output ON 

Delay time Delay time 

Alarm value Alarm value 
Measured value Measured value 

Delay High Limit Alarm (T) Delay Low Limit Alarm (t)

High Limit on Rate-of-Change Alarm (R) Low Limit on Rate-of-Change Alarm (r) 

Alarm value 
Alarm value 

Hysteresis Hysteresis
Difference in the measured values of two channels Difference in the measured values of two channels 

Difference High Limit Alarm (h) Difference Low Limit Alarm (l) 

Change in the
measured value 

Change in the measured value 

Measured value Measured value 

Time Time 
Interval (t2-t1) Interval (t2-t1) 

Amount of change in
the setting 
| | 

T2

T1

t1 t2

T2

T1

t1 t2

T2-T1
Amount of change in
the setting 

| T2-T1

• Alarm Hysteresis
 You can set a width (hysteresis) to the value used to activate and release alarms.

• Delay High Limit Alarm and Delay Low Limit Alarm
 An alarm occurs when the measured value remains above or below the alarm value 

for a specified time period (delay period).

• High Limit on Rate-of-Change Alarm and Low Limit on Rate-of-Change  
 Alarm
 The rate-of-change of the measured values is checked over a certain time (interval). 

An alarm occurs if the rate-of-change of the measured value in the rising/falling 
direction is greater than or equal to the specified value.

 The alarm value of the rate-of-change alarm is set using an absolute value. The 
interval is derived using the following equation and set using the number of samples.

  Interval = the scan interval × the number of samples
 For the setting procedure, see section 3.5.

• Difference Upper Limit Alarm and Difference Lower Limit Alarm
 An alarm occurs when the difference in the measured values of two channels is 

greater/less than or equal to the specified value. These alarms can be specified on 
measurement channels set to difference computation.



1-5IM 04L42B01-01E

O
verview

 of Functions

1

2

3

4

5

6

7

8

9

10

11

12

13

App

Index

Alarm Indication
The alarm conditions are displayed as alarm icons in the status display section and on 
the operation screen such as the trend, digital, bar graph, overview displays. Detailed 
information about the alarms is displayed in the alarm summary.

• Alarm Levels and Colors (Release number 3 or later)
  You can set separate levels and colors for the four alarms on a single channel. When 

multiple alarms occur, the DX gives higher priority to the display of alarms with higher 
levels. It is easy to understand what processes are taking place when alarms occur if 
you associate an alarm’s color with its level. Level and color settings are the same for 
each channel.
•  In the overview display, the channel display area appears in the color of the alarm 

that has occurred.

    

• The following items also appear in the color of the alarm that has occurred.
 • Alarm marks in the trend, digital, and bar graph displays
 • The alarm point marks on scales (when they are set to “Alarm”)
 • The alarm occurrence mark in the alarm summary

  When multiple alarms occur on the same channel, the various displays respond as 
described below:
•  In the overview display, the channel display area is displayed using the color of the 

alarm with the highest priority level.
•  In the trend and digital displays, the alarm type is displayed using the symbol for 

the alarm with the highest priority level.
• In the annunciator display, the display window is displayed using the color of the 

alarm with the highest priority level.
 For the setting procedure, see section 3.7.

• Alarm-Activated Text Display (Release number 3 or later)
 Using the Event Action function, you can display a previously set string of text (comment 

text block) when an alarm occurs.
 For the procedure to set comment text blocks and event action, see sections 5.19 and 

7.1, respectively.

• Hold/Non-hold of Indications
The alarm indication can be set to operate in the following fashion when the condition 
is no longer met.
• Clear the alarm indication (non-hold).
• Hold the alarm indication until the alarm ACK operation is executed (hold).
The default setting is non-hold.

 For the setting procedure, see section 3.5.

1.2  Alarms
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• Alarm Hide Function
 The alarm setting is displayed, but no indication is made when an alarm occurs. The 

alarm is also not recorded in the alarm summary. The alarm is output to the relay  
(/A[ ] option) or internal switch. This function can be set for each channel and each 
alarm.

 For the setting procedure, see section 3.6.

Alarm Output Relay Operation
Contact signals can be generated from alarm output relays (/A_ option) when alarms 
occur. The alarm output relay operation can be changed.
For the setting procedure, see section 3.5.

Alarm

Alarm output relay
(Reflash on)

Alarm output relay
(Reflash off)

Channel 1

Channel 3
Channel 2

Energize or De-energize

AND/OR

Alarm
Channel 1

AND

Channel 2

OR

Alarm output relay
or
internal switch

NO
Energize

De-energize

C NC NO C NC NO C NC

NO C NC NO C NCNO C NC

When power
is shut down

NO: Normally Opened
C: Common
NC: Normally Closed

Normal
operation

When an alarm
is occurring

Alarm

Normal

Alarm

Normal

Reflash

(You can set AND/OR for the alarm output relay and internal
switch. For details about the internal switch, see the next 
page.)

(when a relay is set to OR logic)

 N
or

m
al

R
es

et
R

el
ay

 A
ct

io
n 

on
 A

C
K

 
R

el
ay

 A
ct

io
n 

on
 A

C
K

Occurrence

Activated

Deactivated

Activated

Deactivated

Activated

Deactivated

Release

or

Activated

Deactivated

or

D
is

pl
ay

A
la

rm
H

ol
d

N
on

-h
ol

d
A

la
rm

 o
ut

pu
t r

el
ay

H
ol

d
N

on
-h

ol
d

H
ol

d
N

on
-h

ol
d

Non-hold/Hold

Relay is activated
at the next scan
interval.

Relay is activated
when the next
alarm occurs.

Alarm ACKAlarm ACK

500 ms, 1 s, or 2 s

1.2  Alarms
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• Reflash
 When multiple alarms are assigned to one alarm output relay, this function notifies the 

occurrence of subsequent alarms after the relay is activated by the first alarm. When 
subsequent alarms occur, the output relay is released temporarily.The duration for which 
the relays are deactivated can be set to 500 ms, 1 s, or 2 s.

 The reflash function is set on the first three output relays.*
* I01 to I03 or I11 to I13. I01 and I02 for the /A1 option.

Note
When reflash is enabled, the first three output relays are used exclusively as reflash relays. 
The first three output relays are set to OR logic and de-energize operation regardless of the 
AND/OR and energize/de-energize settings explained below.

• AND/OR
 When multiple alarms are assigned to one alarm output relay, the condition for 

activating the output relay can be selected from the following: You can select AND 
operation also for the internal switch.
• AND: Activated when all assigned alarms are occurring simultaneously.
• OR: Activated when any of the specified alarms is occurring.

• Energize or De-energize Operation
 You can select whether the alarm output relay is energized or de-energized when an 

alarm occurs. If de-energized is selected, the status of the alarm output relay when an 
alarm occurs is the same as the status that results when the DX power is shut down. 
The setting applies to all alarm output relays.

• Non-Hold/Hold
 The alarm output relay can be set to operate in the following fashion when the alarm 

condition is no longer met.
• Turn OFF the relay output (non-hold).
• Hold the relay at ON until the alarm ACK operation is executed (hold).
The setting applies to all alarm output relays.

• Alarm ACK Operation
 The alarm acknowledge (alarm ACK) operation releases all alarm indications and 

relay outputs. For the action of alarm indication and alarm output relay when you 
carried out the alarm ACK operation, see the previous page.

•  Individual Alarm ACK Operation (Only on DXs with the /AS1 advanced 
security option)

 This operation releases the relay output of individual alarms. This operation is referred 
to as “individual alarm ACK.” For information about how alarm display and output 
relay operations respond to an individual alarm ACK, see the previous page. You can 
perform individual alarm ACK from the overview display.

 For operating instructions, see section 4.4.

Note
When you enter the basic setting mode, the activated/deactivated condition of the alarm output 
relay immediately before is retained. In the basic setting mode, alarms are not detected, and 
you cannot acknowledge alarms.

1.2  Alarms
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Internal Switch
The alarm status can be output to software switches (30 internal switches). The values of 
the internal switch are shown below. Like the alarm output relay, you can specify AND/
OR operation (see the previous page). The internal switches cannot be operated other 
than for alarm output.

  
Alarm

Alarm occurrence

Alarm release

Internal switch
1

0

The internal switches can be used events of the event action function (see section 1.6). 
In addition, the internal switches can be written in calculation expressions of computation 
channels (/M1 or /PM1 option).

Alarm Annunciator Function (Release number 3 or later)
You can use the DX as an alarm annunciator. No lock-in, lock-in, and double lock-in 
sequences are supported. The alarm display and alarm output relay operations follow the 
annunciator sequence.

  

For the setting procedure, see section 3.12.

1.2  Alarms
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1.3 Display

Common Items Related to the Display
• 10.4 TFT Color LCD and the Screen Configuration
 The DX has a 10.4-inch TFT color LCD (480 × 640 dot resolution). The screen 

consists of the status display section and the data display section.

   

Status display section

Data display section

 • Status Display Section
 The status display section shows the display name, date/time, batch name (when 

using the batch function), user name (when using the login function), usage of the 
internal memory or CF card, alarm occurrence, computation status (/M1 or /PM1 
option), and usage of key lock or e-mail transmission.

 • Data Display Section
 The data display section shows the measured data using numeric values, 

waveforms, and bar graphs. It also shows the setup screen when setting functions.
• Group Display
 On the trend, digital, and bar graph displays, the data of channels is displayed by 

groups that are set in advance. Up to 36 groups can be registered, and up to 10 
channels can be assigned to each group. Groups are common to the trend, digital, 
and bar graph displays.

 The displayed group can be switched automatically at a specified time interval (5 s to 1 min).
 For the setting procedure, see section 5.1.
• Channel Number Display and Tag Display
 You can choose to label displayed channels according to their tags or according 

to their channel numbers. In the tag display, you can display tag numbers and 
comments. This setting applies to all channels.

 For the setting procedure, see section 5.2. For the tag number and tag comment 
display example, see section 4.2.

• Update Interval of Measured Values
 The values are updated every second. However, if the scan interval is greater than 1 s, 

the values are updated at the scan interval.
 For the setting procedure, see section 5.3.
• Alarm Indication
 Alarms that are set for each channel are checked at all times and are indicated with 

the symbol representing the alarm type on each display.

   
High limit on rate-of-change alarm
Low limit on rate-of-change alarm
Delay high limit alarm
Delay low limit alarm

R
r
T
t

Alarm Type Symbol Alarm Type Symbol
High limit alarm
Low limit alarm
Difference high limit alarm
Difference low limit alarm

H
L
h
l
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Status Display Section
The following information is displayed in the status display section during operation mode 
or setting mode.

Memory sampling status

Error in internal memory. 
Contact your nearest YOKOGAWA dealer for repairs.

Displayed when any alarm is activated.
Blinks when there are alarms that are 
occurring but have not been acknowledged.

The status assigned to the status output 
(/F1 or /F2 option) is occurring.

CF card icon

Keys are locked.

E-mail transmission is enabled.

White icon:Computation started

Yellow icon:Computation data dropout occurred

CF card is being accessed.

Waiting.
Light blue icon: CF card in the slot is not 
recognized. Remove and reset it. 
CF card error.
Carry out the procedure below to reset the CF card icon to 
normal.
•  Remove the CF card, and then reinsert it.
• Replace the CF card with a normal one.
• Format the CF card on the DX (the data on the CF card 
 will be erased).

The green level display indicates the amount of 
CF card used. If Media FIFO* is not enabled and 
the free space on the CF card falls below 10%, 
the level indicator changes to red.
* See section 1.4, in the DX1000/DX1000N User’s
 Manual. Media FIFO is a function available on 
 release number 2 or later.

If the “batch number-lot number” exceeds 20 
characters, the “date and time” position is used to 
display the “batch number-lot number.”

Memory sampling icon

Memory sampling 
stopped

Memory sampling 
in progress

Name of the user logged in

Date and time
Displayed in yellow while the time is being corrected.

Display name or group name
For all channel display on the trend display, 
“All” is displayed.

Data type
Display data
Event data

Memory sampling progress
Displays the progress using a green bar graph.  The frame indicates the file 
save interval (display data) or the data length (event data).

Displays the remaining memory sampling time for the left bar graph.

When using the login function

When using the batch function

Alarm icon

Status icon

Computation icon (/M1 or /PM1 option)

Date and time

Name of the user logged in
When using the login and batch functions

Date and time

Date and time
Display name

(Red)

(Green)Batch name and the display 
name are shown alternately. 

Batch name and the display 
name are shown alternately. 

User locked icon (/AS1 option)
Displayed when the user is locked.

All alarms have been released after they 
have occurred, but there are alarms that 
have not been acknowledged.

Bar Graph
When event data recording is set to pretrigger, the DX will start recording pretrigger data 
after you press the START key. “Waiting” appears in the bar graph (release number 3 or 
later). At this time, the progress bar will turn orange. After the pretrigger time elapses, 
the length of the bar fixed at that point. However, the relevant data is updated until the 
trigger condition is met. When the trigger condition is met, the bar turns green, and data 
is recorded after the data in the pretrigger section.

1.3  Display
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Trend Display (T-Y)
Waveform data is displayed in a waveform. For the operating procedure, see section 4.2.

Vertical display
Display layout

Horizontal split display (displays two groups)
The waveforms of two consecutive groups are displayed. 
The numeric display sections show the data for the first 
four channels in their groups.Horizontal wide display

GridTrend interval Numeric display section

Current value mark

Scale

“Trend space” function
Inserts a division-wide space here.

Color scale band

Alarm point mark

Current value display 
using a bar graph

Waveform (displayed using the channel display color)

Message (mark, time, and message)

Tag or channel number, measured value, 
and specified alarm

Trip line (up to four lines)

1 division 
(30 dots)

Maximum value
Minimum value
1 dot

Displays the maximum and minimum values of the 
data sampled within the time corresponding to 1 dot.

Change the channel display color (see section 5.5.)
Change the waveform line width (see section 5.10.)
Display the waveforms of all channels (see section 4.2.)

See section 5.8.

See section 5.7.

See section 5.10.

See section 5.10.See section 5.3. See section 4.2.

See section 5.4.

See section 5.1.

See section 5.7.

See section 4.2.

See sections 2.4 and 5.3.

See section 5.8.

Alarm mark
Alarm type

Time at the grid position
Displays the time or the date and time.

1.3  Display
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• Updating of the Waveform
 On the screen, 30 dots along the time axis is represented by a unit called division (see 

the figure on the previous page). The displayed waveform is updated at an interval 
corresponding to one dot. This interval is determined by the time corresponding to one 
division (referred to as the trend interval). The relationship between the trend interval 
and the speed of movement of waveforms on the screen is as follows:
Trend interval (/DIV) 5 s*1 10 s*1 15 s*2 30 s 1 min
Time corresponding to one dot 
(in seconds)

0.125 0.25 0.5 1 2

Speed of waveform movement 
(approximation in mm/h)

10000 5000 2500 1250 625

Trend interval (/DIV) 2 min 5 min 10 min 15 min 20 min
Time corresponding to one dot 
(in seconds)

4 10 20 30 40

Speed of waveform movement 
(approximation in mm/h)

312 156 78 42 31

Trend interval (/DIV) 30 min 1 h 2 h 4 h 10 h
Time corresponding to one dot 
(in seconds)

60 120 240 480 1200

Speed of waveform movement 
(approximation in mm/h)

21 10 5.2 2.6 1.0

*1 40 dots per division. Selectable on the DX2004 and DX2008 (release number 3 or later).
*2  Selectable on the DX2010, DX2020, DX2030, DX2040, and DX2048 when the scan interval 

is set to fast sampling mode (release number 3 or later).

 Switching the Trend Interval
 You can switch from the normal trend interval to the secondary trend interval during 

memory sampling and vice versa. For the operating procedure, see section 5.3.

• Writing Messages

   

Preset messages

Free message
Set the message when writing the message

1
2
3
4

Start
Material 1

Trend display

 Preset Messages
 Preset messages are recalled and written.
 The number of messages that you can use are 100 (message 1 to 10 are shared with 

free messages). For the operating procedure, see section 5.4
 Free Messages
 Messages are entered when you need to enter them. The number of messages that 

you can use are 10. For the operating procedure, see section 5.4.

 Automatic Message Writing
• A message is written when the trend interval is switched during memory sampling. 

For the setting procedure, see section 5.3.
• A message is written when the power recovers from a power failure during memory 

sampling. For the operating procedure, see section 5.17.
• A message is written when the setting mode setup items are changed during 

memory sampling (only on DXs with the /AS1 advanced security option).

1.3  Display
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 Message display method
• Except for the vertical display, you can set the direction in which messages are 

displayed to horizontal or vertical. For the setting procedure, see section 5.10.
• Messages can be displayed consolidated at the upper left of the screen (list 

display). For the operating procedure, see section 4.2.

    

List display

Vertical display

• Zone Display
 You can display channels in specified zones. This function can be used to keep the 

waveforms from overlapping for easier view.
 In the example below, channel 1 is displayed in the 0 to 30% zone, channel 2 in the 

30 to 60% zone, and channel 3 in the 60 to 100% zone.

   
Zone 2

Zone 1

Zone 3

100 %

Time axis

30 %

60 %

100 %

0 %0 %
Time axis

When zone display is not used When zone display is used

CH3

CH2

CH1

 For the setting procedure, see section 5.6.

 Auto Zone (Release number 3 or later)
  You can divide the waveform display area evenly between each channel in a group.

For operating instructions, see section 4.2.

1.3  Display
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• Partial Expanded Display
 By compressing a section of the waveform display range, the rest of the section is 

expanded.
 In the example below, 0 V (boundary value) is moved to the 30% position of 

the display range (new boundary position). The 30% area below the boundary 
corresponds to “–6 V to 0 V” and 70% area above the boundary corresponds to “0 V 
to 6 V.”

  

Percentage with 
respect to the 
display span

100

Percentage with 
respect to the 
display spanMeasured value

Boundary
value

New
boundary
position

Measured value
100

300

500

6 V6 V

0– 6 V– 6 V 0

Ex
pa

nd
ed

 s
ec

tio
n

Reduced
section

Time axis Time axis

When partial expanded display 
is used

When partial expanded display 
is not used

 For the setting procedure, see section 5.9.

• Alarm Indication
 Alarm mark, alarm type, and measured value are displayed as follows according to 

the alarm status. When you use the alarm annunciator function (release number 3 or 
later), the alarm mark follows the annunciator sequence.

Alarm
Release

Red None RedNone Red RedNone None None None None

Alarm ACK Alarm ACK
Occurrence

When indication is 
set to non-hold

When indication is 
set to hold

Alarm type

Red Blue RedBlue Red RedBlue Blue Blue Blue BlueMeasured
value

Blinking 
red

Blinking 
green

Blinking 
red

Green Red RedGreen Green GreenGreen GreenAlarm mark

1.3  Display
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Digital Display
Displays the measured data numerically using large numbers. For the operating 
procedure, see section 4.2.

   

Unit

Tag or channel numbers

Alarm mark

Measured value

Note
• Numeric display of measurement channels
 If a measured value of a measurement channel is over range (see below), the measured 

value is indicated as “+Over” or “–Over.” If a burnout is detected on a channel whose 
burnout detection function is enabled, the word “Burnout” is indicated. Otherwise, a numeric 
value is displayed.

 Over range of measurement channels
• For DC voltage input, over range occurs when the measured value of the measurement 

channel exceeds ±5% of the measurable range. For example, the measurable range when 
the measurement range is 2 V is –2.000 to 2.000 V. If the measured value exceeds 2.200 V, 
+ over range occurs; if the measured value falls below –2.200 V, – over range occurs.

• For thermocouple or RTD input, over range occurs when the measured value exceeds 
approximately ±10°C of the measurable range. For example, the measurable range 
when the measurement range is R is 0.0 to 1760.0°C. If the measured value exceeds 
approximately 1770.0°C, + over range occurs; if the measured value falls below 
approximately –10.0°C, – over range occurs.

• For channels that are linearly scaled, + over range occurs when the value exceeds 30000 
excluding the decimal point; – over range occurs when the value falls below –30000. 
However, + over range can be changed to greater than or equal to 105% of the scale width 
and – over range to less than or equal to –5% of the scale width within ±30000. For the 
setting procedure, see section 3.11.

• Numeric display of computation channels
 See section 1.8, “Computation and Report Function (/M1 and /PM1 Options)
• Numeric display of external input channels (/MC1 option)
 The numeric range that can be displayed is –30000 to 30000 excluding the decimal point. 

The decimal place corresponds to the decimal place of the lower limit of span of the external 
input channel. On the numeric display, values are displayed if the value is within the –30000 
to 30000 range regardless of the upper and lower limits of span.

 If the value exceeds 30000, + over range occurs; if the value falls below –30000, – over 
range occurs.

• Alarm Indication
 Alarm mark and measured value are displayed as follows according to the alarm 

status. When you use the alarm annunciator function (release number 3 or later), the 
alarm mark follows the annunciator sequence.

Alarm
Release

Alarm ACK Alarm ACK
Occurrence

When indication is 
set to non-hold

When indication 
is set to hold

Red Blue RedBlue Red RedBlue Blue Blue Blue BlueMeasured
value

Blinking 
red

Blinking 
green

Blinking 
red

Green Red RedGreen Green GreenGreen GreenAlarm mark

1.3  Display



1-16 IM 04L42B01-01E

Bar Graph Display
Waveform data is displayed in a bar graph. For the operating procedure, see section 4.2.

  

Horizontal

Vertical

Alarm point mark

Scale

Bar graph (displayed using the 
 channel display color)

Measured value
Lower limit of span and unit

Upper limit of span

Tag or channel number
Alarm mark

Bar graph base position is set 
to Normal, Lower*, or Upper*.
*  You can select Lower and Upper 
   on DXs with release number 2 or 
   later.

Bar graph base position is set 
to Center

See section 5.7.

See section 5.11.

See section 5.10.

See section 5.11.

Bar graph base position is set to Center
See section 5.11.

See section 5.11.

• Updating of the Bar Graph
 The bar graph is updated at the same interval as numeric values.

• Alarm Indication
 Alarm mark, alarm point mark, and measured value are displayed as follows according 

to the alarm status. When you use the alarm annunciator function (release number 3 
or later), the alarm marks and alarm point marks follow the annunciator sequence.

Alarm
Release

Red Green RedGreen Red RedGreen Green Green Green Green

Alarm ACK Alarm ACK
Occurrence

When indication is 
set to non-hold

When indication is 
set to hold

Point mark

Red Blue RedBlue Red RedBlue Blue Blue Blue BlueMeasured
value

Blinking 
red

Blinking 
green

Blinking 
redGreen Red RedGreen Green GreenGreen GreenAlarm mark
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Historical Trend Display
The waveform of the past measured data (display or event data) in the internal memory 
or external storage medium can be displayed. This function is called Historical trend.
• Methods of Displaying the Historical Trend
 There are four methods to display the historical trend of the measured data in the 

internal memory.
• Display from the alarm summary. For the operating procedure, see section 4.6.
• Display from the message summary. For the operating procedure, see section 4.7.
• Display from the memory summary. For the operating procedure, see section 4.8.
• Recall from the display selection menu. For the operating procedure, see section 4.3.

 Measured data on an external storage medium can also be displayed as historical 
trend. For the operating procedure, see section 6.8.

• Displayed Contents

Cursor

Historical trend

Current trend

Message

Zoom factor of the time axis
Time axis

Measured value (maximum or minimum value over 
the entire display range)*1

Measured value (maximum or minimum value at 
the cursor position)*1

Waveform (channel display color)Background
color
(Can be changed)

The most recent data position among the displayed data

Half screen display

Screen switch display

Trip line

Date and time of the data at the right end on 
the time axis*2 or the time at the cursor position
The time at the cursor position is displayed enclosed in a 
yellow frame.

Unit

Tag or channel number (channel display color)

Date and time of the data at 
the left end on the time axis*2

*1 You can also view a digital display of just the value at the cursor position
 (release number 3 or later).
*2 You can also display the relative time from the start of recording
 (release number 3 or later).

Item Description
Alarm summary Displays an alarm summary of the displayed data.
Message summary Displays a message summary of the displayed data.
Data information Shows information about the displayed data (file name, sample start 

time, end time, etc.).

1.3  Display
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• Added Messages
Added messages can be written. For the operating procedure, see section 5.4.

• Auto Span Display (Release number 3 or later)
 The DX can automatically adjust the display span of the selected channel.*It sets 

the span based on the maximum and minimum displayed historical data values. This 
setting is deactivated when you switch to another group.

*  Auto span affects channels that are in the same scale position as the selected channel.

 When the maximum or minimum values are outside of the set display span

   0

0Auto span

Time axis Time axis

Measured value Measured value

 When the maximum or minimum values are within the set display span

   0 0

Time axis Time axis

Auto span

Measured value Measured value

  If the maximum or minimum data value falls outside the maximum selectable display 
span, the DX adjusts the display span to the maximum or minimum possible value. 
The DX responds in the same way when it encounters overflow data.

• Top Channel Display (Release number 3 or later)
 Displays the selected channel’s historical trend waveform in front of all of the others. 

This setting is deactivated when you switch to another group.

• Signature (Only on DXs with the /AS1 advanced security option)
 See the Advanced Security Function (/AS1) User’s Manual, IM 04L41B01-05EN.

1.3  Display
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Circular Display
The circular display shows the measured data on a circular time axis in place of the trend 
display (T-Y). The time per revolution can be set in the range of 20 minutes to 4 weeks.
For the operating procedure, see section 5.12.

Grid

Time per revolution

Date/time
Time scale (main scale marks and small scale marks)

Scale
Channel number corresponding to the scale value

Message mark (position where the message was written)

Message This position is the time reference position.
The time axis is set so that the time reference 
position is hour 0.
The reference position can be offset in unit of one hour.

Trip line (up to four lines)

To change the channel display color, see section 5.5.
To change the waveform line width, see section 5.10.
To display the waveforms of all channels, see section
4.2.

See section 5.10

See section 5.12

See section 5.4

See section 5.1

Waveform (displayed using the channel display color)

Quarter cycle display Simplified historical trend

• Historical Trend Display
 Displays the past data for each time of revolution. The displayed contents and 

operating procedure are the same as the historical trend of the T-Y display. Half 
screen display is not possible.

   

Cursor (yellow line)

Time per revolution

Date/time

Cursor time

See section 5.12

See section 5.12

1.3  Display
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Overview Display
Displays a list of the statuses of all channels.
You can move the cursor to select a channel and display the trend, digital, or bar graph 
of the group containing the selected channel.
For the operating procedure, see section 4.4.

   

Tag or channel number

Cursor

Measured value and unit

Alarm type

Channels on which an alarm is 
occurring are indicated in red

• Alarm Indication
 Channel display area, tag/channel number, alarm type, and measured value 

are displayed as follows according to the alarm status. When you use the alarm 
annunciator function (release number 3 or later), the displays of the previously listed 
items follow the annunciator sequence.

Alarm
Release

Blinking 
white

Blinking 
black

Blinking 
white

Black White WhiteBlack Black Black Black Black

Alarm ACK Alarm ACK
Occurrence

When indication is 
set to non-hold

When indication is 
set to hold

Tag/Channel 

White None WhiteNone White WhiteNone None None None NoneAlarm type

White Black WhiteBlack White WhiteBlack Black Black Black BlackMeasured
value

Red Green RedGreen Red RedGreen Green GreenGreen GreenChannel
area
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Alarm Summary
Displays a list of the most recent alarms.
• Up to 1000 alarms can be displayed.
• You can select arbitrary alarm information and recall the historical trend of the display 

data or event data that contains the alarm information.
For the setting procedure, see section 4.6.

   

To the historical trend display

Number of the alarm information displayed on the bottom line/number of alarm 
information in the internal memory

Cursor (selects the alarm)

: Alarm occurrence
 (      blinks until the alarm ACK operation is carried out if “Indicator” is set to 
 “Hold.”)

Channels on which alarms are occurring
Alarm level (1, 2, 3, 4)/type (H, L, h, l, R, r, T, t)

Date/Time of alarm occurrence/release

: Alarm release
: Alarm acknowledge 
 (when blinking is cleared through the alarm ACK operation)

When you use the alarm annunciator function (release number 3 or later), the alarm 
occurrence mark follows the annunciator sequence. If the alarm sequence is no lock-in 
(ISA-A-4):
• The alarm occurrence mark does not blink.
• “ACK” is recorded when the alarm is released.

1.3  Display
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Message Summary
Displays a list of written messages and the time the messages were written.
• Up to 450 messages can be displayed.
• Up to 50 messages that are added to the past data section (added messages) can be 

displayed.
• You can select arbitrary message information and recall the historical trend of the 

display data or event data that contains the message.
For the setting procedure, see section 4.7.

  

To the historical trend display

Number of the message displayed on the bottom line/number 
of messages in the internal memory

Cursor (selects the message)

Message
Added message 
(displayed in blue)

Date/Time when the message was written

Destination group to write the message
All groups or a group number

• Switching of the Display Items
 You can switch between two sets of display contents.

• Message, time when the message was written, and group to which the message 
was written

• Message, user name that wrote the message

1.3  Display
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Memory Summary
Displays the information pertaining to the display data and event data in the internal 
memory.
• By selecting the display data or event data, the historical trend display can be recalled.
• The number of manual sampled data and report data (/M1 and /PM1 options) in the 

internal memory is displayed.
 For the setting procedure, see section 4.8.

• You can display file information (only on DXs with the /AS1 advanced security option).
 See the Advanced Security Function (/AS1) User’s Manual, IM 04L41B01-05EN.

   
To the historical trend display

Cursor (selects the file)
Date/Time of memory start

Date/Time of memory stop
Sampling count

Status

Number of data points in the 
internal memory/maximum 
number of data points that 
can be recorded in the 
internal memory

Date/Time of the most recent 
data

Data type
• Display data
• Event data

• Switching of the Display Items
 You can switch between two display methods.

• Display the start and end times
• Display the file name

• Saving the Data
 The data in the internal memory can be saved to a CF card or USB flash memory 

(/USB1 option).

1.3  Display
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Report Data (/M1 and /PM1 Options)
Report data residing in the internal memory can be displayed.
For the operating procedure, see section 4.5.

   

Number of the displayed report data/number of report data in the internal memory

Start: Start date/time
Timeup: Report date/time

Tag or channel number

Unit
Report type

Report data status
Indicates that the following 
occurred between the report 
interval.
E: Error data
O: Over data
P: Power failure
C: Time change
B: Burnout

Average, maximum, minimum, sum, 
or instantaneous value

Stacked Bar Graph (/M1 and /PM1 options)
You can display the report data (that is stored in the internal memory) of each report 
group in a stacked bar graph.
For operating instructions, see section 4.11.
For information about report groups, see section 9.5.

• Types of Displayed Data
 The type of displayed data is determined by the report kind, which is set using the 

report function.
Report Kind Displayed Report Data
Hourly, Hourly + daily Sums for each hour and sums for the day
Daily + weekly Sums for each day and sums for the week
Daily, Daily + monthly Sums for each day and sums for the month

   

Hourly report group sums (bar graph)

Sums for the day (bar graph) 
of a report group

Example: Hourly + daily display

Daily sums of each channel 
and the daily sums of all 
channels of the report group
If you select a bar graph, the 
sum of the hour selected with 
the cursor is displayed.
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• Display Modes
 You can switch the bar graph between single graph and dual graph display.

Single graph display
Dual graph display (Shows the data from two 
consecutive periods)

Status Display
The following displays available.
For the operating procedure, see section 4.5.
• Relay Status Display
 Displays the status of the alarm output relay and internal switch.

• Modbus Client Status Display and Modbus Master Status Display
 Displays the command status.

• Event Level Switch Status (Release number 3 or later)
 Displays the status of the event level switches.

Log Display
Displays various logs (operation log).
For the operating procedure, see section 4.9.

Log Type Description
Login*1 Log of login/logout, log of time setting, and log of power failure
Error Log of error messages
Communications Log of communication commands
FTP transfer Log of FTP transfers
WEB Log of Web operations
E-mail transmission Log of e-mail transmissions
SNTP Log of accesses to the SNTP server
DHCP Log of accesses to the DHCP server
MODBUS Log of communications using Modbus client or Modbus master
Operation*2 Log of operations
Change settings*2 Log of setting changes
*1 Only on DXs without the /AS1 advanced security option
*2 Only on DXs with the /AS1 advanced security option
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Four Panel Display
Displays four different display formats on a single screen. Because the size of each 
screen is reduced to 1/4, there are limitations in the format, content, and operation of the 
display.
For the operating procedure, see section 4.10.

   

Displayable Screen Limitation
Trend No auto switching of groups. No all channel display and 

message display. Number of displayed scales is 6 or less.
Digital No auto switching of groups.
Bar graph display No auto switching of groups. No numeric display. Displays 

one representative alarm character.
Overview No operation. No numeric display when there are more than 

261 channels.
Annunciator There are restrictions on the display characters you can use. 

For more information, see section 3.12.
Alarm summary No operation using the cursor.
Message summary
Memory summary
Modbus client status display
Modbus master status display
Relay Status Display -
Report display No operation using the cursor.
Event switch display -
Stacked bar graph display -

• Registering Screens
 You can assign a display name to the display condition of the four panel display (up 

to four configurations) and register it. A registered configuration can be recalled by its 
display name and displayed.

 The default values are as follows:
Display Name Displays Shown
MIX Trend (group 1), digital (group 1), bar graph (group 1), and 

overview
ALL TREND All trend displays (groups 1 through 4)
ALL DIGITAL All digital displays (groups 1 through 4)
ALL BAR All bar graph displays (groups 1 through 4)
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Other Useful Functions
• Automatically Reverting to the Specified Display
 Show a preset display when there is no operation for a specific time.
 For the setting procedure, see section 5.15.

• Favorite Key
 Register a frequently used display to the Favorite key and enable the display to be 

shown through simple operation.
 For the setting procedure, see section 5.16.

• Customizing the Menus
 Change the FUNC key menu that appears when the FUNC key is pressed and the 

screen menu that appears when the DISP/ENTER key is pressed.
 For the setting procedure, see section 5.18.

Setting the Display Conditions of the LCD
The display conditions of the LCD can be configured.

Display Attribute Setting
Background color of the 
operation display

The background color of the display can be set to white or black. 
The default value is White. For the setting procedure, see section 
5.13.

Background color of the 
historical trend screen

You can select white, cream, black, or light gray for the background 
color of the screen. The default value is Black. For the setting 
procedure, see section 5.13.

LCD brightness The brightness of the LCD can be set among six levels. The default 
brightness is 2. For the setting procedure, see section 2.7.

Backlight saver The lifetime of the LCD backlight can be extended by automatically 
turning OFF or dimming the light when there is no key operation 
for a specified amount of time. The display returns to the original 
brightness with a key operation or an alarm occurrence. By default, 
the backlight saver is disabled. For the setting procedure, see 
section 2.7.

1.3  Display
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1.4 Data Storage Function

This section explains the types of data that the DX can record and how to store them.
For information about the data storage function on DXs with the /AS1 advanced 
security option, see the Advanced Security Function (/AS1) User’s Manual,  
IM04L41B01-05EN.

Data Types
The types of data that the DX can record are as follows:

Data Type Description
Display data •  Waveform data displayed on the trend display. The measured data is recorded as a specified 

sampling interval. The sampling interval is specified using the trend interval.
•  The minimum and maximum values among the measured data within the sampling interval are 

saved.
• A header string (common to other files) can be written in the file.
• The display data contains alarm and message information.
• Data format: Binary (Undisclosed)

Event data •  Measured data that is recorded at a specified sampling interval. There are two modes. One 
mode starts recording when a trigger event occurs. The other mode records at all times.

• A header string (common to other files) can be written in the file.
• The event data contains alarm and message information.
• Data format: Binary (Undisclosed)

Manual sampled data
•  Instantaneous value of the measured data when a manual sample operation is executed.
• A header string (common to other files) can be written in the file.
• Data format: Text

Report data (/M1 and /PM1 options)
•  Hourly, daily, weekly, and monthly report data. Report data is created at an interval that is 

determined by the report type (one hour for hourly reports, one day for daily reports, and so on).
• A header string (common to other files) can be written in the file.
• Data format: Text
•  The data can be converted to XML spreadsheet data (release numbers 4 and later).

Snapshot data (screen image data)
•  The image data of the DX screen when the snapshot operation is executed.
• The data can be saved to a CF card.
• Data format: PNG

Setup data • The setup data of the DX.
• Data format: Binary (Undisclosed)

Custom Display Setup Data
• The custom display setup data of the DX.
• Data format: text

• Display data and event data
 Display data can be likened to the conventional recording on the chart sheet and 

are useful for long-term recording. Event data is useful when you wish to record the 
measured data in detail.

   Measured data per 
scan interval

Display data

Event data

Sampling interval of display data

Scan interval
Time

Sampling interval of event data

Maximum value per sampling interval
Minimum value per sampling interval

Instantaneous value during sampling



1-29IM 04L42B01-01E

O
verview

 of Functions

1

2

3

4

5

6

7

8

9

10

11

12

13

App

Index

Flow of Data Recording and Storage
Measured data is recorded once to the internal memory and then saved to the external 
storage medium.

Measurement
channel

Computation
channel

External input 
channel

...
...

...

Data of another device 
(via communication)

Sampling

Load Display/Event  
 data

Save Screen image  
 data

CF card USB memory (/USB1 option)

External storage medium

Setup dataDisplay

Internal memory

FTP server on 
the network

Save the data

Internal Memory
Display data and event data are held in files in the internal memory. The data area also 
stored on the external storage medium in files.

  

Save the data

Directory on the external storage medium

Manual
sampled data Report dataDisplay data and event data

FTP server on 
the network

Internal memory

File

......

......

Sampling

1.4  Data Storage Function



1-30 IM 04L42B01-01E

Recording Method of Display Data and Event Data
For the setting procedure, see section 6.1.
• Types of Data to Be Acquired
 Select display data only, display data and event data, or event data only.
 Deciding the Data to Be Recorded
 Record the data that suits your application. Refer to the following examples.
 Example 1: Continuously record the waveform data as with the conventional chart 

recorder.
  Record the display data.
 Example 2: Record waveform data under normal conditions but record details around 

the point of alarm occurrence when alarms occur.
  Continuously record display data and record event data when alarms 

occur.
 Example 3: Only record the most-detailed data at all times.
  Record event data by specifying the sampling interval.
 Example 4: No need to continuously record data. Record data only when alarms 

occur.
  Record event data only when alarms occur.

• Internal Memory
 The recorded measured data is divided at a specific time interval and saved to files. 

If the internal memory is full or if the number of display data files and event data files 
exceeds 400, files are overwritten from the oldest file.

• Recording Conditions of Display Data
Item Description
Source channels Select from measurement channels, computation channels, and 

external input channels.
Sampling interval Specify the sampling interval with the trend interval (see the table 

below). You cannot specify a sampling interval that is faster than the 
scan interval.

File creation Files are created at the specified file save interval

Time

File File File Adding data

Files are also created in the following cases.
• When a file is created manually.

• When the memory sampling is stopped.

• When file creation is executed with the event action function.

• After recovering from a power failure.
Memory start/stop Press the START key to start recording (memory start) and the 

STOP key to stop the recording (memory stop).

 Trend interval and the sampling interval of display data
Trend interval 5 s*1 10 s*1 15 s*2 30 s 1 min
Sample rate 125 ms 250 ms 500 ms 1 s 2 s
Trend interval 2 min 5 min 10 min 15 min 20 min
Sample rate 4 s 10 s 20 s 30 s 40 s
Trend interval 30 min 1 h 2 h 4 h 10 h
Sample rate 1 min 2 min 4 min 8 min 20 min
*1 Selectable on the DX2004 and DX2008 (release number 3 or later).
*2 Selectable in fast sampling mode on the DX2010, DX2020, DX2030, DX2040, and DX2048 

(release number 3 or later).

1.4  Data Storage Function



1-31IM 04L42B01-01E

O
verview

 of Functions

1

2

3

4

5

6

7

8

9

10

11

12

13

App

Index

• Recording Conditions of Event Data
Item Description
Source channels Same as the display data.
Sampling interval Select from the available settings between 25 ms to 30 minutes. 

However, you cannot specify an interval that is faster than the scan 
interval.

File creation A file is created when the specified data length is reached.
Files are also created in the following cases.
• When a file is created manually.
• When the memory sampling is stopped.
• When file creation is executed with the event action function.
• After recovering from a power failure.

Mode The available modes are Free (continuously record), Single, and 
Repeat. The recording operation varies depending on the mode as 
follows:
Free
Press the START key to start recording (memory start) and the STOP 
key to stop the recording (memory stop) .

Time

File File File Adding data
Single
Pressing the START key places the DX in the trigger-wait state. When 
the trigger condition is met, the DX records data for a specified time 
(data length) and stops. From this point, the DX does not record even 
if the trigger condition is met.

Time

File

Trigger condition met

Repeat
Pressing the START key places the DX in the trigger-wait state. When 
the trigger condition is met, the DX records data for a specified time 
(data length) and stops. The DX enters the trigger-wait sate again and 
keeps recording the data for a specified time (data length) each time 
the trigger condition is met. To stop the recording of the event data, 
press the STOP key.

Time

File File

Trigger condition met Trigger condition met

 Pretrigger of Event Data
 The pretrigger can be specified in trigger mode.
 This function is used to save the data before the point where the trigger condition 

is met as event data. This function is convenient when you wish to record the data 
before the occurrence of a certain event such as when an alarm occurs.

 Specify the pretrigger as a percentage (0, 5, 25, 50, 75, 95, or 100%) of the recording 
time (data length) of the event data. If set to 0%, the data after the trigger condition is 
met is recorded.

   
Time

Trigger condition met

Data before 
the trigger

Data after 
the trigger

 Trigger for Starting the Event Data Recording
 When set to trigger mode, you can set various conditions for starting the recording.
 Example: Key operation, alarm occurrence, specific time, or remote control

1.4  Data Storage Function
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• Creating Files through Key Operation
 Files can be created using keys.

   
Time

Previous files

Key operation

FileFile File
Current file

 For operating instructions, see “Saving the Display Data or Event Data during Memory 
Sampling through Key Operation” in section 6.4.

Manual Sampled Data
 Manual sampled data is recorded to the internal memory. When the number of manual 

sampled data exceeds 400, the data is overwritten from the oldest data.

   Time

Manual sampled data

Report Data
 Report data is recorded to the internal memory. When the number of report data 

exceeds 100, the data is overwritten from the oldest data.

   Time

Report data

1.4  Data Storage Function
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Saving Data to the External Storage Medium
For the setting and operating procedure, see sections 6.2 and 6.4 respectively.
• Type of External Storage Medium

• CF card (32 MB or more)
• USB flash memory (/USB1 option)

• Auto Save
 Have the CF card inserted in the slot at all times. The data in the internal memory is 

automatically saved to the CF card.
 Auto Save Timing

Data Type Description
Display data The file is saved when the file is created.

Time

Save to the CF card

File File File

Event data Same as the display data.
Manual sampled data The first time manual sample is executed, a manual sampled data file is created on the CF card. The 

data is appended to this file for each subsequent manual sample operation. A new file is created after 
manual sampled data has been stored 100 times. 
For operating instructions, see section 6.5.

Report data The first time report data is generated, a report data file is created on the CF card and report data is 
stored. The report data is appended to this file every time of report.
Dividing of the report files
The appending of the report data to the file is stopped at a specified time, and subsequent reports are 
saved to a new file. The file is divided in the unit shown in the table below. Also, when recording is 
stopped (memory stop), all report files are divided.
Report Template (Release numbers 4 and later)
When the report file is divided, a report data file of the format specified by the XML spreadsheet 
template is created. This function is disabled in the cases listed under “Seprt2” below.
For the setting procedure, see section 9.5.

Report Type Report File
File for Each Type One File Seprt2*1

Hourly report  hourly reports of a day  hourly reports of a day  hourly reports for a day
Daily report  daily reports for a month  daily reports for a month  daily reports for a month
Hourly and daily 
reports

 a file for each daily report  hourly reports for a day and a daily 
report

 daily reports for a month
 hourly reports of a day  hourly reports for a day

Daily and weekly 
reports

 a file for each weekly report  daily reports for a week and a 
weekly report

 weekly report (not divided)*2

 daily reports for a week  daily reports for a week
Daily and monthly 
reports

 a file for each monthly report  daily reports for a month and a 
monthly report

 monthly report (not divided)*2

 daily reports for a month  daily reports for a month

*1 Available for release numbers 4 and later.
*2 When media FIFO is enabled, files are divided at approximately every 100 KB.

 Save Destination
 CF card.

 Data Save Destination Directory
 You can set the data save destination directory name (DATA0 by default). The 

specified directory is created on the CF card, and the data is saved in the directory.

 Save Operation (If Media FIFO Is Disabled)
 The data in the internal memory can be saved only if there is sufficient free space on 

the CF card. Replace the CF card and save the data before the data in the internal 
memory is overwritten.

1.4  Data Storage Function
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 Save Operation (Constantly Retaining the Most Recent Data Files Using 
Media FIFO) (Release Number 2 or Later)

 When saving the data files automatically, you can save the data so that the most 
recent data files are constantly retained in the CF card. This method allow you to use 
the DX continuously without having to replace the CF card.

 •  Operation

    File 1 File 2 File 3 File 4Deleted Saved

Update date

Medium

Old New

 If not enough free space is available when saving a new data file to the CF card, 
files are deleted in order from the oldest data update date/time to save the new file. 
This operation is referred to as FIFO (First In First Out).
• The FIFO operation is carried out only when saving the following files 

automatically. It is not carried out when saving files to the save destination 
directory using another method. Display data files, event data files, report data 
files, manual sample data files, and snapshot data files

• Files that are deleted
 All the files in the save destination directory are applicable to be deleted. 

However, the following files are excluded. Hidden files, read-only files, files in 
the subdirectory within the save destination directory

•  The most recent 1000 files are retained. If the number of files in the save 
destination directory exceeds 1000, the number of files is held at 1000 by 
deleting old files even if there is enough free space. 

•  If there are more than 1000 files already in the save destination directory, one or 
more files are always deleted before saving the new file. The number of files is 
not kept within 1000 in this case.

• Manual Save (Collectively Storing Unsaved Data)
 Unsaved data in the internal memory is stored in unit of files to the external storage 

medium when an external storage medium is inserted and a given operation is carried 
out.

   

Time

Saved the 
previous time

Save operation

FileFile File

Saved this time

 When using manual save, it is important that you save the data in the internal memory 
to the external storage medium before the data is overwritten. Determine the usage 
condition of the internal memory and save the data to the external storage medium at 
appropriate times.

 Save Destination
 You can select a CF card or USB flash memory (/USB1 option).

 Data Save Destination Directory
 You can set the data save destination directory name (DATA0 by default).

1.4  Data Storage Function
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• File Name
 You can select the file name configuration from three types.

Date

Serial

Batch name

Display data
Event data
Manual sampled data
Snapshot data

Report data

Display data
Event data
Manual sampled data
Snapshot data

Report data

.

.

.

.

.

.

Display data
Event data

Report data

Manual sampled data
Snapshot data

.

Specified string

Date

Date

Type

Type

TypeDate

Extension

Extension

Extension

Extension

Extension

Extension

ExtensionDate

Specified string

Specified string

Specified string

Batch name

Ex.: 000123_AAAAAAAAAAA050928_174633.DAD

Ex.: 000123_AAAAAAAAAAA.DAD

Ex.: 000123_AAAAAAAAAAA0HD.DAR

Ex.: 000123_BBBBBBBBBBBBBBBBBBBBB.DAD

Ex.: 000123_050928_174633HD.DAR

Ex.: 000123_050928_174633.DAM

Ex.: 000123_AAAAAAAAAAA050928_174633HD.DAR

Item

Date YYMMDD_hhmmss YY: Year (lower two digits), MM: Month, DD: Day
hh: Hour, mm: Minute, ss: Second

Specified string AAAAAAAAA•••A Up to 16 alphanumeric characters can be used
Batch name BBBBBBBBBBB•••B Up to 40 alphanumeric characters can be used

7-digit
6-digit
number

A sequence number in the order of occurrence. The number ranges from 
000001 to 999999. If the number reaches 999999, it returns to 000000.
Starts with ‘_’ and takes on the following values: A to Z and 0 to 9.
If a file with the same name exists in the specified directory, the file is 
saved by changing the delimiter to prevent overwriting.
Example: If a file named “000123_AAAAAAAAAAA.DAD” already exists, 
the file is saved to the name “000123AAAAAAAAAAAA.DAD.”

Description

Structure Description

Display data :DAD
Event data :DAE
Manual sampled data :DAM

Type Report data type
H_: Hourly, D_: Daily, W_: Weekly, M_: Monthly, 
HD: Hourly and daily, DW: Daily and weekly, 
DM: Daily and monthly

H_, D_, W_, M_, 
HD, DW, DM

Extension Report data :DAR
Report data :xml (Report template; release numbers 4 and later)
Snapshot data :PNG

7-digit

7-digit

7-digit

7-digit

7-digit

7-digit

7-digit

1-character
delimiter

Consists of a 6-digit number and 1-character delimiter.

Note
Differences from the File Names up to Now
• The “ID” item at the end of the file name is deleted and its functionality is included in the 

“Separator” of the 7-digit sequence.

     

000123_AAAAAAAAAAA050928_174633.DAD

000123_AAAAAAAAAAA050928_1746330.DADDXs before release number 2:

DXs with release number 2 or later:

The “ID” functionarity 
has been shifted.

Example

• The sequence section of the display data and event data file names is changed to 7 digits, 
and the “ID” function is included in the “Separator” when using the “Batch name.”

1.4  Data Storage Function
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File Names on DXs before Release Number 2
The table below shows the file name that is assigned when the measured data is saved 
to the CF card.

Date

Serial

Batch
name

Display data
Event data
Manual sampled data
Snapshot data

Report data

Display data
Event data
Manual sampled data
Snapshot data

Except for xml, same as release numbers 2 and later.

Report data

.

.

.

.

.

.

Display data
Event data

Report data

Manual sampled data
Snapshot data

.

Specified string

Date

Date ID

ID

ID

ID

ID

ID

ID

Type

Type

TypeDate

Extension

Extension

Extension

Extension

Extension

Extension

ExtensionDate

Specified string

Specified string

Specified string

Batch name

Ex.: 000123_AAAAAAAAAAA050928_1746330.DAD

Ex.: 000123_AAAAAAAAAAA0.DAD

Ex.: 000123_AAAAAAAAAAAHD0.DAR

Ex.: 123BBBBBBBBBBBBBBBBBBBBB0.DAD

Ex.: 000123_050928_174633HD0.DAR

Ex.: 000123_050928_1746330.DAM

Ex.: 000123_AAAAAAAAAAA050928_174633DH0.DAR

Item
Date YYMMDD_hhmmss Same as release number 2 and later.

7-digit sequence 000001 to 999999

3-digit sequence 001 to 999

Consists of a 6-digit number and an underscore as a separator. 
A sequence number in the order of occurrence.   

Type

ID

Report data type
Same as release number 2 and later.

H_, D_, W_, M_, 
HD, DW, DM

Extension

Description

Structure Description

7-digit

7-digit

7-digit

7-digit

3-digit

7-digit

7-digit

A sequence number in the order of occurrence.   

0 to 9, A to Z When a file with the same name exists in the specified directory, 
the file is saved by changing the ID character to prevent 
overwriting.
Example: If a file named 
“000123_AAAAA050907_1036480.DAD”
already exists, the file is saved to the name 
“000123_AAAAA050907_1036481.DAD.”
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• Saving Data through Key Operation
 You can carry out the following data save operations regardless of whether auto save 

or manual save is used.
Data Storage Description
All save Collectively saves all the data in the internal memory.
Selective save Saves the specified display data or event data file.
Manual sampled data save Collectively saves all the manual sampled data in the internal 

memory.
Report data save Collectively saves all the report data in the internal memory.

 Save Destination
 You can select a CF card or USB flash memory (/USB1 option).

 Data Save Destination Directory
 Creates a directory with the name of the data save destination directory name with the 

date/time added and saves the data.
 Directory name: “Specified string”_YYMMDD_HHMMSS
 Example: If the data is saved at 17 hours 6 minutes 42 seconds on September 30, 

2005, the data is saved to a directory named “DATA0_050930_170642.” 
“DATA0” is the specified string.

Note
The number of directories that you can create on the external storage medium varies 
depending on the length of the directory names. If the length of the “specified string” is 5 
characters, approximately 170 directories can be created. If it is 20 characters, approximately 
120 directories can be created. An error occurs, if you try to create directories exceeding this 
limit.

Other Types of Data That Can Be Stored
• Setup Data
 The setup data of the DX is saved to a CF card or USB flash memory (/USB1 option). 

The setup data is saved to the root directory.

   . PDLSpecified

Example: ABCD10005.PDL
Name of the setup data file

• Snapshot Data
 The screen that the DX displays is saved to a CF card in PNG format. The data is 

saved to the same directory as the display data and event data. For the file name, see 
the previous page.

   
Time

Snapshot
Data fileCF card

• Custom Display Setup Data
 See the Custom Display User’s Manual, IM04L41B01-04E.

Saving Data via the Ethernet Network
Display data, event data, report data (/M1 or /PM1 option), and screen image data 
(snapshot data) can be automatically transferred and saved to an FTP server via the 
Ethernet network by using the FTP client function. Conversely, the DX can function as an 
FTP server. The DX can be accessed from a PC and the data files in the internal memory 
or the external storage medium can be retrieved to be stored on the PC.
See the Communication Interface User’s Manual, IM 04L41B01-17E.

1.4  Data Storage Function
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1.5 Batch Function

This section explains the DX batch function. For information about the multi batch 
function (/BT2 option), see the Multi Batch (/BT2) User’s Manual, IM04L41B01-03E.

Overview
You can add batch information to the display data and event data files. The files can be 
managed using the batch information.
For the setting and operating procedure, see section 6.3.

Batch Information
• Batch Number and Lot Number
 Display data and event data files can be identified by their “batch number-lot number” 

(hereinafter referred to as batch name). The lot number does not have to be specified.
• Batch number (up to 32 characters).
• Lot number (up to 8 digits)

• Automatic Increment of the Lot Number
 The lot number can be automatically incremented when the memory sampling is 

stopped.

• Text Field
 You can enter text fields into a file. There are 24 available text fields (release number 

3 or later). Each text field consists of the following
• Field title (up to 20 characters)
• Field string (up to 30 characters)

The text field can be shown on the DX screen through key operation.

• Batch Comment
 Three arbitrary comments can be entered in a file. A single comment can be entered 

while memory sampling is in progress.
• Comment 1, Comment 2, and Comment 3 (up to 50 characters each)

Using the Batch Function
See the figure below. For example, enter the operator and administrator in the text field. 

  
Time

Memory start Memory stop

Data file

Comment
Batch number + lot number

Text field

Comment
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1.6 Event Action and Remote Control Functions 
(/R1 and /PM1 Options)

A specified action is carried out when an event occurs. This function is called event 
action. The remote control function (/R1 and /PM1 options) allows you to specify actions 
to be performed when the terminal receives a contact input or  an open collector signal. 
The remote control function is configured using the event action function.
For the setting procedure, see section 7.1.

Events
• Events
 Select from the following events.

Event Level/Edge*1 Description
Remote Level/Edge ON/OFF of the remote control input.
Output relay Level/Edge Activated/Deactivated condition of the alarm output 

relay.Relay-Off*3

Internal switch Level/Edge The value, 0 (off) or 1 (on), of the internal switch.
Switch-Off*3

Timer Edge Timer timeout.
Match time timer Edge When the time matches.
Alarm Level/Edge The state in which any alarm is occurring and the state 

in which no alarm is occurring.Alarm-Off*3

USER key Edge The operation of pressing the USER key.
Event edge switch*2 Edge Can be caused by:

•  The Edge Switch soft key in the FUNC key menu.
•  A dedicated communication command or Modbus 

communication.
•  The custom display

Event level switch*2 Level  You can view the status of the switch in the event level 
switch status display. Can be caused by:

EventLevelSwitch-
Off*3

•  A dedicated communication command or Modbus 
communication.

•   The custom display.
*1 For a description of level and edge, see “Miscellaneous” in this section.
*2 This function is available for release numbers 3 and later.
*3 This function is available for release numbers 4 and later.

• Output Relay, Internal Switch, Alarm, Event Level Switch
 The output relay, internal switch, alarm, and event level switch have two states, state 

A and state B, which are explained in the table below. In explanations, “Output relay” 
and similar states are referred to as “ON events,” and “Relay-Off” and similar states 
are referred to as “OFF events.”
Event State A State B
Output relay Deactivated Activated
Internal switch OFF ON
Alarm No alarms At least one alarm
Event level switch OFF ON

 When Edge Is Selected
 An ON event occurs when state A changes to state B. An OFF event occurs when 

state B changes to state A.
 When Level Is Selected
 If the action states that correspond to states A and B during an ON event are called 

“state 2” and “state 1,” respectively, the action states that correspond to states A and 
B during an OFF event will be state 1 and state 2, respectively.

 See “Miscellaneous” and “Level and Edge” in this section.
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• Timers
 Four timers are available. The timers are also used with the TLOG computation 

function (/M1 and /PM1 options).
 Timer Type

   Time

Relative timerAbsolute timer
Set the timer
Reset the timer

B: IntervalTimeout

Time
Set the timer Ref. time

A: Interval
A BBA A A

 • Absolute Time Mode
 The timer expires at the times determined by the reference time and the interval. 

The reference time is set on the hour (00 to 23).
Example: Reference time: 00:00
 Interval: 10 min
 The timer expires at 0 hour, 0 hour 10 min, 0 hour 20 min, ... 23 hour 40 

min, and 23 hour 50 min. For example, if the timer is set at 9 hour 36 
min, the timer expires at 09 hour 40 min, 09 hour 50 min, 10 hour, and 
so on.

• Relative Time Mode
 The timer is started when the timer is set, and the timer expires every specified 

interval. In this mode, the timer stops when a power failure occurs.
Example: Interval: 00:15
 The timer expires every 15 minutes.

• Match Time
 You can set the time matching conditions for the four match time timers. Specify 

the date/time using the method described below. For each condition, you can select 
whether to use the condition once or continuously. The timers are also used with the 
TLOG computation function (/M1 and /PM1 options).
Specified Date/Time Description
Y hour of the X day of the Z year The condition is met once a year. This function is available 

for release numbers 3 and later.
Y hour of the X day The condition is met once a month.
Y hour of the X day of the week The condition is met once a week.
Y hour The condition is met once a day.

1.6  Event Action and Remote Control Functions (/R1 and /PM1 Options)
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Action
• Actions
 Select from the following actions.

Action Level/Edge*1  Description
Memory start/stop Level Starts/stops memory sampling.
Memory start Edge Starts the memory sampling.
Memory stop Edge Stops the memory sampling.
Event trigger*4 Edge Applies a trigger for starting the event data 

recording. 
This is valid when recording event data in trigger 
mode. See the next page.

Alarm acknowledge Edge Releases the alarm output. 
This is valid when the use of the alarm ACK 
operation is enabled.

Computation start/stop*2 Level It is used to start/stop the computation.
Computation start*2 Edge Starts the computation.
Computation stop*2 Edge Stops the computation.
Computation reset*2 Edge Resets the computed values on all computation 

channels. 
Save display data Edge The display data being recorded is saved to the 

internal memory as a file. This is the same function 
as the data save operation using the FUNC key.

Save event data Edge The event data being recorded is saved to the 
internal memory as a file.  
This is the same function as the data save 
operation using the FUNC key.

Message Edge Writes a message. 
This action can be executed while memory 
sampling is in progress.

Snapshot Edge Saves the screen image data.
Switch the display rate Level Toggles between the trend interval and the 

secondary trend interval. 
This action is valid when the DX is configured to 
use trend interval switching.

Manual sample Edge Executes manual sampling.
Reset the relative timer Edge Resets the relative timer. The timer restarts from 

that point.
Switch the display group Edge Switches the display group when the trend, digital, 

or bar graph is displayed.
Flag*2 Level The flag is zero for normal conditions and 1 when 

an event occurs. When the event is an edge 
operation, the value alternates between 0 and 1 
whenever an event occurs.  
The flag can be written in a calculation expression 
of a computation channel.

Load the setup*4 Edge Loads the setup data file in the root directory of the 
CF card into the DX and updates the DX settings. 
See below.

Adjust the time Edge Synchronizes the time to the nearest hour. See the 
next page.

Display comment*3 Edge Displays a preset text string (comment text block). 
For information about how to set comment text 
blocks, see section 5.19.

Show favorite display*3 Edge Shows the display that is registered to the Favorite 
key. For information about how to register a display 
to the Favorite key, see section 5.16.

Reset alarm display*3 Edge An operation for when you are using a double lock-
in sequence with the alarm annunciator function. 
Resets the alarm display. For information about 
annunciator settings, see section 3.12.

*1 For a description of level and edge, see “Miscellaneous” in this section.
*2 This is an option.
*3 This function is available for release numbers 3 and later.
*4 This action is not available on models with the /AS1 advanced security option.
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 Resetting the Relative Timer
 If the event is set to output relay, internal switch, match time timer, or alarm, the 

resetting of the timer is not considered a timeout. (The action is not executed even if 
the timer is used as an event.)

 Loading the Setup
 Can be specified as an action only when the event is set to remote control input.
 Loads the setup data file, LOAD1.PDL, LOAD2.PDL, or LOAD3.PDL, in the root 

directory of the CF card into the DX and updates the DX settings.
 You must create a setup file and save it to the CF card in advance.

 Event Trigger Operation
 When the event is set to output relay, internal switch, or alarm
 If the output relay is activated, the internal switch is 1, or the alarm is occurring during 

memory sampling, the event trigger is always activated. However, the number of times 
the trigger is activated depends on the event data mode (single or repeat).

 Time Adjustment
 Time adjustment can be specified as an action only when the event is set to remote 

control input. The internal clock of the DX is adjusted to the nearest hour through 
remote control input.

 • Operation When Memory Sampling Is Stopped
Difference from the Nearest Hour Operation
00 min 00 s to 01 min to 59 s Truncates the minutes and seconds. 

Example: 10 hours 01 min 50 s becomes 10 hours 00 min 00 s.
02 min 00 s to 57 min to 59 s The time is not changed.
58 min 00 s to 59 min to 59 s Rounds up the minutes and seconds. 

Example: 10 hours 59 min 50 s becomes 11 hours 00 min 00 s.

 • Operation during Memory Sampling
 If the time difference between the time the remote control signal is applied and the 

nearest hour is within the preset time, the time is gradually corrected. Otherwise, 
the time is corrected immediately. For details, see section 10.1.

On DXs with the /AS1 Advanced Security Option and Release Number 4 or 
Later
Event Conditions for Execution
Output relay, internal switch, 
timer, match time timer, and 
alarm

When these events occur, their corresponding actions are 
performed regardless of the user privilege settings and whether 
users are logged in.

User Key The same as the key operation itself. In setting mode, memory 
start cannot be performed.

Event edge switch and event 
level switch

The same as the key operations themselves. Even in setting 
mode, memory start cannot be performed.

Remote When a remote control signal is received, the corresponding 
action is performed regardless of the user privilege settings 
and whether users are logged in. In setting mode, memory start 
cannot be performed.

1.6  Event Action and Remote Control Functions (/R1 and /PM1 Options)
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Miscellaneous
• Limitations on the Combinations of Events and Actions
 The combinations that are checked in the table below can be used.

Alarm ACK
Reset the relative timer
Load the settings
Adjust the time
Reset the alarm display
Other actions

RemoteEvent

Action

Output
Relay

Internal
Switch

Timer Match
Time
Timer

Alarm User
Key

Event
Edge

Switch

Event
Level

Switch














































• Level and Edge
 The combinations of events and actions are summarized in the figure below.

   

Type Operation

Level

Level
State 1

State 2 Operation
executed

Operation
executed

Edge Edge

Edge

Event

Action

OFF event

Level

Edge Edge

 Event Action Example
 The following is an example for when the event is Internal switch (Level or Edge) and 

the action is Memory start/stop (Level) or Manual sample (Edge).

   

Event Action Operation

OFF
ON

OFF

Memory start Memory stop ExecutionExecution

EdgeLevel

Ev
en

t
(in

te
rn

al
 s

w
itc

h) Switch

Action

Memory start/stop Manual sample

Switch-Off ON

 Level and Edge of the Remote Control Input Signal

   

Level Edge

ON

OFF
250 ms or more

 For contact inputs, the remote signal rises when the contact switches from open to 
closed and falls when the contact switches from closed to open. For open collector 
signals, the remote signal rises when the collector signal (voltage level of the remote 
terminal) goes from high to low and falls when the collector signal goes low to high. 
You can reverse the above operations (see section 7.3 for details).

1.6  Event Action and Remote Control Functions (/R1 and /PM1 Options)
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1.7 Security Function

This section explains the DX security functions.
For information about the security functions on DXs with the /AS1 advanced 
security option, see the Advanced Security Function (/AS1) User’s Manual, 
IM04L41B01-05EN.

Key Lock Function
Key lock is a function that prohibits key operations. You enter a password to release the 
key lock.
For the setting procedure, see section 8.1.

Key Lock Items Description
Keys The following keys can be locked independently. 

START key, STOP key, MENU key, USER key, DISP/ENTER 
key (prohibits switching the operation screen), and Favorite 
key.

Access to the storage medium Prohibits all operations listed below.
• Manually save the data
• Load the display data and event data files
• Save/Load setup data files
• List the files on the storage medium
• Delete the files on the storage medium
• Format the storage medium

Setup loading*1  Prevents external storage medium access for the purpose of 
loading setup files (release number 3 or later).

Function operation The following FUNC key operations can be locked 
independently.
• [Alarm ACK], [Alarm DispRST]*1

• [Message], [Free message], [Batch], 
 [Add Message], [Add Free Message], 
 [Text field]
• [Math start]*2, [Math stop]*2, [Math reset]*2, 
 [Math ACK]*2

• [Save display], [Save event], 
 [Manual sample], [Trigger], [Snap shot],  
 [Timer reset], [Save stop], [Edge Switch]*1,  
 [Match T Reset]*1

• [E-Mail start], [E-Mail stop], [E-Mail test], [FTP test],  
 Operations to [Request] or [Release] network information
• [SNTP], time setting (operation in the setting mode)
• [Favorite regist], [4panel], [Standard display], 
 [Second speed], [Normal speed], [Builder]*1

*1 This function is available for release numbers 3 and later.
*2 Optional.
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Login Function
Only registered users can operate the DX. Access from communication functions can 
also be limited to users registered here.
For the setting and operating procedure, see sections 8.2 and 8.3 respectively.
• Login and Logout
 You enter your user name and password to log into the DX in the following cases.

Method of Accessing the DX Login Required
Keys • When the power is turned ON

• When logging in after exiting the basic setting mode
• When logging in after logging out

Communication When accessing the setting/measurement server, FTP 
server, maintenance/test server, or Web server.

 Auto Logout (When Logged in Using Keys)
 When logged in using keys, you are automatically logged out when there is no key 

operation for a specified time. If you are automatically logged out from the setting 
mode, the setting changes are cancelled. You are not automatically logged out during 
basic setting mode.

 Operations That Can Be Carried Out When Logged Out
 When logged out, you can switch the operation screen using the DISP/ENTER key, 

arrow keys and Favorite key.

• User Levels
 A user can be an “administrator” or a “user.”
 Administrator
 Administrators can perform all operations on the DX. At least one administrator must 

be registered to use the login function.
Item Description
Number of users that 
can be registered

5

Range of operations All operations.
Login method Select key operation, via communication, or Web server login.
ID information User name and password

 User
Item Description
Number of users that 
can be registered

30

Range of operations Key operations
Operation Limitation

Not allowed
Not allowed
Specified by user privileges
Specified by user privileges

Basic setting mode
Setting mode

Operation mode

Customize menus
Other
Key operation

• User privileges
  You can set operation privileges for each user. The privileges are 

the same as with the key lock function.
Operations via communication
See the Communications Interface User’s Manual.

Login method Select key operation, via communication, or Web server login.
ID information User name and password
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1.8 Computation and Report Function (/M1 and 
/PM1 Options)

Computation Function
Equations can be defined in computation channels by using the measured data or 
computed data as variables. The result of the computation can be displayed or stored.
For the setting procedure, see section 9.1.
• Channels Dedicated to Computations

Model Number of Channels Channel Numbers
DX2004, DX2008 12 101 to 112
DX2010, DX2020, DX2030, DX2040, DX2048 60 101 to 160

• Computation Types
 In the table below, [001] represents the measured value of channel 001.

Type Example Description of the Example
Four arithmetic 
operation

001+002 Determines the sum of [001] and [002].
001-002 Determines the difference between [001] and [002].
001*002 Determines the product of [001] and [002].
001/002 Divides [001] by [002].

Power 001**002 Determines [001] to the power of [002]. y = Xn

Square root SQR(001) Determines the square root of [001].
Absolute value ABS(001) Determines the absolute value of [001].
Common logarithm LOG(001) Determines the common logarithm of [001]. y = 

log10x
Natural logarithm LN(001) Determines the natural logarithm of [001]. y = lnx
Exponent EXP(001) Determines e to the power of [001]. y = ex

Relational 
computation

001.LT.002 The result is 1 when [001] is less than [002] or 0 
otherwise.

001.LE.002 The result is 1 when [001] is less than equal to [002] 
or 0 otherwise.

001.GT.002 The result is 1 when [001] is greater than [002] or 0 
otherwise.

001.GE.002 The result is 1 when [001] is greater than equal to 
[002] or 0 otherwise.

001.EQ.002 The result is 1 when [001] is equal to [002] or 0 
otherwise.

001.NE.002 The result is 1 when [001] is not equal to [002] or 0 
otherwise.

Logical computation 001AND002 The result is 1 when [001] and [002] are nonzero or 
0 otherwise.

001OR002 The result is 1 when [001] or [002] or both are 
nonzero or 0 otherwise.

001XOR002 The result is 0 when [001] and [002] are nonzero or 
1 otherwise.

NOT001 The result is 1 when [001] is zero or 0 otherwise.
TLOG computation* TLOG.SUM(001) Determines the sum of [001].

TLOG.MAX(001) Determines the maximum value of [001].
TLOG.MIN(001) Determines the minimum value of [001].
TLOG.AVE(001) Determines the average value of [001].
TLOG.P-P(001) Determines the difference between the maximum 

value and minimum value of [001].
* See “Usage of TLOG Computations” in this section.
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Type Example Description of the Example
CLOG computation CLOG.SUM(001.002.003)

Determines the sum of [001], [002], and [003].
CLOG.MAX(001.002.003)

Determines the maximum value among [001], [002], 
and [003].

CLOG.MIN(001.002.003)
Determines the minimum value among [001], [002], 
and [003].

CLOG.AVE(001.002.003)
Determines the average value of [001], [002], and [003].

CLOG.P-P(001.002.003)
Determines the difference between the maximum 
value and the minimum value among [001], [002], and 
[003].

Special computation PRE(001) Determines the previous value of [001].
101=HOLD(001.GT.K01):TLOG.SUM(001)

Under normal conditions, TLOG.SUM(001) is carried 
out to derive the computed value. When [001] exceeds 
K01, the previous computed value is held.

K01

Description
HOLD(a):b When a is zero, b is carried out to derive the computed 

value. Otherwise, the previous computed value is held.
RESET(101.GT.K01):TLOG.SUM(001)

Under normal conditions, TLOG.SUM(001) is carried 
out to derive the computed value. When [101] exceeds 
K01, the previous computed value is reset, and TLOG.
SUM(001) is carried out.

K01 Reset

Description
RESET(a):b When a is zero, b is carried out to derive the computed 

value. Otherwise, the previous computed value is 
reset, and b is carried out to derive the computed 
value.

CARRY(K01):TLOG.SUM(001)
Under normal conditions, TLOG.SUM(001) is carried 
out to derive the computed value. When the computed 
value is greater than or equal to K01, the computed 
result is the excess (computed value – K01).

K01

Description
CARRY(a):b Only TLOG.SUM can be specified for b. If the 

computed value X of b is less than a, the computed 
result is X. If X is greater than or equal to a, the 
computed result is the excess (X – a).

Conditional equation [001.GT.K01?001:001+002]
When [001] is greater than K01, the computed value 
is set to the value of [001]. Otherwise, the computed 
value is set to the value of [001] + [002].

Description
[a?b:c] If the computed result of a is nonzero, b is carried out. 

Otherwise, c is carried out.

1.8  Computation and Report Function (/M1 and /PM1 Options)
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• Data That Can Be Used in Equations
 The data listed below can be used.

Data Notation Description
Measurement channel data 001, etc. Specify the computed data using a channel number.
Computation Channel data*1 101, etc. Specify the computed data using a channel number.
External input channel data*1 201, etc. Specify the computed data using a channel number.
Constant K01 to K60 A value.
Communication input data C01 to C60 Data set through communications.
Status of the remote control*1 input D01 to D08*2 The value is 1 when the remote control input is ON or 0 when 

it is OFF.
Pulse input*1 P01 to P08*2

Q01 to Q08*2
Counts the number of pulses per scan interval.
Counts the number of pulses per second.

Internal switch status S01 to S30 1 or 0.
Alarm output relay*1 status I01 to I36 The value is 1 when activated or 0 when deactivated.
Flag*1 F01 to F08 1 or 0. Set the flag using the event action function (see section 

1.6).
Recording (memory sampling) 
status

M01 to M12 The value is 1 when recording is taking place and 0 when 
recording is stopped. When the multi batch function is not 
being used (release number 3 or later; /BT2 option), M01 
indicates the recording (memory sampling) status. When the 
multi batch function is being used, M01 to M06 indicate the 
recording (memory sampling) statuses of each batch. The 
recording status of an inactive batch group is 0. This function 
is available for release numbers 3 and later.

*1 An option.
*2 Values such as 01 are terminal numbers.

 Only the data that are checked in the table below can be used in TLOG, CLOG, and 
PRE.

TLOG
CLOG
PRE
Other computations

Meas.
Channel

Data
Comp. Type

Comp.
Channel

Ext.
Input

Channel
Constant Comm.

Input
Remote Pulse Internal

Switch
Relay Flag Record

status



































    

Example: TLOG.SUM(S01), CLOG.AVE(001.002.K01), and PRE(S01) are not allowed.

• Processing Order of Computation
 Computation is processed in order from the smallest event action number for each 

scan interval.
 Example: If you specify 102 = 101 + 103, the value of the previous scan interval is 

used for the 103 value.

• Handing of the Unit in Computations
 In computations, measured values are handled as values without units. For example, 

if the measured data from channel 001 is 20 mV and the measured data from channel 
002 is 20 V, the computed result of 001 + 002 is 40.

• Displaying the Computed Data
 The computed data is displayed by setting a measurement span for each computation 

channel. Computation channels can be displayed on various operation screens in the 
same fashion as the measurement channels.

 For the setting procedure, see section 9.3.

• Alarm
 Up to 4 alarms can be assigned to each computation channel. The alarm types are 

high limit alarm (H), low limit alarm (L), delay high limit alarm (T), and delay low limit 
alarm (t).

• Saving Computed Data
 As with the measured data, the computed data can be saved to display data, event 

data, manual sampled data, and report data.

1.8  Computation and Report Function (/M1 and /PM1 Options)
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• Computation Data Dropout
 A computation data dropout occurs if the computation is not completed within the scan 

interval. For the operating procedure, see section 9.4.
• The computation icon in the status display section turns yellow.
• When a computation data dropout occurs, the computed data of the scan interval in 

which the dropout occurred is set to the data immediately before the dropout.
• If computation data dropout occurs frequently, lessen the load on the CPU by 

reducing the number of computation channels or setting a longer scan interval.

• Numeric Display and Recording
 The range of displayed values of computed data is from –9999999 to 99999999 

excluding the decimal point. The decimal place corresponds to the decimal place of 
the lower limit span of the computation channel. On the numeric display, values are 
displayed if the computed result is within the above range regardless of the upper and 
lower limits of span. The following table indicates special displays.
Display/Recording Computed Data Status
+Over • +Display over: When the computed result exceeds 99999999

•  +Computation over: When the value exceeds approximately 
1.79E+308 in the middle of the computation

• When a computation error* occurs (select +Over or –Over.)
–Over • –Display over: When the computed result is less than –9999999

•  –Computation over: When the value is less than approximately  
–1.79E+308 in the middle of the computation

• When a computation error* occurs (select +Over or –Over.)
* Computation error occurs when the following computation is carried out.
 • X/0, SQR(–X), or LOG(–X)
 • If a channel number set to skip or Off is used in the equation

• Rolling Average
 The rolling average of the computed result of the equation specified for the 

computation channel is determined, and the result is the computed data for that 
channel. The number of samples and the sampling interval can be specified for each 
computation channel. The rolling average is applied over the time corresponding to “the 
number of data samples × the sampling interval.” The maximum sampling interval is 1 
hour, and the maximum number of samples is 1500.

• Starting the Computation
 You can configure the DX to start the computation when you press the START key.

• Usage of TLOG Computations
 TLOG computation determines the sum, maximum, minimum, average, or the 

difference between the maximum and minimum of a specific channel for each interval 
determined by a timer.

 Timers That Are Used
 The timer that is used is assigned to each channel.

 Unit of Sum Computation
 Set the sum scale when using sum computation (TLOG.SUM).
 Select Off, /s, /min, or /h. For details, see page 1-51.
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 Resetting the TLOG Computed Value
 You can select whether to reset the TLOG computed value at each interval. The figure 

below illustrates the reset operation for sum computation (TLOG.SUM).
 Example: Result of the TLOG.SUM computation

   

1 2 3
ResetReset Reset

Reset: On

Timer timeout

Reset: Off

 When reset is On, the sum value is calculated over each interval. When set to Off, the 
sum value from computation start is calculated.

  Power Failure Operation, Handling of Error Data, and Handling of 
Overflow Data

 See “Special Data Handling” in this section.

1.8  Computation and Report Function (/M1 and /PM1 Options)
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Report Function
This function is used to create hourly, daily, weekly, and monthly reports.
• Report Data Types
 You can select from four types among maximum value, minimum value, average 

value, sum value, and instantaneous value.

• Report Type
Type Description
Hourly report Creates report data every hour on the hour for the previous one hour.
Daily report Creates report data every day at a specified time for the previous one day.
Weekly report Creates report data every week at a specified time at a specified day of 

the week for the previous one week.
Monthly report Creates report data every month at a specified time at a specified day for 

the previous one month.

• Combinations of Reports That Can Be Created
 You can select from hourly reports only, daily reports only, hourly and daily reports, 

daily and weekly reports, and daily and monthly reports.

• Source Channels
 You can select from measurement channels, computation channels, and external input 

channels. The report data are not created for channels that are set to Skip or Off.
Model Number of Report Channels
DX2004 and DX2008 12
DX2010, DX2020, DX2030, DX2040, and DX2048 60

• Unit of Sum Computation
 In the sum computation, data are summed over the scan interval. However, for flow 

values that have units /s, /min, /h, or /day a simple summation results in the actual 
value not matching the computed result, because the scan interval and the unit of the 
input values are different. In such cases, set the sum scale to match the unit of the 
input value. In effect, the sum value with the same unit as that of the input value is 
calculated.

 For example, if the scan interval is 2 s, and the input value is 100 m3/min, a simple 
summation would add 100 every 2 s resulting in 3000 after one minute. However, if 
the sum scale is set to /min, then 2 s/60 s is multiplied every scan interval before the 
value is added giving a result that has an m3/min unit.

 The following converting equations are used to compute the sum. The unit of the scan 
interval is seconds.
Off:	 Σ(measured	data	every	scan	interval)
/s:	 Σ(measured	data	every	scan	interval)	×	scan	interval
/min:	 Σ(measured	data	every	scan	interval)	×	scan	interval/60
/h:	 Σ(measured	data	every	scan	interval)	×	scan	interval/3600
/day:	 Σ(measured	data	every	scan	interval)	×	scan	interval/86400

• Displaying the Report Data
 You can display the report data using keys.
 For the operating procedure, see section 4.5.

• Saving the Report Data
 See section 1.4, “Data Storage Function.”

• Numeric Display and Recording
 The numeric range of the report data is from –9999999 to 99999999 excluding the 

decimal point (except –3.4E+38 to 3.4E+38 for sum values).
 For the data handling of special cases, see “Special Data Handling” in this section.
 For details on the report file format, see appendix 3.
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Special Data Handling
This section explains the handling of special data in TLOG computation, CLOG 
computation, and reports.
• Power Failure Operation (TLOG and Reports)
 If a power failure occurs when the report function is enabled or in the middle of the 

TLOG computation, the report operation and TLOG computation resume when the 
DX recovers from the power failure. The operation varies depending on whether the 
DX recovers from the power failure before or after the time to create a report or TLOG 
data.
Time of Recovery Operation
After the time to create the data The report or TLOG data is created immediately after the 

DX recovers. The measured data up to the time of the 
power failure is used. At the time the next report or TLOG 
data is created, the data after the recovery is used.

Before the time to create the data After the DX recovers, report or TLOG data is created at 
the normal time to create the data. The measured data 
excluding the power failure period is used.

• Error Data Handling (TLOG, CLOG, and Reports)
 If an error occurs in the channel data, the error data is discarded, and the computation 

continues. If all the data are in error, an error results.
 The following types of data are considered error data.

• Channels set to skip or Off.
• The measured result on a measurement channels is error (A/D converter failure, 

etc.).
• The computed result on a computation channel is error.
• The input of the measurement channel is in a burnout condition.
• The external input channel is Off or there is no data (communication failure, etc.)

• Handling of Overflow Data*
* Refers to over range on a measurement channel, computation overflow on a computation 

channel, and over range of an external input channel.

 For TLOG, CLOG, and Reports
 When the channel data is overflow data, the DX handles the data as follows:

Computation Type Description
Average value or sum 
value

Set the handling to ERROR, SKIP, or LIMIT.
ERROR: Considers the data to be a computation error.
SKIP: Discards the overflow data and continues the computation.
LIMIT: Replaces the data with the limit value and continues the 

computation. 
The limit value is the span upper or lower limit or the scale 
upper or lower limit of the channel.

Maximum, minimum, 
Maximum – minimum

Set the handling to OVER or SKIP.
OVER: Computes by using the overflow data.
SKIP: Discards the overflow data and continues the computation.

 For Multiplication and Relation Computation EQ and NE
Computation Type Computation Computed Result
Multiplication 0*(+Over) 0

0*(–Over) 0
(+Over)*0 0
(–Over)*0 0

.EQ. (+Over).EQ.(+Over) 0
(–Over).EQ.(–Over) 0

.NE. (+Over).NE.(+Over) 1
(–Over).NE.(–Over) 1
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Report Template (Release numbers 4 and later)
You can create report templates and use them to automatically create custom report 
files.
Use Microsoft Office Excel (hereinafter referred to as “Excel”) to create report template 
files. Load a report template file that you have created into the DX internal memory. The 
DX will automatically create report files using the report template file.

  Internal memory

Report template file
Report file based 
on the template

Save Output

For the setting procedure, see section 9.5.
To create a report template, see section 9.6.
To load or save a report template, see section 6.10.

• Report Template
Item Description
Format, extension XML spreadsheet format. The file name extension is .xml (lowercase).
File name You can specify a file name.
Type You need to create different report templates for each report file 

type. The different report file types are hourly, daily, weekly, monthly, 
hourly + daily, daily + weekly, and daily + monthly.

• Template-Based Report File
Item Description
Format, extension XML spreadsheet format. The files can be opened in Excel. The file 

name extension is .xml (lowercase).
File name Except for the extension, the file names of these files are the same 

as those of report files with .DAR extensions.
For information about file names, see section 1.4, or see section 1.2 
in the Advanced Security Function (/AS1) User’s Manual.

Type The reports of each report file type are created using the appropriate 
template file.
The number of report files that can be created depends on the report 
creation range settings (see section 9.5). For example, when the 
report settings are not configured for the creation of daily reports, you 
cannot use a template to create daily reports. However, regardless 
of the report settings, you can output all the different types of report 
computations (average, maximum value, minimum value, sum value, 
and instantaneous value.)

• Creating Template-Based Report Files
 Template-based report files are created (the creation of template-based report files will 

hereinafter be referred to as “template conversion”) in the following cases.
 Auto Save
 When a report file is created (when file division occurs), template conversion is 

performed, and the report file is saved to the CF card. Template conversion is also 
performed when recording stops (memory stop).

 Manual Save (Collectively storing unsaved data)
 When you save a report file manually, template conversion is performed on the report 

files in the internal memory that have not yet been converted. Converted files are 
saved to the external storage medium.

 Collective Storing of Data through Key Operations
 When you execute ALL SAVE or REPORT SAVE, template conversion is performed 

on all the report files in the internal memory. Converted files are saved to the external 
storage medium.
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1.9 FAIL/Status Output Function (/F1 and /F2 
Options)

Output Relay Operation Assignment (Release numbers 4 and later)
For this function, there are relays labeled “FAIL” and “Status” on the rear panel.
You can assign the operations explained below to these two relays. On a relay that has 
been set to “Status relay,” you must also set the DX status that will be relayed.

FAIL Output
When a failure occurs in the CPU of the DX, a relay contact signal (1 signal) is output. 
The relay is energized when the CPU is normal and de-energizes when a CPU failure 
occurs. Therefore, relay output is carried out also when the power is turned OFF (including 
a power failure). You cannot change this behavior.
 Relay Operation

NO C NC
During normal operation

NO C NC
When a failure occurs

NO C NC
When power is turned OFF

If a failure occurs, contact your nearest YOKOGAWA dealer for repairs.

Memory Sample Relay (Only on DXs with the /AS1 advanced security option)
The relay is energized at memory start and de-energized at memory stop. You cannot 
change this behavior
When the multi batch function (/BT2 option) is being used, memory start is when memory 
start occurs for any of the batches, and memory stop is when memory stop occurs for all 
the batches.
 Relay Operation

   
NO C NC

Memory sampling
NO C NC

Memory sampling stopped
NO C NC

When power is turned OFF

Invalid User Relay (Only on DXs with the /AS1 advanced security option)
The relay is energized when the user is invalid and de-energized when you execute the 
Locked ACK command. You cannot change this behavior
 Relay Operation

   
NO C NC

Normal
NO C NC

Invalid user
NO C NC

When power is turned OFF

User Login Status Relay (Only on DXs with the /AS1 advanced security option)
The relay is energized when a user is logged in (through key operations or through 
communication commands) to the DX. You cannot change this behavior
 Relay Operation

   
NO C NC

Not logged in
NO C NC

Logged in
NO C NC

When power is turned OFF
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Status Output
Outputs the status below with a relay contact signal (1 relay). You can select whether 
each status is output to the relay. The relay is energized when the status occurs. You 
cannot change this behavior.
For the setting procedure, see section 2.9.

Status Description Corrective Action
Status of the internal 
memory or CF card

Error in the internal memory. Contact your nearest 
YOKOGAWA dealer for 
repairs.

When the auto save function to the CF card is On.
• The free space on the CF card 

dropped to 10% of the total size (only 
when the media FIFO (see section 1.4) 
is disabled).

Replace the CF card.

• Error in the CF card. •  Replace the CF card with 
a normal one.

•  Format the CF card on the 
DX (the data on the CF 
card will be erased).

However, the status of the internal 
memory is output when the CF card is 
not inserted. 
• 10 MB or less of available space* 

remaining in internal memory. 
•  The number of files in internal memory 

for which Auto Save to the CF card 
has not been completed has exceeded 
390. 

Insert a CF card.

When the auto save function to the CF card is Off.
• 10 MB or less of available space* 

remaining in internal memory. 
•  The number of files in internal memory 

for which Manual Save has not been 
completed has exceeded 390. 

Save the data in the internal 
memory to the CF card.

Measurement error Error in the A/D converter. Contact your nearest 
YOKOGAWA dealer for 
repairs.

Burnout is detected. Replace the thermocouple 
that has burned out.

Communication error A Modbus master or Modbus client 
communication error occurred.

Check the error in the 
Modbus master or Modbus 
client screen and carry out 
the corrective action.

A PROFIBUS-DP communication error 
occurred.

Contact your nearest 
YOKOGAWA dealer for 
repairs.

Memory stop When the memory sampling is stopped. Start the data acquisition.
Alarm occurrence 
(Release number 3 
or later)

An alarm has occurred. Check the alarm.

* The internal memory’s “available space” refers to the following quantities. 
 • Unused regions.
 •  Regions of data for which Auto Save or Manual Save (see page 1-33) has been 

completed. 

 Relay Operation

   
NO C NC

During normal operation
NO C NC

When specified status occurs
NO C NC

When power is turned OFF

1.9  FAIL/Status Output Function (/F1 and /F2 Options)



1-56 IM 04L42B01-01E

1.10 Other Functions

Time Related Functions
• Time Correction
 The DX internal clock can be changed in the following manner.

Method Description
Key operation Sets the DX internal clock to the specified time.
Event action function Synchronizes the DX internal clock to the nearest hour.
SNTP client function Sets the DX internal clock to the time retrieved from an SNTP 

server.

 Time Correction Operation
 The time correction operation varies depending on whether the memory sampling is in 

progress or not.
Status Operation
Memory sampling stopped The DX internal clock is changed immediately.
Memory sampling The DX internal clock is gradually corrected. While the time is 

being gradually adjusted, the date/time in the status display 
section is displayed in yellow.

 Operation of Gradually Correcting the Internal Clock
 If the time deviation between the time of the DX internal clock and the correct time (the 

specified time) is within a specified value, the DX clock is adjusted gradually at 40 ms 
for each second. Otherwise, the clock is corrected immediately. The maximum value 
of time deviation (tm in the figure below) can be selected in the range of 10 s to 5 min.

Time specified using keys or 
retrieved from an SNTP server

Range in which the time is gradually 
adjusted

Nearest
hour

Time deviation

Time when the remote control 
signal is applied
(Time on the DX)

tm tm
Range in which the time is gradually 
adjusted

Time on 
the DX

Time deviation

tm tm

Example: When changing the time to 12 hours 55 minutes 35 seconds when the 
internal clock is 12 hours 55 minutes 32 seconds

 The time deviation of 3 seconds is adjusted 40 ms per second. The 
internal clock will be synchronized to the specified time 75 seconds later.

• Date Format
 You can select the display format of the data from “2005/09/28,” “09/28/2005,” 

“28/09/2005,” and “28.09.2005.”
 For the setting procedure, see section 2.4.

• Time Zone
 Set the time difference between the location where the DX is used and GMT.
 For the setting procedure, see section 2.2.

• DST (Daylight Saving Time)
 If you are using the DX in an area with daylight saving time, enter the daylight 

saving time starting and ending dates, and the DX will automatically change the time 
accordingly.

 For the setting procedure, see section 2.1.
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System Display
Displays the total number of inputs on the DX, the size of the internal memory, the 
communication functions, the external storage drive, the options, the remote controller 
ID, the operation of the devices connected to the USB port (/USB1 option), the MAC 
address, and the firmware version number.
For the operating procedure, see section 2.5.

Language
The displayed language can be set to English, Japanese, German, French, or, Chinese. 
For the setting procedure, see section 2.6.

VGA Output Terminal (/D5 Option)
Shows the DX display on a monitor through the RGB output.

24 VDC Power Supply for Transmitter (/TPS4 or /TPS8 Option)
Provides 24-VDC power supply to up to four (/TPS4) or eight (/TPS8) two-wire system 
transmitters. The measured values of the transmitter correspond to a current signal of 
4 to 20 mA on the same cable. Therefore, the signal can be connected to the DX input 
terminal and displayed.

  
–

+

+

–

Transmitter

Current
DX

Transmitter power 
supply output terminal

Input terminal
Shunt resistor: 250 Ω

Easy Text Entry Option (/KB1 and /KB2 Options)
You can control the DX using the keys on the remote control terminal.
• Set the remote controller ID on the DX and the ID number on the remote control 

terminal to the same value.
• You can set a value between 0 and 31 for the remote controller ID and ID number.
• By changing the ID number on the remote control terminal, you can control DXs with 

different remote controller IDs from a single remote control terminal.
For the operating procedure, see section 2.10.

  

Light-receiving
section

Infrared signal 
output section

1.10  Other Functions
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USB Interface (/USB1 option)
You can connect keyboards, barcode readers , or USB flash memory to two USB ports, 
one on the front and one on the back of the DX.
• You can operate the DX using a keyboard or barcode reader.
• You can save measured data and setup data to the USB flash memory and also load 

from it.
For the operating procedure, see sections 2.11 and 2.12.

External Input Channels (/MC1 option)
These channels handle measured data of other devices that is read with the 
communication function. There are 240 channels available. As with measurement 
channels, the data of these channels can be displayed and saved.
For the setting procedure, see sections 10.1 and 10.2.

Temperature Unit
You can set the unit when measuring temperature with the thermocouple or RTD to °C or 
°F.
For the setting procedure, see section 3.3.

Custom Display (Release numbers 3 and later)
You can create a custom operation screen.
See the Custom Display User’s Manual, IM04L41B01-04E.

Multi Batch Function (/BT2 option; release numbers 3 and later)
You can use this function to simultaneously record the measured data from multiple 
batches.
See the Multi Batch (/BT2) User’s Manual, IM04L41B01-03E.

Advanced Security Function (/AS1 option; release numbers 4 and later)
The advanced security option strengthens measurement security with login, audit trail, 
digital signature, and other functions.
See the Advanced Security Function (/AS1) User’s Manual, IM 04L41B01-05EN.

1.10  Other Functions
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2.1 Setting the Date/Time

Set the date/time. If you are using the DX in a region that uses DST, specify the date/time 
for switching between DST and standard time.

Setup Screen

• Date/Time
  Press MENU (to switch to setting mode), and select the Menu tab > Date/Time > 

Time Settings.

   

• DST
 Press MENU (to switch to setting mode), and select the Menu tab > Date/Time > 

Daylight savings time.

   

Setup Items

• Time set
 Enter the date and time and press DISP/ENTER.
• Daylight savings time > Use/Not
 To set a daylight saving time period, select Use.
• Daylight savings time > Start time
 Specify the date and time when daylight saving time starts.

Item Description
Month Specify the month.
Day order (week order) Specify the week within the month. Specify [Last] for the last week in 

the month.
Day of the week Specify the day of the week.
Hour of the day Specify the hour using a value from 0 to 23.

• Daylight savings time > End time
 Specify the date and time when daylight saving time ends. The settings here are the 

same as those for Start time.

Chapter 2 Common Operations
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2.2 Setting the Time Difference from GMT

Set the time zone of the region in which the DX will be used. Make sure to set this value 
if you are using the Internet network functions or the DST function.

Setup Screen
  Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Menu tab > Time settings.

   

Setup Items

• Date & Time > Time zone
 Set the time zone of the region in which the DX will be used in terms of the time 

difference from GMT. Specify a value in the range of –1300 to 1300 (where the first 
two digits denote the hour and the last two digits denote the minute). A negative value 
indicates that the local time is behind the GMT.

 Example: The standard time in Japan is ahead of the GMT by 9 hours. In this case, 
enter “900.”



C
om

m
on O

perations

IM 04L42B01-01E 2-3

1

2

3

4

5

6

7

8

9

10

11

12

13

App

Index

2.3 Setting the Time Correction Operation during 
Memory Sampling

This function gradually corrects the time when the time is changed while Memory 
Sampling is in progress.
For a description of the time correction operation, see section 1.10.

Setup Screen
  Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Menu tab > Time settings.

   

Setup Items

• Time deviation limit

   

Time deviation limit

Current time Specified time∆

 

 When the time deviation between the time on the DX and the specified time is within  
±(the value specified here), the time on the DX is gradually corrected. Otherwise, 
the clock is corrected immediately. Note that time is not corrected on DXs with the 
Advanced security function (/AS1 option) when the specified time is over the time 
deviation limit. (Firmware version numbers 4.11 and later)
Settings Description
10 s to 5 min The time deviation limit.
Off Disables the function that gradually corrects the time.

 Example: If Time deviation limit is set to 10s and the time on the DX is 10 hours 21 
minutes 15 seconds, the time on the DX is gradually corrected if the specified time is 
between 10 hours 21 minutes 5 seconds and 10 hours 21 minutes 25 seconds.

Note
On DXs with the Advanced security function (/AS1 option), you cannot change the time during 
memory sampling if the time deviation limit is set to OFF. (Firmware version number 4.11 and 
later)
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2.4 Setting the Date Format

Select the display format of the date.

Setup Screen
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Menu tab > Time settings.

   

Setup Items

• Date format
Settings Display Example  

(November 30, 2005)
Display Example of the Time at the 
Grid Position in the Trend Display 
(example: 8 O’clock on November 30)*

Y/M/D 2005/11/30 11/30 08
M/D/Y 11/30/2005 11/30 08
D/M/Y 30/11/2005 30/11 08
D.M.Y 30.11.2005 30.11 08
* Only if the trend interval is set greater than or equal to 1 h/div. A function available on DXs 

with release number 2 or later.

 Applied Range
 The format is applied to the date displayed on the screen. It does not change the 

date format on the setup screen of the date/time, the date in the output data via 
communications, the date saved along with the data, and the date used in the data file 
names.
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2.5 Viewing the DX Information

Show the DX information on the system information screen and the network information 
screen.

Procedure

• Displaying System Information Screen
1. In the operation mode, press FUNC.

The FUNC key menu appears.

2. Press the System info soft key.
The system information screen is displayed.

• Displaying Network Information Screen
1. In the operation mode, press FUNC.

The FUNC key menu appears.

2. Press the Network info soft key.
The network information screen is displayed.

Explanation

• System Information Screen

ANALOG
 Number of measurement channels

(C) denotes the clamped input 
 terminals (/H2 option)
MATH 
 Number of  computation channels
 (/M1 and /PM1 options)
EXTCH
 Number of external input channels 
 (/MC1 option)

MEMORY 
 Internal memory size
OPTIONs

Remote controller ID
 (/KB1 and /KB2 options)

MAC address 
Version 
 Firmware version

 The following items are displayed:
 • Number of measurement channels.
 • Number of computation channels.
 • Internal memory size
 • Options
 • Remote controller ID (/KB1 and /KB2 options)
 • Connected USB HID devices (/USB1 option)
 • MAC address
 • Firmware version
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• Network Information Screen
 The following values set on the DX are displayed.
 IP address, MAC address, DNS server, host name, and domain name

   

 There are two pages of network information. Use the left and right arrow keys to 
switch the screen. The following items are displayed:

 • IP address
 • Subnet mask IP address
 • Default gateway IP address
 • MAC address
 • DNS server IP address
 • Host name
 • Domain name
 • The server function setting conditions listed below.

 FTP, Web, Modbus, SNTP, and EtherNet/IP
 • PROFIBUS-DP information (/CP1 option) 

 Node address and serial number (maintenance information)

2.5  Viewing the DX Information
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2.6 Changing the Displayed Language

Set the displayed language.

Setup Screen
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Environment tab > Operating environment.

   

Setup Items

• Operating environment > Language
 Set the displayed language to English, Japanese, German, French, or Chinese.
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2.7 Setting the LCD Brightness and Backlight 
Saver

Change the LCD brightness. In addition, set the backlight saver function to prolong the 
service life of the LCD backlight.

Setup Screen
 Press MENU (to switch to setting mode), and select the Menu tab > Display > Trend, 

Bar graph, LCD, Monitor.

   

Setup Items

• LCD > Brightness
 Select a value from 1 to 6 (2 by default). Larger the value, brighter the display 

becomes.

• LCD > Backlight saver > Mode
Settings Description
Off Disables the backlight saver
Dimmer Dims the display if there is no operation for a given time.
Timeoff Turns the backlight OFF if there is no operation for a given time.

• LCD > Backlight saver > Saver time
 Select a value from 1 min to 1 h. If the specified time elapses without any key 

operation or alarm occurrence, the LCD backlight switches to the specified mode.

• LCD > Backlight saver > Restore
Settings Description
Key The backlight returns to the original brightness when a key is pressed.
Key+Alm The backlight returns to the original brightness when a key is pressed or 

when an alarm occurs.

Note
• If the backlight is dimmed or turned OFF by the backlight saver function, pressing any key 

on the DX causes the backlight to return to the original brightness. In this operation, the key 
does not perform its intended function.

• The degradation of the brightness and the discoloration of the screen (become yellowish) 
tend to progress faster as the brightness is set higher. Extended use at an unnecessary high 
setting should be avoided. It is also recommended that you use the backlight saver function.
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2.8 Initializing Settings and Clearing the Internal 
Memory

Initialize the settings to default values. In addition, clear the data in the internal memory.
For the default settings, see the DX2000 Operation Guide (IM04L42B01-02E).

Setup Screen
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the File/Initialize tab > Initialize.

 On DXs without the /AS1 advanced security option

   

 On DXs with the /AS1 advanced security option
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Setup Items

• Initialize
 On DXs without the /AS1 advanced security option

Settings Description
Clear 1 Clears and initializes the data in the internal memory in the manner 

indicated on the screen.Clear 2
Clear 3

 Internal Memory Data That Is Initialized or Cleared
Item Description
Basic Settings

Login Info The “Authority of user” settings in basic setting mode are 
initialized.

Other Settings All settings in basic setting mode other than the “Authority of 
user” settings are initialized.

Settings The setting mode settings are initialized.
Measurement and Math Data Display, event, manual sampling, and report (/M1 and /PM1 

options) data is cleared.
Display Data The custom display screen setup data is cleared.
Log Data All the log data is cleared.

 On DXs with the /AS1 advanced security option
Setting Description
Clear 1 Clears and initializes the data in the internal memory in the manner 

indicated on the screen.Clear 2
Clear 3
Clear 4

 Internal Memory Data That Is Initialized or Cleared
 See the explanation for DXs without the /AS1 advanced security option.

Procedure

1. Press the Clear 1, Clear 2, Clear 3, or Clear 4 soft key.

2. Press DISP/ENTER.
A confirmation window opens.

3. Select Yes and press DISP/ENTER.
The specified operation is executed, and the DX returns to the operation mode.
If you do not want to initialize, select No and press DISP/ENTER.

2.8  Initializing Settings and Clearing the Internal Memory
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2.9 Outputting the DX Status via the Relay Contact 
(/F1 and /F2 Options)

A signal is output to a dedicated relay when an error occurs in the DX CPU. In addition, a 
signal is output to a different relay when the a specified status occurs.
For a description of the FAIL/status output function, see section 1.7.

Setup Screen

• Assigning Relay Operations
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Menu tab > Status Relay > Relay Action.

 On DXs without the /AS1 advanced security option

   

 On DXs with the /AS1 advanced security option
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• Status Relay Details
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Menu tab > Status Relay > Status Relay Details.

   

Setup Items

• Relay Action > Fail Relay, Status Relay (Release numbers 4 and later)
 On DXs without the /AS1 advanced security option

Setting Description
Fail Outputs a fail relay.
Status relay Outputs a status relay. Even if you set both relays to “Status relay,” you 

cannot make them output different statuses.

 On DXs with the /AS1 advanced security option
Setting Description
Fail Outputs a fail relay.
Status relay Outputs a status relay. Even if you set both relays to “Status relay,” you 

cannot make them output different statuses.
Mem. sample* Relay output continues from memory start until memory stop.
Invalid user Relay output continues from when a user is determined to be invalid until 

a Locked ACK command is executed.
Login Relay output occurs whenever a user is logged in.
* When the multi batch function (/BT2 option) is being used, relay output starts when memory 

start occurs for any of the batches, and relay output stops when memory stop occurs for all 
the batches.

• Status Relay Details > Memory/Media status
 On: The status of the internal memory and the CF card is relayed.

• Status Relay Details > Measurement error
 On: A relay signal is output when a measurement error occurs.

• Status Relay Details > Communication error
 On: A relay signal is output when a communication error occurs.

• Status Relay Details > Memory stop
 On: A relay signal is output when memory sampling stops.

* When the multi batch function (/BT2 option) is being used, relay output starts when 
recording stops for all the batches.

2.9  Outputting the DX Status via the Relay Contact (/F1 and /F2 Options)
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• Status Relay Details > Alarm (Release numbers 3 and later)
 On: Outputs a relay signal when one or more alarms occur. Alarms whose indications 

are hidden (see section 3.6 for details) do not cause relay signal output. Relay output 
ceases after all alarms are released (if no other relay output conditions are met).

Procedure

• FAIL Output
 There are no operations that are required. A signal is output to the relay contact when 

a CPU error is detected. A signal is also output to the relay contact when the DX is 
turned OFF.

• Status Relay
 A signal is output to the relay contact when a specified status occurs.

2.9  Outputting the DX Status via the Relay Contact (/F1 and /F2 Options)
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2.10 Controlling the DX with the Remote Control 
Terminal (/KB1 and /KB2 Options)

Handling Precautions
• If the infrared signal output section of the remote control terminal or the light-receiving 

section on the DX becomes dirty or receives scratches, it can hinder the transmission/
reception of the infrared signal. Clean the infrared signal output section of the remote 
control terminal or the light-receiving section on the DX.

• When cleaning, wipe using a dry soft cloth. Do not use chemicals such as benzene or 
thinner, since these may cause discoloring and deformation.

• Do not apply shock to the remote control terminal.
• Do not operate the remote control terminal with wet hands.
• The transmission/reception sensitivity of the infrared signal may deteriorate if used in 

the following types of locations.
• Location where the receiver of the DX is exposed to direct sunlight or fluorescent lamp.
• Near magnetic field sources such as a transceiver.

• If you carry the remote control unit in your pocket, for example, keys may be pressed 
unintentionally and cause the DX to be controlled. Handle the remote control terminal 
properly so that keys are not pressed inadvertently.

• When you are near the DX, press the keys on the remote control terminal only when 
controlling the DX. If you are going to press the keys on the remote control terminal 
but do not wish to control the DX, take measures so that the signal does not reach 
the DX such as by covering the infrared signal output section of the remote control 
terminal.

• The distance at which the DX can be controlled using the remote control terminal 
varies depending on the operating environment such as the battery voltage and the 
presence or absence of external light.

• There is a possibility that DXs with the same remote controller ID be controlled 
simultaneously. It is recommended that different remote controller IDs be set on each DX.

Preparing the DX
Set the remote controller ID.
• Setup Screen
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Environment tab > Operating environment.

   

• Remote Controller ID
 Select the remote controller ID from 0 to 31. When not using the remote control 

terminal, select Off.

• Checking the Remote Controller ID
 You can check the DX remote controller ID on the system information screen.
 See section 2.5.
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Preparing the Remote Control Terminal
• Names of Parts

   

Infrared signal 
output section

Battery coverKeys

• Loading Batteries

   

1. While pressing the projection 
 on the battery cover, open 
 the cover.      

2. Load the batteries.
3. Close the battery cover.

Positive polarity

Positive polarity

• Setting the ID Number
 Set the ID number of the remote control terminal to match the remote controller ID of 

the DX that you are to operate.
 The ID number of the remote control terminal is not displayed anywhere. If you are 

not sure which ID number the remote control terminal is set to, set the appropriate ID 
number according to the following procedure.

   

1.  Press ID.

2. Enter the ID number (0 to 31) by pressing the keys 
 from 1 (A1) to 0 (N0).  
 Example For ID number “16” 
   Operation: Press 1 (A1) and 6 (G6).
3.  Press ID.

Note
• If you enter an ID number other than 0 through 31, the ID number retains the original setting.
• Pressing the ID key once causes the remote control terminal to enter the ID number setup 

mode. If none of the keys on the remote control terminal is pressed for 8 s, the remote 
control terminal automatically exits from the ID number setup mode. In this case, the ID 
number of the remote control terminal retains the original setting.

• If you remove the batteries, the ID number is reset to 0. After loading the batteries, set the 
appropriate ID number again.

• Affixing the ID Number Label
 If you are using the remote control terminal with a fixed ID number (such as when 

there is a one-to-one correspondence between the DX to be controlled and the remote 
control terminal), you can enter the ID number on the label and affix the label on the 
remote control terminal.

   

Affix the ID number label on the battery cover 
of the remote control terminal.

2.10  Controlling the DX with the Remote Control Terminal (/KB1 and /KB2 Options)
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Controlling the DX
Control the DX by pointing the infrared output section of the remote control terminal to 
the light-receiving section on the DX. Control the DX while checking the results on the 
DX screen.

Note
• The remote control terminal cannot be used to control the Favorite key.
• When a specific key operation is possible on the DX, the corresponding key on the remote 

control terminal is activated. For example, the operation for entering a character string is 
activated when a window for entering a character string is displayed on the DX screen.

• You cannot control the DX using the remote control terminal, if the remote control terminal is 
in the ID number setup mode.

• Correspondence with the DX Keys

Right arrow key

ESC key

Left arrow key

FUNC key

DISP/ENTER key

MENU key

Soft keys

User key
Up arrow key

START key

Down arrow key

Character input 
keys

Character input 
keys

Hold down SHIFT 
and press F3/F7.

Hold down SHIFT 
and press F2/F6.

Hold down SHIFT 
and press F1/F5.

STOP key
Character type switch key for character input keys (see the next page)

Delete key
Deletes the character at the cursor position when inputting characters.

Space key
Enters a space at the cursor position when inputting characters.

• Entering Strings
 When a character input window is displayed on the DX screen, pressing the A/a/1 

key switches the character type assigned to the character input keys as shown in the 
following figure.

   
Uppercase alphabet 

characters and symbols
Lowercase alphabet 
characters and symbols

Numbers

• Uppercase Alphabet Characters and Symbols/Lowercase Alphabet 
Characters and Symbols

Alphabet (A to Z or a to z)

1 2 3 4 5 6 7 8 9    10
Number of times 
the key is pressed 
Symbol % #         @      ( )          

Each time the MARK key is pressed, the displayed symbol switches 
in the following order.
The display switches in a cyclic pattern. 

° _

11 12 13

:      [      ]    +    * / 

2.10  Controlling the DX with the Remote Control Terminal (/KB1 and /KB2 Options)
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• Numbers

   

Number (1 to 9 and 0)
Decimal point
However, when setting a constant to be used in the computation 
on the DX with the /M1 or /PM1 option, the display switches 
in the order “.”, “+”, and “E” each time the key is pressed.
The display switches in a cyclic pattern.
Minus sign

When a window for entering an equation is displayed on the DX with the /M1 math 
option, the character strings of computing elements are assigned to each key as shown 
in the following figure.

1 2 3 4 5 6 7 8 9
1 ( ) 
2 K C D P Q I S F
3 + – * / .
4 [ ] ? :
5 .EQ. .NE. .GT. .LT. .GE. .LE.
6 AND NOT XOR OR
7 SQR( ABS( LOG( EXP( LN(
8 PRE( RESET( CARRY( HOLD(

9 TLOG.AVE( TLOG.MAX( TLOG.MIN( TLOG.SUM( TLOG.P-P(

0 CLOG.AVE( CLOG.MAX( CLOG.MIN( CLOG.SUM( CLOG.P-P(

key

The character string switches in the following order each time the key is pressed.  The 
display switches in a cyclic pattern.

Number of times the key is pressed

2.10  Controlling the DX with the Remote Control Terminal (/KB1 and /KB2 Options)
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Troubleshooting
The DX does not react when you try to control it using the remote control terminal.
• Are the correct batteries loaded in the remote control terminal?
 Check the voltage and polarity of the batteries.
• Are the batteries flat?
 Replace the batteries with new ones.
• Does the ID number of the remote control terminal match the remote 

controller ID of the DX that you are trying to control?
 Check the remote controller ID on the DX, and set the ID number of the remote control 

terminal to the same value.
• Is the remote control terminal in ID number setup mode (condition in 

which the ID key is pressed once)?
 Wait 8 seconds without pressing any keys to exit from ID number setup mode.
• Is the remote control terminal too far away from the DX?
 Get closer to the DX. Control from as close to the front of the DX as possible.
• Is a strong light hitting the light-receiving section of the DX?
 Take measures to prevent strong light from hitting the light-receiving section of the DX.
• Is there a magnetic field source such as a transceiver nearby?
 Move the magnetic field source away from the DX.
• Is the infrared output section of the remote control terminal or the light-

receiving section on the DX dirty?
 Clean them.
• Is the DX in a condition that allows the relevant key operation?
 Check the condition of the DX, and start from an operation that is possible.

2.10  Controlling the DX with the Remote Control Terminal (/KB1 and /KB2 Options)
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2.11 Controlling the DX with a Keyboard or Barcode 
Reader (/USB1 Option)

This section explains how to connect and use a USB keyboard or barcode reader. 
Barcode readers can be used if the DX release number is 3 or later.

Connecting and Disconnecting a Keyboard or Barcode Reader
• Connection

1. Connect the keyboard or barcode reader to a DX USB port.

    
POWER

USB CF CARD

USB port

 A display appears asking whether you have connected a keyboard or a barcode 
reader.

    

2. Select the type of device that you have connected, and then DISP/ENTER.
You can now use the device that you connected.
* If you change the display without selecting a device, the device type is automatically set to 
keyboard.

*This setting is unrelated to the connection of USB flash memory.

• Removal
 Remove the keyboard or barcode reader cable from the DX USB port.

Note
• You can connect and remove keyboards and barcode readers at any time, regardless of the 

display and whether the DX is on or off.
• You can only connect one human interface device (HID) to the DX. You cannot use a 

keyboard and a barcode reader at the same time.
• Use a keyboard appropriate for the language setting on the DX.
• The statuses of the Caps Lock and Num Lock keys are retained even if the USB keyboard is 

removed (release number 2 and later). However, if a bar code reader is connected, the key 
statuses will be initialized to off.

• The device that is currently connected is indicated in the system information display (see 
section 2.5 for details).
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Operating from the Keyboard
Use the keyboard while watching the DX screen. An operation that can be carried out on 
the DX can be carried out from the keyboard.
 Example: Switch to setting mode
 When the DX is in the operation mode, press Ctrl+M.
 The DX switches to setting mode, and the setting menu appears.

• Mapping of the Keys on the DX to the Keys on the Keyboard

   

Enter DISP/ENTER
Left arrow key
Up arrow key
Down arrow key
Right arrow key

Num Enter DISP/ENTER
Esc ESC
F1 to 7 Soft key 1 to soft key 7
F9 FUNC
F12 Hold down FUNC for 3 seconds
Left-Windows MENU
Right-Windows MENU
Application Favorite key
Ctrl+S START
Ctrl+P STOP
Ctrl+U USER
Ctrl+M MENU
Ctrl+F Favorite key
Tab, Shift+Tab Arrow keys*

Keys on the Keyboard
104 Keyboard (US)for the PC

Keys on the DX

←
↑
↓
→

*  Press Tab to move the cursor to the next item, or Shift+Tab to move to the previous item. 
However, this does not work in the following screens:

  Operation screens, Menu screens for Setting mode and Basic setting mode, screens for 
entering values and characters, “Menu customize” and “Save/Load” screens in Setting 
mode, and “Load setting, Initialize” screen in Basic setting mode

• Entering Alphabets, Numbers, and Symbols
 When alphabets, numbers, and symbols can be entered on the DX, you can enter 

them from the keyboard. The operation is the same as with normal keys. However, 
symbols that cannot be used on the DX are invalid.

 Symbols That Can Be Entered Using the Keyboard
 The symbols below can be entered. However, symbols that cannot be used on the DX 

are invalid. For example, the characters *, /, :, and ? cannot be used in the data save 
destination directory name.

    #  %  (  )  *  +  -  .  /  :  ?  @  [  ]  ^  _

* Press “^” on the keyboard to enter the temperature degree symbol.

2.11  Controlling the DX with a Keyboard or Barcode Reader (/USB1 Option)
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• Invalid Keys
 Keys enclosed in frames are invalid.

   

The 104 Keyboard for a PC (US)

2.11  Controlling the DX with a Keyboard or Barcode Reader (/USB1 Option)
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Barcode Reader Operations (Release number 3 or later)
When you scan communication commands with a barcode reader, the DX will respond 
as follows.
• The DX will accumulate key codes until it reaches a terminator. Then it will execute 

the accumulated character string. The terminator is the enter key code.
• The DX can accumulate up to 200 characters, not including the terminator. The DX 

will process a character string when it reaches 200 characters in length.
• The DX can read ASCII characters (128 characters: numbers, symbols, and 

uppercase and lowercase letters of the alphabet). 

Note
• Barcode reader operations are treated as key operations.
• Barcode reader operations except the operation using UD command are limited by the 

settings of the key lock and login functions.

• Barcode Reader Settings
Configure the barcode reader to the settings in the table below.
USB host parameter Setting
USB device type HID keyboard simulation
USB keyboard type English (U.S.) standard USB keyboard

2.11  Controlling the DX with a Keyboard or Barcode Reader (/USB1 Option)



C
om

m
on O

perations

IM 04L42B01-01E 2-23

1

2

3

4

5

6

7

8

9

10

11

12

13

App

Index

• How to Use
 Follow the standard operating procedure for the barcode reader that you are using.
 Operate the barcode reader while checking the status of the DX. An operation can be 

carried out using the barcode reader when it can be carried out on the DX.
 Commands
 Scan the communication commands encoded in bar codes to operate the DX with 

a barcode reader. The communication commands that you can use are listed in 
the table below. For information about communication command syntax, see the 
Communication Interface User’s Manual, IM 04L41B01-17E.
Command Description
KE Performs key operations
PS Starts or stops memory sampling
EV Starts manual sampling

Causes triggers to occur
Takes snapshots
Saves display data
Saves event data

MS Writes messages
TL Starts or stops computation

Resets computation
Clears the computation data dropout display

IR Resets the relative timer
AK Releases alarm output (alarm ACK)
CV Switches the trend interval
EM Starts or stops e-mails
CU Manually recovers the Modbus master or client
BJ Writes free messages
BV Inserts characters
BT Sets batch names
BU Sets batch comments
CL Executes manual SNTP
LO Reads the setting mode setup data
LI Saves setup data
MA Resets the single match time timer
YC Clears measured and computed data and initializes setup data
EJ Changes login passwords
YO Loads setup files (for basic setting mode)
UD Switches the screen
MH Writes batch text fields (release numbers 4 and later)
BP Enters login information (/AS1 option; release numbers 4 and later)
BQ Invalid user ACK operation (/AS1 option; release numbers 4 and later)
EC Initialization (/AS1 option; release numbers 4 and later)

 Command Example
 The command to write message number 8 in group 1 is: MS8,GRPUP,1. There must 

be a terminator (an enter key code) at the end.

Note
•  You can read multiple commands (as many as 10) by putting sub delimiters (semicolons) 

between them.
 Example: PS0;MS8,GRPUP,1
•  When you enter commands using bar codes, you can enter them separated or all at 

once. You can separate commands however you want to. For example, you can separate 
the command to write message number 8 in group 1, MS8,GRPUP,1, into the following 
components: MS > 8 > , > GRPUP > , > 1 > ENTER key code.

•  If you use a barcode reader that automatically attaches a footer and a header to every 
transmission, the result will be the same if MS is set to the header, the enter key code is set 
to the footer, and you scan 8,GRPUP,1.

•  When the DX receives an unsupported key code, it clears all of the key codes that it has 
accumulated so far.

2.11  Controlling the DX with a Keyboard or Barcode Reader (/USB1 Option)
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2.12 Using the USB Flash Memory (/USB1 Option)

Connecting/Removing a USB Flash Memory
• Connecting a USB Flash Memory
 If you are using the multi batch function (/BT2 option), see the DX1000/DX1000N/

DX2000 Multi Batch (/BT2) User’s Manual, IM04L41B01-03E.

1. Connect a USB flash memory to the USB port on the DX.

2. In operation mode, possible operations are shown. Select the desired operation 
using the arrow keys and press DISP/ENTER.

 When set to auto save

     

 When set to manual save
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Setting Description
Save Manual Saves unsaved data in the internal memory to the USB flash memory.
DATA SAVE MODE Switches to the DATA SAVE MODE display. For the procedure to save 

the internal memory data, see section 4.8. This item only appears when 
the DX is configured to display DATA SAVE MODE in the display menu 
(release numbers 2 and later). You can change the item that is displayed 
here with the menu customize function.

Load Settings Moves to the setup load display of the setting mode. For the procedure 
to load the setup data, see section 6.9.
Load Settings will not be displayed:
• When Media/USB loading is locked (see chapter 8 for details).
•  When the DX is accessing storage media (formatting, saving, or FTP 

communication).
Cancel Closes the operation selection window.

• Removing the USB Flash Memory
1. In the operation mode, press FUNC.

The FUNC key menu appears.

2. Press the Media eject soft key and then the USB soft key.
A message “Media can be removed safely.” appears.

3. Remove the USB flash memory.

Note
• One USB flash memory can be connected.
• Be sure to carry out the procedure above when removing the USB flash memory. If you 

remove the USB memory without performing the above procedure, the data stored on it 
could be damaged.

Saving and Loading Data
The following data save/load and file operations can be carried out.

Save/Load setup data files (see section 6.9).
Save display data and event data files (see sections 4.8 and 6.4).
Load display data and event data files (see section 6.8).
List files and delete files (see section 6.7).
Format (see section 6.7).

2.12  Using the USB Flash Memory (/USB1 Option)
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2.13 Setting the Decimal Point Type (Release 
number 3 or later)

You can set the decimal point type for the display and files saved in text format.

Setup Screen

Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 
setting mode), and select the Environment tab > Operating environment.

  

Setup Items

• Decimal Point Types
Setting Display Example
Point 1234.56
Comma 1234,56

Explanation

• Decimal Point Types
 The decimal point type setting affects the following kinds of files and displays. The 

decimal point of any file or setting not listed below (the setup screen for example) is 
displayed using a period.
Type Item
File output Manual sampled data file

Report file
Display Trend display

Digital display
Bar graph display
Overview display
Historical trend
Report data display
Custom display

Webpage All channel display
E-mails The instantaneous value data in alarm e-mails and scheduled e-mails.

The report data in report e-mails
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2.14 Showing or Hiding the Menu Item for Switching 
from Setting Mode to Basic Setting Mode 
(Release number 3 or later)

Set whether or not to display a menu item in the setting mode menu for switching to 
basic setting mode.

Setup Screen

Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 
setting mode), and select the Environment tab > Operating environment.

  

Setup Items

• Basic Setting Mode > Menu display
Setting Description
On Displays “Basic setting mode” in the setting mode menu.
Off Basic setting mode is not displayed in the setting mode menu.

Operations
When “Basic setting mode” appears in the setting mode menu, you can perform the 
following operation:

1. Press MENU and select the Menu tab > Basic setting mode. Then press DISP/
ENTER.
 A confirmation window opens.

2. Select Yes, and press DISP/ENTER.
 The basic setting mode menu appears.

Note
Regardless of this setting, you can switch from setting mode to basic setting mode by holding 
down the FUNC key for 3 seconds.
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3.1 Setting the Scan Interval and the Integration 
Time of the A/D Converter

Select the scan interval and the integration time of the A/D converter.
For a description of the scan interval and the integration time of the A/D converter, see 
section 1.1.

Setup Screen
  Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Menu tab > A/D, Memory.

   

Setup Items

• Scan interval > Scan mode
 Normal: Measures at the normal mode scan interval.

* The scan mode is fixed at Normal on DXs equipped with external input channels (/MC1 
option) and when the multi batch function (/BT2 option; release numbers 3 and later) is 
being used.

 FAST: Measures at a scan interval of 25 ms (DX2004 and DX2008) or 125 ms (DX2010, 
DX2020, DX2030, DX2040, and DX2048).

• Scan interval > Scan interval
 The selectable settings appear.

• Scan interval > A/D integrate
 When the scan mode is set to Normal, select the A/D integration time as necessary. 

Only the selectable settings are displayed.
Settings Description
Auto The DX automatically detects the power supply frequency and sets the integration 

time to 16.7 ms and 20 ms for 60 Hz and 50 Hz, respectively. Fixed to 20 ms on 
/P1 models that use the 24 VDC power supply.

50Hz Sets the integration time to 20 ms.
60Hz Sets the integration time to 16.7 ms.
100ms Sets the integration time to 100 ms (when the scan interval is 2 s or 5 s).
600Hz The A/D integration time for fast sampling mode. You cannot change this value.

Chapter 3 Measurement Channels and Alarms
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3.2 Setting the Burnout Detection and the 
Reference Junction Compensation of the 
Thermocouple Input

Set the function that detects burnouts in the sensor for thermocouple input and 1-5V 
input and the reference junction compensation method of the thermocouple.

Setup Screen
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Menu tab > Burnout, RJC.

   

Setup Items

• First-CH/Last-CH
 Select the target channels.

• Burnout set > Mode
 Detects thermocouple and 1-5V input sensor burnouts.

Settings Description
Off Does not detect burnouts in the sensor.
Up When the sensor burns out, the measured result is set to +over range. The 

measured value displays “Burnout.”
For 1-5V input, the DX assumes that the sensor has burned out when the 
measured value exceeds the scale upper limit by 10% of the scale width. 
(Example: When the measured value is greater than 110 when the scale is from 
0 to 100)

Down When the sensor burns out, the measured result is set to –over range. The 
measured value displays “Burnout.”
For 1-5V input, the DX assumes that the sensor has burned out when the 
measured value falls below the scale upper limit by 5% of the scale width. 
(Example: When the measured value is less than –5 when the scale is from 0 to 
100)

• RJC > Mode
 Sets the reference junction compensation method of the thermocouple input. Select 

Internal or External.
Settings Description
Internal Uses the reference junction compensation function of the DX.
External Uses an external reference junction compensation function. When set to 

External, Volt is displayed.

• RJC > Volt
 The compensation voltage to be added to the input. Set the value in the range of –

20000 µV to 20000 µV.
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3.3 Setting the Input Range

Set the input range for each channel.

Setup Screen
 Press MENU (to switch to setting mode), and select the Menu tab > Meas channel > 

Range, Alarm.

   

Setup Items

• First-CH/Last-CH
 Select the target channels.

• Range > Mode
Settings Description
Skip Not measured.
Volt, TC, RTD, DI, 1-5V Input type. Represents DC voltage, thermocouple, RTD, ON/OFF 

input, and 1-5V inputs, respectively.
Delta, Scale, Sqrt Difference computation, linear scaling, and square root computation.

 Set the items with check marks in the table below according to the mode value.

   

























































































   Volt TC RTD DI Delta Scale Sqrt 1-5V Skip
Type
Range
Span Lower
Span Upper
Scale Lower
Scale Upper
Unit
Ref. CH
Low-cut
Low-cut value

Mode
Setup Item
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• Range > Type
 Input type when Mode is Delta or Scale. See the description on Mode above. 

• Range > Range
 Input type details.

   

Standard Standard20mV –20.000 mV to 20.000 mVDC
60mV –60.00 mV to 60.00 mVDC
200mV –200.00 mV to 200.00 mVDC
2V –2.000 V to 2.000 VDC
6V –6.000 V to 6.000 VDC
20V –20.000 V to 20.000 VDC
20V –50.00 V to 60.00 VDC
Pt Pt100
JPt JPt100
Level ON/OFF(Voltage)
Contact ON/OFF(Contact
1-5V 0.800V to 5.200V

R Type R
S Type S
B Type B
K Type K
E Type E
J Type J
T Type T
N Type N
W Type W
L Type L
U Type U
WRe type WRe

Setting Input Type   Notes Setting Input Type Notes

Cu10 (GE)
Cu10 (L&N)
Cu10 (WEED)
Cu10 (BAILEY)
Cu10: a = 0.00392 at 20°C
Cu10: a = 0.00393 at 20°C
Cu25: a = 0.00425 at 0°C

Cu1
Cu2
Cu3
Cu4
Cu5
Cu6
Cu25

Setting Input Type  Notes
/N3
option

/N1
option

Kp Kp vs Au7Fe
PLATI PLATINEL
PR PR40-20
NiMo NiNiMo
W/WRe W/WRe26
N2 Type N (AWG14)
XK XK GOST*1

Pt50 Pt50
Ni1 Ni100 (SAMA)
Ni2 Ni100 (DIN)
Ni3 Ni120
J263 J263*B
Cu53 Cu53
Cu100 Cu100: a = 0.00425 at 0°C
Pt25 Pt25
Pt100G Pt100 GOST*1

Cu100G Cu100 GOST*1

Cu50G Cu50 GOST*1

Cu10G Cu10GOST*1

Pt46G Pt46 GOST*1

Setting Input Type  Notes

Pt200W Pt200(WEED)*2

*1 A function available on DXs with release number 3 or later.
*2 This function is available for release numbers 4 and later.

• Range > Span Lower, Span Upper 
 Input range. The selectable range is displayed on the screen.

Note
• You cannot set the same value to Span Lower and Span Upper.
• When the Mode is 1-5V or Sqrt, Span Lower must be less than Span Upper.

• Range > Scale Lower, Scale Upper 
 Input range after converting the unit.
 The selectable range is from –30000 to 30000. The decimal place is determined by 

the Scale Lower setting. It can be set to the following positions: “X.XXXX,”  
“XX.XXX,” “XXX.XX,” “XXXX.X,” or “XXXXX.”

3.3  Setting the Input Range



M
easurem

ent C
hannels and A

larm
s

3-5IM 04L42B01-01E

1

2

3

4

5

6

7

8

9

10

11

12

13

App

Index

Note
• The DX converts the measured value to a value obtained by removing the decimal point 

from the value span specified by Scale Lower and Scale Upper. For example, if the scale 
setting is “–5 to 5,” the value is converted to a value within the span of “10”; if the scale 
setting is “–5.0 to 5.0,” the value is converted to a value within a span of “100.” In this case, 
the resolution of the value converted to a span of “10” is lower than the value converted to a 
span of “100.” To prevent the display from becoming rough, it is recommended that the scale 
be set so that this value is greater than 100.

• You cannot set the same value to Scale Lower and Scale Upper.
• When the Mode is 1-5V or Sqrt, Scale Lower must be less than Scale Upper.

• Range > Unit
 Set the unit (up to 6 characters, A a # 1).

• Range > Ref. CH
 The reference channel for difference computation.

• Range > Low-cut
 Select On to use the low-cut function.

* The low-cut value for 1 to 5 V input is fixed to 0% value of the input span.

• Range > Low-cut value
 On a square root computation channel, set the low-cut value in the range of 0.0% to 

5.0% of the input span.

   

Input value

Low-cut value

Result of square root computation

Measured value

3.3  Setting the Input Range
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3.4 Setting the Moving Average of the Input

Set the moving average function of the measurement channel. This function suppresses 
the effects of noise.
For a description of the function, see section 1.1.

Setup Screen
 Press MENU (to switch to setting mode), and select the Menu tab > Meas channel > 

Moving average.

   

Setup Items

   Average value

Scan Interval

Count

Average value
 

• First-CH/Last-CH
 Select the target channels.

• On/Off
 To use moving average, select On.

• Count
 Set the number of data points of the moving average in the range of 2 to 400.
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3.5 Setting the Auxiliary Alarm Function

Set the alarm display and output relays.
For a description of the functions, see section 1.2.

Setup Screen
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Menu tab > Alarm.

   

Setup Items

• Basic setting > Reflash
 To set the reflash operation on the alarm output relay, select On. The reflash function 

is set on the first three output relays.
Setting Description
Off Reflash is not used.
On Reflash is used. The relays are deactivated for approximately 500 ms.
On-1s Reflash is used. The relays are deactivated for approximately 1 s.
On-2s Reflash is used. The relays are deactivated for approximately 2 s.

• Basic setting > Rate of change
 • Decrease

 Set the interval for the rate-of-change calculation of the low limit on rate-of-change 
alarm in terms of the number of sampled data points (1 to 32). The actual interval is 
obtained by multiplying the value specified here by the scan interval.

 • Increase
 Set the interval for the rate-of-change calculation of the high limit on rate-of-change 

alarm in the same manner as the interval for the low limit on rate-of-change alarm.

• Basic setting > Indicator
 You can choose to make the alarm displays behave in the following ways. When you 

use the alarm annunciator function (release number 3 or later), the setting follows the 
annunciator sequence.
Settings Description
Nonhold Clears the alarm indication when the alarm condition is released (returns to 

normal condition).
Hold Holds the alarm indication until an alarm acknowledge operation is performed.
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• Switch, Relay
 • Internal Switch > AND

 Select the internal switches that are to operate using AND logic. Set the range 
of internal switches (from the first internal switch) to take the AND logic. All 
subsequent switches will be set to OR logic.

 • Relay > AND
 Select the relays that are to operate using AND logic. Set the range of relays (from 

the first alarm relay) to take the AND logic. All subsequent relays will be set to OR 
logic. Available settings are None, I01 (I01 only), I01-I02 (I01 and I02), I01-I03 (I01 
to I03), etc. Only alarm output relays that are installed are valid.

Note
When reflash is turned ON, the operation of the first three output relays is fixed to OR logic. 
Specifying AND produces no effect.

 • Relay > Action
 Select whether the alarm output relay is energized or de-energized when an alarm 

occurs. The setting applies to all alarm output relays.

 • Relay > Hold
 You can choose to make the alarm output relays behave in the following ways. This 

setting applies to all relays. When you use the alarm annunciator function (release 
number 3 or later), the setting follows the annunciator sequence.

Settings Description
Nonhold Turns the output relay OFF when the alarm condition is released (returns to 

normal condition).
Hold Holds the output relay at ON until an alarm acknowledge operation is performed.

Note
When reflash is turned ON, the operation of the first three output relays is set to nonhold. 
Specifying Hold produces no effect.

 • Relay > Relay Action on Ack
 You can select the relay output status that is enabled after the AlarmACK operation 

from the following two settings. When you use the alarm annunciator function 
(release number 3 or later), the setting follows the annunciator sequence.

Settings Description
Normal The relay is deactivated when the alarm ACK operation is executed. If the 

condition for activating the alarm output relay is met in the next scan interval, the 
relay is activated. 
This operation is valid only when the alarm output relay is set to Hold.

Reset The relay is deactivated when the alarm ACK operation is executed. If a new 
condition for activating the alarm output relay is met, the relay is activated.

 An example of the relay action when alarm ACK is executed is shown below. This 
example is for the case when the output relay AND item is set to None.

  Normal

    

Alarm ACK

Alarm output relay

Alarm 2

Alarm 1

Relay is activated in the next scan interval

Activated

Alarm
occurrence

Alarm
occurrence

Deactivated

3.5  Setting the Auxiliary Alarm Function
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  Reset

    

Alarm ACK

Relay is activated on the next alarm occurrence

Alarm output relay

Alarm 2

Alarm 1

Activated

Alarm
occurrence

Alarm
occurrence

Deactivated

• Hysteresis > Meas CH
 • High/Low

 Sets the hysteresis width of the alarm occurrence/release of the high/low limit alarm 
specified on measurement channels.

 Selectable range: 0.0% to 5.0% of the span or scaling width
 • Delta High/Low

 Sets the hysteresis width of the alarm occurrence/release of the difference high/low 
limit alarm specified on measurement channels.

 Selectable range: 0.0% to 5.0% of the span

• Hysteresis > Math CH (/M1 and /PM1 options) and Ext. CH (/MC1 option)
 Sets the hysteresis width of the alarm occurrence/release of the high/low limit alarm 

specified on computation and external input channels.
Selectable range: 0.0% to 5.0% of the measurement span

3.5  Setting the Auxiliary Alarm Function
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3.6 Hiding the Alarm Indication

Select whether to enable the alarm hide function.
For a description of the function, see section 1.2.

Setup Screen
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Environment tab > Alarm > Action.

   

Setup Items

• Alarm action > No logging
 To enable the function that turns off the alarm indicator and logging, select On. The 

Detect setup item is displayed in the alarm setting screen (see section 3.7).

 This function disables the alarm indicator and the logging of alarm events to the alarm 
summary. Alarms are also not displayed by the alarm annunciator (release number 3 
or later).

• Settings for Each Channel and Each Alarm
 See section 3.7.
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3.7 Setting Alarms on Channels

Set the alarms after setting the range. All alarm settings of a channel are cancelled in the 
following cases.
• When the input type (Volt, TC, etc.) is changed.
• When the input range is changed.
• When the upper or lower limit of the span or scale is changed on channels that are set 

to linear scale, square root computation, or 1-5 V (including changes in the decimal 
point position).

Setup Screen

• Alarms for Each Channel
 Press MENU (to switch to setting mode), and select the Menu tab > Meas channel > 

Range, Alarm.

   

• Alarm Delay Time
 Press MENU (to switch to setting mode), and select the Menu tab > Meas channel > 

Tag, Memory sample, Alarm delay.

 On DXs without the /AS1 advanced security option
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 On DXs with the /AS1 advanced security option

   

• Alarm Levels and Colors (Release number 3 or later)
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Environment tab > Alarm > Level/Color.

   

3.7  Setting Alarms on Channels
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Setup Items

• First-CH/Last-CH
 Select the target channels. The target channels are common with the other items that 

are displayed on the screen.

• Alarm > 1, 2, 3, and 4
 For each alarm, 1 to 4, select On to enable it.

• Alarm > Type
 Select the alarm type.

Settings Name Description
H High limit alarm –
L Low limit alarm –
h Difference high limit alarm Can be specified on channels set to difference computation.
l Difference low limit alarm Can be specified on channels set to difference computation.
R High limit on rate-of-change alarm –
r Low limit on rate-of-change alarm –
T Delay high limit alarm –
t Delay low limit alarm –

 Alarms on channels set to difference computation are inserted at the following 
positions.

   Input value

Measured value on the reference channel

H, L, T, t R, r, h, l

Measured value
–

• Alarm > Value
 Set the alarm value for the selected alarm type.
 When the Mode of the Channel Is Set to Volt, TC, RTD, or DI

Type Value Example of a Range of Alarm Values
H, L Value in the measurable range –2.0000 to 2.0000 V for 2 V range
R, r 1 digit to the upper limit of the width of  

the measurable range
0.0001 to 3.0000 V for 2 V range

However, less than or equal to 30000 
excluding the decimal point.

0.1 to 1760.0°C for thermocouple type R

T, t Same as H and L. Same as H and L.

 When the Mode of the Channel Is Set to Delta
Type Value Example of a Range of Alarm Values
H, L Value in the measurable range –2.0000 to 2.0000 V for 2 V range
h, l Value in the measurable range –1760.0 to 1760.0°C for thermocouple type R
R, r 1 digit to the width of the measurable 

range
0.0001 to 3.0000 V for 2 V range

However, less than or equal to 30000 
excluding the decimal point.

0.1 to 1760.0°C for thermocouple type R

T, t Same as H and L. Same as H and L.

 When the Mode of the Channel Is Set to Scale, Sqrt, or 1-5V
Type Value Example of a Range of Alarm Values
H, L –5% to 105% of the scale width.

However, within –30000 to 30000 
excluding the decimal point. 

–5.0 to 105.0 when the scale is 0.0 to 100.0 
–120.00 to 300.00 when the scale is –100.00 
to 300.00

R, r Within 1 to 30000 excluding the decimal 
point. 

0.1 to 3000.0 when the scale is 0.0 to 100.0 
0.01 to 300.00 when the scale is –100.00 to 
300.00

T, t Same as H and L. Same as H and L.

3.7  Setting Alarms on Channels
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• Alarm > Relay
 Select whether to turn On or Off the relay output.

• Alarm > Number
 Set the output relay number or internal switch number when performing relay output.

• Alarm > Detect
 This item appears when the alarm hide function (see section 3.6) is turned On. Select 

whether to show or hide the alarm indication when an alarm occurs. If set to Off, a 
signal is output to the alarm output relay or internal switch when an alarm occurs, but 
it is not indicated on the screen. The alarm is also not recorded in the alarm summary, 
and alarms are not displayed by the alarm annunciator (release number 3 or later).

• Alarm delay > Time (for delay high/low limit alarms)
 Set the alarm delay time using an integer in the range of 1 to 3600 s.
 On DXs with the /AS1 advanced security option, you can set the delay time to a value 

within the range of 1 to 3600 seconds or 1 to 24 hours.

Note
• The alarm delay time takes on a value that is an integer multiple of the scan interval. For 

example, if the alarm delay time is set to 5 s when the scan interval is 2 s, the actual delay 
time is 6 s.

• The delay alarm has the following special operations.
• If the computation is stopped in a condition in which the computed value is exceeding the 

alarm setting when a delay alarm is set on a computation channel, the alarm is turned 
On after the specified period (delay period) elapses.

• The alarm detection operation is reset if a power failure occurs. The operation restarts 
after the power recovers.

• If the alarm setting of the delay high limit alarm is changed when an alarm is already 
activated and the input is greater than or equal to the new setting, the alarm continues. 
For all other cases, the alarm detection operation starts at the new setting. This is also 
true for the delay lower limit alarm.

• Alarm delay > Unit (For delay high/low limit alarms)
 This setting is only available on DXs with the /AS1 advanced security option. Set the 

unit of the alarm delay time. You can select seconds or hours.

• Alarm display > Level (Release number 3 or later)
 When multiple alarms occur, the display of alarms with higher levels is given higher 

priority. This setting applies to all channels.
Setting Description
1>2>3>4 The order of alarm level preference, from highest to lowest preference, is 1, 

2, 3, 4.
1>4>2>3 The order of alarm level preference, from highest to lowest preference, is 1, 

4, 2, 3.
1>4>3>2 The order of alarm level preference, from highest to lowest preference, is 1, 

4, 3, 2.

• Alarm display > Color (Release number 3 or later)
 Determines the alarm color for each alarm level. This setting applies to all channels.

Item Setting
1  Sets the alarm level 1 color to red, orange, yellow, or pink.
2 Sets the alarm level 2 color.
3 Sets the alarm level 3 color.
4 Sets the alarm level 4 color.

3.7  Setting Alarms on Channels
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3.8 Releasing the Alarm Output (Alarm ACK 
Operation)

This operation is valid when the DX is set as follows:
DX with release number 3 or later
• When Annunciator mode is set to On in the basic setting mode.
• When Annunciator mode is set to Off, the operation is the same as described for DX 

with release number 2 below.
DX with release number 2
• When Indicator is set to Hold in the basic setting mode.
• When Relay Hold is set to Hold and Relay action on ACK is set to Normal in the 

basic setting mode.
• When Relay action on ACK is set to Reset in the basic setting mode.
DX before release number 2
• When Indicator is set to Hold in the basic setting mode.
• When Relay Hold is set to Hold in the basic setting mode.
For the procedure to set the relay action, see section 3.5.

On a DX with advanced security (/AS1 option; release numbers 4 and later), you can 
perform separate alarm ACK operations on each alarm.
For information about individual alarm ACK operations, see section 4.4.

Procedure
This operation is carried out after an alarm occurs.

1. In the operation mode, press FUNC.
The FUNC key menu appears.

2. Press the Alarm ACK soft key.
The alarm output is released.

Explanation

• Alarm Acknowledge (ACK) Operation
 When an alarm acknowledge operation is carried out, the indications and outputs 

(relays and switches) of all activated alarms are cleared.
 In annunciator mode (release number 3 or later), the alarm indications and outputs 

follow the annunciator sequence.
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3.9 Performing Calibration Correction (/CC1 
Option)

The input value is corrected using segments, and the result is used as a measured value.
For a description of the function, see section 1.1.

Setup Screen
 Press MENU (to switch to setting mode), and select the Menu tab > Meas channel > 

Calibration correction.

   

Setup Items

   

True val

Number of set points

Calibration set points

Y5
Y4

Y3
Y2

Y1

MES val

X1 X2 X3 X4 X5

Condition
X1 < X2 < X3 < X4 < X5

• First-CH/Last-CH
 Select the target channels. You can set consecutive channels whose range is set to 

the same value as the first channel.

• Calibration correction > Number of set points
 Select the number of points that make up the segments (including the start and end 

points) in the range of 2 to 16.
 To disable calibration correction, select Off.

• Calibration correction > MES val, True val
 Press the Input soft key and enter the value.
 For the MES value, set a value that is greater than the previous value.
 Press the Measure soft key to set the measured value at that point to MES val. If 

you press the Measure soft key when setting multiple channels simultaneously, the 
measured value of the first channel are set to the MES val of all channels.

 Selectable Range of MES and True Values
 • Channels on which linear scaling is specified

 –30000 to 30000 (the decimal place is the same setting as the scale value)
 • Other channels

 Value in the measurable range of the selected range
 Example: –2.0000 to 2.0000 for 2 V range

Note
• The calibration correction setting is set to Off if you change the Mode or Range setting.
• Calibration correction cannot be specified on channels set to Skip.
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3.10 Counting Pulses (/PM1 Option)

The pulses applied to the pulse input terminal are counted on a computation channel.
For a description of the function, see section 1.1.

Setup Screen
 Press MENU (to switch to setting mode), and select the Menu tab > Math channel > 

Calculation expression, Alarm.

   

Setup Items

• First-CH/Last-CH
 Select the target computation channels.

• Math range > Math On/Off
 Select On.

• Math range > Calculation expression
 Enter the equation using symbols.
 Q01 to Q08: Displays the number of pulses per second.
 P01 to P08: Displays the number of pulses per scan interval.

* The numbers 01 to 08 correspond to the pulse input terminal numbers.
 For the procedure to set the computation channels, see section 9.1.

The procedure is explained below using an example.
• Example 1: Pulse Sum Value
 Display the sum value of the pulse signal applied to pulse input terminal number 6.

   
Number of pulses 
per scan interval

TLOG.SUM
Pulse sum value

Pulse input
Scan interval

Time

(Sum)

P6

 Expression
 Assign the computation channel and set the expression. Set the span lower/upper 

limit and unit according to the application.

 101 Sum of the number of pulses per scan interval
 Channel Equation Description

TLOG.SUM(P6)
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• Example 2: Number of Pulses per Minute
 Count the pulse signal applied to pulse input terminal number 6 on the DX2004 (scan 

interval set to 250 ms), and calculate and display the number of pulses per minute.

   Number of pulses 
per second

101ch

102ch
 Number of pulses 
 per minute

Pulse input
Sampling interval 

(250 ms)

Time

(Moving average over a minute)

(60x)

 Expression
 Assign the computation channel as shown below and set the expressions. Set the 

span lower/upper limit and unit according to the application.

   

101 Q6 Number of pulses per second
102 101*K01 Number of pulses per minute

 Channel Equation Description

K01 60 Coefficient for converting the number of 
pulses per second to the number of 
pulses per minute

    Constant Value Description

101 Sampling interval: 1s Moving average over a minute
Number of samples: 60

 Channel Rolling average Description

 Channels
 The computation is performed in order from the channel with the smallest channel 

number in one scan interval.
 Use a channel of a channel number larger than that of the channel counting the 

number of pulses per second for the computation channel that is to calculate the 
number of pulses per minute.

• Example 3: Reset When the Pulse Sum Value Exceeds a Certain Value
 Reset the sum value when the pulse sum value exceeds a specified value (reset 

value) and carry over the value exceeding the reset value to the sum after the reset. 
Count the number of resets and calculate the total sum value up to that point.

 Expression
 Assign expressions to the computation channels as shown below and set the 

constants.
Channel Expression Application
101 ((102+P01).GE.K01)+101 Pulse sum value reset count
102 CARRY(K01):TLOG.SUM(P01) Pulse sum value
103 K01*101+102 Total sum value

Symbol Description
P01 Counts the number of pulses per scan interval.
K01 Constant. The reset value. The sum value is reset when this value is exceeded.

3.10  Counting Pulses (/PM1 Option)
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0 0 1 1 1 2 2

 P01
Number of pulses 
per scan interval

102ch
Sum value

101ch
Reset count

Pulse input
Scan interval

Time

 K01
reset value

(Resets the value below the reset value)

(Sum)

 Channel 101: Reset Count
 Calculates the number of times the pulse sum value is reset.
 The expression “((102+P01).GE.K01)” is set to 1 when “the previous pulse sum value 

(102) + the current pulse count (P01)” is greater than the reset value (K01). Otherwise, 
the expression is set to 0. The value of channel 101 is incremented when the pulse 
sum value exceeds the reset value.

 Channel 102: Pulse Sum Value
 Calculates the pulse sum value.
 Under normal conditions, the pulse sum value TLOG.SUM (P01) is calculated. When 

the pulse sum value is greater than or equal to the reset value (K01), the pulse sum 
value is set to the amount exceeding K01.

 Channel 103: Total Sum Value
 Multiplies the reset value (K01) by the reset count (101) and adds the pulse sum value 

(102) to derive the total sum value.

Note
• The computation is performed in order from the channel with the smallest channel number 

in one scan interval. If the channel number in the expression is greater than or equal to the 
channel number in which the expression is assigned, the previous computed result (previous 
value) is used for the channel in the expression.

• If the pulse input value of the scan interval is greater than the reset value, correct 
computation cannot be achieved.

3.10  Counting Pulses (/PM1 Option)
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3.11 Setting the Method of Detecting Over-Range 
Values of Linearly Scaled Measurement 
Channels

Setup Screen
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Environment tab > View, Message, Input, Tag.

   

Setup Items

• Input > Value on over-range
Settings Description
Free The value is set to –over range if the value is less than –30000 and +over range 

if the value is greater than 30000 excluding the decimal point. The value is 
displayed as –Over and +Over, respectively.

Over The value is set to –over range if the value is less than –5% of the scale and 
+over range if the value is greater than 105%. The value is displayed as –Over 
and +Over, respectively.
Example: If the scale is 0.0 to 200.0, the value is set to –over range if the value 
is less than –10.0 of the scale and +over range if the value is greater than 210.0.

Note
For computations such as TLOG, CLOG, and report, the handling of the scale over-range value 
can be set in advance.
See section 9.1.
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3.12 Using the Alarm Annunciator Function (Release 
number 3 or later)

This section explains how to use the alarm annunciator function.
For a description of the function, see section 1.2.

Setup Screen

• Annunciator Mode
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Environment tab > Alarm > Action.

   

• Alarm Levels and Colors
 See section 3.7.

• Display
 Press MENU (to switch to setting mode), and select the Menu tab > Display > 

Annunciator.
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Setup Items

• Alarm action > Annunciator mode
 Select On to use the annunciator function.

• Alarm action > Sequence
 Select the annunciator sequence. For details about the annunciator sequence, see 

“Explanation” in this section.
Setting Description
ISA-A-4 A no lock-in sequence.
ISA-A A lock-in sequence.
ISA-M A double lock-in sequence.

• Alarm action > Time off color
 The window display color when no alarms are activated. You can select white or 

green.

• Levels and Colors
 See section 3.7.

• Annunciator position
 The position of the annunciator window. See the explanation for the next item.

• Annunciator position > On/Off
 Set the annunciator position that you want to use to On.
 Starting with 1, consecutively set all annunciator positions that you want to use to On. 

After a position has been set to Off, all of the positions after it will also be turned off 
even if they are set to On. The annunciator display changes depending on how many 
annunciator windows you use. For details, see “Explanation.”

• Annunciator position > Channel, Level
 You can assign alarms to annunciator windows by specifying channel numbers and 

alarm levels.
 You can set Level to 1, 2, 3, 4, or All. If you select All, all of the alarms in the specified 

channel are assigned to the specified window.

• Annunciator position > Comment txt block No.
 You can select a text string (label) to display in the annunciator window by selecting a 

comment text block number.
 For information about how to set comment text blocks, see section 5.19.

3.12  Using the Alarm Annunciator Function (Release number 3 or later)
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Procedure

• Opening the Display
 The annunciator display appears when you turn on the power. You can switch to the 

annunciator display from other displays by following the procedure below.

1. Press DISP/ENTER to show the display selection menu.

2. Use the up and down arrow keys to select Annunciator, and then press DISP/
ENTER.

     

The display appears. The example below is for when there are four annunciator windows.

     

• Alarm ACK
 Perform this operation after an alarm has occurred. This operation affects all alarms.

1. In operation mode, press FUNC.
The FUNC key menu appears.

2. Press the Alarm ACK soft key.
The alarm indications and outputs are cleared according to the annunciator sequence. For 
details, see “Explanation.”

• Alarm Display Reset (When the annunciator sequence is set to ISA-M)
 The alarm display reset operation will not take place unless the alarm ACK operation 

is performed first. The alarm display reset operation affects all alarms.

1. In operation mode, press FUNC.
The FUNC key menu appears.

2.  Press the Alarm DispRST soft key.
The alarm displays are reset. They are reset according to the annunciator sequence. For 
details, see “Explanation.”

3.12  Using the Alarm Annunciator Function (Release number 3 or later)
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Explanation

• Display Window Layouts and Labels
 The annunciator display layouts and labels change as indicated in the table below.

Displayed 
Windows

Window Layout
Vertical × Horizontal

Labels (max number of displayable characters) Font Size
Lines Characters

When displayed on 1 screen.
4 2 × 2 5 32 8
6 3 × 2 5 32 8
8 4 × 2 5 32 8
10 5 × 2 5 32 8
12 6 × 2 4 32 8
16 8 × 2 3 32 8
20 10 × 2 3 32 6
24 8 × 3 4 32 6
30 10 × 3 3 32 6
40 10 × 4 3 26 6
50 10 × 5 3 20 6
60 10 × 6 3 16 6
70 10 × 7 3 14 6
80 10 × 8 3 12 6
When assigned to the 4-Panel display.
4 2 × 2 5 26 6
6 3 × 2 5 26 6
8 4 × 2 4 26 6
10 5 × 2 3 26 6
12 6 × 2 2 26 6
16 8 × 2 2 26 6
20 10 × 2 1 26 6
24 8 × 3 2 17 6
30 10 × 3 1 17 6
40 10 × 4 1 13 6
50 10 × 5 1 10 6
60 10 × 6 1 8 6
70 10 × 7 1 7 6
80 10 × 8 1 6 6

 Display Positions
 Annunciator windows are assigned to positions starting with the left column. 

Annunciator windows are assigned in ascending order. The example below is for an 
annunciator display with eight windows.

   

Annunciator
position number

1

2

3

4

5

6

7

8

 Labels
 The number of characters that can be displayed varies depending on the number of 

annunciator windows.

• Window Colors
State Color
When an alarm is released “Time off color” (green or white)
When an alarm is occurring The alarm color. If multiple alarms are occurring, the window is 

displayed using the color of the alarm with the highest priority.
Displayed windows not in use Gray

3.12  Using the Alarm Annunciator Function (Release number 3 or later)
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• Annunciator Sequence
ISA-A-4

Sequence diagram
Process

Sequence
Display

Relay output
Alarm icon

Normal
Normal
Normal

Deactivated
No display

Process
Sequence

Display
Relay output
Alarm icon

Deactivated

Process
Sequence

Display
Relay output
Alarm icon

Activated

Abnormal
Acknowledged

On

On (red) Blinking (red)

Flashing
Alarm

Abnormal

To abnormal

Return to normal Return to normal

Alarm ACK 
while abnormal

Sequence pattern

Alarm

Display

Relay output

Alarm ACK

When multiple alarms have been assigned to a single annunciator window
• If multiple alarms are occurring, the window is displayed using the color of the alarm with the highest priority.

When two alarms have been assigned to a single relay
When the relay is set to OR logic

Alarm A   
 Occurrence

Alarm B
 Occurrence

 Release

 Release

Relay
 Activated

 Deactivated

ACK ACK

An alarm has occurred, and the relay has been activated.

3.12  Using the Alarm Annunciator Function (Release number 3 or later)
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When the relay is set to AND logic

ACK ACK

Alarm A   
 Occurrence

Alarm B
 Occurrence

 Release

 Release

Relay
 Activated

 Deactivated

Alarm B has occurred, so now all alarms have occurred.
This causes the relay to be activated.

3.12  Using the Alarm Annunciator Function (Release number 3 or later)
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ISA-A
Sequence diagram

Process
Sequence

Display
Relay output
Alarm icon

Normal
Normal
Normal

Deactivated
No display

Process

Sequence
Display

Relay output
Alarm icon

Deactivated

Process

Sequence
Display

Relay output
Alarm icon

Activated

Abnormal

Acknowledged
On

On (red) Blinking (red)

Flashing
Alarm

Abnormal or 
normal

To abnormal

Return to normal

Alarm ACK 
while abnormal

Alarm ACK 
while normal

Sequence pattern

Alarm

Display

Relay output

Alarm ACKAlarm ACK

• If an alarm is released before the alarm ACK operation is performed, the annunciator blinks with the color that is displayed 
when no alarms are activated.

• If an alarm is released before the alarm ACK operation is performed, the alarm icon blinks green.

When multiple alarms have been assigned to a single annunciator window
• If multiple alarms are occurring, the window is displayed using the color of the alarm with the highest priority.

When two alarms have been assigned to a single relay
When the relay is set to OR logic

ACK ACK

Relay hold

Alarm A   
 Occurrence

Alarm B
 Occurrence

 Release

 Release

Relay
 Activated

 Deactivated

An alarm has occurred so the relay has been activated.

3.12  Using the Alarm Annunciator Function (Release number 3 or later)
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When the relay is set to AND logic

Relay hold

ACK ACK

Alarm A   
 Occurrence

Alarm B
 Occurrence

 Release

 Release

Relay
 Activated

 Deactivated

Alarm B has occurred, so now all alarms have occurred.
This causes the relay to be activated.

3.12  Using the Alarm Annunciator Function (Release number 3 or later)
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ISA-M
Sequence diagram

Process
Sequence

Display
Relay output
Alarm icon

Normal
Normal
Normal

Deactivated
No display

Process

Sequence
Display

Relay output
Alarm icon

Deactivated

Process

Sequence
Display

Relay output
Alarm icon

Activated

Abnormal or 
normal

Acknowledged
On

On (red) Blinking (red)

Flashing
Alarm

Abnormal or 
normal

To abnormal

Alarm ACK

Alarm display reset while 
normal

Sequence pattern

Alarm

Display

Relay output

Alarm ACK Alarm ACK

Display reset Display
reset

Display
reset

Alarm

Display

Relay output

Alarm ACK Alarm ACK

Display
reset

• Even if an alarm is released before the alarm ACK operation is performed, the annunciator continues to blink with the color 
that is displayed when an alarm has occurred.

• Even if an alarm is released before the alarm display reset operation is performed, the annunciator continues to blink with 
the color that is displayed when an alarm has occurred.

• Even if an alarm is released before the alarm ACK operation is performed, the alarm icon continues to blink red.
• Even if an alarm is released before the alarm display reset operation is performed, the alarm icon stays red.

When multiple alarms have been assigned to a single annunciator window
• If multiple alarms are occurring, the window is displayed using the color of the alarm with the highest priority.

When two alarms have been assigned to a single relay
Same as for ISA-A.

3.12  Using the Alarm Annunciator Function (Release number 3 or later)
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3.13 Managing the Input Calibration Interval (/CC1 
option; release numbers 4 and later)

Manage the input calibration interval to make sure that calibration is performed regularly.
For a description of the function, see section 1.1.

Setup Screen
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Menu tab > Set Calibration.

   

Setup Items

• Set Calibration > Use/Not
 Select whether to Use or Not use calibration management.
 When you select Use, the Set Calibration tab appears in setting mode.

• Set Calibration > Notification (DayBfr)
 You can specify how many days before the calibration due date you want to display 

the calibration notification screen. You can set the number of days to a value between 
1 and 10.

• Set Calibration > Renotification
 You can specify the period at which to display the calibration notification screen. The 

calibration notification screen will continue to appear until calibration is completed.
Setting Description
10min The screen will appear every 10 minutes.
30min The screen will appear every 30 minutes.
1h The screen will appear every hour.
8h The screen will appear every 8 hours.
24h The screen will appear every 24 hours.



M
easurem

ent C
hannels and A

larm
s

3-31IM 04L42B01-01E

1

2

3

4

5

6

7

8

9

10

11

12

13

App

Index

Procedure

• Viewing the Calibration Notification Screen

   

 The calibration notification screen only appears over operation screens. It will continue 
to appear until you perform calibration (Finish Calibration).

 You can close the calibration notification screen by pressing ESC or DISP/ENTER.
 Operation Example
 When Notification is set to 1 (DayBfr) and Renotification is set to 8h

   

Notification screen 
display start Calibration due date

Notification screen 
appears

Renotification Renotification Renotification Renotification

00:00 08:00 16:00 00:00 08:00

Notification (DayBfr) setting

Notification screen 
appears

Notification screen 
appears

Notification screen 
appears

Note
• The calibration notification screen will close if you change screens while it is displayed.
• If the calibration due date passes before you complete calibration, that information will be 

recorded in the login log (the operation log on DXs with the /AS1 option).

3.13  Managing the Input Calibration Interval (/CC1 option; release numbers 4 and later)
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• Checking the Calibration Due Date
 Carry out the procedure below to show the display.

 Press MENU (to switch to setting mode) > Set Calibration tab.

     

The date on which the last 
calibration was completed
Displayed according to the 
date format 
(see section 2.4)

Due date for next 
calibration
Displayed according to the 
date format (see section 2.4)

• Configuring Calibration
 Carry out the procedure below to show the display.

 Press MENU (to switch to setting mode) > Set Calibration tab > Calibration 
Correction.

     

 The setup items are the same as in section 3.9, “Performing Calibration 
Correction.”

 For the setting procedure, see section 3.9.

3.13  Managing the Input Calibration Interval (/CC1 option; release numbers 4 and later)
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• Finishing Calibration
 Set the next calibration due date.

1. Carry out the procedure below to show the display.

 Press MENU (to switch to setting mode) > Set Calibration tab > Finish 
Calibration.

 A window for setting the calibration due date appears.

     

2. Set the next calibration due date, and press DISP/ENTER.

Soft Key Description
Input Enter the date directly.
+1 Week Set the date by adding weeks to the current calibration due date.
–1 Week Set the date by subtracting weeks from the current calibration due date.
+1 Month Set the date by adding months to the current calibration due date.
–1 Month Set the date by subtracting months from the current calibration due date.

3. Use the arrow keys to select Execute, and press DISP/ENTER.
Calibration is complete.

Note
• You cannot set the calibration due date to a date before the current day.
• Whenever you complete calibration, a log is added to the login log (the operation log on DXs 

with the /AS1 option).

3.13  Managing the Input Calibration Interval (/CC1 option; release numbers 4 and later)
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4.1 Operations in Operation Mode

Switching the Screen with the DISP/ENTER Key and Arrow Keys
Press DISP/ENTER and arrow keys to show the display selection menu and sub menu 
to switch the display. The flow of operation is indicated below.

TREND

GROUP 1 GROUP n

GROUP n

GROUP 1 GROUP n

DIGITAL

BAR

OVERVIEW

INFORMATION

TREND
HISTORY

LOG

Login log, error log, communication log,
FTP log, Web log, e-mail log, SNTP log,
DHCP log, Modbus status log, 
operation log (/AS1 option), 
and change settings log (/AS1 option)

ALARM
SUMMARY

MESSAGE
SUMMARY

MEMORY
SUMMARY

MODBUS
MASTER
MODBUS
CLIENT

GROUP 1

DISP/ENTER key and arrow keys
Sec. 4.2

Sec. 4.2

Sec. 4.2

Sec. 4.5

To display, see section 5.18.Not displayed with the default settings.

Appears when the annunciator function is being used.

Display selection menu
Sub menu

Sec. 4.6 Sec. 4.7 Sec. 4.8

REPORT DATA

COLUMN BAR

RELAY
Sec. 4.5

Sec. 4.10

Sec. 4.5

EVENT SWITCH

Sec. 4.5

Sec. 4.4

CUSTOM
DISPLAY

IM04L41B01-04E

Annunciator
Sec. 3.12

Sec. 4.3

Sec. 4.9

About tag display
Long tags may not fit into their display areas.
When this is the case, they are displayed as follows:
• After the screen is displayed, the tag automatically 

scrolls through the display area once.
• Press ESC to scroll the tag through the display 

area again.

Chapter 4 Switching Operation Screens
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Operations Using Other Keys

   

Favorite key (see section 5.16)FUNC key (see below)

Soft keys (see below)

USER key (see section 7.1)
START and STOP keys (see section 6.4)

Operation Using the FUNC Key
 Press FUNC to display the FUNC key menu at the bottom of the screen. Press the 

Next soft key to switch the menu. Press the desired soft key.

   

FUNC key menu
Press the desired soft key.

Next soft key

4.1  Operations in Operation Mode
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Menu Item Refer to
Alarm ACK Section 3.8
Alarm DispRST Section 3.12
Message Section 5.4
Free message Section 5.4
Media eject Sections 6.4 and 2.12
Snap shot Section 6.6
Manual sample Section 6.5
Trigger Section 6.4
Save display Section 6.4
Save event Section 6.4
Save stop Section 4.8
Math start/stop Section 9.4
Math reset Section 9.4
Math ACK Section 9.4
Edge Switch Section 7.1
Timer reset Section 7.1
Match T Reset Section 7.1
Keylock Section 8.1
Logout Section 8.3
Locked ACK IM04L41B01-05EN
Password change Section 8.3
Normal speed/Second speed Section 5.3
Batch Section 6.3
Text field Section 6.3
Builder IM04L41B01-04E
Favorite regist Section 5.15
Four panel display Section 4.10
Standard display Section 5.14
System info Section 2.5
Network info Section 2.5
SNTP IM04L41B01-17E
E-Mail start/stop IM04L41B01-17E
E-Mail test IM04L41B01-17E
FTP test IM04L41B01-17E

Customizing the Menus
 The display selection menu that appears when the DISP/ENTER key is pressed and 

the FUNC key menu that appears when the FUNC key is pressed can be changed.
 See section 5.18

4.1  Operations in Operation Mode
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4.2 Displaying the Measured Data as Waveforms, 
Values, or Bar Graphs 

This section explains how to use the trend, digital, and bar graph displays.
For a description of the function, see section 1.3.

Procedure

• Showing the Display
1. Press DISP/ENTER to show the display selection menu.
2. Press the arrow keys to select TREND, DIGITAL, or BAR, and press DISP/

ENTER.
The selected display appears.

• Changing the Displayed Contents
1. Press DISP/ENTER to show the display selection menu.
2. Press the right arrow key to display the sub menu.
3. Press the up and down arrow keys to select the sub menu item.

TREND SPACE ON: Inserts a space at the right edge (horizontal display)
or the top edge (vertical display) in the waveform 
display area

TREND SPACE OFF: Does not insert a space

Group name: Displays the group

ALL CHANNEL: Displays the waveforms of all channels
GROUP CHANNEL: Displays the waveforms of the

channels registered to groups

AUTO ZONE ON: Displays trend waveforms
separately by assigning each
channel in the group to separate
display areas (zones)

AUTO ZONE OFF: Does not display waveforms in zones
SCALE ON: Displays the scale
SCALE OFF: Clears the scale

FINE GRID ON: Displays the fine grid
FINE GRID OFF: Clears the fine grid

TAG DETAIL ON: When a tag does not fit into the typical tag display 
space, the alarm and measured values are covered 
so that the tag can be displayed completely.

TAG DETAIL OFF: Priority is not given to tag display.

DIGITAL OFF: Clears the numeric display section
DIGITAL ON: Displays the numeric display section

MESSAGE DISP1: Displays the messages using display method 1
MESSAGE DISP2: Displays the messages using display method 2

Trend display sub menu

(Not displayed with the default settings. To display, see section 5.18.)
AUTO SCROLL ON: Automatically switches the

displayed groups
AUTO SCROLL OFF: Does not automatically switch

the displayed groups



Sw
itching O

peration Screens

4-5IM 04L42B01-01E

1

2

3

4

5

6

7

8

9

10

11

12

13

App

Index

     

Digital display sub menu

AUTO SCROLL ON: Automatically switches the
displayed groups

AUTO SCROLL OFF: Does not automatically switch
the displayed groups

Group name: Displays the group

TAG DETAIL ON: When a tag does not fit into
the typical tag display space,
the alarm and measured values
are covered so that the tag can
be displayed completely.

TAG DETAIL OFF: Priority is not given to tag display.

     

Bar graph display submenu

Group name: Displays the group

AUTO SCROLL ON: Automatically switches the
displayed groups

AUTO SCROLL OFF: Does not automatically switch
the displayed groups

TAG DETAIL ON: When a tag does not fit into
the typical tag display space,
the alarm and measured values
are covered so that the tag can
be displayed completely.

TAG DETAIL OFF: Priority is not given to tag display.

4. Press DISP/ENTER to change the displayed contents.
To close the menu without changing the displayed contents, press the ESC key.

• Starting the Waveform Display of the Trend Display/Stopping the 
Waveform Updating

 Press START to start the waveform display of the trend display. Press STOP to stop 
the waveform updating.

• Writing Messages
 See section 5.4.

• Switching the Displayed Group Using Arrow Keys
 Press the right arrow key to switch the displayed group in ascending order. Press the 

left arrow key to switch the displayed group in reverse.

• Switching the Trend, Digital, and Bar Graph Displays Using the Arrow 
Keys

 Press the down arrow key while showing the trend, digital, or bar graph display to 
switch the display in the order trend, digital, bar graph, trend, and so on. Press the up 
arrow key to switch the display in reverse order.

4.2  Displaying the Measured Data as Waveforms, Values, or Bar Graphs 
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Explanation

• ALL CHANNEL*/GROUP CHANNEL on the Trend Display
 In the group display, the waveforms of the channels that are registered to the group 

are displayed. In all channel display, the waveforms of all channels that are configured 
to record data are displayed on the current group display. The waveforms of channels 
that are not assigned to the group are displayed in the waveform display area, but the 
scales, current value marks, and digital values of the channels are not displayed.

* On a DX2010, DX2020, DX2030, DX2040, or DX2048 that is equipped with external input 
channels (/MC1 option), all channel display is not possible when the trend update rate is 30 
s/div or less.

• SCALE ON/OFF and DIGITAL ON/OFF on the Trend Display
 Select whether to show or hide the scale and numeric display sections.
• AUTO SCROLL ON/OFF
 The displayed groups can be automatically switched at a specified interval by 

selecting AUTO SCROLL ON. The display switches in ascending group order.
 For the procedure to set the auto scroll interval of groups, see section 5.14. 
• MESSAGE DISP 1 and MESSAGE DISP 2 on the Trend Display
 Switches the message display method.
• AUTO ZONE (Release number 3 or later)
 Displays trend waveforms separately by evenly dividing display areas (zones) among 

a group’s channels.
With AUTO ZONE OFF      With AUTO ZONE ON

 
Waveform display area 
is divided evenly.

• FINE GRID (Release number 3 or later)
 Display the fine grid when the normal grid is too wide for reading measured values. 

The fine grid can be used in the trend and historical trend displays. The fine grid 
places an additional four lines between the normal grid lines.

With FINE GRID OFF      With FINE GRID ON

 

Fine grid

4.2  Displaying the Measured Data as Waveforms, Values, or Bar Graphs 
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• TAG DETAIL ON/OFF (Release number 3 or later)
 When TAG DETAIL is set to ON and a tag does not fit into the typical tag display 

space, it covers the alarm and measured values so that it can be displayed 
completely. Depending on display space limitations, it may not be possible to display 
the entire tag. If the tag comment and number do not fit within a display area, they can 
be scrolled. The TAG DETAIL setting made in one display affects the settings in all of 
the other displays.

 The figure below shows an example for when ten channels are being displayed.
 When the Tag Number Is Not Displayed
 If TAG DETAIL is on, the tag comment is displayed as much as possible.

With TAG DETAIL OFF      With TAG DETAIL ON

Tag comment

 

Tag comment

Tag comment

 

Tag comment

Tag comment

 

Tag comment

4.2  Displaying the Measured Data as Waveforms, Values, or Bar Graphs 
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 When the Tag Number Is Displayed
 When TAG DETAIL is set to off, display priority is given to the tag number. If TAG 

DETAIL is on, the tag number and comment are displayed as much as possible. When 
there is enough space, the tag number and comment are displayed completely, even 
if TAG DETAIL is off.

With TAG DETAIL OFF      With TAG DETAIL ON

Tag no.

Tag comment

 

Tag no.

Tag comment

    

Tag no.

Tag comment

    

Tag no.

Tag comment

4.2  Displaying the Measured Data as Waveforms, Values, or Bar Graphs 
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• TREND SPACE ON/OFF
 With TREND SPACE ON

   

Space

4.2  Displaying the Measured Data as Waveforms, Values, or Bar Graphs 
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4.3 Displaying Past Measured Data (Historical 
Trend Display)

There are five methods to display the past measured data.
For a description of the function, see section 1.3.

Recall from the display selection menu (see this section).
Display from the alarm summary (see section 4.6).
Display from the message summary (see section 4.7).
Display from the memory summary (see section 4.8).
Show the measured data stored on an external storage medium (see section 6.8).

Procedure
• Showing the Display
 Carry out the procedure below while memory sampling is in progress.

1. Press DISP/ENTER to show the display selection menu.
2. Press the arrow keys to select TREND HISTORY, and press DISP/ENTER.

The display appears.

• Changing the Displayed Contents
1. Press DISP/ENTER to show the display selection menu.
2. Press the right arrow key to display the sub menu.
3. Press the up and down arrow keys to select the sub menu item.

  

Historical trend display sub menu

ALL CHANNEL: Displays the waveforms of all channels
GROUP CHANNEL: Displays the waveforms of the

channels registered to groups

Group name: Displays the group

AUTO ZONE ON: Displays trend waveforms separately by
assigning each channel in the group to
separate display areas (zones)

AUTO ZONE OFF: Does not display waveforms in zones
SCALE ON: Displays the scale
SCALE OFF: Clears the scale
FINE GRID ON: Displays the fine grid
FINE GRID OFF: Clears the fine grid
TAG DETAIL ON: When a tag does not fit into the typical

tag display space, the alarm and
measured values are covered so that the
tag can be displayed completely.

TAG DETAIL OFF: Priority is not given to tag display.
MESSAGE DISP2: Displays the messages using display

method 2
MESSAGE DISP1: Displays the messages using display

method 1
CURSOR VALUE: With display data, shows the maximum

data value at the cursor position. With
event data, shows the data at the cursor
position.

DIGITAL MAX/MIN: Displays the maximum and minimum
values at the cursor position and the
maximum and minimum values within
the displayed data in the digital value
display area

CURSOR TIME ON: Shows the time at the cursor position in
the top right of the display

CURSOR TIME OFF: Displays the date/time of the data at the
right edge of the screen

RELATIVE TIME: Displays the time that has elapsed since
memory start

ABSOLUTE TIME: Displays the time when data was
recorded
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Historical trend display sub menu

Switches to the specified display

Returns to the display that was shown before the historical trend

Displays the alarm summary in the loaded data file

Displays the message summary contained in the loaded data file

Displays information about the loaded data file

Displays the trend waveform and scale markers of the selected
channel in front of all the others. (List items like “ABC-1” are
tags.)

Adjusts the display span of the selected channel.
Select OFF to return to the original span. (List items like
“ABC-1”are tags.)

4.3  Displaying Past Measured Data (Historical Trend Display)
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Expands or reduces the time axis

  

Sub menu when the alarm summary is being displayed

Sub menu when the message summary is being displayed

INFORMATION: Shows information about the measured
 data that is currently displayed

For an explanation of the other menu items, see section 4.6.

INFORMATION: Shows information about the measured
 data that is currently displayed

For an explanation of the other menu items, see section 4.7.

4. Press DISP/ENTER to change the displayed contents.
To close the menu without changing the displayed contents, press the ESC key.

4.3  Displaying Past Measured Data (Historical Trend Display)
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• Moving the Cursor and Scrolling the Waveform

   

Cursor

Moves the cursor to the left by 1 dot.

Moves the cursor to the right by 1 dot.

Hold down an arrow key to move 
the cursor by 2 divisions.

Use the up and down arrow keys on the vertical trend display.

Cursor value mark

• Displaying the Continuing Data 
 Approximately one screen of data is shown on the historical trend display. The 

continuing data can be shown as follows:

  

Move the cursor to the end of the waveform and 
continue to press the arrow key to shift a half a page 
and display the continuing data (release number 3 or 
later).

Move the cursor to the end of the waveform and 
continue to press the arrow key to shift a half a page 
and display the continuing data (release number 3 or 
later).

Use the up and down arrow keys on the vertical trend display.

 Displayed

4.3  Displaying Past Measured Data (Historical Trend Display)
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• Specifying the Display Range
 Specify the display range. Items inside the parentheses are for the vertical trend display.

* When you clear the scale (see page 4-10), the screen switching icons appear in its place.

1. Press the up (right) arrow key.
The waveform of the entire data range is displayed at the top (right ) section of the screen.

     

All data display (all of the 
data in the display memory)
Loads as much of the 
continuous data as the display 
memory can hold and shows 
the data when switching to the 
all data display.

Displayed highlighted.
These icons are not displayed
if the scale is displayed.

Frame indicating the 
display range

2. Press the left and right (up and down) arrow keys to set the display position 
by moving the frame that indicates the display range. If you hold down one of the 
arrow keys, the frame that indicates the display range will move continuously in 
the direction of the arrow that you hold down.

3. Press the down (left) arrow key.
The specified range is displayed.

• If the Data Does Not Fit in the All Data Display (Release Number 2 or Later) 
 Specify the range to be displayed in the all data display.
 Below is the procedure to display data that is older than the data displayed currently. 

Items inside the parentheses are for the horizontal trend display.

1. Press the up (right) arrow key.
The waveform of all the data in the display memory is displayed at the top (right) of the 
screen. At the same time, the data area in the internal memory that can be loaded is 
displayed. In addition, the data position of 8 MB that is displayed in the all data display is 
indicated using a rectangular frame in the loadable data area.

Loadable data in the
internal memory
All data display
(all the display data in the 
display memory amounting 
to 8 MB)
A frame indicating the range
shown in the screen.
The green arrow indicates 
that loadable data exists in 
the arrow direction.
A frame indicating the 8 MB 
that is shown in the all data 
display.

2. Press the left (down) arrow key to move the frame indicating the display range 
to the edge of the all data display. If you press the left (down) arrow key again, 
the message “Overwrite old data?” appears.

3. Select Yes and press DISP/ENTER to replace 4 MB of data in the display 
memory.

4.3  Displaying Past Measured Data (Historical Trend Display)
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4. Press the left/right (up/down) arrow key to move the frame indicating the 
display range to specify the range you want to display.

5. Press the down (left) arrow key.
The specified range is displayed.

• Dividing the Screen into Halves and Displaying the Current Trend and 
Historical Trend Simultaneously

 This operation is possible only when the historical trend of the display data is being 
displayed. Items inside the parentheses are for the vertical trend display.
* This operation is not possible when the scale is displayed.

 Press the down (left) arrow key.
 The current trend is displayed in the right half (top half), and the historical trend is 

displayed in the left half (bottom half) of the screen.

   

Current trend

Historical trend

 To revert to the original screen, press the up (right) arrow key.

• Writing Add Messages
 For the operating procedure, see section 5.4.

4.3  Displaying Past Measured Data (Historical Trend Display)
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•  Displaying Measured Data from the Specified Date and Time (Release 
number 3 or later)

 You can search for measured data from the specified date and time and display the 
results. You can search the display data or event data in the DX internal memory.

1. Press DISP/ENTER to show the display selection menu.

2. Select DATA SEARCH using the arrow keys, and then press DISP/ENTER.
A calendar appears for the month of the data at the cursor position.

     

3. Use the arrow keys and the soft keys to change the date, and then press DISP/
ENTER.
If there is display data and event data at that date, a data type selection window appears.

     

Changes the displayed year

Changes the displayed month

Red square: Indicates the selected day
Use the up, down, left, and right arrow 
keys to move the red square and select 
a day.

D: Indicates that there is display data
E: Indicates that there is event data

  Searchable Range
You can search for data between the year 2000 and the year 2079.

  Appearance of “D” and “E”
 “D” appears when there is display data for the specified day and the DX is 

configured to record display data (see section 6.1 for details).
 “E” appears when there is event data for the specified day and the DX is configured 

to record event data (see section 6.1 for details).

4.3  Displaying Past Measured Data (Historical Trend Display)
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4. Select Display or Event, and press DISP/ENTER.
A search time input window appears.

     

5. Enter the time you want to search for, and press DISP/ENTER.
If there is data for the time that you specify, the data appears in the historical trend display.

     

 Display Example

     

 Display Conditions
• The cursor is located at the time that you specify for the search.
• All other display conditions are the same as those of the display before the search.
•  If there is no data at the date and time that you specify, data from a later time in the 

same day is displayed. If there is no such data, an error message appears.
•  If the display group that was being displayed before the search does not exist in the 

data that you have specified, the display group in the data with the lowest number 
is displayed.

4.3  Displaying Past Measured Data (Historical Trend Display)
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• You can configure the calendar so that weeks start with Sunday or Monday.
 Procedure
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to 

basic setting mode), and select the Menu tab > Time Settings > Calendar display 
> 1st weekday.

    

 You can set the first weekday (the day that appears on the far left side of the 
calendar) to SUN (Sunday) or MON (Monday).

• Signature (Only on DXs with the /AS1 advanced security option)
 See the Advanced Security Function (/AS1) User’s Manual, IM 04L41B01-05EN.

4.3  Displaying Past Measured Data (Historical Trend Display)
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Explanation

• ALL CHANNEL/GROUP CHANNEL
 In the group display, the waveforms of the channels that are registered to the group 

are displayed. In the all channel display, the waveforms of all channels that have 
been set to be recorded are displayed on the current group display. The waveforms 
of channels that are not registered to the group are displayed, without any additional 
information, in the waveform display area. 

   

The waveforms of all 
channels are displayed.

• AUTO ZONE
 Displays trend waveforms separately by assigning display areas (zones) to the set 

channels.
With AUTO ZONE OFF      With AUTO ZONE ON

 
Waveform display area 
is divided evenly.

• SCALE ON/OFF
 Select whether to display the scale. The current value mark of the scale indicates the 

value at the cursor position.
With SCALE ON      With SCALE OFF

Scale

Cursor position mark
 

Time axis

Time axis expansion/reduction rate

Screen switching icons

4.3  Displaying Past Measured Data (Historical Trend Display)
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●	 FINE GRID
With FINE GRID OFF      With FINE GRID ON

 

Fine grid

• TAG DETAIL
 When TAG DETAIL is set to ON and a tag does not fit into the typical tag display 

space, it covers the alarm and measured values so that it can be displayed completely. 
If the tag comment and number do not fit within a display area, they can be scrolled. 
The TAG DETAIL setting made in one display affects the settings in all of the other 
displays.

 The figure below shows an example for when six channels are being displayed.
 When the Tag Number Is Not Displayed
 If TAG DETAIL is on, the tag comment is displayed as much as possible.

With TAG DETAIL OFF      With TAG DETAIL ON

Tag comment

 

Tag comment

 When the Tag Number Is Displayed
 When TAG DETAIL is set to off, display priority is given to the tag number. If TAG 

DETAIL is on, the tag number and comment are displayed as much as possible.
With TAG DETAIL OFF      With TAG DETAIL ON

Tag no.

Tag comment

 

Tag no.

Tag comment

4.3  Displaying Past Measured Data (Historical Trend Display)
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• MESSAGE DISP 1, MESSAGE DISP 2
 Switch between message displays.

• CURSOR VALUE/DIGITAL MAX/MIN
 Switch between numeric displays.

With DIGITAL MAX/MIN      With CURSOR VALUE

The maximum and minimum measured 
values at the cursor position

The maximum and minimum waveform 
values in the current display  

Display data: Shows the maximum 
value at the cursor position

Event data: Shows the measured 
value at the cursor position

• CURSOR TIME
 With CURSOR TIME ON

   

The time at the 
cursor position

• ABSOLUTE TIME/RELATIVE TIME
With ABSOLUTE TIME      With RELATIVE TIME

The time when the data 
was recorded

 

The time that has elapsed 
since memory start

4.3  Displaying Past Measured Data (Historical Trend Display)
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• TOP CHANNEL (Release number 3 or later)
 The following example is for when the top channel is set to channel 8. The displayed 

scale marker and grid are those of the channel selected as the top channel.
 If you switch from the trend history display to another display, the top channel setting 

is cleared. Channels other than the top channel are displayed in their assigned order 
within their group.

   Channel 8

• AUTO SPAN (Release number 3 or later)
Before AUTO SPAN      Using AUTO SPAN for channel ABC-1

Channel ABC-1

 

Channel ABC-1

4.3  Displaying Past Measured Data (Historical Trend Display)
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• TIME AXIS > ZOOM+ and ZOOM-
The time axis can be expanded or reduced around the cursor position.
• Display data: 2 times the trend display to 1/60 minimum
• Event data: Reduction only, up to 1/60 minimum
 The minimum magnification and the factor by which the display can be expanded 

or reduced with one operation vary depending on the trend interval for the display 
data and on the sampling interval for the event data. To expand or reduce further, 
repeat the procedure.

With TIME AXIS ZOOM-      With TIME AXIS ZOOM+

 

4.3  Displaying Past Measured Data (Historical Trend Display)
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• INFORMATION (Information on the Displayed Measured Data)
 The following information is displayed.

Page switch mark
Use the left and right arrow 
keys to switch the page.

Display Description
File name Data in the internal memory is displayed as “Memory.” For a file 

on the external storage medium, the file name is displayed.
Data type Display corresponds to display data, and Event corresponds to 

event data.
Serial number The serial number of the DX that was used.
Batch number, Lot number Displayed when the file is created using the batch function.
Start time and End time The start time and end time of recording.
User name Name of the user who performed the operation. Displayed when 

the login function or /AS1 advanced security option was used.
Comment A comment (when the batch function is in use).
Text field A text field (when the batch function is in use).
Signature Signature data (when the /AS1 advanced security option is in 

use).

Note
When measured data on the external storage medium is displayed, the serial number 
corresponds to that of the DX that was used to save the data.

• Background Color of the Historical Trend
 You can change the background color of the historical trend.
 For the procedure to change the background color of the historical trend, see section 

5.13. 

4.3  Displaying Past Measured Data (Historical Trend Display)
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4.4 Display the Statuses of All Channels on One 
Screen (Overview Display)

This section explains how to use the overview display.
For a description of the function, see section 1.3.

Procedure

• Showing the Display
1. Press DISP/ENTER to show the display selection menu.
2. Press the arrow keys to select OVERVIEW, and press DISP/ENTER.

The display appears.

• Changing the Displayed Contents
1. Press DISP/ENTER to show the display selection menu.
2. Press the right arrow key to display the sub menu.
3. Press the up and down arrow keys to select the sub menu item.

     

TAG DETAIL ON: When a tag does not fit into the
typical tag display space, the
alarm and measured values are
covered so that the tag can be
displayed completely.

TAG DETAIL OFF: Priority is not given to tag display.
(Appears when Tag Number is set to Use. See section 5.2 for details.)

JUMP TO TREND: Switches to the trend display of
the smallest group number that
includes the channel selected
with the cursor.

JUMP TO DIGITAL: Switches to the digital display of
the smallest group number that
includes the channel selected
with the cursor.

JUMP TO BAR: Switches to the bar graph display
of the smallest group number that
includes the channel selected
with the cursor.

JUMP TO ALM SUM: Switches to the alarm summary

CURSOR OFF: Clears the cursor
CURSOR ON: Displays the cursor

(Not displayed with the default settings. To display, see section 5.18)

Overview display sub menu

4. Press DISP/ENTER to change the displayed contents.
To close the menu without changing the displayed contents, press the ESC key.

• Showing the Trend, Digital, Bar Graph Display Containing the Specified 
Channel
1. Press the arrow keys to move the cursor, and select a channel.

     
Cursor (white Frame)

2. Switch to the trend, digital, or bar graph display according to the procedure 
described in “Changing the Displayed Contents.”
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• Individual Alarm ACK Operation (Only on DXs with the /AS1 advanced 
security option)

 You can perform alarm ACK on individual alarms. This operation is referred to as 
“individual alarm ACK.” Individual alarm ACK can be performed when the settings are 
configured in the exact manner described below.
• Basic setting > Indicator is set to Hold.
 For the setting procedure, see section 3.5.
• Relay > Relay Action on Ack is set to Reset.
 For the setting procedure, see section 3.5 in the DX2000 User’s Manual.
• Annunciator Mode is set to Off.
 For the setting procedure, see section 3.12 in the DX2000 User’s Manual.

1. Use the arrow keys to move the cursor to a channel with active alarms.

2. Press DISP/ENTER to show the display selection menu.

3. Press the right arrow key to display the submenu.

4. Use the arrow keys to select an alarm, and press DISP/ENTER.
 The alarm output is released.

     

Select a channel with 
active alarms.

Select the alarm that you 
want to acknowledge.

4.4  Display the Statuses of All Channels on One Screen (Overview Display)
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• TAG DETAIL
 The same as the TAG DETAIL setting in other displays.
 The following example is for the DX2048 OVERVIEW display.
 When the Tag Number Is Not Displayed (the TAG DETAIL does not appear)
 Tag comments are displayed.

   

Tag comment

 When the Tag Number Is Displayed
 When TAG DETAIL is set to off, display priority is given to the tag number. If TAG 

DETAIL is on, the tag number and comment are displayed as much as possible.
With TAG DETAIL OFF      With TAG DETAIL ON

Tag no.

 

Tag no.

Tag comment

4.4  Display the Statuses of All Channels on One Screen (Overview Display)
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4.5 Displaying Various Information

This section explains how to display reports (/M1 and /PM1 options) and how to use the 
status display.
For a description of the function, see section 1.3.

Procedure
• Showing the Display

1. Press DISP/ENTER to show the display selection menu.
2. Press the up and down arrow keys to select INFORMATION.
3. Press the right arrow key to display the sub menu.
4. Press the up and down arrow keys to select the sub menu item.

To close the menu without changing the displayed contents, press the ESC key.

     

Information display submenu

MODBUS CLIENT: Displays the Modbus
client status

MODBUS MASTER: Displays the Modbus master
status

RELAY: Displays the relay status

REPORT DATA: Displays report data

ALARM SUMMARY: Displays an alarm summary
See section 4.6.

(Not displayed with the default settings. To display, see section 5.18.)

MESSAGE SUMMARY: Displays a message summary
See section 4.7.

MEMORY SUMMARY: Displays a memory summary
See section 4.8.

EVENT SWITCH: Displays the status of the
event level switches

COLUMN BAR: Displays report data using
stacked bar graphs

5. Press DISP/ENTER.
The display appears.

• Displaying the Report
 • Switching the Displayed Report Data

 The Index item on the report display shows “the number of the report data being 
displayed/the number of report data saved in the internal memory.” The largest 
report data number corresponds to the most recent report data.

    

Number of the report data being displayed
Number of report data saved to the internal memory



Sw
itching O

peration Screens

4-29IM 04L42B01-01E

1

2

3

4

5

6

7

8

9

10

11

12

13

App

Index

 Carry out the procedure below to switch the displayed report data.
 Up arrow key: Report data being displayed + 1.
 Down arrow key: Report data being displayed – 1.
 Left arrow key: Report data being displayed + 10.
 Right arrow key: Report data being displayed – 10.

Note
The display is not updated even if a new report is created while displaying the report data. 
Perform either of the operations below to display the most recent report data.
• Hold down the left arrow key until the latest report data is displayed.
• Press DISP/ENTER and display the report data again from the display selection menu.

• Switching the Report Channels
 Up to 30 report channels can be shown on one screen. If there are more than 30 

report channels, you can switch the displayed report channels.

1. Press DISP/ENTER to show the display selection menu.

2. Press the right arrow key to display the sub menu.

3. Press the up and down arrow keys to select CHANGE REPORT CH.

4. Press DISP/ENTER.
The displayed report channels are switched.

• Relay Status Display
Lists the statuses of the alarm output relays and internal switches. You cannot change 
the settings on this display.

   

Red: ON
Green: OFF

• Modbus Status Display
 Lists the statuses of the Modbus client or Modbus master commands.
 For the operating procedure, see the Communication Interface User’s Manual, 

IM04L41B01-17E.

   

Communication conditions

Status
Command

Communication destination
DX channels

4.5  Displaying Various Information
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• Event Level Switch Status Display (Release number 3 or later)
 Displays the status of the event level switches. You cannot perform operations in this 

display.

   

 Red:   On
 Green:  Off

4.5  Displaying Various Information
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4.6 Using the Alarm Summary

This section explains how to use the alarm summary.
For a description of the function, see section 1.3.

Procedure

• Changing the Displayed Contents
1. Press DISP/ENTER to show the display selection menu.

2. Press the right arrow key to display the sub menu.

3. Press the up and down arrow keys to select the sub menu item.

     

Sort symbol
  Ascending sort
  Descending sort

ASCENDING ORDER: Sorts in ascending order
DESCENDING ORDER: Sorts in descending order

CHANGE SORT KEY:  Sorts alarm information by
 channel or alarm time

TO HISTORY (DISP): Switches to the display data
historical trend display

TO HISTORY (EV): Switches to the event data
historical trend display

Display name: Switches to the specified display

TO OVERVIEW: Switches to the overview display

TAG DETAIL ON: When a tag does not fit into the
typical tag display space, the
alarm and measured values are
covered so that the tag can be
displayed completely.

TAG DETAIL OFF: Priority is not given to tag display.

4. Press DISP/ENTER to change the displayed contents.
To close the menu without changing the displayed contents, press the ESC key.

• Moving the Cursor ( ) and Scrolling the Alarms

   

Scrolls the alarm information up by half a page
Moves the cursor up

Scrolls the alarm information down by half a page

Moves the cursor down

• Recalling the Historical Trend Display at the Point When the Alarm 
Occurred
1. Select an alarm with the cursor.

2. Display the historical trend according to the procedure described in “Changing the 
Displayed Contents.”

Explanation

• CHANGE SORT KEY, ASCENDING ORDER, and DESCENDING ORDER
The alarms are sorted in ascending or descending order by the following keys. The 
sort symbol is displayed next the sort item (see the figure above).
• Channel number: Sorts the alarms by channel number even if tags are being 

used. Alarms in a channel are sorted by the alarm level number.
• Time of alarm occurrence/release



4-32 IM 04L42B01-01E

• TAG DETAIL
 The same as the TAG DETAIL setting in other displays.
 When the Tag Number Is Not Displayed
 Tag comments are displayed in their entirety.

   

Tag comment

 When the Tag Number Is Displayed
 Tag numbers and comments are displayed.

   

Tag no.

Tag comment

4.6  Using the Alarm Summary
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4.7 Using the Message Summary

This section explains how to use the message summary.
For a description of the function, see section 1.3.

Procedure

• Changing the Displayed Contents
1. Press DISP/ENTER to show the display selection menu.
2. Press the right arrow key to display the sub menu.
3. Press the up and down arrow keys to select the sub menu item.

     

Sort symbol
    Ascending sort
    Descending sort

CHANGE DISP ITEM: Switches between displaying
   message times and groups
   and displaying the message
   user names

ASCENDING ORDER: Sorts in ascending order
DESCENDING ORDER: Sorts in descending order

CHANGE SORT KEY: Sorts messages by message
   number, time, group, or user
   name

TO HISTORY (DISP): Switches to the display data
   historical trend display

Display name:

TO HISTORY (EV): Switches to the event data
   historical trend display

Switches to the specified display

4. Press DISP/ENTER to change the displayed contents.
To close the menu without changing the displayed contents, press the ESC key.

• Moving the Cursor ( ) and Scrolling the Messages

   

Scrolls the messages up by half a page
Moves the cursor up

Scrolls the messages down by half a page

Moves the cursor down

• Recalling the Historical Trend Display at the Point When the Message 
Was Written
1. Select a message with the cursor.

2. Display the historical trend according to the procedure described in “Changing the 
Displayed Contents.”

Explanation

• CHANGE DISP ITEM
Switches between the following two message display methods.
• Message, time, and group
• Message, user name

• CHANGE SORT KEY, ASCENDING ORDER, and DESCENDING ORDER
The messages are sorted in ascending or descending order by the respective key. 
The sort symbol is displayed next the sort item (see the figure above).
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4.8 Using the Memory Summary

This section explains how to use the memory summary.
For a description of the function, see section 1.3.

Procedure

• Changing the Displayed Contents
1. Press DISP/ENTER to show the display selection menu.

2. Press the right arrow key to display the sub menu.

3. Press the up and down arrow keys to select the sub menu item.

The displayed data type is
indicated with a green mark.

REPORT SAVE: Saves all report data

M.SAMPLE SAVE: Saves all manually sampled data

SELECT SAVE: Saves the selected file

DATA SAVE MODE: Switches to data save mode

ALL SAVE: Saves all data

(Not displayed with the default settings. To display, see section 5.18.)

FILENAME DISPLAY: Displays the file name
  For information about file names, see section 1.4.
TIME DISPLAY: Displays the times of the first

and last items of data in the file

TO HISTORY: Switches to the historical trend
display

Display name: Switches to the specified
display

CHANGE DATA KIND: Switches between display
data and event data

4. Press DISP/ENTER to change the displayed contents.
To close the menu without changing the displayed contents, press the ESC key.

• Moving the Cursor ( ) and Scrolling the Memory Information

   

Scrolls the memory information up by half a page
Moves the cursor up

Scrolls the memory information down by half a page

Moves the cursor down

• Displaying the Historical Trend for the Data Specified by Memory 
Summary
1. Select the data with the cursor.

2. Display the historical trend according to the procedure described in “Changing the 
Displayed Contents.”
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• Saving the Data
 Save the data in the internal memory to the CF card or the USB flash memory (/USB1 

option). 
 For a description of the function, see section 1.4.

1. Press DISP/ENTER to show the display selection menu.

2. Press the right arrow key to display the submenu.

3. Select DATA SAVE MODE with the up and down arrow keys.

4. Press DISP/ENTER.
The display switches to DATA SAVE MODE.

5. To save a specified file, select it with the cursor. This operation is not necessary in 
other cases.

     

Cursor
(move with the arrow keys)

6. Press DISP/ENTER to show the display selection menu.

     

7. Use the up and down arrow keys to select SELECT SAVE, ALL SAVE, M. 
SAMPLE SAVE, or REPORT SAVE.

8. Press DISP/ENTER.
* If you are using a CF card and a USB flash memory (/USB1 option), the message “Which 

media do you want save to?” appears. Select the destination medium using the arrow 
keys, and press DISP/ENTER.
The measured data is saved.

Note
To abort the data saving operation in progress, carry out the procedure below.
Press FUNC and press the Save Stop soft key.

4.8  Using the Memory Summary
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 Progress Display When Saving All Data of the Internal Memory (Release Number 
2 or Later) 
If you carry out All Save* on the memory summary screen, a pop-up window appears
showing the progress of the save operation.

* Function for saving all data in the internal memory to a CF card or USB flash memory.

     

Note
• The pop-up window appears only when the memory summary display is showing.
• If you press the ESC key, the pop-up window clears temporarily and reappears 

approximately 10 seconds later.
• The time estimate for saving all data is indicated in the table below (when the memory is full 

of data). It may take longer depending on the operating conditions of the DX.
Save Destination

 
Time to Save All Data 

(Estimate)
CF Card USB Flash Memory

Standard memory (internal memory size suffix code 
-3) 

20 minutes 40 minutes

* Values for the DXs with firmware version 2.02 or later. Values inside the parentheses are 
for the DXs with firmware version 2.01 or earlier.

• To abort the data saving operation in progress, carry out the procedure below.
 Press FUNC and press the Save Stop soft key.

• Displaying File Information (Only on DXs with the /AS1 advanced 
security option)

 See the Advanced Security Function (/AS1) User’s Manual, IM 04L41B01-05EN.

4.8  Using the Memory Summary
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Explanation

• Save directory
• The data is saved by creating a directory each time the save operation is carried out.
 Directory name: Specified string_YYMMDD_HHMMSS (where YY to SS is the date 

of operation)

    

Save directory

File list example

• Display data or event data that is in the process of adding data cannot be saved.
• The save operation explained here merely copies the data in the internal memory. 

It does not save the unsaved data in the internal memory (see page 1-33).
• Data saving is aborted when there is insufficient free space on the storage medium. 

Use a storage medium with sufficient free space when saving data.

4.8  Using the Memory Summary
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4.9 Displaying a List of Operation Logs

Displays the following operation logs.
Login log*1, error log, communication log, FTP log, Web log, e-mail log, SNTP log, DHCP 
log, Modbus status log, operation log*2, and change settings log*2

*1 Only on DXs without the /AS1 advanced security option
*2 Only on DXs with the /AS1 advanced security option

Procedure

• Displaying the Log
1. Press DISP/ENTER to show the display selection menu.

2. Press the up and down arrow keys to select LOG.
* To show LOG on the menu, see section 5.18.

3. Press the right arrow key to display the sub menu.

4. Press the up and down arrow keys to select the sub menu item.
To close the menu without changing the displayed contents, press the ESC key.
Sub menu items are LOGIN, ERROR, COMMUNICATION, FTP, MAIL, WEB, SNTP, 
DHCP, and MODBUS.

5. Press DISP/ENTER.
The display appears.

Explanation

• Login Log
 This log is only for DXs without the /AS1 advanced security option. DXs with the /AS1 

advanced security option use the operation log.

   

The log number of the last line and the 
total number of logs

User name
Operation method (see the table below)
Operation (see the table below)
Date/time

Action Description
Login Login
Logout Logout
NewTime Time change while memory is stopped
TimeChg Time change through key operation
PowerOff Power OFF (power failure occurred)
PowerOn Power ON (recovered from a power failure)
TrevStart Start the operation of gradually adjusting the time
TRevEnd End the operation of gradually adjusting the time
TimeDST Switch the daylight savings time
SNTPtimset Time change by SNTP
TimeDST Switch to or out of daylight saving time
CCSetEnd Completion of calibration correction
CCExpire Passing of the calibration due date without calibration having been completed
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Factor Description
KEY Key operation
COM Operations via communication
REM Operation through the remote control function
ACT Operation through event action
SYS Operation by the system

• Error Log

   

Error message*
Error code*
Date/time

* See section 11.1, “A List of Messages.”

• Communication Log

   Message*
Input/output symbol (>: input, <: output)
User name
User ID number (0: serial, 1 to 3: Ethernet)
Date/time

* See the Communication Interface User’s Manual, IM04L41B01-17E.

• FTP Log

   File Name
FTP connection destination 
(P: primary, S: secondary)
Error message (detail code)*
Date/time

* See section 11.1, “A List of Messages.”

4.9  Displaying a List of Operation Logs
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• Web Log

   
Operation (see the table on the next page)
Error code*
Requested operation (see the table below)
Date/time

* See section 11.1, “A List of Messages.”

Request Description
Screen Screen switch
Key Key operation
Message Message assignment/write

Parameter Description
TREND Trend display
DIGIT Digital display
BAR Bar graph display
HIST Historical trend display
OV Overview display
DISP DISP/ENTER key
UP Up arrow key
DOWN Down arrow key
LEFT Left arrow key
RIGHT Right arrow key
FAVOR Favorite Key
Messages Character strings that are written.
Data Ref Searches for data from a specific date and time and displays the data 

in the historical trend display.

• E-mail Log

   Recipient (mail address, message)
Recipient (1: recipient 1, 2: recipient 2)
Error code*
Event (see the table below)
Date/time

* See section 11.1, “A List of Messages.”

Type Description
Alarm Alarm mail
Time Scheduled mail
Report Report timeout mail
Fail Power failure recovery mail
Full Memory full mail
Test Test mail
Error Error message mail
User locked Invalid user mail (only on DXs with the /AS1 advanced security option)

4.9  Displaying a List of Operation Logs
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• SNTP Log

   
Error message (detail code)*
Error code*
Date/time

* See section 11.1, “A List of Messages.”

• DHCP Log

   

Error message (detail code)*
Error code*
Date/time

* See section 11.1, “A List of Messages.”

• Modbus Status Log

   
Command number, command type
(R: read, W: write)
Communication status*
Communication type (C: client, M: master)
Date/time

* See the Communication Interface User’s Manual, IM04L41B01-17E.

4.9  Displaying a List of Operation Logs
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• Operation Log (Only on DXs with the /AS1 advanced security option)

  

To switch displays, in the display 
selection menu, select LOG > 
CHANGE DISP ITEM, and press 
DISP/ENTER.

Operation type*
User name
Operation*
Date and time

Detailed display

Additional information display
When you move the cursor to an 
item that has additional informa-
tion, the Add.info. soft key 
appears at the bottom of the 
screen. Press the soft key to 
display the additional information. 
The additional information is 
displayed using the command 
syntax.
See the Communication Manual, 
IM04L41B01-17E.

Press ESC to close the additional 
information display.

Cursor (blue arrow)
Move the cursor with the arrow
keys.

* See the Advanced Security Function (/AS1) User’s Manual, IM 04L41B01-05EN.

• Change Settings Log (Only on DXs with the /AS1 advanced security 
option)

   

Operation type (see the table below)
User name
Saved setup file name
Date and time

Operation type Description
K Key operations
C Communication operations

4.9  Displaying a List of Operation Logs
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4.10 Showing the Four Panel Display

This section explains how to use the four panel display.
For a description of the function, see section 1.3.

Procedure

• Showing the Display
1. Press DISP/ENTER to show the display selection menu.

2. Press the arrow keys to select 4 PANEL. Then, select the desired four panel 
name, and press DISP/ENTER.
The display appears.

• Switching the Display
 Press the right arrow key to change the display in the order “four panel 1,” “four 

panel 2,” “four panel 3,” “four panel 4,” “four panel 1,” and so on. Press the left arrow 
key to switch the display in reverse order.

• Changing the Displays Assigned to the Four Panel Display
 Carry out the procedure below on the four panel display.

1. Press DISP/ENTER.
The title bar of one of the four panels turns dark blue.

2. Select the panel you wish to change the display using the arrow keys (the panel 
of which the title bar is dark blue is the selected panel).

     
The title section of the 
selected quadrant 
displayed in dark blue.

3. Press DISP/ENTER to show the display selection menu.

4. Press the arrow keys to select the display to be assigned.

5. Press DISP/ENTER to assign the specified display to the selected panel.
To close the menu without assigning the display, press ESC.

• Registering the Four Panel Display with a New Combination of Screens
 Operate as described in “Changing the Name of the Four Panel Display” on next 

page. 
* If you switch to other screens and return to the four panel display without registering the 

display, the new combination of four panels returns to the original. 

Note
• When the four panel display is showing, screens that you cannot assign to the four panel 

display (LOG, TREND HISTORY, and CUSTOM) do not appear in the menu.

• When the DX is showing the four panel display, you cannot switch between TAG DETAIL 
ON and TAG DETAIL OFF. Tags are displayed with the same setting as was specified prior 
to switching to the four panel display.
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• Expanding One of the Panels to Full Screen
1. Press DISP/ENTER.

The title bar of one of the panels turns dark blue.

2. Select the panel you wish to expand using the arrow keys (the panel of which the 
title bar is dark blue is the selected panel).

3. Press DISP/ENTER to show the display selection menu.
4. Press the right arrow key to show the sub menu.
5. Press the up and down arrow keys to select EXPAND.

* To show EXPAND on the screen menu, see section 5.18.

     

Select EXPAND

This EXPAND is not shown under the initial conditions. To show, operate as follows:
Press MENU and select Menu customize > Display menu. Set EXPAND on the 
display menu to View.
For the operating procedure, see section 5.18.

6. Press DISP/ENTER to expand the specified panel.
To close the menu without expanding the screen, press ESC.

• Changing the Name of the Four Panel Display
 If you change the name of a four panel display, the specified name appears in the 

display menu.
 Carry out the following procedure when the four panel display is shown.

1. Press FUNC to display the FUNC key menu.
2. Press the 4Panel soft key to display a list of four panel names.

     

3. Press any of the 4Panel 1 to 4panel 4 soft keys to display a window used to enter 
the display name.

4. Enter the display name (up to 16 characters, A a # 1 )
5. Press DISP/ENTER to activate the specified display name and return to the four 

panel display.
To cancel the change, press ESC.

4.10  Showing the Four Panel Display
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4.11 Displaying Stacked Bar Graphs (/M1 and /PM1 
options; release number 3 or later)

This section explains how to use stacked bar graphs.

Procedure

• Changing the Displayed Contents
1. Press DISP/ENTER to show the display selection menu.

2. Press the right arrow key to display the submenu.

3. Press the up and down arrow keys to select the sub menu item.

REPORT GROUP 1 through 6*: Select the report group that you
    want to display.
* Varies according to the model.
 For information about report groups, see section 9.5.

SELECT GROUP: Use the arrow keys to switch
  between displayed report groups.

SELECT COLUMN: Use the arrow keys to select a bar
  graph.

SINGLE GRAPH: Displays a single graph
DUAL GRAPH: Displays two graphs

Display name:  Switches to the specified display

4. Press DISP/ENTER to change the display setting.
To close the menu without changing the display contents, press ESC.

• Changing Groups, Selecting Bar Graphs, and Moving the Cursor
 The amount of data that the up and down arrow keys scroll through depends on the 

type of report data. For example, with an “H+D” report, you can use the arrows to 
scroll through the data one day at a time.

   

SELECT GROUP: Switches to the display for the report group with
  the next smallest number
SELECT COLUMN: Moves the bar graph selection cursor to the left

Switches to the previous day, week, or month’s data

SELECT GROUP: Switches to the display for the report group with
  the next highest number
SELECT COLUMN: Moves the bar graph selection cursor to the right

Switches to the next day, week, or month’s data
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Explanation

• SINGLE GRAPH/DUAL GRAPH
 You can display one or two bar graphs. The sums of the first channel in a group and of 

all other channels that have the same unit as it are displayed.
• SINGLE GRAPH

    

Numeric
display
section

Display area 1 Display area 2

 The displayed report data varies depending on the report kind, which is set using 
the report function.

Report kind Display Area 1 Display Area 2
Hourly, H+D Sums for each hour Sums for the day
Day+Week Sums for each day Sums for the week
Daily, D+M Sums for each day Sums for the month

Note
In 4-panel display, the numeric display section only contains channel numbers or tags.

• DUAL GRAPH
 Shows the data from two consecutive periods at the top and bottom of the display.

    

Channel number or tag
Numbers are abbreviated.

Display area 2

Display area 4

Display area 1

Display area 3

 The displayed report data varies depending on the report kind, which is set using 
the report function. Display areas 1 and 2 contain the same report data listed above 
for SINGLE GRAPH display.

4.11  Displaying Stacked Bar Graphs (/M1 and /PM1 options; release number 3 or later)
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Report kind Display Area 1 Display Area 2 Display Area 3 Display Area 4
Hour, H+D Sums for each 

hour
Sums for the 
day

Sums for each 
hour

Sums for the 
day

(The data of the day before the 
data in display areas 1 and 2)

Day+Week Sums for each 
day

Sums for the 
week

Sums for each 
day

Sums for the 
week

(The data of the week before the 
data in display areas 1 and 2)

Day, D+M Sums for each 
day

Sums for the 
month

Sums for each 
day

Sums for the 
month

(The data of the month before the 
data in display areas 1 and 2)

Note
The numbers on the vertical axis of display areas 3 and 4 and the dates on the horizontal axis 
are abbreviated.
Display areas 3 and 4 can only display the data from the period immediately preceding that of 
display areas 1 and 2.

• Selecting a Bar
 When SINGLE GRAPH is selected, you can move the cursor to a bar that you want to 

check, and view the sums of each channel.

   

The sums of each channel 
and the sums of all channels 
of the report group at the 
cursor position

Cursor

4.11  Displaying Stacked Bar Graphs (/M1 and /PM1 options; release number 3 or later)
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• Power Failure and Time Adjustment Indications

   

Indicates a power failure
A “C” appears if more than one
report has been filed for the
same time period.

• Power failure
 A “P” indicates when a power failure occurred and a report was supposed to be 

filed. A “P” also indicates when the DX recovered from a power failure and the next 
report was filed.

• Time adjustment
 When a time adjustment causes a report to be filed twice because the time was 

moved back, the time adjustment is marked with a “C,” and the bar graph of the 
report that was filed first is used.

 If the data for a period does not exist because of a power failure or time adjustment, a 
bar graph for the period will not be displayed.

4.11  Displaying Stacked Bar Graphs (/M1 and /PM1 options; release number 3 or later)
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5.1 Setting Display Groups

Assign channels and set the group name for each display group. Set lines at specified 
positions in the waveform display range on the Trend display.

Setup Screen
 Press MENU (to switch to setting mode), and select the Menu tab > Group set, Trip 

line.

   

Setup Items

• Group number
 Select the target group number (1 to 36).

• Group set
 • On/Off

 Turn On the groups you want to use.
 • Group name

 Set the group name. (up to 16 characters, A a # 1 )
 • CH set

 Set up to 10 channels from measurement channels, computation channels (/M1 
and /PM1 options), and external input channels (/MC1 option).
• Enter the channel number using two or three digits.
• Separate each channel with a period.
• To specify a range of consecutive channels numbers, use a hyphen.
 Example: To assign channels 1 and 5 to 8, enter “001.005-008.”

Note
• The trend, digital, and bar graph displays are shown in the specified order.
• A channel can be assigned to multiple groups.
• The same channel cannot be assigned multiple times in a group.

Chapter 5 Operations for Changing the Displayed Contents
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Note
The channel settings of a display group can be copied to another group on a DX with release 
number 2 or later.

    

 Procedure
1. Select the copy source channel settings.
2. Press the Copy soft key.
3. Select the copy destination channel settings.
4. Press the Paste soft key. The channel settings are copied.

• Trip line
 Set lines at specified positions in the waveform display range on the Trend display.
 • On/Off

 Turn On the trip lines you want to display.
 • Position

 Set the position in the range of 0 to 100% of the display width.
 • Color

 The default colors are red, green, blue, and yellow. If you want to change the color, 
select from the 24 available colors.

 • Line width
 Set the line width of the trip line in dots (1 to 3).

5.1  Setting Display Groups
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5.2 Displaying Tags or Channel Numbers

Display the channels using tags or channel numbers. On DX release numbers 3 and 
later, tags have tag numbers and tag comments. The tag number is a fixed number that 
corresponds to the measurement source. The tag comment can be used to list details 
about the channel. You can choose whether or not to use tag numbers.

Setup Screen

• Tag/Channel
  Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Environment tab > Operating environment.

   

• Tag Number Use/Not (Release number 3 or later)
  Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Environment tab > View, Message, Input, Tag.
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• Tag
 Press MENU (to switch to setting mode), and select the Menu tab > Meas channel > 

Tag, Memory sample, Alarm delay.

   

5.2  Displaying Tags or Channel Numbers
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Setup Items

• Operating environment > Tag/Channel
 This setting applies to all channels.

Setting Description
Tag  Displays tag numbers and comments.
 •  If an allotted display space is not large enough to display a tag number and a tag 

comment, priority is given to the tag number.
 •  Depending on display space limitations, it may not be possible to display the 

entire tag.
 •  If a channel is not configured to display tag numbers or comments, the channel 

number is displayed.

Channel Displays channel numbers.
* Tag numbers are available for release numbers 3 and later.

•  Tag Basic settings > Tag No. Use/Not (Release number 3 or later)
 To display tag numbers, select “Use.” This setting applies to all channels.

• First-CH/Last-CH
 Set the target channels. The target channels are common with the other items that are 

displayed on the screen.

• Tag > Comment
 Sets the tag comment. On a DX with a release number of 3 or later, you can enter up 

to 32 characters. On a DX with a release number of 2 or earlier, you can enter up to 
16 characters. The characters that can be entered are: A a # 1 .

• Tag > No. (Release number 3 or later)
 This setting only appears when you have enabled the use of tag numbers.
 Sets the tag number. (Up to 16 characters: A a # 1 )
• Items Displayed for Different Tag and Channel Settings
 Text is displayed depending on the tag and channel settings as shown in the figure 

below.
Operating 
Environment

Tag Basic 
Settings

Tag*1 Displayed Text

Tag/Channel Tag No. 
Use/Not

Tag No. Tag 
Comment

Channel 
Number

Tag Number Tag 
Comment

Tag Use Input Input No Yes Yes
Not input No Yes No

Not input Input Yes*2 No Yes
Not input Yes No No

Not — Input No No Yes
Not input Yes No No

Channel Use — — Yes No No
Not — — Yes No No

“Yes” means that the item is displayed
“No” means that the item is not displayed

*1 “Input” means that characters are input.
 “Not input” means that no characters are input.
  “—“ means that the setting does not affect the display.
*2 Channel numbers are displayed instead of tag numbers.

5.2  Displaying Tags or Channel Numbers
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5.3 Setting the Trend Interval and Switching to the 
Secondary Trend Interval

Set the trend interval. Switch the trend interval to the secondary trend interval while the 
memory sampling is in progress. Automatically write messages when the trend interval is 
switched.
For a description of the function, see section 1.3.

Setup Screen

• Switching the Trend Interval and Writing Messages (When Using the 
Secondary Trend Interval)

 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 
setting mode), and select the Environment tab > View, Message, Input, Tag.

   

• Trend interval [/div] and Secondary interval [/div]
  Press MENU (to switch to setting mode), and select the Menu tab > Display > Trend/

Save interval.

   

Setup Items

• View > Trend rate switching
 On: Enables the function that switches the trend interval while the memory sampling 

is in progress. The “Second interval [/div]” item is displayed in the setting mode.
* When the trend rate switching function is On, the DX cannot be configured to record both the 

display and event data (see section 6.1).
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• Message > Change message
 On: Writes the time the interval is switched and the new trend interval as a message 

when the trend interval is switched.
 On DXs with the /AS1 advanced security option, a message is written even when the 

setting mode setup items are changed during memory sampling.
Item Message
Alarm setting change AlarmSet
Alarm delay time change AlmDlaySet
Calibration change Calibration correction Setting

• Trend interval [/div] and Second interval [/div]
 Select the time corresponding to 1 division of the time axis on the trend display from 

below: You cannot specify a trend interval that is faster than the scan interval.
 5s*1, 10s*1, 15s*2, 30s, 1min, 2min, 5min, 10min, 15min, 20min, 30min, 1h, 2h, 4h, and 

10h
*1 Selectable on the DX2004 and DX2008 (release number 3 or later).
*2 Selectable on the DX2010, DX2020, DX2030, DX2040, and DX2048 when the scan interval 

is set to fast sampling mode (release number 3 or later).

Note
If the trend interval is set greater than or equal to 1h/div on a DX with release number 2 or later, 
the month, day, and hour at the grid position are displayed on the screen. The display format 
can be changed by setting the date format.

    

Month, day, and hour
at the grid position.

Procedure

• Switching the Trend Interval
1. In the operation mode, press FUNC.

The FUNC key menu appears.

2. Press the Normal speed soft key or Second speed soft key.
The trend interval is switched. A message is written on the trend display (when the change 
message is turned ON).
Display example: 10:53 1min/div

•  Changing the Trend Display Time Axis While Recording (Memory 
sampling) Is in Progress (Release number 3 or later)

 On a DX whose release number is 3 or later, you can change the secondary trend 
interval even while recording (memory sampling) is in progress. If you are using the 
secondary trend interval to display waveforms and you change it, the time axis will 
change immediately afterwards.
Note

Only the displayed time axis changes when you switch to the secondary trend interval. The 
data sampling interval does not change. 

5.3  Setting the Trend Interval and Switching to the Secondary Trend Interval
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5.4 Writing Messages

Write messages.

Setup Screen

• Message Write Group
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Environment tab > View, Message, Input, Tag.

   

• Setting the Messages
 Press MENU (to switch to setting mode), and select the Menu tab > Message.

   

Setup Items

• Message
 • Write group

 This setting applies only for messages that are written using keys.
Settings Description
Common Write the message to all groups.
Separate Write the message to the displayed group.

If you are using the multi batch function (/BT2 option), see the DX1000/DX1000N/DX2000 Multi 
Batch (/BT2) User’s Manual, IM04L41B01-03E.

 • Power-fail message
 See section 5.17.

 • Change message
 See section 5.3.
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• Message No.
 Select the message number (1 to 100). Messages 1 to 10 are common with free 

messages.*  If a message is changed as a free message, the old message is 
overwritten.
* Messages that are written by creating the message on the spot.

• Message > Characters
 Set the message. (up to 32 characters, A a # 1 )

Procedure

• Writing Messages
 Messages cannot be written when the memory sampling is stopped.

1. Display the group to write the message.
• If a screen unrelated to a group such as the overview is displayed, messages are written to 

all groups even when Write group is set to Separate. For the four panel display, messages 
are written to the displayed groups.

• Messages are written to all groups regardless of the displayed screen when Write group is 
set to Common.

2. Press FUNC.
The FUNC key menu appears.

3. Press the Message soft key.

4. Press the soft key corresponding to the desired message number range  
(example: [1-10]).
A list of message is displayed.

     

5. Press the soft key corresponding to the number of the message you want to 
write.

 A message mark, time, and message are shown on the trend display.

     

Message

5.4  Writing Messages
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• Writing Free Messages
 Create a message on the spot and write it.

1. Display the group to write the message.
2. Press FUNC.

The FUNC key menu appears. 

3. Press the Free message soft key.
4. Press a message number soft key.

The message entry window appears.

5. Enter the message. (up to 32 characters, A a # 1 )
6.  Press DISP/ENTER.

A message mark, time, and message are shown on the trend display. 

• Writing Add Messages
 Add messages to the past data positions. This operation can be carried out on the 

past section of the data that is currently being memory sampled.
1.  Carry out the procedure below to show the historical trend of the data that is 

currently being memory sampled.

 Press DISP/ENTER and select TREND HISTORY > (group name) > DISP/
ENTER

2. Press the arrow keys to move the cursor to the position you want to write the 
message.

3. Write the message according to the procedure given in “Writing Messages” or 
“Writing Free Messages.” Use the Add Message or Add Free Message soft key.

     
Add message

Cursor
(yellow line)

Explanation

• Display Color of Messages
 The message colors on the trend display are shown below. You cannot change them.

No. 1 2 3 4 5 6 7 8 9 10
Color Red Green Blue Blue violet Brown Orange Yellow-green Light blue Violet Gray

 The colors for messages 11 to 100 are repetitions of the colors above.

• Add Message
• The message timestamp is the time that the message is written. It is not the time 

stamp of the data at the position where the message is written.

    
Add message 
(displayed in blue)

Display example on the 
message summary

• Up to 50 messages can be written.
• Messages cannot be added to data in the internal memory that has already been 

saved to a file or data that has been loaded from the external storage medium.

5.4  Writing Messages
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5.5 Changing the Channel Display Colors

Change the channel display colors. The settings are applied to the trend and bar graph 
displays.

Setup Screen
 Press MENU (to switch to setting mode), and select the Menu tab > Meas channel > 

Color.

   

Setup Items

• Group of channel
 Select the target channels.

• Color
 To change the color, select from the following 24 colors.
 Red, green, blue, blue violet, brown, orange, yellow-green, light blue, violet, gray, lime, 

cyan, dark blue, yellow, light gray, purple, black, pink, light brown, light green, dark 
gray, olive, dark cyan, and spring green



5-12 IM 04L42B01-01E

5.6 Displaying Channels in Display Zones

Specify a waveform display zone for each channel so that waveforms do not overlap.
For a description of the function, see section 1.3.

Setup Screen
 Press MENU (to switch to setting mode), and select the Menu tab > Meas channel > 

Zone, Scale, Bar graph.

   

Setup Items

• First-CH/Last-CH
 Select the target channels. The target channels are common with the other items that 

are displayed on the screen.

• Zone > Lower, Zone > Upper
 Sets the zone in which the waveform is displayed. You can set Lower and Upper as 

a position (%) when taking the maximum display width to be 100%. Set Upper greater 
than Lower, and the zone width (Upper – Lower) greater than or equal to 5%.

 Lower: 0 to 95%
 Upper: 5 to 100%
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5.7 Displaying a Scale on the Trend Display

Display a scale on the trend display.
For a description of the function, see section 1.3.

Setup Screen

• Scale Position and Number of Scale Divisions
 Press MENU (to switch to setting mode), and select the Menu tab > Meas channel > 

Zone, Scale, Bar graph.

   

   

• Number of Displayed Scale Digits and Current Value Indicator
 Press MENU (to switch to setting mode), and select the Menu tab > Display > Trend, 

Bar graph, LCD, Monitor.

   

• Showing the Scales
 To show scales on the trend display, press DISP/ENTER (show the display 

selection menu) > the right arrow key (show the sub menu), and select SCALE 
ON (see section 4.2).

Setup Items

• First-CH/Last-CH
 Select the target channels. The target channels are common with the other items that 

are displayed on the screen.

• Scale > Position
 Select the scale display position on the trend display from 1 to 10. Select Off if you do 

not wish to display the scale.
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• Scale > Division
 Set the number of divisions to make with the main scale marks on the trend display to 

a value from 4 to 12 or C10.
 C10:  The scale is equally divided into 10 sections by main scale marks, and scale 

values are indicated at 0, 30, 50, 70, and 100% positions on the trend display.
 The figure below is an example in which each scale is displayed with the position 

shifted.
 Horizontal Trend Display

   

10 9 8 7 6 5 4 3 2 1

Number of scale divisions: 4
Number of scale divisions: 5
Number of scale divisions: 6
Number of scale divisions: 7
Number of scale divisions: 8
Number of scale divisions: 9
Number of scale divisions: 10
Number of scale divisions: 11
Number of scale divisions: 12
Number of scale divisions: C10

Scale display position

 Vertical Trend Display

1
2
3
4
5
6
7
8
9

10

Number of scale divisions: 4
Number of scale divisions: 5
Number of scale divisions: 6
Number of scale divisions: 7
Number of scale divisions: 8
Number of scale divisions: 9
Number of scale divisions: 10
Number of scale divisions: 11
Number of scale divisions: 12
Number of scale divisions: C10

Scale display position

5.7  Displaying a Scale on the Trend Display
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Note
• If the scales of multiple channels are set to the same position, the scale of the channel 

assigned first to the group is displayed.
 Example: If the order of assignment of a group is 003.002.001, and the scale display 

position of all channels is set to 1, the scale of channel 3 is displayed at display position 1.
• Even if some of the scale display positions are skipped, the scale is packed towards display 

position 1.
 Example: Suppose the assignment of channels to a group is 001.002.003, and the display 

positions of the scales are set to 1, 3, and 6, respectively. The scales are actually displayed 
at positions 1, 2, and 3, respectively.

• The scale is divided into 4 to 12 sections by the main scale marks. The section between 
the main scale marks is divided into 5 or 10 subsections by medium and small scale marks. 
However, small scale marks are not displayed in the following cases.
• When the resolution of the input range is smaller than the total number of small scale 

marks.
• When zone display is used.
• When partial expanded display is used (numbers are displayed at the ends of the scale 

and at the boundary position).
• The scale values are displayed according to the following rules.

• If the number of scale divisions is 4 to 7 for the vertical trend display, values are 
displayed at all main scale marks. If the number of scale divisions is greater, the values 
are displayed at every other main scale marks.

• Scale upper and lower limits are displayed at the ends of the scale.
• Scale values are displayed up to 3 digits excluding the minus sign. However, if the 

integer part of values at the ends of the scale is both 1 digit or the integer part is zero, 2 
digits are displayed.

 Example: If the scale is –0.05 to 0.50, the lower limit is “–0.0” and the upper limit is “0.5.”
• If the integer part of either end of the scale is 2 or 3 digits, the fractional part is truncated.
 Example: If the scale is 0.1 to 100.0, the lower limit is “0” and the upper limit is “100.”
• If the integer part of either end of the scale is 4 or more digits, the value is displayed 

using a 3-digit mantissa and exponent like “×10” or “×102”.
 Example: If the scale is 10 to 2000, the lower limit is “1” and the upper limit is “200 × 10”.

• The unit is displayed near the center of the scale. If partial expanded display is used, 
the display position is offset from the center. For the vertical trend display, the number of 
characters that can be displayed is up to six. For the horizontal trend display, the number of 
characters that can be displayed is up to four.

• Trend > Scale > Digit
  Fine: For example, if the scale range is “49.0 to 51.0” and you select “Normal,” the 

scale values are displayed using 2 digits (“49” for example, see Note above). If you 
select “Fine,” the scale values are displayed using 3 digits as shown below.

   

• Trend > Scale > Value indicator
The current value is displayed as a mark or a bar graph.

   

Bar graph

5.7  Displaying a Scale on the Trend Display
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5.8 Displaying Alarm Point Marks and Color Scale 
Band on the Scale

Display alarm point marks on the scale. Display the specified range with a color band.
For a description of the function, see section 1.3.

Setup Screen
 Press MENU (to switch to setting mode), and select the Menu tab > Meas channel > 

Alarm mark, Color scale band.

   

Setup Items

   

Alarm point mark

Color band

• First-CH/Last-CH
 Select the target channels. The target channels are common with the other items that 

are displayed on the screen.
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• Alarm Mark Indication
 Displays marks indicating the values of the high and low limit alarms, delay high and 

low limit alarms, and difference high and low limit alarms. This setting is common with 
the bar graph display.

 • Alarm mark > Mark kind
Settings Description Mark
Alarm The alarm mark is green under normal conditions. It changes to the 

specified alarm color when an alarm occurs (release number 3 or 
later; see section 3.7 for details).

or

Fixed Displays a fixed color.

 • Alarm mark > Indicate on Scale
 To display alarm point marks, select On.

 •  Alarm mark > Alarm mark color > Alarm 1, Alarm 2, Alarm 3, and Alarm 4
 If the Mark kind is set to Fixed, specify the color of the alarm point marks.
 If one of the colors under Alarm mark color is set to Auto, its corresponding point 

mark will appear in the specified alarm color (release number 3 or later; see section 
3.7 for details).

• Color Scale Band
 Displays a specified section of the measurement range using a color band on the 

scale. This setting is common with the bar graph display.
 • Color scale band > Band area

Settings Description
In Displays the area inside using the color band.
Out Displays the area outside using the color band.
Off Disables the function.

 • Color scale band > Color
 Set the display color.

 • Color scale band > Display position > Lower and Upper
 Specify the display position. Set a value within the span or scale range.
 Lower: Lower limit of the area.
 Upper: Upper limit of the area.

5.8  Displaying Alarm Point Marks and Color Scale Band on the Scale
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5.9 Partially Expanding the Waveform

Partially expand a waveform (reduce the other sections) on the display.
We recommend that you display the scale when viewing partially expanded channels. 
The numbers for the ends of the scale and the boundary position are displayed, and 
you can identify the expanded and reduced areas easily. However, numbers are not 
displayed for other scale marks.
For a description of the function, see section 1.3.

Setup Screen

• Turning ON/OFF the Partial Expanded Display Function
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Environment tab > View, Message, Input, Tag.

   

• Partially Expanded Display Method
 Press MENU (to switch to setting mode), and select the Menu tab > Meas channel > 

Partial.

   

Setup Items

• View > Partial
 If you select On, the Partial setup item appears in the setting mode.

• First-CH/Last-CH
 Select the target channels.

• Partial > On/Off
 To enable partial expanded display, select On.

• Partial > Expand
 Set the position where the value specified by Boundary is to be displayed within the 

display span in the range of 1 to 99.
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 • Partial > Boundary
 Set the value that is to be the boundary between the reduced section and the 

expanded section in the range of “minimum span value + 1 digit to maximum span 
value – 1 digit.” For channels that are set to scaling, the selectable range is “minimum 
scale value + 1 digit to maximum scale value – 1 digit.”

 Example: Input range: –6 V to 6V. Expand: 30. Boundary: 0
  The –6 V to 0 V range is displayed in the 0% to 30% range, and the 0 V 

to 6 V range is displayed in the 30% to 100% range.

5.9  Partially Expanding the Waveform
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5.10 Changing the Display Layout, Clearing of the 
Waveform at Start, Message Display Direction, 
Waveform Line Width, and Grid

Change the display layout, clearing of the waveform at start, waveform line width, and 
grid.
For a description of the function, see section 1.3.

Setup Screen
 Press MENU (to switch to setting mode), and select the Menu tab > Display > Trend, 

Bar graph, LCD, Monitor.

   

Setup Items

• Trend > Direction
 Set the display direction of the trends to Horizontal, Vertical, Wide, or Split.

• Trend > Trend clear
Settings Description
On Clears the displayed waveform when the memory sampling is started.
Off Does not clear the waveform when the memory sampling is started.

• Trend > Message direction
 Set the display direction of messages to Horizontal or Vertical. When the trend is set 

to Vertical, the message direction is fixed to Horizontal.

• Trend > Trend line
 Set the line width of the trend in dots (1 to 3).

• Trend > Grid
 Select the number of grids to be displayed in the waveform display area of the trend 

display.
Settings Description
4 to 12 Displays a grid that divides the display width into 4 to 12 sections.
Auto Displays the same number of grids as the number of scale divisions of the 

first assigned channel of the group.
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5.11 Changing the Bar Graph Display Method

Change the bar graph display method.
For a description of the function, see section 1.3.

Setup Screen

• Display Direction
 Press MENU (to switch to setting mode), and select the Menu tab > Display > Trend, 

Bar graph, LCD, Monitor.

   

• Base Position and the Number of Scale Divisions 
 Press MENU (to switch to setting mode), and select the Menu tab > Meas channel > 

Zone, Scale, Bar graph.

   

Setup Items

• Bar graph > Direction
 Set the display direction of bar graphs to Horizontal or Vertical.

• First-CH/Last-CH
 Set the target channels. The target channels are common with the other items that are 

displayed on the screen.

• Bar graph > Base position
 Set the base position of bar graphs to Normal, Center, Lower,* or Upper.*
 The setting is applied when displaying the bar graph and when displaying the current 

value on the scale using the bar graph.
* You can select Lower and Upper on DXs with release number 2 or later.
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When the Display Direction of the Bar Graph Is Vertical
• Normal
 Value at the bottom of the bar graph: Span lower limit or span upper limit (or scale 

lower limit or scale upper limit), whichever is less
 Value at the top of the bar graph: Span lower limit or span upper limit (or scale lower 

limit or scale upper limit), whichever is greater
 Starting point of the bar: Bottom edge
• Center
 Value at the bottom of the bar graph: Same as with Normal.
 Value at the top of the bar graph: Same as with Normal.
 Starting point of the bar: Center
• Lower
 Value at the bottom of the bar graph: Span lower limit (or scale lower limit)
 Value at the top of the bar graph: Span upper limit (or scale upper limit)
 Starting point of the bar: Bottom edge
• Upper
 Value at the bottom of the bar graph: Same as with Lower.
 Value at the top of the bar graph: Same as with Lower.
 Starting point of the bar: Top edge

   

Normal Center Lower Upper

VS

VL

VS

VL

Vlower

Vupper

Vlower

Vupper

Vupper: Span upper limit (or scale upper limit)
Vlower: Span lower limit (or scale lower limit)
VL: Vlower or Vupper, whichever is greater
VS: Vlower or Vupper, whichever is less
     : Starting point of the bar

Normal Center Lower Upper

0.0

-100.0

0.0

-100.0

–100.0

0.0

–100.0

0.0

Example: When the span lower and upper limits of the input 
range are 0.0 and –100.0, respectively

5.11  Changing the Bar Graph Display Method
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When the Display Direction of the Bar Graph Is Horizontal
The span lower limit (or scale lower limit) becomes the left edge of the bar graph, and the 
span upper limit (or scale upper limit) becomes the right edge of the bar graph.
• Starting point of the bar
 Normal: Left edge or right edge, whichever is less
 Center: Center
 Lower: Left edge
 Upper: Right edge

   Center

Normal

Upper

Lower
Vlower (Vlower < Vupper)

(Vlower > Vupper)

Vupper

Vlower Vupper

Vlower Vupper

Vlower Vupper

Vupper: Span upper limit (or scale upper limit)
Vlower: Span lower limit (or scale lower limit)
    : Starting point of the bar

   Center

Normal

Upper

Lower

0.0 –100.0

0.0 –100.0

0.0 –100.0

0.0 –100.0

Example: When the span lower and upper limits of the input 
range are 0.0 and –100.0, respectively

When Displaying the Current Value on the Scale Using the Bar Graph

   

(Vlower < Vupper)

Center

Normal

Upper

Lower

Vlower Vupper

(Vlower > Vupper)

Normal Center Lower Upper

Vlower

Vupper

• Bar graph > Division
 Select the number of main scale marks from 4 to 12.

5.11  Changing the Bar Graph Display Method
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5.12 Using the Circular Display

Use a circular display in place of the trend display.
For a description of the function, see section 1.3.

Setup Screen
• Circular Display
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Environment tab > View, Message, Input, Tag.

   

• Time per Revolution
 Press MENU (to switch to setting mode), and select the Menu tab > Display > 

Circular/Save interval.
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• Operation at One Cycle
 Press MENU (to switch to setting mode), and select the Menu tab > Display > 

Circular, Bar graph, LCD, Monitor.

   

5.12  Using the Circular Display



5-26 IM 04L42B01-01E

Setup Items

• View > Trend type
 Select Circular. 

• Circular/Save interval > Time per revolution [/rev]
 Select the time of revolution from 20min to 4week.

* You can specify 20min on DX2004s or DX2008s with release number 2 or earlier. For 
release numbers 3 and later, in addition to the DX2004 and DX2008, this can also be 
specified in the fast sampling modes of the DX2010, DX2020, DX2030, DX2040, and 
DX2048.

• Circular/Save interval > Save interval (when recording display data)
 Select the size of a record data file. The recorded data is divided by the file size 

specified here. The available settings vary in the range of 10min to 31day depending 
on the Time per revolution setting.
*  For the setting procedure to record the event data, see section 6.1.

• Circular/Save interval > Offset time
 The time at the reference position on the circle can be offset in unit of an hour. The 

available settings vary depending on the time of revolution setting. The figure below 
is an example in which the time per revolution is 6h and indicates the time positions 
when the offset time is Off and 1h.

Hour 0, 6, 12, and 18

Hour 1, 7, 13, and 19

Hour 2, 8, 14, and 20Hour 4, 10, 16, and 22

Hour 3, 9, 15, and 21

Hour 5, 11, 17, and 23

Hour 5, 11, 17, and 23

Hour 0, 6, 12, and 18

Hour 1, 7, 13, and 19Hour 3, 9, 15, and 21

Hour 2, 8, 14, and 20

Hour 4, 10, 16, and 22

Offset time set to Off Offset time set to 1h

1h

Time per Revolution Selectable Offset Times
20min, 30min, 1h –
2h 1h
6h 1h to 5h
8h 1h to 7h
12h 1h to 11h
16h 1h to 15h
1day, 2day, 1week, 2week, 4week 1h to 23h

• Circular > Full circle action
Settings Description
Allclear Clears the entire waveform when one revolution of waveform is recorded and 

continues the recording of the next revolution.
Divclear Clears one division of the old waveform when the remaining amount of 

waveform to be recorded falls to one division and continues the recording.

5.12  Using the Circular Display
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Procedure

• Circular Display
1. Press DISP/ENTER to show the display selection menu.

2. Select TREND using the arrow keys and press DISP/ENTER.
The display appears.

• Changing the Displayed Contents
1. Press DISP/ENTER to show the display selection menu.

2. Press the right arrow key to display the sub menu.

3. Select the sub menu item using the up and down arrow keys.

     SCALE ON:
SCALE OFF:

1/4 CIRCLE:
FULL CIRCLE:

DIGITAL OFF: 
DIGITAL ON:

AUTO SCROLL ON:

AUTO SCROLL OFF:

Group name:

Displays a quarter of the cycle.
Displays the full cycle.

Displays the scale.
Clears the scale.

Clears the numeric display section.
Displays the numeric display section.

Automatically switches the displayed 
groups.
Does not automatically switch the 
displayed groups.

Displays the group.

4. Press DISP/ENTER to change the displayed contents.
To close the menu without changing the displayed contents, press ESC.

• Displaying the Quarter Cycle Display
 Select 1/4 CIRCLE as described in the “Changing the Displayed Contents.” The most 

recent quarter cycle is displayed expanded.

   

5.12  Using the Circular Display
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• Simplified Historical Trend
 Press the up arrow key while showing the quarter cycle to show the historical trend of 

the displayed quarter cycle.

   

 Carry out the procedure below to switch the display in unit of quarter cycle.

  

1/4 CIRCLE

Quarter cycle

FULL CIRCLE

Full cycle

FULL CIRCLE

Up arrow key

Simplified historical trend

Down arrow key

Up arrow key

Down arrow key

Up arrow key

Down arrow key

...

• Historical Trend
 There are five methods to display the past measured data.

For a description of the function, see section 1.3.
For the procedure to recall from the display selection menu, see below.
For the procedure to display from the alarm summary, see section 4.6.
For the procedure to display from the message summary, see section 4.7.
For the procedure to display from the memory summary, see section 4.8.
To show the measured data stored on an external storage medium, see section 6.8.

• Showing the Display
Carry out the procedure below while memory sampling is in progress.

1. Press DISP/ENTER to show the display selection menu.

2. Select TREND HISTORY using the arrow keys and press DISP/ENTER.
One screen of data is displayed.

     

Cursor (yellow line)

5.12  Using the Circular Display
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• Changing the Displayed Contents
1. Press DISP/ENTER to show the display selection menu.

2. Press the right arrow key to display the sub menu.

3. Select the sub menu item using the up and down arrow keys.

     

Group name: Displays the group.

Displays the alarm summary in the loaded data file.

Switches to the specified display.

Expands/Reduces the time axis.

Displays the message summary in the loaded data file.

Displays the information of the loaded data file.

SCALE ON:
SCALE OFF:

Return to the display that was shown before the 
historical trend.

Displays the scale.
Clears the scale.

4. Press DISP/ENTER to change the displayed contents.
To close the menu without changing the displayed contents, press ESC.

• Moving the Cursor

   

Move the cursor in the 
past direction

Move the cursor in the 
current direction

Hold down an arrow key to move the 
cursor by a division.

• Displaying the Continuing Data (Loading Data to the Display Memory)
 Approximately one screen of data is shown on the historical trend display. The 

continuing data can be shown as follows:

Move the cursor to the end of the waveform and press 
the arrow key yet again to display the continuing data.

Move the cursor to the end of the waveform and press 
the arrow key yet again to display the continuing data.

 Displayed

5.12  Using the Circular Display
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• Specifying the Display Range
 Select the display range.

1. Press the up arrow key.
The waveform of the entire data range is displayed at the top section of the screen. The 
white frame indicates the data range that is currently displayed. The yellow horizontal line is 
the cursor.

     

Cursor (yellow line)

All data display
Displayed data range
(White frame)

2. Press the left and right arrow keys to move the cursor.

     

A is selected when the cursor position is at a.
B is selected when the cursor position is at b.

 Displayed

A

a b

B

Cursor

3. Press the down arrow key.
The specified range is displayed.

• Selecting Another File
 To display data from another file, select the file from the memory summary.

• Message
 On the historical trend, up to eight newest messages that exist before the cursor 

position can be displayed.

5.12  Using the Circular Display
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Explanation

• Scale Marks
 The number of scale marks varies depending on the time corresponding to one cycle. 

Scale marks consist of main scale marks and subscale marks. Main scale marks are 
used to divide the cycle into sections; subscale marks are used to divide between the 
main scale marks. The number of divisions created by main scale marks and subscale 
marks are as follows:
Time/rev Number of Divisions 

Created by Main Scale 
Marks

Number of Divisions 
Created by Subscale 
Marks

Time per 
Scale Mark

Display 
Update Rate

20min 5 4 1 min 0.5 s
30min 5 4 1 min 30 s 1 s
1h 12 2 2 min 30 s 2 s
2h 12 2 5 min 4 s
6h 12 2 15 min 10 s
8h 8 2 30 min 20 s
12h 12 2 30 min 20 s
16h 8 2 1 h 40 s
1day 12 2 1 h 1 min
2day 12 2 2 h 2 min
1week 7 4 6 h 4 min
2week 7 4 12 h 8 min
4week 4 7 24 h 20 min

• Event Data
 When displaying event data using the historical trend, the time corresponding to one 

cycle is automatically determined from the sampling interval (Sample rate) of the 
event data to be displayed as follows:
Sample rate Time/rev Number of Divisions Created 

by Main Scale Marks
Number of Divisions Created 
by Subscale Marks

25 ms 1min/rev 6 4
125 ms 5 min/rev 5 4
250 ms 10 min/rev 5 4
500 ms 20 min/rev 5 4
1 s 30 min/rev 5 4
2 s 1 h/rev 12 2
5 s 2 h/rev 12 2
10 s 6 h/rev 12 2
30 s 12 h/rev 12 2
1 min 1 day/rev 12 2
2 min 2 day/rev 12 2
5 min 1 week/rev 7 4
10 min 2 week/rev 7 4
15 min 3 week/rev 7 3
20 min 4 week/rev 4 7
30 min 6 week/rev 7 3

5.12  Using the Circular Display
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5.13 Changing the Background Color of the Display

Change the background color of the display. This setting is applied to the operation 
screens.

Setup Screen
 Press MENU (to switch to setting mode), and select the Menu tab > Display > Trend, 

Bar graph, LCD, Monitor.

   

Setup Items

• Monitor > Background > Display
 Set the background color of the operation screen to White (default setting) or Black.

• Monitor > Background > Historical trend
 Select the background color of the historical trend display from the following:
 Settings: White, Black (default setting), Cream, and Lightgray
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5.14 Automatically Switching Display Groups

Automatically switch the displayed group at a specified interval.

Setup Screen
 Press MENU (to switch to setting mode), and select the Menu tab > Display > Trend, 

Bar graph, LCD, Monitor.

   

 

Setup Items

• Monitor > Scroll time
 Set the switching interval from the available settings between 5 s and 1 min. The 

groups switch in ascending order.
 Select whether to automatically switch on the display selection menu.
 See section 4.2
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5.15 Automatically Switching Back to the Default 
Display

Show a preset display when there is no operation for a specific time.

Setup Screen
 Press MENU (to switch to setting mode), and select the Menu tab > Display > Trend, 

Bar graph, LCD, Monitor.

   

Setup Items

• Monitor > Jump default display
 Returns to a preset display if there is no key operation for a specific time.

Settings Description
1min to 1h Time until switching the display.
Off Disables the function.

Procedure

• Specifying the Display to be Shown
1. Show the operation display you want to designate.

2. In the operation mode, press FUNC.
The FUNC key menu appears.

3. Press the Standard display soft key.
The display is registered.
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5.16 Using the Favorite Key

Register a frequently used display to the Favorite key and enable the display to be 
shown through simple operation.

  

Favorite key

Setup Screen

• FAVORITE Key action (Release number 3 or later)
 Press MENU (to switch to setting mode), and select the Menu tab > Display > 

FAVORITE Key action.

   

Setup Items

• Action (Release number 3 or later)
Setting Description
History The historical trend of the currently displayed data appears when you press 

the favorite key.
Favorite The displays that have been registered to the favorite key appear when you 

press the favorite key.
Select Favorite when you want to register displays to the favorite key and use 
it to switch between them.

If you are using the multi batch function (/BT2 option), see the DX1000/DX1000N/DX2000 Multi 
Batch (/BT2) User’s Manual, IM04L41B01-03E.

• Group display (Release number 3 or later)
 Specify this setting when Action is set to Favorite.

Setting Description
Current Of the displays that have been registered to the favorite key, those that 

display groups (the trend, digital, bar graph, and historical trend displays) are 
displayed using the currently displayed group.

Saved Registered displays are displayed as they were registered.



5-36 IM 04L42B01-01E

• Time axis zoom (Release number 3 or later)
 Specify this setting when Action is set to Favorite.

Setting Description
Current Historical trend displays that have been registered to the favorite key are 

displayed using the current time axis zoom.
Saved Historical trends are displayed using the time axis zooms that they were 

registered with.

Procedure

• Registering the Display
 Up to 8 displays can be registered.

1.  In the operation mode, show the display you want to register.

2. Press FUNC.
The FUNC key menu appears.

3. Press the Favorite regist soft key. Then, press a registration number soft key.

4.  Press the Regist soft key.
A window appears for you to enter the display name.

* To delete a registration, press the Delete soft key.

5. Enter the display name (using up to 16 characters, A a # 1 ).

6. Press DISP/ENTER.
The display is registered.

• Switching the Display
 When You Set Action to History
 The historical trend of the currently displayed data appears when you press the 

favorite key. Press the key again to return to the previous display.

 When You Set Action to Favorite
 The displays change in the order that they were registered in each time you press the 

favorite key. Pressing the favorite key after the last registered display appears returns 
the display to what it was before the favorite key was pressed.

5.16  Using the Favorite Key
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5.17 Writing a Message When the DX Recovers 
from a Power Failure

A message is written to the trend display when the DX recovers from a power failure 
while memory sampling is in progress.

Setup Screen

• Power-fail message
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Environment tab > View, Message, Input, Tag.

   

Setup Items

• Message > Power-fail message
Settings Description
On A message is written when the DX recovers from a power failure while memory 

sampling is in progress. 
Display example: 15:12 Power Off 2005/10/25 15:12:57

Off Disables the function.

If you are using the multi batch function (/BT2 option), see the DX1000/DX1000N/DX2000 Multi 
Batch (/BT2) User’s Manual, IM04L41B01-03E.
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5.18 Changing the FUNC Key Menu and Display 
Selection Menu

Change the FUNC key menu that appears when the FUNC key is pressed and the 
display selection menu that appears when the DISP/ENTER key is pressed.
If you are using the multi batch function (/BT2 option), see the DX1000/DX1000N/
DX2000 Multi Batch (/BT2) User’s Manual, IM04L41B01-03E.

Setup Screen

• FUNC Key Menu
 Press MENU (to switch to setting mode), and select the Menu tab > Menu customize 

> Function menu.

   

Number indicating 
the display order

Menu name
White: Used
Gray:  Not used

• Display Menu
  Press MENU (to switch to setting mode), and select the Menu tab > Menu customize 

> Display menu.

   

Separator

Setup Items

• Enabling/Disabling the FUNC Key Menu
 Items whose menu name is white are shown.

1.  Press the arrow keys to select a menu item.

2. Press the View or Hide soft key.
If you press the Hide soft key, the menu name is displayed in gray, and does not appear in 
the FUNC key menu.
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• Changing the Display Order of the FUNC Key Menu
 Menu items are displayed in order by number. In addition, menu items appear when 

the corresponding function can be used.

1.  Press the arrow keys to select a menu item.

2.  Press the Select soft key.
The menu item is enclosed in a red frame.

3.  Press the arrow keys to select the destination.
4.  Press the Transfer soft key.

The menu item moves to the selected number position.

• Description of the FUNC Key Menus
 For a description of each item, see section 4.1.

• Enabling/Disabling the Display Menu and Sub Menu
 Items whose menu name is white are shown.

1.  Press the arrow keys to select a menu item.

2.  Press the View or Hide soft key.
If you press the Hide soft key, the menu name is displayed in gray, and does not appear in 
the display selection menu.

• Changing the Display Menu/Sub Menu Positions
1. Press the arrow keys to select a menu item.

2. Press the Select soft key.
The menu item is enclosed in a red frame.

3. Press the arrow keys to select the destination.

4. Press the Transfer soft key.
The menu item moves to the selected position.

• Showing/Hiding Separators
1. Press the arrow keys to select a menu item.

2. Press the Separate soft key.
A separator (line) is displayed between the current item and the lower item.
If you select a menu item whose separator is already shown, this operation hides the 
separator.
You can set up to three separators in the display selection menu and each sub menu.

5.18  Changing the FUNC Key Menu and Display Selection Menu
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• Description of the Display Selection Menus and Sub Menus
 Items with asterisk (*) are set to Hide by default.

Display Selection Menu Sub Menu Reference Section
TREND GROUP 1 to GROUP 36 Sections 4.2 and 5.12

1/4 CIRCLE Section 5.12
ALL CHANNEL/GROUP CHANNEL Sections 4.2 and 5.12
SCALE ON/OFF Sections 4.2 and 5.12
DIGITAL OFF/ON Sections 4.2 and 5.12
MESSAGE DISP2/1 Section 4.2

* TREND SPACE ON/OFF Sections 4.2 and 5.12
AUTO SCROLL ON/OFF Sections 4.2 and 5.12
FINE GRID ON/OFF Section 4.2
AUTO ZONE ON/OFF Section 4.2
TAG DETAIL ON/OFF Section 4.2
EXPAND Section 4.10

TREND HISTORY GROUP 1 to GROUP 36 Section 4.3
DIGITAL GROUP 1 to GROUP 36 Section 4.2

AUTO SCROLL ON/OFF Section 4.2
TAG DETAIL ON/OFF Section 4.2
EXPAND Section 4.10

BAR GROUP 1 to GROUP 36 Section 4.2
AUTO SCROLL ON/OFF Section 4.2
EXPAND Section 4.10

CUSTOM DISPLAY INTERNAL 1 TO INTERNAL 3
EXTERNAL 1 TO EXTERNAL 25

IM04L41B01-04E

NEW IM04L41B01-04E
OVERVIEW CURSOR OFF/ON Section 4.4

JUMP TO ALM SUM Section 4.4
JUMP TO TREND Section 4.4

* JUMP TO DIGITAL Section 4.4
* JUMP TO BAR Section 4.4

TAG DETAIL ON/OFF Section 4.4
EXPAND Section 4.10
ACK ALARM 1*2 Section 4.4
ACK ALARM 2*2

ACK ALARM 3*2

ACK ALARM 4*2

ANNUNCIATOR EXPAND Section 3.12

5.18  Changing the FUNC Key Menu and Display Selection Menu
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Display Selection Menu Sub Menu Reference Section
INFORMATION ALARM SUMMARY Section 4.5

MESSAGE SUMMARY Section 4.5
MEMORY SUMMARY Section 4.5
TAG DETAIL ON/OFF Section 4.6

* MODBUS CLIENT Section 4.5
* MODBUS MASTER Section 4.5
* RELAY Section 4.5

EVENT SWITCH Section 4.5
REPORT DATA Section 4.5
COLUMN BAR Section 4.11
TO HISTORY Sections 4.6, 4.7, and 4.8
TO HISTORY(DISP) Sections 4.6, 4.7, and 4.8
TO HISTORY(EV) Sections 4.6, 4.7, and 4.8
TO OVERVIEW Section 4.6
CHANGE SORT KEY Sections 4.6 and 4.7
ASCENDING ORDER/
DESCENDING ORDER

Sections 4.6 and 4.7

DATA SAVE MODE Section 4.8
SELECT SAVE Section 4.8

* M.SAMPLE SAVE Section 4.8
* REPORT SAVE Section 4.8

ALL SAVE Section 4.8
CHANGE DISP ITEM Section 4.7
CHANGE DATA KIND Section 4.8
FILENAME DISPLAY/TIME DISPLAY Section 4.8
CHANGE REPORT CH Section 4.5
SINGLE GRAPH/DUAL GRAPH Section 4.11
SELECT COLUMN/SELECT GROUP Section 4.11
REPORT GROUP 1 to 6 Section 4.11
EXPAND Section 4.10

* Log LOGIN*1 Section 4.9
Operation*2 Section 4.9
ERROR Section 4.9
COMMUNICATION Section 4.9
FTP Section 4.9
MAIL Section 4.9
WEB Section 4.9
SNTP Section 4.9
DHCP Section 4.9
MODBUS Section 4.9
Change settings*2 Section 4.9
CHANGE DISP ITEM*2 Section 4.9

4 PANEL MIX Section 4.10
ALL TREND Section 4.10
ALL DIGITAL Section 4.10
ALL BAR Section 4.10

* EXPAND Section 4.10
*1 Only on DXs without the /AS1 advanced security option
*2 Only on DXs with the /AS1 advanced security option

5.18  Changing the FUNC Key Menu and Display Selection Menu
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5.19 Displaying Comments (Release number 3 or 
later)

Register text strings to comment text fields and combine comment text fields to create 
comment text blocks.
•  You can display the text from a comment text block when a certain event occurs (an 

alarm for example).
•  You can use comment text block text for annunciator window labels (see section 3.12 

for details).

Setup Screen

• Entering Comments
 Press MENU (to switch to setting mode), and select the Menu tab > Message, 

Comment Text > Comment txt fields.

   

 Press MENU (to switch to setting mode), and select the Menu tab > Message, 
Comment Text > Comment txt block.

   

• Displaying Comments
 Press MENU (to switch to setting mode), and select the Menu tab > Timer, Event 

action > Event action
 See section 7.1.
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Setup Items

• Comment txt field no, Text info
 You can register a comment to a specified comment text field (field 1 to 200).
 Text info: you can enter up to 32 characters (A a # 1 ).

• Comment txt block no, Comment txt field no
 You can register a comment to a specified comment text block (block 1 to 100). 

Register comments to comment text blocks by combining up to 5 comment text fields. 
The text from the selected comment text fields appears on the right of the screen.

• Logic box number, Event, Action, Comment Txt Block No
 Use the event action function to specify the event that will cause a comment to be 

displayed. For information about how to set the event action function, see section 7.1.
 Example: If even one alarm occurs, the text from comment text block 2 is displayed.

Item Setting
Event Alarm
Action CommentDisplay
Comment Txt Block No 2

   

 A comment appears when an alarm occurs. Pressing any key makes the comment 
disappear.

   

5.19  Displaying Comments (Release number 3 or later)
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6.1 Setting the Recording Conditions of the 
Measured Data

Set the method for recording the measured data.
For a description of the function, see section 1.4.

Setup Screen

• Data Type
  Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Menu tab > A/D, Memory.

   

• Measurement Channels
 Press MENU (to switch to setting mode), and select the Menu tab > Meas channel > 

Tag, Memory sample, Alarm delay.

   

• File Save Interval (Display Data)
 Press MENU (to switch to setting mode), and select the Menu tab > Display > Trend/

Save interval or Circular/Save interval.

   

T-Y Display Circular Display

Chapter 6 Saving and Loading Data
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• Recording Conditions of Event Data
 Press MENU (to switch to setting mode), and select the Menu tab > Data save > 

Event data.

   

Setup Items

• Memory > Data kind
Settings Description
Display Records display data.
E+D Records display data and event data. This setting cannot be selected 

when the trend interval switching function is set to On. This setting cannot 
be selected when the multi batch function (/BT2 option) is being used or 
on DXs with the /AS1 advanced security option.

Event Records event data.

• Memory sample > On/Off
 Turn On the target channels.

• Trend/Save interval > Trend interval [/div] (when recording display data)
 See the table below. You can only set trend intervals that are longer than the scan 

interval you set in Basic Setting Mode.

• Trend/Save interval > Save interval (when recording display data)
 Select the size of a record data file. The recorded data is divided by the file size 

specified here. The available settings vary depending on the number of memory 
sampling channels and the Trend interval setting.
Trend interval*1 5 s*2 10 s*2 15 s*3 30 s 1 min
Sample rate 125 ms 250 ms 500 ms 1 s 2 s
Selectable range 
of auto save 
interval

10 min to 12 
hours

10 min to 1 
day

10 min to 3 
days

10 min to 7 
days

10 min to 14 
days

Trend interval*1 2 min 5 min 10 min 15 min 20 min
Sample rate 4 s 10 s 20 s 30 s 40 s
Selectable range 
of auto save 
interval

10 min to 14 
days

10 min to 31 
days

10 min to 31 
days

10 min to 31 
days

1 hour to 31 
days

Trend interval*1 30 min 1 h 2 h 4 h 10 h
Sample rate 1 min 2 min 4 min 8 min 20 min
Selectable range 
of auto save 
interval

1 hour to 31 
days

1 hour to 31 
days

2 hours to 
31 days

4 hours to 
31 days

8 hours to 
31 days

*1 You cannot set a trend interval that corresponds to a sampling interval that is faster than the 
scan interval.

*2 Selectable on the DX2004 and DX2008 (release number 3 or later).
*3 Selectable in fast sampling mode on the DX2010, DX2020, DX2030, DX2040, and DX2048 

(release number 3 or later).

• Trend/Save interval > Second interval [/div]
 See section 5.3. 

6.1  Setting the Recording Conditions of the Measured Data
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• Circular/Save interval
 See section 5.12.

• Event data (when recording event data)
 • Sample rate

 Select the data recording interval. Use the table under “Data length” for reference.
 • Mode

Settings Description
Free Records data continuously.
Single Records data when the trigger condition is met.
Repeat Records data each time the trigger condition is met.
* This setting is fixed at “Free” when the multi batch function (/BT2 option) is being used 

and on DXs with the /AS1 advanced security option.

 • Data length
 Select the size of a record data file. The recorded data is divided by the file size 

specified here. The available data lengths vary depending on the number of 
memory sampling channels and the Sample rate setting.
Sample rate*1 25 ms*2 125 ms 250 ms 500 ms 1 s
Selectable 
range of data 
length

10 min to 4 
hours

10 min to 1 
day

10 min to 2 
days

10 min to 3 
days

10 min to 7 
days

Sample rate*1 2 s 5 s 10 s 30 s 1 min
Selectable 
range of data 
length

10 min to 14 
days

10 min to 31 
days

10 min to 31 
days

1 hour to 31 
days

1 hour to 31 
days

Sample rate*1 2 min 5 min 10 min 15 min*3 20 min*3

Selectable 
range of data 
length

1 hour to 31 
days

1 hour to 31 
days

1 hour to 31 
days

1 hour to 31 
days

1 hour to 31 
days

Sample rate*1 30 min*3

Selectable 
range of data 
length

1 hour to 31 
days

*1 You cannot choose an interval that is faster than the scan interval.
*2 Selectable on the DX2004 and DX2008.
*3 Release number 3 or later.

 • Pre-trigger
 Specify the range when recording data before the trigger condition is met. Select 

the range as a percentage of the data length from 0, 5, 25, 50, 75, 95, and 100%. 
If you do not want to record the data existing before the trigger condition is met, 
select 0%.
• Trigger signal > Key

Select On if you want to activate the trigger using key operation.

Note
• Triggers can be applied using event action (see section 7.1).
• If the trigger condition is already met when you press START, recording starts.

6.1  Setting the Recording Conditions of the Measured Data
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6.2 Setting the Method for Saving the Data

Set the method for recording the measured data to the storage medium.
For a description of the function, see section 1.4.

Setup Screen

• Auto save
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Environment tab > Security, Media save, Batch.

   

• File header, Data file name
 Press MENU (to switch to setting mode), and select the Menu tab > Data save > File 

header, Data file name.

   

• Save directory
  Press MENU (to switch to setting mode), and select the Menu tab > Data save > 

Save directory.
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Setup Items

• Save > Auto save
Settings Description
On Automatically saves the measured data to the CF card. Specify On to 

enable the media FIFO function.
Off Does not automatically save the data. Save the measured data manually 

to the CF card or USB flash memory (/USB1 option).

• Save > Media FIFO (Release Number 2 or Later) 
 This item appears if Auto save is set to On.

Settings Description
On Enable media FIFO. Constantly retains the most recent data files in the 

CF card.
Off Disable media FIFO. Replace the CF card if the free space on the CF 

card drops low.

• File header > Characters
 Set the header comment to be written to the data file. (Up to 50 characters, A a # 1 )
• Data file name > Structure
 Sets the structure of the file name when saving data.

Settings Description
Date Serial number + user-assigned character string + date
Serial Serial number + user-assigned character string
Batch Serial number + batch name (when using the batch function)

• Data file name > Identified strings
Set the user-assigned section of the file name. (Up to 16 characters, A a # 1 )

 Symbols that can be used: #, %, (, ), +, -, ., @, °, and _.
 For details on the data file name, see section 1.4.

• Save directory > Directory name
 Set the name of the directory on the storage medium for saving the data on the 

external storage medium. (Up to 20 characters, A a # 1 )
 Symbols that can be used: #, %, (, ), +, -, ., @, °, and _.
 Strings that cannot be used: AUX, CON, PRN, NUL, CLOCK, COM1 to COM9, and 

LPT1 to LPT9.

6.2  Setting the Method for Saving the Data
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6.3 Using the Batch Function

Set the batch function.
For a description of the function, see section 1.5.

Setup Screen

• Batch Function
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Environment tab > Security, Media save, Batch.

   

• Data file name
 Press MENU (to switch to setting mode), and select the Menu tab > Data save > File 

header, Data file name.

   

• Text Field
 Press MENU (to switch to setting mode), and select the Menu tab > Data save > 

Batch text.
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Setup Items

• Batch > On/Off
 Select On to use the batch function.
 For details on MultiBatch, see IM04L41B01-03E.

• Batch > Lot-No. digit
 Select the number of digits of the lot number from 4, 6, or 8. Select Off to disable the 

lot number.

• Batch > Auto increment
Settings Description
On Automatically sets the lot number of the next measurement to “the lot number of 

the current measurement + 1.”
Off Disables the operation described above.

• Data file name > Structure
 Batch: Sets the name of the display data files or event data files to “sequence number 

+ batch name.”
 For details on the data file name, see section 1.4.

• Text field number
 Select a number from 1 to 24 on a DX whose release number is 3 or later. Select a 

number from 1 to 8 on a DX whose release number is 2 or earlier.

• Text field > Title of field, Text field > Characters
 Set the string. 
 Title of field: (Up to 20 characters, A a # 1 ), Characters: (Up to 30 characters, A a # 1 )

Procedure

• Setting the Batch Name (Batch number + lot number) and Comment
1. In the operation mode, press FUNC.

The FUNC key menu appears.

2. Press the Batch soft key.
A window appears for you to enter the batch name and comment.

3. Set the batch number. (Up to 32 characters, A a # 1 )
Symbols that can be used: #, %, (, ), +, -, ., @, °, and _.

If you are using the lot number, set the lot number.

4.  Set batch comments 1, 2, and 3. (Up to 50 characters each, A a # 1 )

5. Press DISP/ENTER.

Note
• Batch numbers and lot numbers cannot be changed after memory start.
• You can change the comment as many times as you wish before executing memory start. 

After memory start, only the comments that are not specified can be entered. You can 
change the comment as many times as you wish while the window for setting the comment 
is displayed. The last specified comment is valid.

• The comment is cleared when memory stop is executed.
• The text fields set upon memory start (see “Starting Recording (Memory Start)” on the next 

page) are cleared upon memory stop.
• The batch number, lot number, and comments are saved to the display data file or event 

data file. They are not saved to the setup file.

6.3  Using the Batch Function
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• Displaying the Text Field Settings
 If you are using the multi batch function (/BT2 option), see the DX1000/DX1000N/

DX2000 Multi Batch (/BT2) User’s Manual, IM04L41B01-03E.

1. In the operation mode, press FUNC.
The FUNC key menu appears.

2. Press the Text field soft key.
The text field settings are displayed.

     

Page switch mark 
(release numbers 3 
and later)
Eight text fields are 
displayed on a single page.
Use the left and right arrow 
keys to switch the page.

 The text field contents are displayed on page 3. Use the left and right arrow keys to 
switch pages (release number 3 or later).

• Starting Recording (Memory start)
1. Press START to open the start recording screen (release number 3 or later).

* On DXs with the /AS1 advanced security option, recording will not start, even if you press 
START in setting mode.

     

2. Enter the batch number, lot number, and comments.

 To edit the contents of a text field, proceed to step 3.

3. Select Input, and press DISP/ENTER. The text field screen appears (release 
numbers 4 and later).

6.3  Using the Batch Function
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The settings that you 
made in setting mode 
appear here.

 Select a text field number, and enter text. However, you cannot specify the Tilte of 
field. (Firmware versions numbers 4.11 and later)

 Press DISP/ENTER.
The start recording screen will appear.

 If you press the +1 and –1 soft keys to increase and decrease the text field 
number, any text field numbers whose "Title of field" have not been set will be 
skipped. If you press the Input soft key to enter text field numbers directly, any 
text field numbers whose Title of field have not been set are also displayed.

 The text fields that you specify here will only be saved to the measured data file 
whose recording you are starting. The text fields that you set in setting mode (see 
page 6-6) will not change.

4. Move the cursor (blue) to START, and then press DISP/ENTER.
The internal memory icon in the status display section changes from the icon that indicates 
that memory sampling is stopped to the icon that indicates that memory sampling has started.
 • If you are recording display or event data in Free mode, recording will start.
 •  If you are recording event data in a trigger mode (Single or Repeat), the DX will enter a 

trigger-wait state.

• Stopping Recording (Memory stop)
1. Press STOP. A confirmation window opens.

     

2. Select Yes, and press DISP/ENTER.
If the DX is equipped with computation functions (/M1 and /PM1 options), select 
Mem+Math or Memory and press DISP/ENTER.
On DXs with the /AS1 advanced security option, if there are alarms upon which the alarm 
ACK operation has not been performed, a confirmation message will appear. Perform the 
alarm ACK operation as necessary.
The internal memory icon in the status display section changes to the icon that indicates 
that memory sampling is stopped.

6.3  Using the Batch Function
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6.4 Starting/Stopping the Recording and Saving 
the Measured data

Start the recording and save the measured data to the external storage medium.
For a description of the function, see section 1.4.

Procedure
• Starting the Recording (Memory Start)
 Press START. The internal memory icon in the status display section changes from 

the stop icon to memory sampling icon.
• When recording display data or event data in free mode, recording starts.
• When recording event data in trigger mode, the DX enters the trigger-wait 

condition.
* On DXs with the /AS1 advanced security option, recording will not start, even if you press 

START in setting mode.
* For the procedures when using the batch function, see section 6.3. If you are using the multi 

batch function (/BT2 option), see the DX1000/DX1000N/DX2000 Multi Batch (/BT2) User’s 
Manual, IM04L41B01-03E.

• Applying a Trigger to Start the Recording
Carry out the procedure below when the DX is waiting for a trigger.

 Trigger through Key Operation
 The procedure below can be carried out when recording event data in trigger mode 

and the DX is configured so that the start trigger is applied through key operation.

1. Press FUNC.
The FUNC key menu appears.

2. Press the Trigger soft key.
The recording starts.

 Trigger by an Event (Event action function must be configured. See 
section 7.1.)

 Recording starts when an event occurs.

• Automatically Saving Measured Data
 Automatic saving takes place when Auto save is set to On (see section 6.2 for details).
 The save destination is the CF card.
 Have the CF card inserted in the slot at all times. While the memory sampling is in 

progress, the measured data recorded in the internal memory is automatically saved 
to the CF card.

 Action when Media FIFO is not enabled: If data storage to the storage medium is not 
complete such as due to insufficient free space, the unsaved data is saved the next 
time the data is automatically saved.

 Saving the Display Data or Event Data during Memory Sampling through 
Key Operation

 The save destination is the CF card.
 This operation can be carried out when recording display data or when recording 

event data in Free mode. Unsaved measured data is saved to the CF card.

1. In the operation mode, press FUNC.
The FUNC key menu appears.

2. Press the Save display or Save event soft key.
The display data or event data is saved to the CF card.

     
Time

Saved the previous time

Save operation

FileFile File
Saved this time
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• Saving Measured Data Manually (Collectively Storing Unsaved Data)
 Automatic saving takes place when Auto save is set to Off (see section 6.2 for details).
 You can save to a CF card or to USB flash memory (/USB1 option). The procedure for 

saving unsaved data to a CF card is described below.
 For the procedure to save data to the USB flash memory, see section 2.12.

1. Insert the CF card.
A confirmation window containing the message “There is data which is not saved to media. 
Do you want to store to media?” appears.

2.  Select Yes and press DISP/ENTER.
The unsaved data in internal memory will be saved to the CF card.

3. Follow these steps to remove the CF card.
Press FUNC (display the FUNC key menu) > Media eject soft key > CF soft key.
When the message “Media can be removed safely” appears, remove the CF card.

Note
• If there is not enough free space on the storage medium, the message “Not enough free 

space on media” appears, and the data is not saved. If this message appears, replace the 
storage medium. Then, carry out the procedure again.

• You cannot abort the data save operation while it is in progress.

• Stopping the Recording (Memory Stop)
* For the procedures when using the batch function, see section 6.3.

1. Press STOP. A confirmation window is displayed.

     

2. Select Yes using the arrow keys and press DISP/ENTER.
On models with the computation function (/M1 or /PM1 option), select Mem+Math or 
Memory, and press DISP/ENTER.
On DXs with the /AS1 advanced security option, if there are alarms upon which the alarm 
ACK operation has not been performed, a confirmation message will appear. Perform the 
alarm ACK operation as necessary.
The internal memory icon in the status display section changes to the stop icon.

• Saving the Data in the Internal Memory Collectively or Selectively 
through Key Operation

 See section 4.8.

6.4  Starting/Stopping the Recording and Saving the Measured data
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Explanation

• Operations That Start Simultaneously with Memory Start
• Waveform display updating on the trend display.
• Report (/M1 and /PM1 options)
• The computation function (/M1 and /PM1 options) can be configured to start 

simultaneously with memory start.
 See section 9.4.

• Operations That Stop Simultaneously with Memory Stop
• Waveform display updating on the trend display.
• Report (/M1 and /PM1 options)
• Computation function (/M1 and /PM1 options): When selected in the procedure 

described above.

• Performance While Data Is Being Saved
 If the internal memory or external storage medium is continuously accessed, the 

following phenomena may occur. When such phenomena occur, the storage medium 
access indicator frequently illuminates.
• Files being saved to the external storage medium drop out.
• Accessing the DX through communications takes a long time
In such case, take the following measures.
• If you are creating data files at short intervals consecutively using the event action 

function, increase the data file save interval.
• If you are creating numerous files in a single directory on the external storage 

medium, change the destination directory name at approximately every 1000 files.
• If data recording and display are using up resources (for example if you are 

recording on multiple channels using a fast sampling rate, and displaying four trend 
displays on the 4-panel display), use a slower sampling rate or change the display.

6.4  Starting/Stopping the Recording and Saving the Measured data
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• Changing Settings and Performing File Operations during Recording 
(Memory sampling)

 If you are using the multi batch function (/BT2 option), if even one batch group is being 
recorded, the DX is recording (memory sampling).

 On DXs without the /AS1 advanced security option
 You can change all settings except for the ones listed below.

• Basic settings
• Input range
• Memory sampling on/off
• Computation channel calculation expressions and constants
• TLOG
• Trend interval
• File save interval
• Timer and match time timer

 On DXs With the /AS1 Advanced Security Option
 You can change the following settings and perform the following file operations. The 

administrator can perform all operations. Users can only perform operations that have 
been permitted. The setting menu that appears varies depending on the operations 
that can be performed.

 Setting Changes
• Date and time settings
• Alarm settings
• Alarm delay time settings
• Calibration settings
• Destination directory settings
• Administrator settings*
• User settings*

* See the Advanced Security Function (/AS1) User’s Manual, IM 04L41B01-05EN.

 File Operations
• Loading display data files
• Loading event data files
• Listing the files on the external storage medium

6.4  Starting/Stopping the Recording and Saving the Measured data
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6.5 Manually Saving the Measured Data (Manual 
Sample)

Save the instantaneous values of all channels (excluding those set to Skip or Off) 
through key operation. On models with the external input channels (/MC1 option), the 
instantaneous values of specified channels (among 120 channels) are saved.
For a description of the function, see section 1.4.

Setup Screen

• Channel to be Manual Sampled
 This setting applies to models with the external input channels (/MC1 option).
 Press MENU (to switch to setting mode) and select the Menu tab > Data save > 

Manual sample.

   

Setup Items

• Manual sample number
 Select a number from 001 to 120. The instantaneous values are output in this order.

• ManualSample
 • On/Off

 Select On when assigning a channel to the manual sample number.
 • Channel

 Enter a channel number of a measurement channel, computation channel (/M1 and 
/PM1 options), or external input channel (/MC1 option).

Procedure
1. In the operation mode, press FUNC.

The FUNC key menu appears.
2.  Press the Manual sample soft key.

Manual sampling is executed.
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Explanation

• Number of Manual Sampled Data Set in the Internal Memory
 The number of manual sampled data set in the internal memory is displayed on the 

memory summary display (see section 1.9)

• Saving Manual Sampled Data
• If auto save is On, the manual sampled data is saved to the CF card when you 

carry out manual sampling.
• If auto save is Off, save the manual sampled data to the CF card according to the 

procedure for manually saving the data (see section 6.4).
• The manual sampled data can be saved manually to a CF card or USB flash 

memory (/USB1 option) regardless of whether the auto save function is set to On/
Off. For the manual save operation, see section 4.8.

6.5  Manually Saving the Measured Data (Manual Sample)
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6.6 Saving the Screen Image Data (Snapshot)

Save the current screen image data to the CF card. This operation is called snapshot, 
and the screen image data file is called snapshot data file.
For a description of the function, see section 1.4.

Procedure

1.  In the operation mode, press FUNC.
The FUNC key menu appears.

2. Press the Snap shot soft key.
The snapshot data file is saved to the CF card.
Image of the soft keys and the message window are not saved.

Note
If you assign the snapshot function to the USER key, you can carry out snapshots in all modes 
(operation mode, setting mode, and basic setting mode). However, error messages are not 
saved.

Explanation

• File Format
 The snapshot data file is in PNG format.

• File Name
 See section 1.4.
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6.7 Managing the Files on the Storage Medium

This section explains how to display a list of files on the storage medium, check the free 
space, delete files and directories, and format the storage medium.

Procedure

• Displaying a List of Files on the Storage Medium, Deleting Files, and 
Checking the Free Space

 Carry out the procedure below to show the display.
 Press MENU (to switch to setting mode), and select the File tab > File list/delete > 

press the CF or USB soft key* > and press DISP/ENTER.
* When a CF card and a USB flash memory (/USB1 option) are being used.

   

 Displaying a List of Files in a Directory and Checking the Free Space
 Press the arrow keys to select a directory, and press DISP/ENTER. The files in the 

directory are displayed. The root directory is denoted by [/].

   

 Sorting Files and Directories (Release Number 2 or Later)
 The files and directories can be sorted by the update date/time.
 Each time you press the Sort soft key, the files and directories are sorted in order from 

the oldest or the latest update date/time. A mark indicating the sort order is displayed 
by Date/Time.
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 Deleting a File
 Press the arrow keys to select the file to be deleted, and press the Delete soft key.
 A confirmation window appears. Select Yes, and press DISP/ENTER.
 The file is deleted.
 This operation cannot be performed on DXs with the /AS1 advanced security 

option.

 Deleting a Directory
 First, delete all the files in the directory.
 Select the directory you want to delete. The rest of the procedure is the same as 

deleting a file.
 This operation cannot be performed on DXs with the /AS1 advanced security 

option.

 Checking the Free Space
 The free space on the storage medium is shown at the lower right of the screen.

• Formatting the Storage Medium
 Formatting will remove the contents of the storage media.
 This operation cannot be performed on DXs with the /AS1 advanced security 

option.

1. Carry out the procedure below to show the display.

 Press MENU (to switch to setting mode), and select the File tab > Format. Press 
the CF or USB soft key*, and then press DISP/ENTER.
* When a CF card and a USB flash memory (/USB1 option) are being used.

     

2. Enter the volume name and press DISP/ENTER. (Up to 11 characters, A 1)
A confirmation window opens.

3. Select Yes and press DISP/ENTER.
The storage media is formatted.

Explanation

• Format Type
Size Type
Storage medium smaller than or equal to 512 MB FAT16
Storage medium greater than 512 MB FAT32

6.7  Managing the Files on the Storage Medium
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6.8 Loading and Displaying the Measured Data in 
the Storage Medium

Load the display or event data file saved on the external storage medium and display the 
waveform. The loaded data is shown on the historical trend display.
For the operations on the historical trend display, see section 4.3.

Procedure

• Loading a File
1. Carry out the procedure below to show the display.

 Press MENU (to switch to setting mode), and select the File tab > Load display 
data or Load event data. Press the CF or USB soft key*; and press DISP/
ENTER.
* When a CF card and a USB flash memory (/USB1 option) are being used.

     

2. Press the arrow keys to select a directory, and press DISP/ENTER. The files in 
the directory are displayed. The root directory is denoted by [/].

     

3. Press the arrow keys to select a file, and press DISP/ENTER.
The file is loaded, and the waveform is displayed in the historical trend.

Note
• As shown in the table below, the display data and event data file name extensions change 

depending on whether or not the /AS1 advanced security option is installed.
Advanced Security Display Data Files Event Data Files
Not installed .DAD .DAE
Installed .DSD .DSE

• For details on how to use the Sort key, see section 6.7.
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6.9 Saving/Loading the Setup Data

Save the setup data to the external storage medium or load the setup data from the 
external storage medium.

Procedure

• Saving the Setup Data
1. Carry out the procedure below to show the display.
 Press MENU (to switch to setting mode), and select the File tab > Save settings. 

Press the CF or USB soft key*, and then press DISP/ENTER.
* When a CF card and a USB flash memory (/USB1 option) are being used.

     

2. Set the file name. (Up to 32 characters, A a # 1 )
Symbols that can be used: #, %, (, ), +, -, ., @, °, and _.
Strings that cannot be used: AUX, CON, PRN, NUL, CLOCK, COM1 to COM9, and LPT1 to LPT9.
To cancel the operation, press ESC.

3. Press DISP/ENTER.
The setup data is saved.
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• Loading the Setup Data for the Setting Mode
1. Carry out the procedure below to show the display.

 Press MENU (to switch to setting mode), and select the File tab > Load settings. 
Press the CF or USB soft key*, and then press DISP/ENTER.
* When a CF card and a USB flash memory (/USB1 option) are being used.

     

Note
For details on how to use the Sort key, see section 6.7.

2. Use DISP/ENTER and arrow keys to select the setup file to be loaded.
* Setup data files are stored in the root directory [/].

To cancel the operation, press ESC.

3. Press DISP/ENTER.
The setup data is loaded.

6.9  Saving/Loading the Setup Data
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• Loading the Setup Data for the Setting Mode and Basic Setting Mode
1. Carry out the procedure below to show the display.

 On DXs without the /AS1 advanced security option

 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to 
basic setting mode), and select the File/Initialize tab > Load settings. Press the 
CF or USB soft key*, and then press DISP/ENTER.
* When you are using a CF card and USB flash memory (/USB1 option).

 On DXs with the /AS1 advanced security option

 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch 
to basic setting mode), and select the File/Initialize tab > Load settings > All 
settings, Login info only, or Other settings. Press the CF or USB soft key*, 
and then press DISP/ENTER.
* When you are using a CF card and USB flash memory (/USB1 option).

     

2. Use DISP/ENTER and arrow keys to select the setup file to be loaded.
* Setup data files are stored in the root directory [/].

To cancel the operation, press ESC.

3. Press DISP/ENTER.
The setup data is loaded.

Note
For details on how to use the Sort key, see section 6.7.

6.9  Saving/Loading the Setup Data
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Explanation

• Setup Data File
 On DXs without the /AS1 advanced security option

• The setup data file extension is .PDL.
• The maximum setup data file size is approximately 250 KB.
• The following settings are also saved.

• Current monitor display conditions
• Default display registration data
• Favorite key registration data

 On DXs with the /AS1 advanced security option
• The setup data file extension is .PEL.
• The maximum setup data file size is approximately 250 KB.
• The following settings are also saved.

• Current monitor display conditions
• Default display registration data
• Favorite key registration data

• Loading Setup Data
 On DXs without the /AS1 advanced security option

• Only the setup data of the setting mode is loaded in the setting mode. However, 
settings that contradict the setup data of the basic setting mode are not loaded.

• The monitor display conditions, default display, and favorite keys are also loaded.
• If the contents of the loaded setup data is invalid, check the error log (see section 

4.9).
• Operations through keys, communications, and remote control input are not 

executed while the setup data is being loaded.

 On DXs with the /AS1 advanced security option
• If the setup data is changed by loading new setup data, the original setup file 

is automatically saved to CF card. If no CF card is inserted, an error message 
appears and the operation cannot be completed.

• All settings, Login info only, and Other settings
The “Load settings” 
option

Description

All settings The DX loads all setting mode and basic setting mode settings. 
However, the login password is not loaded. The password is set 
to the default password.

Login info only The DX only loads the login settings. However, the login 
password is not loaded. The password is set to the default 
password.

Other settings The DX loads all setting except for the login settings.

• In setting mode, only the setting mode settings are loaded. However, settings that 
contradict the basic setting mode settings are not loaded.

• In any case, the option to “Load settings” also loads monitor display conditions, the 
default display, and favorite keys.

• If the loaded setup data is not applied, check the error log (see section 4.9).

Note
• While loading the setup data, key operations, operations via communications, and 

operations via remote input are not available.
• While loading the setup data, actions of the Event Action function are disabled. Events 

occurring while loading the setup data are ignored.

6.9  Saving/Loading the Setup Data
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6.10 Loading and Saving Report Templates (/M1 and 
/PM1 options; release numbers 4 and later)

This section explains the procedures for loading a report template (.xml extension) from 
an external storage medium and for saving a report template from the internal memory to 
an external storage medium.

Procedure

• Loading a Template File
1. Carry out the procedure below to show the display.

 Press MENU (to switch to setting mode), and select the File tab > Load template. 
Press the CF or USB soft key*, and then press DISP/ENTER.
* When you are using a CF card and USB flash memory (/USB1 option).

     

Under Template File Status, the check boxes of the template files that are stored in the 
internal memory are selected.

2. Press a soft key to select a report type, and press DISP/ENTER.
The directories on the external storage medium appear. “/” is the root directory.

3. Use the arrow keys to select a directory, and press DISP/ENTER.
The files in the directory will appear in a list.

     

4. Use the arrow keys to select the file that you want to load, and press DISP/
ENTER.
The report template file is loaded, and the screen from step 1 appears. The check boxes 
that are selected under Template File Status will match the file type that you loaded.
If the DX fails to load the file, it will display an error message.
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• Saving a Template File
1. Carry out the procedure below to show the display.

 Press MENU (to switch to setting mode), and select the File tab > Save template. 
Press the CF or USB soft key*, and then press DISP/ENTER.
* When you are using a CF card and USB flash memory (/USB1 option).

     

Under Template File Status, the check boxes of the template files that are stored in the 
internal memory are selected.

2. Press a soft key to select a report type, and press DISP/ENTER.
The directories on the external storage medium appear. “/” is the root directory.

3. Use the arrow keys to select a directory, and press DISP/ENTER.

     

4. Enter the file name (up to 32 characters, A a # 1 ).
Symbols that can be used: #, %, (, ), +, –, ., @, °, and _.
Strings that cannot be used: AUX, CON, PRN, NUL, CLOCK, COM1 to COM9, and LPT1 to 
LPT9.
To cancel the operation, press ESC.

5. Press DISP/ENTER.
The report template file is saved.

6.10  Loading and Saving Report Templates (/M1 and /PM1 options; release numbers 4 and later)
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Explanation

• Report Template Files
• The report template file name extension is .xml.
• The DX can only handle template files that are 400 KB or smaller.

• Report Types and Templates Used
Report Settings Template Type
Report kind File type
Hour Combine/Separate The hourly report template
Daily Combine/Separate The daily report template
Hour+Day Separate The hourly report and daily report templates

Combine The hourly + daily report template
Day+Week Separate The daily report and weekly report templates

Combine The daily + weekly report template
Day+Month Separate The daily report and monthly report templates

Combine The daily + monthly report template

6.10  Loading and Saving Report Templates (/M1 and /PM1 options; release numbers 4 and later)
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7.1 Setting the Event Action Function (Including 
the remote control function of the /R1 and /
PM1 options and the USER key)

A specified action is carried out when an event occurs. This function is called event action. 
The remote control function (/R1 option) and the USER key are set by the event action.
For a description of the function, see section 1.6.

Setup Screen
• Event and Action
 Press MENU (to switch to setting mode), and select the Menu tab > Timer, Event 

action > Event action.

   

• Timer
 Press MENU (to switch to setting mode), and select the Menu tab > Timer, Event 

action > Timer.

 • When set to absolute time • When set to relative time

    

Chapter 7 Customizing Actions Using the Event Action and Remote Control Functions  
(/R1 and /PM1 Options)
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• Match Time
 Press MENU (to switch to setting mode), and select the Menu tab > Timer, Event 

action > Match time timer.

   

Setup Items

• Logic box number
 You can set up to 40.

• Event-Action > Event
 The condition to execute the action.

Settings Description
None Not use.
Remote Select the remote control input terminal number.
Relay Select the alarm output relay number. During Edge operation, a change from 

deactivated to activated is an event.
Relay-Off*2 Select the alarm output relay number. During Edge operation, a change from 

activated to deactivated is an event. During Level operation, the action states 
that correspond to “activated” and “deactivated” are the opposite of when you 
select “Relay.”

Switch Select the internal switch number. During Edge operation, a change from off to 
on is an event.

Switch-Off*2 Select the internal switch number. During Edge operation, a change from on to 
off is an event. During Level operation, the action states that correspond to “on” 
and “off” are the opposite of when you select “Switch.”

Timer Select the timer number.
Matchtime Select the match timer number.
Alarm During Edge operation, a change from “no alarms are active” to “at least one 

alarm is active” is an event.
Alarm-Off*2 During Edge operation, a change from “at least one alarm is active” to “no 

alarms are active” is an event. During Level operation, the action states that 
correspond to “at least one alarm is active” and “no alarms are active” are the 
opposite of when you select “Alarm.”

UserKey -
Edge*1  Select the event switch number (1 to 30). This function is available for release 

numbers 3 and later.
Level*1  Select the event switch number (1 to 30). During Edge operation, a change 

from off to on is an event.
LevelOff*2 Select the event switch number (1 to 30). During Edge operation, a change 

from on to off is an event. During Level operation, the action states that 
correspond to “on” and “off” are the opposite of when you set the event to 
“Level.”

*1 Available for release numbers 3 and later.
*2 Available for release numbers 4 and later.

7.1  Setting the Event Action Function  
(Including the remote control function of the /R1 and /PM1 options and the USER key)



7-3IM 04L42B01-01E

C
ustom

izing A
ctions U

sing the Event A
ction and R

em
ote C

ontrol Functions 
(/R

1 and /PM
1 O

ptions)

1

2

3

4

5

6

7

8

9

10

11

12

13

App

Index

• Event-Action > Action
 The action to be executed when an event occurs.

Settings Description
Memory -
Start -
Stop -
Trigger* Can be specified when the DX is configured to record event data.
AlarmACK Cannot be specified when the event is set to Relay, Switch, or Alarm.
Math Can be specified on /M1 and /PM1 options.
MathStart Can be specified on /M1 and /PM1 options.
MathStop Can be specified on /M1 and /PM1 options.
Math rst Can be specified on /M1 and /PM1 options.
SaveDisp Can be specified when the DX is configured to record display data.
SaveEvent Can be specified when the DX is configured to record event data.
Message Set the message number to write the message and the destination. Set the 

message destination to all groups (All) or a group number.
Snapshot -
Rate1/2 Can be specified when the function for switching between the trend interval 

and the secondary trend interval is enabled.
M.sample -
TimerRst Cannot be specified when the event is set to Timer.
Group Specify the number of the group to be displayed.
Flag Can be specified on /M1 and /PM1 options.
Time adj Can be specified only when the event is set to Remote.
PnlLoad* Can be specified only when the event is set to Remote.
Comment Specify the comment text block number to display. This function is available for 

release numbers 3 and later.
Favorite Choose which registered display to switch to. This function is available for 

release numbers 3 and later.
Setting Description
Key Performs the same operation as 

pressing the favorite key.
Select>Favorite Screen No Displays the specified favorite screen.
*  If you configure the settings so that the Favorite action and the Group 

action occur at the same time, only the action whose event action number 
is largest will be executed.

AlarmRst This action can only be specified when using the double lock-in sequence of 
the alarm annunciator function (see section 3.12), and the event is Remote, 
UserKey, or Edge. This function is available for release numbers 3 and later.

* This action is not available on DXs with the /AS1 advanced security option.

7.1  Setting the Event Action Function  
(Including the remote control function of the /R1 and /PM1 options and the USER key)
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• Timer
 Timer used by event action. Used also in the TLOG computation computation function.

* The timer cannot be changed while memory sampling or computation is in progress.

 • Timer No.
 Up to four timers (1 to 4) can be set.

 When Using an Absolute Timer
 • Mode

 Select Absolute.
 • Interval

 Select the interval from the available settings between 1min to 24h.
 • Ref.time

 Set the time in the range of hour 0 to hour 23.

 When Using a Relative Timer
 • Mode

 Select Relative.
 • Interval

 Set the interval in the range of 00:01 (1 min) to 24:00 (24 hours).
 • Reset at Math Start

 On: Resets the timer when computation is started. The resetting of the timer is not 
considered to be a timeout. Even if the timer is used as an event, the action is not 
executed.

• Match Time Timer
 Set the time match condition used in event action.

* The condition cannot be changed while memory sampling or computation is in progress.

 • Timer number
 You can set up to four match time conditions (1 to 4).

 • Kind
Settings Description
Day Set the time match condition of a day.
Week Set the time match condition of a week.
Month Set the time match condition of a month.
Year The condition is matched once a year. This function is available for 

release numbers 3 and later.

 Set the items with check marks in the following table depending on the Kind setting.

    

Day Week Month Year

Day
Day of week
Hour:Minute

Type
Setting














Month

 • Month
 Set the month.

 • Day
 Set the day.

 • Weekday
 Set the day of the week.

 • Hour:Minute
 Set the time in the range of 00:00 to 23:59.

 • Timer action
Settings Description
Single Executes the action once when the condition is met.
Repeat Executes the action at every specified time.

7.1  Setting the Event Action Function  
(Including the remote control function of the /R1 and /PM1 options and the USER key)
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Procedure

• Resetting the Relative Timer
1. In the operation mode, press FUNC.

The FUNC key menu appears.

2. Press the Timer reset soft key.

3. Press the soft key corresponding to timer you want to reset. Select All to reset all 
timers.
The relative timer is reset.

• Operating Event Switches (Release number 3 or later)
 Operating Event Level Switches
 You can operate an event level switch using:

• A custom display switch.
• A communication command.

 Operating Event Edge Switches
 You can operate an event edge switch using:

• The FUNC key (the procedure for operating the switch with the FUNC key is 
described below).

• A custom display push button.
• A communication command.

 Operating the Event Edge Switch Using the FUNC Key
1. In operation mode, press FUNC.

The FUNC key menu appears.

2. Press the Edge Switch soft key.

3. Press the switch number soft key.
The switch will turn on briefly and then turn off again.

• Displaying an Event Level Switch Status List (Release number 3 or later)
 Display the status of the event level switch. For the operating procedure, see section 

4.5.

• Resetting the Match Time Timer (Release number 3 or later)
 Operation ends when a match time timer whose timer action is set to single expires. 

To use such a match time timer again, you must reset it.

1. In operation mode, press FUNC.
The FUNC key menu appears.

2. Press the Match T Reset soft key.
*  This soft key appears when a match timer whose timer action is set to single has expired.

3. Press the soft key with the match time timer number of the timer that you want to 
reset.
The match time timer that you specify is reset.

7.1  Setting the Event Action Function  
(Including the remote control function of the /R1 and /PM1 options and the USER key)
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Explanation

• Resetting the Relative Timer
 Restarts the timer.

• The resetting of the timer is considered to be a timeout. (If the timer is used as an 
event, the action is executed.)

• If the timer is used in TLOG computation on the /M1 or /PM1 math option and 
TLOG computed value reset at each interval is specified, the computed result is 
reset.

• Resetting the Match Time Timer (Release number 3 or later)
 This operation resets an expired match time timer so that it can operate again.

• The resetting of a match time timer does not count as a timer expiration (and it will 
not count as an event action event).

• This operation can be used with match time timers whose timer action is set to 
single.

• If the timer is used in TLOG computation on the /M1 or /PM1 math option and 
TLOG computed value reset at each interval is specified, the computed result is 
reset.

7.1  Setting the Event Action Function  
(Including the remote control function of the /R1 and /PM1 options and the USER key)
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7.2 Setup Examples of Event Action

Example 1:  Starting/Stopping the Memory Sampling through Remote Control 
(/R1 Option)

Starts/Stops the memory sampling when a signal is applied to remote control input 
terminal 2. Use logic box number 1.
• Setup Screen and Setup Items
 Press MENU (to switch to setting mode), and select the Menu tab > Timer, Event 

action > Event action.

   

<Operation>
If the input to the remote control input terminal 2 is turned ON when memory sampling 
is stopped, memory sampling starts. If the remote control input is turned OFF when 
memory sampling is in progress, memory sampling stops.

Example 2: Writing a Message When an Alarm Occurs
Write the message “Channel 1 Alarm” to group 1 when an alarm occurs on channel 1. 
Use logic box number 2.

• Setup Screen and Setup Items
 Press MENU (to switch to setting mode), and select the Menu tab > Timer, Event 

action > Event action.

   

<Other Settings>
• Set an alarm to channel 1 and output to internal switch 3.
• Register “Channel 1 Alarm” in message number 4.
For the procedure to set the alarm, see section 3.7.
For the procedure to set the message, see section 5.4.



7-8 IM 04L42B01-01E

Example 3: Saving the Data Every Day at Hour 17
Save the recorded data to the CF card every day at hour 17. Use logic box number 3. 
Use match time condition 1.

• Setup Screen and Setup Items
 Logic box number 3
 Press MENU (to switch to setting mode), and select the Menu tab > Timer, Event 

action > Event action.

   

 Match Time Condition
 Press MENU (to switch to setting mode), and select the Menu tab > Timer, Event 

action > Match time timer.

   

<Other Settings>
Set the display data to be saved automatically. Set the file save interval to 1day or 
longer. If a file save interval shorter than 1day is specified, the data is also saved at the 
file save interval.
For the procedure to set the recording conditions of the display data, see section 6.1.

7.2  Setup Examples of Event Action
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Example 4:  Releasing the Alarm Output Using the USER Key (Alarm 
Acknowledge Operation)

Release the activated alarm output by pressing the USER key. Use logic box number 4.
• Setup Screen and Setup Items
 Press MENU (to switch to setting mode), and select the Menu tab > Timer, Event 

action > Event action.

   

<Operation>
Press the USER key to release the activated alarm indication and relay output.

<Related Settings>
Set the alarm indication and alarm output relay operation to Hold.
For the procedure to set the alarm indication operation and alarm output relay operation, 
see section 3.5.

7.2  Setup Examples of Event Action
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7.3 Changing the Response to Remote Contact 
Input Opening and Closing (/R1 and /PM1 
options; release number 3 or later)

Set the remote contact input operation.

Setup Screen
Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 
setting mode), and select the Environment tab > Remote.

  

Setup Items

• Remote Input > 1 to 8
 Specify an operation for each remote control terminal. Five remote control terminals 

can be used for pulse input (/PM1 option).
Setting Description
N.O The remote signal rises when the contact input switches from open to 

closed, and it falls when the contact input switches from closed to open.
N.C The remote signal rises when the contact input switches from closed to 

open, and it falls when the contact input switches from open to closed.

   

Type
Remote
contact
input

Operation

Control operation

N.C

N.O Closed

ClosedClosed

OFF

ON

Open

Open

Open

Note
On models with the pulse input option (/PM1), the remote control input terminals can be 
used for pulse input. When pulses are counted, the number of rising pulse edges is counted, 
regardless of the Remote Input setting.
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8.1 Disabling the Key Operation (Key Lock 
Function)

Disable the key operation.
For a description of the function, see section 1.7.
This operation cannot be performed on DXs with the /AS1 advanced security 
option.

Setup Screen

• Selecting the Key Lock Function
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Environment tab > Security, Media save, Batch.

   

• Key Operation to Be Disabled
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Menu tab > Keylock.

   

Setup Items

• Security > Key
 Select Keylock.

Settings Description
Keylock Enables the key lock function. The Keylock item is displayed in the 

basic setting mode menu.
Login Enables the login function. See section 8.2.

• Keylock > Password
 The password used to release the key lock. (Up to 8 characters, A a # 1 )
 The password is displayed as “********” (release number 3 or later).

Chapter 8 Using the Security Function
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• Keylock > Key action, Media/USB, Action of Function
 Select whether to lock each item.

Settings Description
Free Key lock not applied.
Lock Disables the operation.

Procedure

• Locking the Keys
1. In the operation mode, press FUNC.

 The FUNC key menu appears.

2. Press the Keylock soft key.

 The key lock is activated. The key lock icon appears in the status display section.

• Releasing the Key Lock
1. In the operation mode, press FUNC.

 The FUNC key menu appears.

2. Press the Keylock soft key.

 A window appears for you to enter the password.

     

3. Enter the password and press DISP/ENTER.

 The key lock is released. The key lock icon in the status display section 
disappears.
* The password that you entered is displayed as “********.”

8.1  Disabling the Key Operation (Key Lock Function)
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8.2 Enabling Only Registered Users to Operate the 
DX (Login Function)

Only registered users can operate the DX.
For a description of the function, see section 1.7.
For information about using this function on a DX with the /AS1 advanced 
security option, see the Advanced Security Function (/AS1) User’s Manual, 
IM04L41B01-05EN.

Setup Screen

• Login Function
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Environment tab > Security, Media save, Batch.

   

• Logout Method
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Menu tab > Login > Basic settings.
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• Registering Administrators
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Menu tab > Login > Admin settings.

   

• Registering Users
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Menu tab > Login > User settings.

   

• User Privileges
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Menu tab > Login > Authority of user.

   

8.2  Enabling Only Registered Users to Operate the DX (Login Function)
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Setup Items
The login function can be set separately for login through keys and login through 
communications.
• Security > Key
 Select Login.

Settings Description
Login Enables only registered users to operate the DX using keys. The Login 

item is displayed in the basic setting mode menu.
Keylock Enables the key lock function. See section 8.1.
Off Disables the security functions.

• Security > Communication
Settings Description
Login Enables only registered users to operate the DX via communications. The 

Login item is displayed in the basic setting mode menu.
Off Disables the security functions.

• User basic settings > Auto logout
Settings Description
Off Does not log out until the logout operation is executed.
1min to 10min Automatically logs out when there is no key operation for a specified time.

• User basic settings > Operation without login
 Sets the operation that the user can carry out when logged out.

Settings Description
Off Only login operation is available.
Display Allows the user to switch the operation screen in addition to the login operation.

• Admin number
 Up to five administrators can be registered. Be sure to register at least one 

administrator. At least one administrator must be registered to use the login function.

• Admin settings > Mode
 The available settings vary depending on the Security setting.

Settings Description
Off Not register.
Key Log into the DX using keys.
Comm Log into the DX via communications.
Web Log into the operator page and monitor page of the DX using a Web browser.
Key+Comm Log into the DX using keys and via communications.

• Admin settings > User name
 Set the user name. (Up to 20 characters, A a # 1 )

• You cannot register user names that are already registered.
• You cannot register “quit” or a user name containing all spaces.

• Admin settings > Password
 Set the password. (Release numbers 3 and later: up to 8 characters. Release 

numbers 4 and later: up to 20 characters. A a # 1 )
 Unregistered password is displayed as “????????.” An entered password is displayed 

as “********.”
• You cannot register “quit” or a password containing all spaces.

8.2  Enabling Only Registered Users to Operate the DX (Login Function)
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• User number
 Up to 30 users can be registered.

• User settings > Mode
 The available settings vary depending on the Security setting.

Settings Description
Off Not register.
Key Log into the DX using keys.
Comm Log into the DX via communications.
Web Log into the monitor page of the DX using a Web browser.
Key+Comm Log into the DX using keys and via communications.

• User settings > User name, Password
 See the explanation for the administrator user name and password.

• Authority of user
Settings Description
Off No limitations on the operation.
1 to 10 Registration number of the operation limitation.

• Authority of user > Key action, Media/USB, Action of Function
 See section 8.1.

8.2  Enabling Only Registered Users to Operate the DX (Login Function)
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8.3 Logging in and Logging Out

This section explains the procedure to log into the DX using keys. For the procedure to 
log into the DX via communications, see the Communication Interface User’s Manual, 
IM04L41B01-17E.
For information about using this function on a DX with the /AS1 advanced 
security option, see the Advanced Security Function (/AS1) User’s Manual, 
IM04L41B01-05EN.

Procedure

• Logging In
1. In the operation mode, press FUNC.
 A list of registered user names appears.

     

2. Press the arrow keys to select a user name, and press DISP/ENTER.
 A window appears for you to enter the password.

     

3. Enter the password* and press DISP/ENTER.
 The DX is ready to be operated using keys. The name of the user that is logged in 

is displayed in the status display section.
* The password that you enter is displayed as “********.”

• Logging Out
 Using Keys

1. In the operation mode, press FUNC.
The FUNC key menu appears.

2. Press the Logout soft key.
 You are logged out from the DX. The user name in the status indication section 

disappears.
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 Auto Logout
 If auto logout is enabled, you are automatically logged out if there is no key operation 

for a specified time.

• Changing the Password
 Using Keys

1. In the operation mode, press FUNC.

 The FUNC key menu appears.

2. Press the Password change soft key.

 A window appears for you to enter the current password.

3. Enter the current password and press DISP/ENTER.

 A window appears for you to enter the new password.

4. Enter the new password and press DISP/ENTER.

 A window appears for you to enter the new password again.

5. Enter the new password and press DISP/ENTER.

 The window closes, and the new password is activated.

8.3  Logging in and Logging Out
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9.1 Setting the Expression, Measurement Range, Alarm, 
Tag, and Data Storage on Computation Channels

This section explains how to set a computation channel’s expression, measurement 
range, tag, alarm, and recording On/Off. You cannot set expressions or constants while 
memory sampling or computation is in progress.
For a description of the function, see section 1.8.

Setup Screen
• Expression and Alarm
 Press MENU (to switch to setting mode), and select the Menu tab > Math channel > 

Calculation expression, Alarm.

   

• Constants Used in Expressions
 Press MENU (to switch to setting mode), and select the Menu tab > Math channel > 

Constant.

   

• Tag, Memory Sampling On/Off, and Alarm Delay Time of Computation  Channels
 Press MENU (to switch to setting mode), and select the Menu tab > Math channel > 

Tag, Memory sample, Alarm delay.

   

Chapter 9 Computation and Report Functions (/M1 and /PM1 Options)
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• Conditions of TLOG Computation and Rolling Average
 Press MENU (to switch to setting mode), and select the Menu tab > Math channel > 

TLOG, Rolling average.

   

• Display for Computation Errors and Handling of Overflow Data in 
Statistical Computation

 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 
setting mode), and select the Environment tab > Math, Report.

   

Setup Items
• First-CH/Last-CH
 Set the target channels.

• Calculation expression and Span
 • Math On/Off

 Select On for channels to be used.
 • Calculation expression

 Enter the expression using up to 120 characters.
 Pressing the Input soft key displays a window used to enter the expression. Use 

the numeric keys to enter numbers and operators.

    

 For details on how to write expressions, see section 9.2.

Note
You cannot use both the USB keyboard (/USB1 option) and the DX keys to enter the equation. 
If you press a DX soft key, for example, while you are entering an equation from the USB 
keyboard, the entered equation is cleared.

9.1  Setting the Expression, Measurement Range, Alarm, Tag, and Data Storage on Computation Channels
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 • Span Lower, Span Upper
 Set the measurement range.
 Selectable range of values: –9999999 to 99999999
 Selectable decimal places: X.XXXX, XX.XXX, XXX.XX, XXXX.X

 • Unit
 Set the unit of the computed value (Up to 6 characters, A a # 1 ).

• Alarm
 The available alarm types are high limit alarm, low limit alarm, delay high limit alarm, 

and delay low limit alarm.
 The range of alarm values is as follows:

Type Value
H, L, T, t Within –9999999 to 99999999 excluding the decimal point

 For details on setting alarms, see section 3.7.
* If the Math On/Off or calculation expression is changed, the alarms for that channel are turned 

Off.

• Alarm delay > Time
 Set the alarm delay time using an integer in the range of 1 to 3600 s.

• Tag > Comment
 Sets the tag comment. On a DX with a release number of 3 or later, you can enter up 

to 32 characters. On a DX with a release number of 2 or earlier, you can enter up to 
16 characters. The characters that can be entered are: A a # 1 .

• Tag > No. (Release number 3 or later)
 This setting only appears when you have enabled the use of tag numbers.
 Sets the tag number. (Up to 16 characters: A a # 1 )

• Constant
 • Number of constant

 Select the constant (K01 to K60) to set.
 • Value

 The selectable range is as follows:
 –9.9999E+29 to –1.0000E–30, 0, 1.0000E–30 to 9.9999E+29
 The number of significant digits of a constant is five. When specifying the 

constant using exponential notation, set the mantissa less than or equal to 5 
digits and the exponent less than or equal to 2 digits.

• TLOG
 • Timer type

 You can set the timer type to Timer or Match T (match time timer).
 • Timer No.

 Select the timer number to use.
 For details on setting the timer, see section 7.1.
 For match time timer setting instructions, see section 7.1.

 • Sum scale
 Set the sum scale to /s to /h to match the unit of the measured value.
 Example: If the unit of the measured value is “m3/min,” select /min.
 Off: Sums as-is the measured data per scan interval.

 • Reset
 To reset the TLOG computed value at each interval, select On.

9.1  Setting the Expression, Measurement Range, Alarm, Tag, and Data Storage on Computation Channels
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• Rolling average
 • On/Off

 To take the rolling average of the measured results, select On.
 • Interval

 Select the sampling interval when taking the rolling average from the following: 
The sampling interval takes on a value that is an integer multiple of the scan 
interval. For example, if the sampling interval is set to 5 s when the scan interval 
is 2 s, the actual sampling interval is 6 s.

 • Number of samples
 Set the number of samples for the rolling average using an integer between 1 

and 1500.
 The rolling average time is equal to the sampling interval × the number of 

samples.

Note
• If the number of data points to be averaged has not reached the specified number of 

samples immediately after computation is started, the average of the available data is 
calculated.

• Computation error data is excluded from the rolling average computation.
• If the computed data exceeds the upper or lower limit, the data is clipped at the upper or 

lower limit, and the rolling average is computed. The upper and lower limit is “±100000000” 
excluding the decimal point. The decimal place is the same as that of the span lower limit.

• Memory sample > On/Off
 Select On  to record the computed data of the target channels.

• Math
 • Value on Error

 Specify whether to set the display for a computation error to +Over or –Over.
 • Value on Overflow > SUM, AVE

 Specify how to handle overflow data when it is detected in the SUM or AVE 
computation of TLOG or CLOG. This setting is also applied to report generation.

Settings Description
Error Sets the computed result to computation error.
Skip Discards the overflow data and continues the computation.
Limit Uses a limit value in place of the overflow data and continues the computation.

 • Value on Overflow > MAX, MIN, P-P
 Specify how to handle overflow data when it is detected in the MAX, MIN, or P-P 

computation of TLOG or CLOG. This setting is also applied to report generation.
Settings Description
Over Uses the overflow data as-is.
Skip Discards the overflow data and continues the computation.

9.1  Setting the Expression, Measurement Range, Alarm, Tag, and Data Storage on Computation Channels
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9.2 Writing Expressions

This section explains the meaning and how to write expressions.

Common Items
Follow the rules below when writing expressions.
• Use up to 120 characters to write expressions.
• The precedence of computing terms can be specified using parentheses.
• Specify the channels in the expression using channel numbers.
 Example: 1, 12, 101, and 201
• The one-digit number of constants (K), communication input data (C), remote input 

terminal status (D), pulse input (P, Q), internal switch (S), alarm output relay status 
(I), flag (F), and recording (memory sampling) status (M) in the expression can be 
denoted as in “01” and “1.”

 Example: K01, K1, C01, C1, D01, D1, P01, P1, Q01, Q1, S01, S1, I01, I1, F01, and F1.
• The data of the previous scan is used in the computation for its own channel number 

and channel numbers greater than its own channel number in the expression.
• Special computation (HOLD, RESET, and CARRY) and conditional expressions are 

written at the beginning of the expression.

Order of Precedence in Computations
The order of precedence of computation in expressions is as follows:

Type Computing Element
(high order of precedence)

Function ABS(), SQR(), LOG(), LN(), EXP(), 
TLOG.MAX(), TLOG.MIN(), TLOG.
AVE(), TLOG.SUM(), TLOG.P-P(), 
CLOG.MAX(), CLOG.MIN(), CLOG.
AVE(), CLOG.SUM(), CLOG.P-P()

Special computation and conditional expression PRE, HOLD, RESET, CARRY, [a?b:c]
Power **
Logical negation NOT
Multiplication and division *, /
Addition and subtraction +, –
Greater than and less than .GT., .LT., GE., LE.
Equal and not equal .EQ., .NE.
Logical product AND
Logical sum and exclusive logical sum OR, XOR

(low order of precedence)

Limitations
The following limitations exists in writing expressions.

Type Limitations
TLOG computation A computing element cannot be written inside the parentheses.

Only one TLOG computation can be specified in a single expression.
CLOG computation Number of channels that can be written in the parentheses is 30 channels or less.

A computing element cannot be written inside the parentheses.
Only one CLOG computation can be specified in a single expression.

PRE A computing element cannot be written inside the parentheses.
HOLD(a):b Can only be written at the beginning of an expression.

Only one HOLD computation can be specified in a single expression.
RESET(a):b Can only be written at the beginning of an expression.

Only one RESET computation can be specified in a single expression.
CARRY(a):b Can only be written at the beginning of an expression.

Only one CARRY computation can be specified in a single expression.
Only TLOG.SUM can be written in “b.”

Conditional equation 
[a?b:c]

RESET, CARRY, or HOLD cannot be written to “a,” “b,” or “c.” Other computing 
elements cannot be combined (example: [a?b:c]+001). However, conditional 
equations can be specified for a, b, and c.
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Four Arithmetic Operation
Expression Example
• Addition 001+002

 (Determines the sum of the measured values of channel 1 and channel 2.)
• Subtraction 001–002
 (Determines the difference of the measured values of channel 1 and 

channel 2.)
• Multiplication 001*K03
 (Multiplies constant K03 to the measured value of channel 1.)
• Division 001/K02
 (Divides the measured value of channel 1 by constant K02.)

Power and Other Computations
Expression Example
• Power 001**002
 (Determines the measured value of channel 1 to the power of the 

measured value of channel 2.)
• Square root SQR(002)

 (Determines the square root of the measured value of channel 2.)
• Absolute value ABS(002)
  (Determines the absolute value of the measured value of channel  

 2.)
• Common logarithm LOG(001)
  (Determines the common logarithm (log10) of the measured value  

 of channel 1.)
• Natural logarithm LN(001)
  (Determines the natural logarithm of the measured value of  

 channel 1.)
• Exponent EXP(001)
  (Determines e to the power of the measured value of channel 1.)

Relational Computation
Expression Example
002.LT.003
If the measured value of channel 2 is less than the measured value of channel 3, the 
computed result is “1.” Otherwise, the result is “0.”

002.GT.003
If the measured value of channel 2 is greater than the measured value of channel 3, the 
computed result is “1.” Otherwise, the result is “0.”

002.EQ.003
If the measured value of channel 2 is equal to the measured value of channel 3, the 
computed result is “1.” Otherwise, the result is “0.”

002.NE.003
If the measured value of channel 2 is not equal to the measured value of channel 3, the 
computed result is “1.” Otherwise, the result is “0.”

002.GE.003
If the measured value of channel 2 is greater than or equal to the measured value of 
channel 3, the computed result is “1.” Otherwise, the result is “0.”

002.LE.003
If the measured value of channel 2 is less than or equal to the measured value of channel 3, 
the computed result is “1.” Otherwise, the result is “0.”

9.2  Writing Expressions
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Logical Computation
Checks whether the two data values, e1 and e2 (e1 only for NOT), are zeroes or non-
zeroes, and computes according to the conditions.
AND
Logical product
(Syntax) e1ANDe2
(Condition)  If the two data values e1 and e2 are both non-zeroes, the computed 

result is “1.” Otherwise, it is “0.”
(Explanation)	 e1	=	0,	e2	=	0	 →	 e1ANDe2	=	0
	 e1	≠	0,	e2	=	0	 →	 e1ANDe2	=	0
	 e1	=	0,	e2	≠	0	 →	 e1ANDe2	=	0
	 e1	≠	0,	e2	≠	0	 →	 e1ANDe2	=	1

OR
Logical sum
(Syntax) e1ORe2
(Condition)  If the two data values e1 and e2 are both zeroes, the computed result 

is “0.” Otherwise, it is “1.”
(Explanation)	 e1	=	0,	e2	=	0	 →	 e1ORe2	=	0
	 e1	≠	0,	e2	=	0	 →	 e1ORe2	=	1
	 e1	=	0,	e2	≠	0	 →	 e1ORe2	=	1
	 e1	≠	0,	e2	≠	0	 →	 e1ORe2	=	1

XOR
Exclusive OR
(Syntax) e1XORe2
(Condition)  If the two data values e1 and e2 are zero and non-zero or non-zero 

and zero, the computed result is “1.” Otherwise, it is “0.”
(Explanation)	 e1	=	0,	e2	=	0	 →	 e1XORe2	=	0
	 e1	≠	0,	e2	=	0	 →	 e1XORe2	=	1
	 e1	=	0,	e2	≠	0	 →	 e1XORe2	=	1
	 e1	≠	0,	e2	≠	0	 →	 e1XORe2	=	0

NOT
Logical negation
(Syntax) NOTe1
(Condition) The result is the inverse of the status of data e1 (zero or non-zero).
(Explanation)	 e1	=	0	 	 →	 NOTe1	=	1
	 e1	≠	0	 	 →	 NOTe1	=	0

Expression Example
01-02OR03.GT.04
Determines the OR of the computed results of “01-02” and “03.GT.04”.

9.2  Writing Expressions
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TLOG Computation
In the explanation below, an expression containing a computing element in e1, an 
internal switch (S), a relay (I), or flag (F) cannot be written. In addition, only one TLOG 
computation can be specified in a single computing equation.
TLOG.MAX( )
Maximum value
(Syntax) TLOG.MAX(e1)
(Condition) Determines the maximum value of channel e1.

TLOG.MIN( )
Minimum value
(Syntax) TLOG.MIN(e1)
(Condition) Determines the minimum value of channel e1.

TLOG.AVE( )
Average value
(Syntax) TLOG.AVE(e1)
(Condition) Determines the average value of channel e1.

TLOG.SUM( )
Sum value
(Syntax) TLOG.SUM(e1)
(Condition) Determines the sum of channel e1.

TLOG.P-P( )
Maximum - minimum value
(Syntax) TLOG.P-P(e1)
(Condition) Determines the maximum - minimum value of channel e1.

Expression Example
TLOG.MAX(01)+K01*SQR(02)

Examples of Equations That Are Not Allowed
TLOG.AVE(01)+TLOG.AVE(02)
Reason: TLOG appears twice in one equation.

TLOG.AVE(ABS(01))
Reason: A computing element is used inside the parentheses.

9.2  Writing Expressions
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CLOG Computation
Only data of measurement channels, computation channels, and external input channels 
can be used in the CLOG computation. Up to 30 channels can be written in the 
parentheses.
In the explanation below, an expression containing a computing element cannot be 
written to e1, etc. In addition, only one CLOG computation can be specified in a single 
computing equation.
CLOG.SUM( )
Sum value
(Syntax) CLOG.SUM(e1.e2.e4-e6)
(Condition)  Determines the sum of the data of channels e1, e2, e4, e5, and e6 that 

are measured at the same time.

CLOG.MAX( )
Maximum value
(Syntax) CLOG.MAX(e1.e2.e4-e6)
(Condition)  Determines the maximum value among the data of channels e1, e2, 

e4, e5, and e6 that are measured at the same time.

CLOG.MIN( )
Minimum value
(Syntax) CLOG.MIN(e1.e2.e5.e7)
(Condition)  Determines the minimum value among the data of channels e1, e2, e5, 

and e7 that are measured at the same time.

CLOG.AVE( )
Average value
(Syntax) CLOG.AVE(e1-e6)
(Condition)  Determines the average value among the data of channels e1 to e6 

that are measured at the same time.

CLOG.P-P( )
Maximum - minimum value
(Syntax) CLOG.P-P(e1.e2.e5.e7)
(Condition)  Determines the difference between the maximum and minimum values 

among the data of channels e1, e2, e5, and e7 that are measured at 
the same time.

Expression Example
CLOG.MAX(001.002.104-106)+K01*SQR(002)

Examples of Equations That Are Not Allowed
CLOG.AVE(001.003.005)+CLOG.AVE(002.004.006)
Reason: CLOG appears twice in one equation.

CLOG.AVE(001.ABS(001))
Reason: A computing element is used inside the parentheses.

9.2  Writing Expressions
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Special Computation
PRE( )
(Syntax) PRE(e1)
(Condition) Determines the previous value of e1.

HOLD(a):b
(Syntax) HOLD(a):b
(Condition)  When a is zero, b is carried out to derive the computed value. 

Otherwise, the previous computed value is held.

RESET(a):b
(Syntax) RESET(a):b
(Condition)  When a is zero, b is carried out to derive the computed value. 

Otherwise, the previous computed value of b is reset, and b is carried 
out to derive the computed value.

CARRY(a):b
(Syntax) CARRY(a):b
(Condition)  Only TLOG.SUM can be specified for b. If the computed value X of b is 

less than a, the computed result is X. If X is greater than or equal to a, 
the computed result is the excess (X – a).

(Description) When a value such as the flow rate is summed and the threshold value 
is reached or exceeded, the sum value is reset while carrying over the 
amount that exceeded the threshold value.

Expression Example
Expression that sums the values of channel 1 and resets the value when it reaches or 
exceeds 10000
K01 = 10000
CARRY(K01):TLOG.SUM(001)

Examples of Equations That Are Not Allowed
002+HOLD(K01):TLOS.SUM(001)
Reason: HOLD is not at the beginning of the expression.

RESET(101.GT.K01):TLOG.SUM(001)+RESET(101.GT.K01):002
Reason: RESET appears twice in one equation.

Conditional Expression
[a?b:c]
(Syntax) [001.GT.K01?002:003]
(Condition)  If the measured value of channel 1 is greater than constant K01, the 

computed result is the measured value of channel 2. Otherwise, the 
computed result is the measured value of channel 3.

Examples of Equations That Are Not Allowed
[001.GT.K01?002:003]*K02
Reason: Used in combination with another computing element.

Nested Conditional Expressions
A conditional expression can be written to Expression1, Expression2, and Expression3 
in the equation [Expression1?Expression2:Expression3]. For example, the following 
expression is allowed: [Equation1?[Equation2-1?Equation2-2:Equation2-3]:[Equation3-

1?Equation3-2:Equation3-3]]
Expressions can be nested as long as the number of characters of the expression does 
not exceed 120 characters.

9.2  Writing Expressions



9-11IM 04L42B01-01E

C
om

putation and R
eport Functions (/M

1 and /PM
1 O

ptions)

1

2

3

4

5

6

7

8

9

10

11

12

13

App

Index

9.3 Displaying the Computation Channels

Computation channels can be assigned to groups and displayed in a similar manner to 
measurement channels.
For a description of the function, see section 1.8.

Setup Screen
• Color
 Press MENU (to switch to setting mode), and select the Menu tab > Math channel > 

Color.

   

• Zone Display, Scale Display, and Bar Graph Display
 Press MENU (to switch to setting mode), and select the Menu tab > Math channel > 

Zone, Scale, Bar graph.

   

• Partial Expanded Display
 Press MENU (to switch to setting mode), and select the Menu tab > Math channel > 

Partial.
* The Partial command appears in the menu if you set Partial to On in Basic Setting Mode.
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• Alarm Marks and Color Scale Band
 Press MENU (to switch to setting mode), and select the Menu tab > Math channel > 

Alarm mark, Color scale band.

   

Setup Items

• Channel Numbers, First-CH, and Last-CH
 Select the target channel range. 

• Color
 See section 5.5.

• Zone
 See section 5.6.

• Partial
 See section 5.9.

• Bar graph
 See section 5.11.

• Scale
 See section 5.7.

• Alarm Marks and Color Scale Band
 See section 5.8.

9.3  Displaying the Computation Channels
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9.4 Starting/Stopping Computation, Resetting 
Computation, and Releasing Computation Data 
Dropout Display

Setup Screen

• Action Taken When the START Key Is Pressed
 Press MENU (to switch to setting mode), and select the Menu tab > Math channel > 

Math start action.

   

Setup Items

• Math start action > Math start
Settings Description
Off Does not start the computation even when the START key is pressed.
Start Starts the computation when the START key is pressed.
Rst+St Resets the computed result up to then and starts the computation when the 

START key is pressed.

Procedure

• Starting the Computation
 •  Starting the Computation Simultaneously with the Memory 

Sampling
 Press START. Computation starts simultaneously with the start of the memory 

sampling. The computation icon appears in the status display section.
* Math start must be set to Start or Rst+St.

 • Starting Only the Computation
1. In the operation mode, press FUNC.

 The FUNC key menu appears.

2. Press the Math start soft key.

 Computation starts, and the computation icon is displayed in the status display 
section.
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• Stopping the Computation
 •  Stopping the Computation Simultaneously with the Memory 

Sampling
1. Press STOP.
 A confirmation dialog box appears.

     

2. Select Mem+Math and press DISP/ENTER.
 The memory sampling and computation stop, and the computation icon in the 

status display section disappears.

 • Stopping Only the Computation
1. In the operation mode, press FUNC.
 The FUNC key menu appears.
2. Press the Math stop soft key.
 The computation stops, and the computation icon in the status display section 

disappears.
Note

When the computation is stopped, the computed data of the computation channel is held at the 
value that existed immediately before the computation is stopped. When memory sampling is in 
progress, the held value is recorded.

• Resetting the Computed Results on All Computation Channels
 This operation can be carried out when the computation is stopped. You can carry out this 

operation even while the computation is in progress on DXs with release number 2 or later.
1. In the operation mode, press FUNC.
 The FUNC key menu appears.
2. Press the Math reset soft key.
 The computed results of all computation channels are reset.

• Releasing the Computation Data Dropout Display
 This operation can be carried out when a computation data dropout occurs. When a 

computation data dropout occurs, the computation icon turns yellow.
1. In the operation mode, press FUNC.
 The FUNC key menu appears.
2. Press the Math ACK soft key.
 The computation icon returns to white.

* Math ACK is displayed in the FUNC key menu only when a computation data dropout occurs.

Note
A computation data dropout occurs when the computation process cannot be completed within 
the scan interval. If computation data dropout occurs frequently, lessen the load on the CPU by 
reducing the number of computation channels or setting a longer scan interval. If a computation 
data dropout occurs during memory sampling, the data immediately before the dropout is 
recorded as the computed data of the scan interval in which the dropout occurred.

9.4  Starting/Stopping Computation, Resetting Computation, and Releasing Computation Data Dropout 
Display
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9.5 Creating Reports

Set how the reports are created.
For a description of the function, see section 1.8.

Setup Screen

• Report Computation Type
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Environment tab > Math, Report.

   

• Report Type and Time of Creation
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Menu tab > Report > Basic settings.

   

• Source Channels
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Menu tab > Report > Report settings.

   



9-16 IM 04L42B01-01E

Setup Items

• Report > Report select > 1, 2, 3, and 4
 Select the type of data to output as reports. The only data type that can be set more 

than once is Off. You cannot set 1 to Off.
Settings Description
Off Does not output reports.
Ave Outputs the average value.
Max Outputs the maximum value.
Min Outputs the minimum value.
Sum Outputs the sum value.
Inst Outputs the instantaneous value.

• Report > File type
 Set this item when creating two types of reports such as daily report and monthly 

report.
Settings Description
Separate Saves each type of report to a separate file. For information about how files are 

divided, see section 1.4.
Combine Saves the report data of two types in a single file.
Seprt2 Saves each type of report to a separate file. For information about how files 

are divided, see section 1.4, or see section 1.2 in the Advanced Security 
Function (/AS1) User’s Manual. You cannot select Use Template when Seprt2 
is selected.

When you change the setting from Combine or Separate to Seprt2, or vice versa, the report 
data in the internal memory is cleared.

• Report > Use Template
 When you want to use a report template to create reports, select Use. You cannot use 

this function when Report > File type is set to Seprt2. The setting is fixed at Not.

• Report set > Report kind
Select the type of report to be created.
Settings Description
Hour Creates hourly reports.
Day Creates daily reports.
Hour+Day Creates hourly and daily reports.
Day+Week Creates daily and weekly reports.
Day+Month Creates daily and monthly reports.

• Report set > Date/Day of the week and Time (hour)
 Set the date or day of the week and the time when the report is to be created. The 

specified date/time is when the report file is divided. Set the values in the range 
indicated below. Items with a dash are invalid.
Report Type Date Day of Week Time
Hour - - 0 to 23
Day 1 to 28* - 0 to 23
Hour+Day - - 0 to 23
Day+Week - SUN to SAT 0 to 23
Day+Month 1 to 28* - 0 to 23
* You cannot specify 29, 30, or 31.

 Report Time and Date/Time When the Report File Is Divided
 Example: When the Date of a daily report is set to 1 and the Time (hour) is set to 

18:00
 A daily report is created every day at hour 18.
 The file storing the report is divided at 18:00 on day 1 of each month.

9.5  Creating Reports
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• Report Channel number
The report is output in order by this number.

• Report CH > On/Off
 Select On for the report channels to be used.

• Report CH > Channel
 Set the channel to assign to the report channel. All channels can be assigned, but 

reports are not created for channels set to Skip or Off even if they are assigned.
 In the stacked bar graph display (see section 4.11 for details), report data is displayed 

in the following groups. However, only channels that have the same unit as the first 
channel in the group are displayed.
Report Group DX2004, DX2008 DX2010, DX2020, DX2030, 

DX2040, DX2048
1 R01 to R10 R01 to R10
2 R11 to R20 R11 to R20
3 - R21 to R30
4 - R31 to R40
5 - R41 to R50
6 - R51 to R60

• Report CH > Sum scale
 Set the sum scale to /s to /day to match the unit of the measured value.
 Example: If the unit of the measured value is “m3/min,” select /min.
 Off: Sums as-is the measured data per scan interval.

• Handling of Overflow Data
 Overflow data is handled in the same way as it is in statistical computations (TLOG 

and CLOG).
 See section 9.1.

Procedure

• Starting/Stopping the Report Function
 Starting the memory sampling starts the report function. Likewise, stopping the 

memory sampling stops the report function.

• Displaying the Reports
 See section 4.5.

• Saving the Reports
 See section 1.4.

9.5  Creating Reports
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9.6 Creating a Report Template (Release numbers 
4 and later)

This section explains how to make a report template.
To create a report template, you put keywords and text into cells in Excel.
Keywords specify the data that will be entered into a cell. Other text is included in the 
report as it is written. Save the report templates that you create in XML spreadsheet 
format. The report template file name extension is .xml.
For a description of the function, see section 1.8.
For the setting procedure, see section 9.5.
To load or save a report template, see section 6.10.
Template Example

Channel Number $Ch(R01)$ $Ch(R02)$
Name Tank 1 temperature Tank 1 pressure
Unit $Unit(R01)$ $Unit(R02)$
$ReportDataTime(Hour)$ $ReportDataInst(Hour,R01)$ $ReportDataInst(Hour,R02)$
$Repeat$  $Repeat$ $Repeat$
$Repeat$ $Repeat$  $Repeat$

Report Example

Channel Number TIC-001 PIC-002
Name Tank 1 temperature Tank 1 pressure
Unit °C kPa
2010/04/01 00:00:00 76.5 45.6

2010/04/01 01:00:00 78.9 56.7

2010/04/01 02:00:00 77.7 50.8
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Keyword Format
Keywords are written by themselves or with parameters.

$ Keyword(parameter)$ Example: $ReportDataSum(Hour,R01,00,23)$

• Basic Rules
• The dollar sign on the left indicates the start of a keyword, and the dollar sign on 

the right indicates the end of a keyword.
• You can only write keywords using letters of the alphabet, dollar signs, parentheses, 

commas, and spaces. You can put a space after an opening parenthesis, before 
and after a comma, and before a closing parenthesis. There is no distinction 
between uppercase and lowercase letters. You cannot use a dollar sign inside of a 
keyword.

• The maximum length of a keyword, including spaces, is 100 characters.

• Parameter Rules
• Parameters are enclosed in parentheses.
• Multiple parameters (up to 4) are separated by commas.
• Examples of how parameters can be omitted are shown below.

$ReportDataSum(Hour, R01, ,23)$ The third parameter is omitted.
$ReportDataSum(Hour, R01, 01, )$ or The fourth parameter is omitted.
$ReportDataSum(Hour, R01, 01)$

• Rules That Relate to Excel
• Set the data format by setting the cell format.
• Set the proper format for each keyword’s cell in the cell’s Number properties.
• The keyword in a cell is only valid when the keyword name and parameters are 

all in the same format. When a keyword’s font size or some other property is not 
consistent, it is invalid.
$ReportDataSum(Hour, R01, 00, 23)$ The font size of “Hour” is different, so the 

keyword is invalid.

• When a single cell contains text and a keyword, only the format of the keyword has 
to be consistent. The format of the text can be different.
Date and time: $DateTime$ The format of the keyword is consistent, 

so it is valid.

9.6  Creating a Report Template (Release numbers 4 and later)
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Keyword Definitions
For examples of how to use the keywords, see “Report Template Examples.”

• System Keywords
 One keyword produces one item of data.

Keyword Description Format
Time Current time on the DX Time
Date Current date on the DX Date
DateTime Current date and time on the DX
DateTimeString Current date and time on the DX Character string
Serial DX serial number
FileHeader DX file header
Ch Channel number*1

Tag Tag comments*1

ChId Tag number*1

Unit Unit*1

*1 The parameter is the report channel number (it cannot be omitted).

• Report Data Keywords
 One keyword produces multiple items of data.

Keyword Description Format
ReportDataDate Report creation date*1 Date
ReportDataTime Report creation time*1 Time
ReportDataDateTime Report creation date and time*1 Date
ReportDataDateTimeString Report creation date and time*1 Character string
ReportDataStatus Report data status*2 Character string
ReportDataSum Report data sum*2 Number or character string*3
ReportDataInst Instantaneous report data value*2
ReportDataAve Average report data value*2
ReportDataMax Maximum report data value*2
ReportDataMin Minimum report data value*2
*1 List the parameters in this order: report type (cannot be omitted), report start date and time 

(can be omitted), report end date and time (can be omitted).
*2 List the parameters in this order: report type (cannot be omitted), report channel number 

(cannot be omitted), report start date and time (can be omitted), report end date and time (can 
be omitted).

*3 The decimal point type (dot or comma) depends on whether the converted data is a value or 
character string.

 Whether the converted data is a value or character string depends on the format of the cell 
that the keyword is written in. When the cell format is numerical, the decimal point type is 
determined by the cell format. When the cell format is text, the decimal point type matches 
the format of the report data.

• Special Keywords
Keyword Description Format
Repeat Specifies the output location of the data that 

corresponds to a report data keyword.
The same as the corresponding 
keyword.

Comment Adds comments to the template. Nothing is 
displayed after template conversion.

–

9.6  Creating a Report Template (Release numbers 4 and later)
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• Parameters
Parameter Format Range Description
Report kind Hour Hourly report

Day Daily report
Week Weekly report
Month Monthly report

Report channel number Rxx  
(xx are numerals)

R01 to R60  
(varies by model)

DX report channel

Start date or time xx 
(xx are numerals)

00 to 23 Specifies the start time
01 to 31 Specifies the start date

End date or time xx 
(xx are numerals)

00 to 23 Specifies the end time
01 to 31 Specifies the end date

Starting and Ending Dates and Times
Use the start date and time and end date and time to specify the parts of the report  
file’s report data that you will output to the file that you create with the template. You can 
specify the starting and ending dates (for daily reports) or times (for hourly reports).
Example when the report type is hourly and the report was created at 18:00.

  
18:00 19:00

Report file 1 Report file 2

Report
creation time

$ReportDataSum(Hour,R01,20,22)$ $ReportDataSum(Hour,R01,16,19)$

20:00 21:00 22:00 16:00 17:00 18:00 19:00

Keyword: $ReportDataSum(Hour,R01,20,22)$
 From the hourly data from 19:00:01 to 22:00:00, the report data (sums) of report 

channel R01 for 20:00, 21:00, and 22:00 is output.

Keyword: $ReportDataSum(Hour,R01,16,19)$
 From the hourly data from 15:00:01 to 19:00:00, the report data (sums) of report 

channel R01 for 16:00, 17:00, and 18:00 is output. Because the report data for 
19:00 is in another report file, it is not output.

Keyword: $ReportDataSum(Hour,R01)$
 One file’s worth (18:00:01 to 18:00:00) of data from report channel R01 is output, 

starting from 19:00.
 When you omit the start and end times for an hourly report, the data for the hour 

after the report creation time until the 24th hour is output. For daily reports, the data 
for the day after the report creation time until the end of the month is output.

Keyword: $ReportDataSum(Hour,R01,08)$
 From the hourly data from 07:00:01 to 18:00:00, the report data (sums) of report 

channel R01 for 08:00 to 18:00 is output.

9.6  Creating a Report Template (Release numbers 4 and later)
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Report Template Examples
• System Keyword Examples
 Mixing a keyword and text

File header: $FileHeader$

Date and time: $DateTime$
↓

File header: DX2000

Date and time: 2010/01/01 12:00:000

 Mixing multiple keywords and text

Device number: $Serial$ File Header: $FileHeader$

↓
Device number: ABCDEFG File Header: DX2000

• Report Data Keyword Examples
 The following examples are for when the hourly report data for report channel R01 is 

101, 102, 103, 104, and 105 and the hourly report data for report channel R02 is 201, 
202, 203, 204, 205, and 206.

 The $Repeat$ command applies to the closest keyword above the command in the 
same column.

$ReportDataInst(Hour,R01)$ 101
$Repeat$ 102
$Repeat$ 103
$Repeat$ → 104
$ReportDataInst(Hour,R02)$ 201
$Repeat$ 202
$Repeat$ 203
$Repeat$ 204
$Repeat$ 205

 The $Repeat$ command applies to the keyword above it in the same column, even 
when that keyword is not directly above the command.

$ReportDataInst(Hour,R01)$ 101
$Unit(R01)$ °C

$Repeat$ 102
$Unit(R01)$ → °C

$Repeat$ $Unit(R01)$ 103 °C

 You can mix system keywords, report data keywords, and text. If the data specified by 
a keyword does not exist, nothing is output.

$ReportDataInst(Hour,R01)$($Unit(R01)$) 101(°C)
$Repeat$ 102
$Repeat$ 103
$Repeat$($Unit(R01)$) → 104(°C)
$Repeat$(°C) 105(°C)
$Repeat$

9.6  Creating a Report Template (Release numbers 4 and later)
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 Keywords in merged cells are affected by the leftmost cells above them.

$ReportDataInst(Hour,R01)$ $ReportDataInst(Hour,R02)$
$Repeat$ $Repeat$

$Repeat$ $Repeat$
$Repeat$ $Repeat$
↓
101 201
102 202

203
103 204

 When a keyword is written incorrectly or its formatting is wrong, the keyword will be 
output to the file as it is written.

$ReportDataInst(Hour,R)$ $ReportDataInst(Hour,R)$
→

$ReportDataInst(Hour,R02)$ 201
$Repeat$ $Repeat$
$Repeat$ 202
$Repeat$ 203
$Repeat$ 204

$ReportDataInst(Hour,R01)$
$ReportDataInst(Hour,R02)$

*1 101
$ReportDataInst(Hour,R02)$

*1 When there are multiple system keywords in the same cell, only the first keyword is valid.

9.6  Creating a Report Template (Release numbers 4 and later)
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10.1 Setting External Input Channels

External input channels can be used on the DX2010, DX2020, DX2030, DX2040, and 
DX2048. The data of other devices loaded using the communication function can be 
displayed on the DX and saved.

Setup Screen

• Setting the Input
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to 

basic setting mode), and select the Menu tab > Communication (Ethernet) or 
Communication (Serial) > Modbus client or Modbus master > Command 
settings.

   

• Input Range and Alarm
 Press MENU (to switch to setting mode), and select the Menu tab > Ext. channel > 

Range, Alarm.

   

Chapter 10 Using External Input Channels (/MC1 Option)
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• Tag, Memory Sample, and Alarm Delay Time
 Press MENU (to switch to setting mode), and select the Menu tab > Ext. channel > 

Tag, Memory sample, Alarm delay.

   

10.1  Setting External Input Channels
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Setup Items

• Setting the Input
 The measured values of external instruments are loaded using the Modbus client or 

Modbus master function to be used as external input channel inputs.
 For the setup procedure, see the Communication Interface User’s Manual, 

IM04L41B01-17E.

• First-CH/Last-CH
 Select the target channels. Channel numbers are 201 to 440.

• Ext. range > On/Off
 Select On to use the external input channel.

• Ext. range > Span Lower and Span Upper
 Measurement range.
 Selectable range of values: –30000 to 30000
 Decimal place: Down to four digits to the left of the decimal point

10.1  Setting External Input Channels
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• Ext. range > Unit
 Set the unit. (Up to 6 characters, A a # 1 ;	for	release	numbers	3	and	later:	°,	Ω,	and	μ.)

• Alarm
 The available alarm types are high limit alarm, low limit alarm, delay high limit alarm, 

and delay low limit alarm.
 The range of alarm values is as follows:

Type Value Example of a Range of Alarm Values
H, L Within –30000 to 30000 

excluding the decimal point.
Within –3000.0 to 3000.0 when the span 
is 0.0 to 100.0.

T, t Same as H and L Same as H and L

 For details on setting alarms, see section 3.7.
* If the external input channel On/Off or the decimal place of the span setting is changed, the 

alarms for that channel are turned Off.

• Tag > Comment
 Sets the tag comment. On a DX with a release number of 3 or later, you can enter up 

to 32 characters.
 On a DX with a release number of 2 or earlier, you can enter up to 16 characters. The 

characters that can be entered are: A a # 1 .

• Tag > No. (Release number 3 or later)
 This setting only appears when you have enabled the use of tag numbers.
 Sets the tag number. (Up to 16 characters: A a # 1 )

• Memory sample > On/Off
 Turn On the target channels.

• Alarm delay > Time
 For details on setting the alarm delay time, see section 3.7.

10.1  Setting External Input Channels
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10.2 Displaying the External Input Channels

External input channels can be assigned to groups and displayed in a similar manner to 
measurement channels. See chapter 5.

Setup Screen

• Channel Display Color
 Press MENU (to switch to setting mode), and select the Menu tab > Ext. channel > 

Color.

   

• Zone Display, Scale Display, and Bar Graph Display
 Press MENU (to switch to setting mode), and select the Menu tab > Ext. channel > 

Zone, Scale, Bar graph.
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• Partial Expanded Display
 Press MENU (to switch to setting mode), and select the Menu tab > Ext. channel > 

Partial.
* The Partial command appears in the menu if you set Partial to On in Basic Setting Mode.

   

• Alarm Marks and Color Scale Band
 Press MENU (to switch to setting mode), and select the Menu tab > Ext. channel > 

Alarm mark, Color scale band.

   

Setup Items

• Channel Numbers, First-CH/Last-CH
 Select the target channel range. Channel numbers are 201 to 440.

• Color
 See section 5.5.

• Zone
 See section 5.6.

• Partial
 See section 5.9.

• Bar graph
 See section 5.11.

• Scale
 See section 5.7.

• Alarm Marks and Color Scale Band
 See section 5.8.

10.2  Displaying the External Input Channels
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11.1 A List of Messages

There are cases in which error codes and messages are displayed on the screen during 
operation. A list of the possible error codes and messages are given in the table below. 
Communication error codes and messages are also listed.
Error responses to communication commands are output in English.

Errors Related to Parameter Settings
• Setting Errors
Code Message Explanation/Countermeasures/Ref. section
1 System error. Contact your nearest YOKOGAWA dealer.
2 Incorrect date or time setting. Enter a correct value.
3 A disabled channel is selected. Specify a channel that is not set to Skip or Off.

Specify a channel that is installed.
4 Incorrect function parameter. See chapter 3 the communication manual.
5 The input numerical value exceeds the set range. Enter a proper value.
6 Incorrect input character string. Enter a proper character string.
7 Too many characters. Enter the correct number of characters.
8 Incorrect input mode. Specify a correct mode.

See section 3.3.
9 Incorrect input range code. Specify a correct range code.

See section 3.3.
11 Range settings are not same within the selected channels. Specify channels with the same range setting.

See section 3.9.
12 A disabled batch group is selected. Set the last batch group greater than the first batch 

group.
See section 2.2 in IM04L41B01-03E.

13 Cannot set a trip line for a display group that is OFF. Check the display group settings.
See section 5.1 and section 2.2 in IM04L41B01-03E.

21 Cannot set an alarm for a skipped channel. Cannot be specified on channels set to Skip.
See section 3.7.

22 The upper and lower span limits are equal. Cannot be set to the same value.
See section 3.3.

23 The upper and lower scale limits are equal. Cannot be set to the same value.
See section 3.3.

24 The lower limit of the span band is greater than the upper limit. Set the lower limit less than the upper limit.
See section 3.3.

25 The lower limit of the scale band is greater than the upper limit. Set the lower limit less than the upper limit.
See section 3.3.

30 The partial boundary value exceeds the range of the span. Set the boundary value in the range of “the minimum 
span value + 1 digit” to “the maximum span value – 1 
digit.”
See section 5.9.

31 Partial-expansion display is set ON for a SKIPPED channel. Cannot be specified on channels set to Skip.
See sections 3.3 and 5.9

35 The upper and lower limits of the display band are equal. Set the upper limit greater than the lower limit + 5.
See section 5.6.

36 The lower limit of the display band is greater than the upper 
limit.

Set the upper limit greater than the lower limit + 5.
See section 5.6.

37 The display band is narrower than 4% of the entire display. Set the upper limit greater than the lower limit + 5.
See section 5.6.

40 Incorrect group set character string. Check the syntax.
See section 5.1.

41 There is no specified input channel. Specify a channel that is installed.
Operation Guide and section 5.1.

42 Exceeded the number of channels which can be set. Up to 10 channels per group.
See section 5.1.

Chapter 11 Troubleshooting
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Code Message Explanation/Countermeasures/Ref. section
43 A channel number cannot repeat in a group. Check that a channel is not registered twice.

See section 5.1.
45 There is no character string saved in the clipboard. Copy a character string to the clipboard.
46 The character string saved in the clipboard is too long. Paste a character string with the specified number of 

characters.
47 Start and end time cannot match. Check the starting and ending times.

See section 2.1.
48 Invalid or missing DST time settings. Check the starting and ending times.

See section 2.1.
61 There is no channel specified by the MATH expression. Check the channel number specified by the expression.

See sections 1.8 and 9.1.
62 MATH expression grammar is incorrect. Check that the expression grammar is correct.

See section 9.2.
63 MATH expression sequence is incorrect. Check that the operator used in the expression in 

relation to the applicable operands meets the grammar 
requirements.
See section 9.2.

64 MATH upper and lower span values are equal. Set the upper limit not equal to the lower limit.
See section 9.1.

65 Too many operators for MATH expression. The maximum number of operators in an expression 
has been exceeded. Reduce the number of operators, 
such as by splitting up the expression into multiple 
computation channels.See section 9.2.

70 Nonexistent constant specified in MATH expression. Check the constant number specified by the expression. 
See section 9.1.

71 Set range of the MATH constant is exceeded. Check the selectable range.
See section 9.1.

80 This username is already registered. Register another user name.
See section 8.2.

81 All space or ‘quit’ string cannot be specified. Change the character string.
See section 8.2.

83 This user ID and password combination is already in use. Change the user ID or the password.
See section 2.1 in the advanced security manual.

84 The login password has not been set up. Set a password.
See section 8.2.

85 The login password is incorrect. Check the password. If you lost the password, ask your 
administrator to reset it.
See sections 8.2 and 8.3.

86 The key-lock release password is incorrect. Check the password. If you lost the password, it must 
be reset.
See section 8.1.

87 This key is locked. Release the key lock.
See section 8.1.

88 This function is locked. Release the key lock.
See section 8.1.

89 Press [FUNC] key to login. Log in.
See section 8.3.

90 No permission to enter to the SETUP mode. Check the keylock or login settings.
See sections 8.2 and 8.3.

91 Password is incorrect. Enter the correct password. If you lost the password, it 
must be reset.
See sections 8.2 and 8.3.

92 Press [ESC] key to change to the operation mode. Press the ESC key.
93 String including space or all space cannot be specified. Spaces are not allowed in the Web browser user name 

and password.
See section 1.5 in the communication manual.

94 More than one address cannot be specified. Only a single sender is allowed.
See section 1.4 in the communication manual.

95 Number entered exceeds channel number range. 
Use another command.

Check the syntax of the Modbus command.
See sections 1.10 and 2.6 in the communication 
manual.

11.1  A List of Messages
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Code Message Explanation/Countermeasures/Ref. section
96 This menu is locked. Check the key lock setting. Release the key lock.

See section 8.1.
97 This function is locked. To use the function, login as a user who has permission 

to use it.
See section 8.2 in the advanced security manual.

100 IP address doesn’t belong to class A, B, or C. Check the IP address.
See section 1.3 in the communication manual.

101 The result of the masked IP address is all 0s or 1s. Check the subnet mask.
See section 1.3 in the communication manual.

102 SUBNET mask is incorrect. Check the subnet mask.
See section 1.3 in the communication manual.

103 The net part of default gateway is not equal to that of IP 
address.

Check the IP address.
See section 1.3 in the communication manual.

105 This port number is already in use. Please enter a different 
number.

Enter a different port number for each function.
See section 6.1 in the communication manual.

110 This user name is not registered. Log in as a registered user.
See section 8.2 and section 2.1 in the advanced 
security manual.

111 The login user ID is incorrect. Enter the correct user ID.
See the advanced security manual.

112 Password must use more than 6 alphanumeric characters. The password must be between 6 and 20 characters in 
length.
See section 2.1 in the advanced security manual.

113 Password entered is incorrect. Enter the correct password.
See section 8.3 and section 2.2 in the advanced 
security manual.

114 This user name is invalid. Have a system administrator clear the “invalid user” 
status.
See the advanced security manual.

116 This user name cannot be specified. The user name is reserved.
See section 8.2 and the advanced security manual.

117 This password is not effective. Because the wrong password has been entered 
consecutively for more than the permissible number of 
times, this user is invalid. Have an administrator clear 
the “invalid user” status.
See section 2.2 in the advanced security manual.

119 This user name is unable to use this mode. A user-level user cannot enter the Basic Setting mode
See section 8.2.

120 Measured value is incorrect. (in ascending order) Set the calibration correction value to a value greater 
than the previous value.
See section 3.9.

121 A user is already logged in. Another user has logged in with the same name or is 
logging in.
See section 1.3 in the advanced security manual.

122 Measured value exceeds the range setting. Check the channel input or the channel range setting.
See sections 3.3 and 3.9.

124 Password entry cannot be performed. You cannot use bar codes to enter a password.
See section 2.9 in the advanced security manual.

125 Character entry cannot be performed. The DX is not showing a display used to enter character 
strings.
See section 2.11.

126 You cannot use the same password. Specify a different password.
See section 8.3.

127 Report kind overlaps and cannot be set up. Change the overlapped report data type.
See section 9.5.

128 “Logout” cannot be set to “Hide”. See sections 5.17 and 8.3.
129 IP address is not set. Set the IP address of the DX.

See section 1.3 in the communication manual
131 You have exceeded the available channel capacity. You cannot connect more than 240 channels.

See section 1.10 in the communication manual
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Code Message Explanation/Countermeasures/Ref. section
132 You have exceeded the available number of commands. The maximum number of commands that can be sent is 

16. The modules that can be set with a single command 
are consecutive modules that can be automatically set. 
Change the MW100 module configuration so that there 
are no empty slots.
See section 1.10 in the communication manual.

133 External I/O auto setting information is not available. Below are the possible causes. Check them.
•  The MW100 is in calibration mode. Change to the 

setting mode or measurement mode.
•  The measurement module may not have been 

detected. Perform system reconfiguration.
•  There are no modules that can be automatically set. 

Check the modules.
•  An IP address has not been assigned to the MW100. 

Set the IP address.
•  The Modbus server of the MW100 is turned OFF. Turn 

ON the server.
See section 1.10 in the communication manual.

134 Auto setting has already been executed. You cannot set an MW100 that has been automatically 
set.
See section 1.10 in the communication manual.

135 External I/O cannot be found. Check the Ethernet connection.
See section 1.3 in the communication manual.

136 External I/O start cannot be executed. The current MW100 settings do not allow the 
measurement to be started. Check the settings.
See section 1.3 in the communication manual.

137 DNS for this device is not set. Set the DNS of the DX.
See section 1.3 in the communication manual.

138 Cannot create object. The maximum allowed number was 
exceeded.

This occurs when the custom display is generated.
See section 2.2 in IM04L41B01-04E.

139 This dependency is not possible. This occurs when the custom display is generated.
See section 1.10 in IM04L41B01-04E.

140 You cannot set this while you are logged in. You cannot change the registered settings of a user that 
is logged in.
See the advanced security manual.

141 You cannot set multiple channels. During memory sampling, you cannot configure settings 
for multiple consecutive channels at the same time.
See section 1.5 in the advanced security manual.

142 Another user is configuring settings. You can perform operations after the user who is in 
setting mode or basic setting mode logs out or returns 
to operation mode.
See the section 1.3 in advanced security manual.
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• Execution Errors
Code Message Explanation/Countermeasures/Ref. section
150 This action is not possible because sampling is in progress. Stop the memory sampling and then execute.

See section 6.4.
151 This action is not possible during sampling or calculating. Stop the memory sampling and then execute.

See sections 6.4 and 9.4.
152 This action is not possible because saving is in progress. Wait until the saving is complete.
153 This action is not possible because formatting is in progress. Wait until the formatting is complete.
154 Message not accepte because message limit was reached. The limit is 50 messages.

See section 5.4.
155 The message is not written while sampling is stopped. Start the memory sampling and then execute.

See section 6.4.
156 There are no channels to be saved to the memory. Set the channels to be saved.

See sections 6.1 and 9.1.
157 This function is not possible at this time. Check the DX status.
158 Exceeds time deviation setting. When synchronizing the clock through remote control.

When you specified time that exceeds the time deviation 
limit on DXs with Advanced security function (/AS1 
option). (Firmware version number 4.11 and later)
See section 2.3.

159 It is outside the postscript message write-in range. Add message can be written to the past section of the 
data being memory sampled.
See section 5.4.

162 Data storage is already started. Memory sampling is in progress on the batch group.
See section 3.2 in IM04L41B01-03E.

163 Data storage is already stopped. Memory sampling on the batch group has already been 
stopped.
See IM04L41B01-03E.

164 This action is not possible because there is a bar code data 
error.

Check the text that the barcode reader scanned.
See section 2.11.

170 End process can’t proceed, because setting file is not saved to 
Media.

When you switch from setting mode to operation mode 
or basic setting mode, the DX automatically saves the 
changed settings to the CF card. This message appears 
when the DX cannot save the changed settings. Check 
the CF card.
See section 1.5 in the advanced security manual.

173 Data save is not possible because of insufficient media 
capacity.

Change the external storage medium.

174 Cannot execute because of failure to save unsaved setting file. The DX cannot save an unsaved setting file to the CF 
card. Check the CF card.
See the advanced security manual.

175 The calibration due date has not been set properly. Check the year, month, and day of the calibration due 
date.
See section 3.13

700 The specified command does not exist. The command specified from the custom display is not 
registered. Register commands whose command type 
is “E-M,” and specify the numbers of those commands 
in the custom display.
See section 1.10 in the communication manual.
See section 2.32 in IM04L41B01-04E.

701 Saving data. The previous transmission is not finished.
See section 1.10 in the communication manual.

702 Failed to save data. Check for communication errors or Modbus server 
errors.
See section 1.10 in the communication manual.

760 Cannot find KDC server. The KDC server cannot be found in the same domain.
See section 1.14 in the communication manual.

761 KDC server connection error. An error occurred while the DX was connecting to the 
KDC server.
See section 1.14 in the communication manual.

764 Not supported by this machine. Not supported by the DX.
See section 1.14 in the communication manual.
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765 Preauthentication failed. Preauthentication failed. Check the information that you 

entered.
766 The encryption type is not supported by this machine. Use the same encryption method on the DX and the 

server.
See section 1.14 in the communication manual.

767 Failed to receive authentication from KDC server. Check the DX and server settings.
See section 1.14 in the communication manual.

768 Change the password. The password has expired.
See section 1.14 in the communication manual.

769 The time difference with the KDC server exceeds the limit. There is a time difference of 5 minutes or more between 
the DX and the server. Eliminate this time difference.
See section 1.14 in the communication manual.

771 The host principal is not registered. The DX account is not registered on the server.
See section 1.14 in the communication manual.

772 The host principal is invalid. Check the DX account that is registered on the server.
See section 1.14 in the communication manual.

773 The host password is incorrect. Make sure that the password set on the DX matches 
the server password.
See section 1.14 in the communication manual.

774 Preauthentication failed. An internal error occurred during preauthentication. 
Disable the server's preauthentication function.

775 The realm is incorrect. Set the correct realm name on the DX.
See section 1.14 in the communication manual.
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Operation Errors
Code Message Explanation/Countermeasures/Ref. section
200 Operation aborted because an error was found in media. Use another storage medium or format it.

See section 6.7.
201 Not enough free space on media. There is not enough free space on media or the number 

of directories exceeded the limit. Use another storage 
medium.
See section 1.4.

202 Media is read-only. Make it writable.
210 Media has not been inserted. Insert a storage medium into the drive.
211 Media is damaged or not formatted. Remove the medium and set it again. If an error still 

occurs, replace or format the medium.
See section 6.7.

212 Format error. Try formatting again.
See section 6.7.

213 The file is read-only. Access another file or make the file writable.
214 There is no file or directory. Specified a file in which data is being added. Tried to 

save a file which does not exists in the internal memory. 
215 Exceeded the allowable number of directories or files. Replace a storage medium. Delete unneeded files and 

directories. 
See section 6.7.

216 The file or directory name is incorrect. Use alphanumeric characters and symbols.
See section 6.2.

217 Unknown file type. Check the extension.
See section Appendix 2.

218 This directory or file now exists. Delete it or change the name. See section 6.2.
219 Invalid file or directory operation. Tried to delete multiple directory levels. Or, tried to 

delete a directory containing files.
Delete the files and directories in the directory first 
before executing the operation.
See section 6.7.

220 The file is already in use. Try again later. Wait until the file is accessible.
221 This action is not possible because FTP transmission is in 

progress.
Execute after FTP data transfer is complete.

222 Media is not recognized. Remove and reset the storage medium.
231 Abnormal setting exists in file. Specify another file.
232 There is no available data. Appears when displaying historical trends. Specify 

another file.
233 The specified historical data do not exist. Appears when switching to historical trend from 

information display. 
See section 4.5.

234 The specified channel is not assigned to the display group. Appears when switching to trend, digital, or bar graph 
from overview. 
See sections 4.4 and 7.6.

235 There is no data for the chosen date. Select a day of the month that has “E” or “D” displayed. 
See section 4.3.

236 There is no data after the selected time for this day. Select an earlier time.
Section 4.3.

237 The specified screen cannot be displayed The DX display mode and the Web display mode are 
different, or a display group that does not exist has been 
specified from the Web. See IM04L41B01-03E.

240 You cannot sign this record because a signature is already 
present.

You cannot overwrite a signature.
See section 1.6 in the advanced security manual.

245 This function cannot be used in the historical trend display. Close the historical trend display.
246 This function cannot be used due to no data file saved in 

media.
Insert a storage medium. Make sure that the storage 
medium is formatted.

247 This function cannot be used in setting mode. Exit setting mode.
249 You cannot sign, because some batch data is missing. When the process type is batch, you cannot use the DX 

to sign the measured data unless everything from the 
start to the stop of measurement is contained in a single 
file.
Use DAQSTANDARD to sign the data.
See the advanced security manual.
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250 Failed to load template file. The template file that you attempted to load is 400 KB 

or larger. Load a template file that is smaller than 400 
KB.

251 There is no template file. There is no template file in the internal memory. Load a 
template file.

252 The template file is incorrect. Check the template file format.
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Communication Application Errors
• Errors Related to E-mail and Web Server
260 IP address is not set or ethernet function is not available. The IP address is not specified.

Check the IP address.
See section 1.3 in the communication manual.

261 SMTP server is not found. Occurs when the SMTP server is specified by name.
• Check the DNS setting.
• Check the SMTP server name.
See sections 1.3 and 1.4 in the communication manual.

262 Cannot initiate E-mail transmission. • The host name of the DX is not correct. Check the host 
name.

• The port number of the SMTP server is not correct. 
Check the port number.

See sections 1.3 and 1.4 in the communication manual.
263 Sender’s address rejected by the server. Check the sender’s address.

Section 1.4 in the communication manual
264 Some recipients’ addresses are invalid. Check the recipients’ addresses.

See section 1.4 in the communication manual.
265 SMTP protocol error. May occur if a network failure (cable problems, duplicate 

addresses, network device failure, and so on) occurs in 
the middle of the e-mail transmission.

266 Ethernet cable is not connected. Check the cable connection.
See section 1.3 in the communication manual.

267 Could not connect to SMTP server. • Check to see that the SMTP server is connected to the 
network.

• If the SMTP server name is specified using an IP 
address, check to see that the IP address is correct.

See section 1.4 in the communication manual.
268 E-mail transmission request failed. Contact your nearest YOKOGAWA dealer.
269 E-mail transfer error. May occur if a network failure (cable problems, duplicate 

addresses, network device failure, and so on) occurs in 
the middle of the e-mail transmission.

270 Could not connect to POP3 server Check the connection settings.
See section 1.4 in the communication manual.

271 Not able to login to the POP3 server. Check the login name and the password.
See section 1.4 in the communication manual.

272 SMTP authentication failed. Make sure that the user name and password that you are 
using for authentication are recognized by the server.
See section 1.4 in the communication manual.

273 The server requested an unsupported authentication 
method.

Change the server configuration.
See section 1.4 in the communication manual.

275 The current image cannot be output to the Web. The setup display cannot be output to the Web browser. 
This message is displayed on the Web browser.

276 Image data currently being created. Unable to perform key 
operation.

Try again a little later.This message is displayed on the 
Web browser.

277 Could not output screen to Web. Failed to create the image.This message is displayed on 
the Web browser.

278 Web control denied because a user has control. You cannot control the DX from a browser when:
•  There is a user who is logging in or who has logged into 

the DX through key operations.
•  There is a user who has logged into the DX through 

communication commands.
See section 1.5 in the communication manual.
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• Errors Related to FTP Client
For a description of the FTP client function of the DX, see the Communication Interface 
User’s Manual, IM 04L41B01-17E. The detail code does not appear in the error message 
on the screen. You can view the code on the FTP log display of the DX or using the FTP 
log output via communications.

Code Message
280 IP address is not set or FTP function is not available.

Further details are provided by the character string that appears after error code 280.
Character String and Details
HOSTADDR

 An IP address has not been assigned to the DX.
 Check the IP address.

DORMANT
 Internal processing error.*1

LINK
 Data link is disconnected.
 Check the cable connection.

281 FTP mail box operation error.
Further details are provided by the character string that appears after error code 281.
Character String and Details
MAIL
 Internal processing error.*1

STATUS
 Internal processing error.*1

TIMEOUT
 Internal processing error.*1

PRIORITY
 Internal processing error.*1

NVRAM
 Internal processing error.*1

282 FTP control connection error.
Further details are provided by the character string that appears after error code 282.
Character String and Details
HOSTNAME
 Failed the DNS lookup (search the IP address corresponding to the host name).
 Check the DNS setting and the destination host name.
TCPIP
 Internal processing error.*1

UNREACH
 Failed to connect to a control connection server.
 Check the address setting and that the server is running.
OOBINLINE

 Internal processing error.*1

NAME
 Internal processing error.*1

CTRL
 The control connection does not exist.
 Check that the server does not drop the connection and that it responds within the proper time 

period.
IAC
 Failed to respond in the TELNET sequence.
 Check that the server does not drop the connection and that it responds within the proper time 

period.
ECHO

 Failed to transmit data on the control connection.
 Check that the server does not drop the connection and that it responds within the proper time 

period.
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Code Message
Character String and Details
REPLY

 Failed to receive data on the control connection.
 Check that the server does not drop the connection and that it responds within the proper time 

period.
SERVER

 The server is not in a condition to provide the service.
 Check that the server is in a condition in which service can be provided.

283 FTP command was not accepted.
Further details are provided by the character string that appears after error code 283.
Character String and Details
USER
 Failed to verify the user name.
 Check the user name setting.

PASS
 Failed to verify the password.
 Check the password setting.

ACCT
 Failed to verify the account.
 Check the account setting.
TYPE
 Failed to change the transfer type.
 Check that the server supports the binary transfer mode.

CWD
 Failed to change the directory.
 Check the initial path setting.
PORT
 Failed to set the transfer connection.
 Check that the security function is disabled.

PASV
 Failed to set the transfer connection.
 Check that the server supports PASV commands.
SCAN
 Failed to read the transfer connection settings.
 Check that proper response to the PASV command is received from the server.

284 FTP transfer setting error.
Further details are provided by the character string that appears after error code 284.
Character String and Details
MODE
 Internal processing error.*1

LOCAL
 Internal processing error.*1

REMOTE
 The destination file name is not correct.
 Check that you have the authority to create or overwrite files.

ABORT
 File transfer abort was requested by the server.
 Check the server for the reason for the abort request.
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Code Message
285 FTP data connection error.

Further details are provided by the character string that appears after error code 285.
Character String and Details
SOCKET
 Failed to create a socket for the transfer connection.*2

BIND
 Failed the transfer connection command.*2

CONNECT
 Failed the transfer connection.*2

LISTEN
 Failed the transfer connection reception.*2

ACCEPT
 Failed to accept the transfer connection.*2

SOCKNAME
 Internal processing error.*1

RECV
 Failed to receive data over the transfer connection.*2

SEND
 Failed to send data over the transfer connection.*2

286 FTP file transfer error.
287 FTP is failed because of file acquirement from external media.
290 SNTP access failure.

Further details are provided by the character string that appears after error code 290.
Character String and Details
DORMANT

 Internal processing error.*1

LINK
 Data link is disconnected.
 Check the cable connection.

291 SNTP server does not respond.
Further details are provided by the character string that appears after error code 291.
Character String and Details
TIMEOUT
 Check that the server is running.*2

292 Incorrect SNTP server setting.
Further details are provided by the character string that appears after error code 292.
Character String and Details
HOSTNAME
 Failed the DNS lookup (search the IP address corresponding to the host name).
 Check the DNS setting and the SNTP server name.

TCPIP
 Internal processing error.*1

293 Invalid SNTP server reply.
Further details are provided by the character string that appears after error code 293.
Character String and Details
SEND
 A correct IP address has not been assigned to the DX.
 Check the IP address.

BROKEN
 There is a problem with the SNTP server.
 If this error occurs even after executing SNTP manually several times, check the SNTP server.
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Code Message
294 No time correction because excess time deviation with SNTP server. 

Further details are provided by the character string that appears after error code 294.
Character String and Details
OVER
 This error occurs when periodic SNTP is executed by the auto setting of the clock and the 

clock is not adjusted because the time difference between the DX and the SNTP server is 
greater than or equal to 10 minutes.

Check the time on the DX and the SNTP server.
295 IP address was released because DHCP setting is invalid.

Further details are provided by the character string that appears after error code 295.
Character String and Details
REJECT
 Address obtained by DHCP is inappropriate.

296 DHCP access failure.
Further details are provided by the character string that appears after error code 296.
Character String and Details
ESEND
 Failed to transmit to the DHCP.

ESERVER
 DHCP server not found.

ESERVFAIL
 No response from the DHCP server.

ERENEWED
 Address renewal rejected.

EEXTENDED
 Address lease extension rejected.

EEXPIRED
 Address lease period expired.

297 Registration of the hostname to the DNS server failed.
Further details are provided by the character string that appears after error code 297.
Character String and Details
INTERNAL
 Failed to register the host name (transmission error, reception timeout, etc.).

FORMERR
 Failed to register the host name (format error: DNS message syntax error).

SERVFAIL
 Failed to register the host name (server failure: DNS server processing error).

NXDOMAIN
 Failed to register the host name (non existent domain).

NOTIMP
 Failed to register the host name (not implemented).

REFUSED
 Failed to register the host name (operation refused).

YXDOMAIN
 Failed to register the host name (name exists).

YXRRSET
 Failed to register the host name (RR set exists).

NXRRSET
 Failed to register the host name (RR set does not exist).

NOTAUTH
 Failed to register the host name (not authoritative for zone).

NOTZONE
 Failed to register the host name (different from zone section).

NONAME
 Host name not entered on the DX.
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Code Message
298 Deletion of the hostname to the DNS server failed.

Further details are provided by the character string that appears after error code 298.
Character String and Details
INTERNAL
 Failed to delete the host name (transmission error, reception timeout, etc.).

FORMERR
 Failed to delete the host name (format error: DNS message syntax error).
SERVFAIL
 Failed to delete the host name (server failure: DNS server processing error).
NXDOMAIN
 Failed to delete the host name (non existent domain).

NOTIMP
 Failed to delete the host name (not implemented).

REFUSED
 Failed to delete the host name (operation refused).

YXDOMAIN
 Failed to delete the host name (name exists).
YXRRSET
 Failed to delete the host name (RR set exists).

NXRRSET
 Failed to delete the host name (RR set does not exist).
NOTAUTH
 Failed to delete the host name (not authoritative for zone).

NOTZONE
 Failed to delete the host name (different from zone section).

NOTLINKED
4 Physical layer was disconnected when removing the host name.

700 The specified command does not exist.
701 Saving data.
702 Failed to save data.

*1 Contact your nearest YOKOGAWA dealer.
*2 These errors may occur if the network experiences trouble during the data transmission  

(bad cable connection, duplicate addresses, network equipment failure).

Note
• The FTP client function on the DX has a timer function that drops the connection if there is 

no data transfer for two minutes. If the server does not respond within this time period, the 
transfer fails.

• The FTP client function on the DX overwrites files without a warning if files with the same 
name exist at the transfer destination unless the server returns a negative response.
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Communication Errors
For information regarding the communication function of the DX, see the Communication 
Interface User’s Manual, IM 04L41B01-17E.

•  Errors during Setting and Basic Setting Modes, Output Communication 
Command Execution, and Setup Data Loading

Code Message
300 Command is too long.
301 Too many number of commands delimited with ‘;’.
302 This command has not been defined.
303 Data request command can not be enumerated with sub-delimiter.
350 Command is not permitted to the current user level.

351 This command cannot be specified in the current mode.
352 The option is not installed.
353 This command cannot be specified in the current setting.
354 This command is not available during sampling or calculating.

•  Memory Access Errors during Setting and Basic Setting Modes and Output 
Communication Command Execution

An English error message is returned via the communication interface. It is not displayed 
on the screen.

Code Message
362 There are no data to send ‘NEXT’ or ‘RESEND’.
363 All data have already been transferred.

• Maintenance and Test Communication Command Errors
An English error message is returned via the communication interface. It is not displayed 
on the screen.

Code Message
390 Command error.
391 Delimiter error.
392 Parameter error.
393 No permission.
394 No such connection.
395 Use ‘quit’ to close this connection.
396 Failed to disconnect.
397 No TCP control block.
398 Format error.
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• Other Communication Errors
An English error message is returned via the communication interface. It is not displayed 
on the screen.

Code Message
400 Input username.

Enter the name of a user that is registered on the DX and that is allowed to log in to the DX through communication.
401 Input password.

Enter the password.
402 Select username from ‘admin’ or ‘user’.

Select “admin” or “user” to specify the user level to connect to.
403 Login incorrect, try again!

The login failed. Enter the information again, starting with the user name.
404 No more login at the specified level is acceptable.

Connecting would cause the maximum number of simultaneous connections (administrator: 1, normal user: 2 or  
setting: 1, monitoring: 2) to be exceeded. Connect to a different level, or exit by entering “quit.”

405 Input user ID.
Enter a user ID.

406 Select function from ‘setting’ or ‘monitor’.
Select “setting” (to connect to the setting function) or “monitor” (to connect to the monitoring function).

407 Password has expired. Please enter a new password.
The password has expired. Enter a new password.

408 Enter password again for confirmation.
Enter the password again for confirmation.

409 This password is not correct or was already used.
The password is incorrect or has already been used.

410 Login successful. (The special user level)
You have logged in to the administrator level.

411 Login successful. (The general user level)
You have logged in to the user level.

420 Connection has been lost.
The connection has been lost.

421 The number of simultaneous connection has been exceeded.
The maximum number of simultaneous connections has been reached, so no further connections can be made.

422 Communication has timed-out.
Communication timed out so the connection was closed.

450 This entry is incorrect.
You cannot currently log in. This may happen for one of the following reasons:
•  The user name is not registered.
•  The user name is invalid.
•  The user ID is wrong.

451 Login prohibited because another user is logged in.
Another user is already logged in. This may happen for one of the following reasons:
•  Someone has already logged in with the same user name.
•  When the multi-login function is not enabled and someone has logged in through key operations.

452 This command must be used with LL command.
Use the LL command.
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Status Messages
Code Message
500 Execution is complete.
501 Please wait a moment...
503 Data are being saved to media...
504 File is being loaded from media...
505 Formatting...
506 Memory save to media was interrupted.
508 There is no file or directory.
509 Press [DISP/ENTER] key to display file name.
510 Range cannot be changed during sampling or calculating.
511 MATH expression cannot be changed during sampling or calculating.
513 Post process in progress.
514 Now loading historical data.
515 Data save is completed.
516 Files are now being sorted.
520 Connecting to the line...
521 The data file is being transferred.
530 Media can be removed safely.
531 Media was removed compulsorily.
532 USB device has been connected.
533 USB device cannot be recognized.
534 There was no data which is not saved to media.
535 Media was recognized.
542 Media read error.
543 Flash write error.
550 The A/D calibration is being executed...
551 FTP test is being executed...
552 E-mail test is being executed...
553 Review and sign functions cannot be used when the file is divided.
554 Signature functions are being executed.
555 Login prohibited because software login is active.
556 Press [FUNC] key to login.
557 This user is not allowed to change a setting.
558 Setting changes are aborted while data is saved.
559 This command must be used with LL command.
560 Now connecting to SNTP server...
561 Now adjusting the time.

11.1  A List of Messages
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Code Message
562 Ethernet cable is disconnected.

Further details are provided by the character string that appears after error code 562.
Character String and Details
ON

 Detected that an Ethernet cable was connected.
OFF

 Detected that an Ethernet cable was disconnected.
563 The command is sent to DHCP. 

Further details are provided by the character string that appears after error code 563.
Character String and Details
RENEW

 Requesting address renewal to the DHCP server.
564 The response was received from DHCP.

Further details are provided by the character string that appears after error code 564.
Character String and Details
RENEWED

 Address renewal complete.
EXTENDED
 Address release extension request complete.

RELEASED
 Address release complete.

565 IP address was set.
Further details are provided by the character string that appears after error code 565.
Character String and Details
IPCONFIG

 Assigned the IP address.
566 It is a setting that doesn’t register hostname to the DNS server.

Further details are provided by the character string that appears after error code 566.
Character String and Details
NOREQUEST
 Configured not to register the host name.

567 The hostname was registered to DNS server.
Further details are provided by the character string that appears after error code 567.
Character String and Details
UPDATE
 Registered the host name to the DNS server.

568 The hostname was deleted from DNS server.
Further details are provided by the character string that appears after error code 568.
Character String and Details
REMOVE
 Assigned the IP address.
OFF

 Removed the host name from the DNS server.
571 Querying KDC server.
572 Saving template file.
573 Loading template file.

11.1  A List of Messages
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Warning Messages
Code Message Ref. Section
600 Measured data and Settings have been initialized. –
601 Measured data have been initialized. –
610 This usernema is already registered. See section 8.2.
611 There is no user who can enter to the SETUP mode. –
612 Please acknowledge all active alarms before stopping this record. This message appears if you try to stop 

recording when there is an alarm that the alarm 
ACK operation has not been performed on. You 
can either stop recording or perform the alarm 
ACK operation and then stop recording. See 
the See sections 6.3 and 6.4 in the advanced 
security manual.

614 Calibration settings are reset because of range setting change. See section 3.9.
615 Noise may influence measurement in test mode. See section 3.1.

For information about messages whose codes are in the 700s, see page 11-5.

System Errors
Servicing is required when a system error occurs. If this happens, contact your nearest 
YOKOGAWA dealer for repairs.

Code Message
901 ROM failure.
902 RAM failure.
910 A/D memory failure for all input channels.
921 Channel 1 A/D calibration value error.
925 A/D calibration error.
930 Memory acquisition failure.
940 The Ethernet module is down.
950 Incorrect number for the A/D calibration.
951 Failed to write A/D calibration value.

11.1  A List of Messages
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11.2 Troubleshooting

Is the power supply 
connected properly?

Is the power 
supplied properly?

NO

NO

NO

YES

YES

YES

Does not function (nothing is displayed).

Is the power switch 
turned ON? Does the 
switch work properly?

Connect properly.

Turn ON the power properly.

Contact your nearest YOKOGAWA 
dealer.

O.G.

O.G.

O.G.: Operation Guide

O.G.

Supply the power at the specified 
voltage and frequency.
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Does the input meet
the specifications? 

NO

NO

NO

NO

NO

YES

YES

YES

YES

•  The error is large. 
•  The trend or digital values fluctuate. 
•   The trend is off the scale on either the 0% or 100% side. 

YES

Change the input to meet the
specifications.

Is the input wiring correct? 

• Attach the input terminal cover properly. 
• Protect the input terminal from wind or  
 fans. 
• Keep the temperature fluctuation near  
 the input terminal to a minimum. 

• Adjust the span and range (section 3.3). 
• If you use Calibration Correction (/CC1  
 option), check the set values for  
 correction points (section 3.9). 

Is the range/span
setting appropriate? 

Taking measures  
against noise? 

Is the environmental 
temperature kept constant 
(TC input)?

• Separate the input wiring from the
 noise source. 
• Ground the recorder. 
• Ground the measured object properly. 
• Insulate the TC from the measured object. 
• Use shielded cables for input. 
• Change the integral time of the input  
 A/D converter (section 3.1). 
• Use moving average on the input  
 (section 3.4). 

• Wire correctly (O.G.). 
• Install the terminal block correctly. 
• Fasten the terminal screws correctly. 
• Insulate the RTD from the ground. 
• If burnt, replace the TC. 

Is the input wiring parallel
with other equipment? 

YES

NO

NO

YES

Is the RJC setting correct 
(TC input)?

• Stop the TC burnout upscale/downscale  
 function of other equipment. 
• Ground the DX and other equipment  
 at one point. 
• Disconnect parallel wiring  
 (use a double-element TC, for instance). 

Set it correctly. 

Contact your nearest YOKOGAWA  
dealer. 

Section 3.2 

Section 12.1 

O.G.: Operation Guide 

11.2  Troubleshooting
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Taking measures 
against noise?

NO

YES

• Move the input and communication wires 
 away from the noise source.
• Ground the recorder.
• Use shielded cables for input and 
 communication wires.
• Insert an isolation transformer into the 
 power line.
• Insert a power line filter into the power line.
• If an inductive load is used in the alarm 
 output line, insert a serge suppressor in 
 the line.

Contact your nearest YOKOGAWA 
dealer.

Display and other functions do not work properly.

 

Is the function of the DX
configured properly? 

NO

YES

• Use the customize-menu function to show  
 the item on the menu. 
• Confirm that the DX is equipped with the  
 necessary options. 

Contact your nearest YOKOGAWA  
dealer. 

Some items on the display selection menu
or FUNC key menu are not displayed. 

Section 5.17

11.2  Troubleshooting
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12.1 Periodic Inspection

Check the operation periodically to keep the DX in good working order. 
Perform the following checks and replace worn parts as needed.
• Is the display and storage functioning properly?
 If not, see chapter 11, “Troubleshooting” in the DX2000 User’s Manual.
• Has the brightness of the LCD backlight deteriorated?
 If replacement is necessary, see “Recommended Replacement Periods for Worn 

Parts.”

Chapter 12 Calibration
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12.2 Calibrating the DX

It is recommended that the DX be calibrated once a year to assure its measurement 
accuracy.
Calibration service is also provided by YOKOGAWA dealers.
For details, contact your nearest YOKOGAWA dealer.

Required Instruments
Calibration instruments with the following resolution are required for calibrating the DX.
Recommended Instruments
• DC voltage standard: Fluke 9100 or equivalent
  Main specifications
  Output accuracy: ±(0.005% + 1 µV)
• Decade resistance box: Yokogawa Meters & Instruments Model 2793-01 

or equivalent
  Main specifications
	 	 Accuracy	of	output	range	0.1	to	500	Ω:	±(0.01%	

+2	mΩ)
	 	 Resolution:	0.001	Ω
• 0°C standard temperature device: ZC-114/ZA-10 by Coper Electronics or equivalent
  Main specifications
  Standard temperature stability accuracy: ±0.05°C
For information on purchasing the calibration instruments, contact your nearest 
YOKOGAWA dealer.

Calibration Procedure
1. Wire the DX and the calibration instrument as shown in the following figure, and 

adequately warm up the instruments (the warm-up time of the DX is at least 30 
minutes).

2. Check that the operating environment such as ambient temperature and humidity 
is within the standard operating conditions (see section 13.6).

3. Apply appropriate input signals corresponding to 0, 50, and 100% of the input 
range and calculate the errors from the readings.

 If the error does not fall within the accuracy range of the specifications, contact 
your nearest YOKOGAWA dealer.

Note
For thermocouple inputs, you must measure the temperature of the input terminal and apply a 
voltage taking into account the reference junction temperature.

DC Voltage Measurement (Example for the DX2010)

  

DC voltage standard

Input terminal +
–

+

–
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Temperature Measurement When Using an RTD (Example for the DX2010)

  

Decade resistance box

The resistance of three lead 
wires must be equal.

(Model 2793-01 from Yokogawa 
Meters & Instruments Corporation)

b

B

Input terminal

A

Temperature Measurement When Using a Thermocouple (Example for the 
DX2010)

Input terminal

Thermocouple wires or TC 
extension wires

Thermocouple
wires

Copper
wires

Copper wires

DC voltage standard
–

+

+
–

(0 °C standard temperature device  ZC-114/ZA-10 by Coper Electronics)

RJC of TC Input
As the measurement terminal of the DX is generally at room temperature, the actual 
output of the thermocouple is different from the values given on the thermoelectromotive 
force table based on 0°C. The DX performs compensation by measuring the temperature 
at the input terminal and adding the corresponding thermoelectromotive force to the 
actual output of the thermocouple. Therefore, when the measurement terminal is shorted 
(equivalent to the case when the detector tip is 0°C), the measured value indicates the 
temperature of the input terminal.
When calibrating the DX, this compensation voltage (thermoelectromotive force of 0°C 
reference corresponding to the input terminal temperature) must be subtracted from the 
output of the standard generator before application. As shown in the figure, by using the 
0°C standard temperature device to compensate the reference junction at 0°C, you can 
input the thermoelectromotive force of 0°C reference from the DC voltage standard and 
perform the calibration.

12.2  Calibrating the DX
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13.1 Signal Input and Alarm

Measurement Input
Item Specifications
Number of inputs, scan interval, and A/D integration time

DX2004
DX2008
DX2010
DX2020
DX2030
DX2040
DX2048

25 ms

125 ms

4
8
10
20
30
40
48

Fast sampling mode*Normal modeNumber of inputsModel
Scan interval

Integration time of the A/D converter 60 Hz/50 Hz/100 ms60 Hz/50 Hz 600 Hz (fixed)

125 ms, 250 ms

1 s, 2 s, 5 s 2 s, 5 s

*  Not available on models equipped with external input channels (/MC1 option) or when the multi 
batch function (/BT2 option) is being used.

Input Type DC voltage, 1-5V, thermocouple (TC), resistance temperature detector (RTD), ON/OFF input (DI), 
and DC current (by adding an external shut resistor)

Measurement range and measurable range
 

DC voltage 20 mV  –20.000 to 20.000 mV 
   60 mV   –60.00 to 60.00 mV 
   200 mV  –200.00 to 200.00 mV
  2 V –2.0000 to 2.0000 V 
  6 V  –6.000 to 6.000 V 
  20 V –20.000 to 20.000 V 
  50 V –50.00 to 50.00 V 
1-5V  1 to 5 V*6 0.800 to 5.200 V
Thermocouple R*1 0.0 to 1760.0°C
  S*1 0.0 to 1760.0°C
  B*1 0.0 to 1820.0°C
  K*1 –200.0 to 1370.0°C
  E*1 –200.0 to 800.0°C
  J*1 –200.0 to 1100.0°C
  T*1 –200.0 to 400.0°C
  N*1 –270.0 to 1300.0°C, on models 
   with release numbers 3 and later.
   0.0 to 1300.0°C, on models with
   release numbers 2 and earlier.
  W*2 0.0 to 2315.0°C
  L*3 –200.0 to 900.0°C
  U*3 –200.0 to 400.0°C
  WRe*4 0.0 to 2400.0°C
RTD  Pt (Pt100)*5 –200.0 to 600.0°C
  JPt (JPt100)*5 –200.0 to 550.0°C
DI   Level 0: Less than 2.4 V.  1: 2.4 V or higher (judged at the 6 V range)
  Contact*7 0: Open.  1: Closed (parallel capacitance of 0.01 µF or less)
*1:  R, S, B, K, E, J, T, N: IEC584-1 (1995), DIN IEC584, JIS C1602-1995
*2:  W: W-5%Re/W-26%Re (Hoskins Mfg. Co.), ASTM E988
*3:  L: Fe-CuNi, DIN43710, U: Cu-CuNi, DIN43710
*4:  WRe: W-3%Re/W-25%Re (Hoskins Mfg. Co.)
*5:  Pt100: JIS C1604-1997, IEC751-1995, DIN IEC751-1996
  JPt100: JIS C1604-1989, JIS C1606-1989
  Measuring current: i = 1mA (Pt100, JPt100)
*6: The range for linear scaling of 1-5V inputs. Burnout detection and low-cut

functions are available.
*7: The detected current value is approx. 10 μA. 

32 to 3200°F
32 to 3200°F
32 to 3308°F
–328 to 2498°F
–328.0 to 1472.0°F
–328.0 to 2012.0°F
–328.0 to 752.0°F
–454 to 2372°F, on models with 
release numbers 3 and later.
32 to 2372°F, on models with
release numbers 2 and earlier.
32 to 4199°F
–328.0 to 1652.0°F
–328.0 to 752.0°F
32 to 4352°F
–328.0 to 1112.0°F
–328.0 to 1022.0°F

Measurable RangeRangeInput Type

Chapter 13 Specifications



13-2 IM 04L42B01-01E

Item Specifications
Thermocouple burnout* Burnout upscale/downscale selectable (for each channel).

Normal:	2	kΩ	or	less.,	Burnout:	100	kΩ	or	more	(parallel	capacitance	of	0.01	µF	or	less)
Detection current: Approx. 10 µA

1-5 range burnout* Burnout upscale/downscale selectable (for each channel).
Burnout detection:  Greater than “scale upper limit + 10% of scale width“ (upscale) or  

“scale lower limit – less than 5% of scale width“ (downscale)
TC reference junction compensation

Internal reference junction compensation or external reference junction compensation
Filter function Takes the moving average of the input values (for each channel). Moving average data points: 2 to 

400
Computation

Difference computation Computable range: DC voltage, TC, RTD, and DI
Linear scaling Computable range: DC voltage, TC, RTD, and DI

Scalable range: –30000 to 30000. The decimal place is within 4 digits to the right 
of the decimal point.

Unit: 6 digits or less
Over value detection: The value can be set to over value when ±5% of the scale range 

is exceeded.
Square root computation Takes the square root of the input and apply linear scaling

Computable type: DC voltage
Scalable range and unit: Same as linear scaling
Low-cut: Set the low-cut value in the range of 0.0% to 5.0% of the span.
Over value detection: Same as linear scaling

1-5V Computable range: 1-5
Scalable range and unit: Same as linear scaling
Low-cut: The low-cut point is fixed to the span lower limit.
Over value detection: Same as linear scaling

* In fast sampling mode, burnouts on all measurement channels cannot be detected within a scan interval. Burnout may not be 
detected until the number of measurements indicated below is carried out if measurement is started in a burnout condition or 
after a burnout occurs.
DX2004 and DX2008: Up to 4 measurements. DX2010, DX2020, DX2030, DX2040, and DX2048: Up to 2 measurements.

Alarms
Item Specifications
Number of alarms Up to four alarms (level) for each measurement channels
Levels and colors You can change the alarm colors and display order by setting priorities and colors for each alarm 

(release number 3 or later). 
The alarm level and color settings are shared by all channels.

Alarm type High limit, low limit, difference high limit, difference low limit, high limit on rate-of-change alarm, low 
limit on rate-of-change alarm, delay high limit, and delay low limit

Alarm delay time 1 to 3600 s (for each channel)
Rate-of-change calculation interval of rate-of-change alarms

1 to 32 times the scan interval (common to all channels)
Alarm output Output to the internal switch

Number of internal switches: 30
Internal switch operation: AND/OR operation selectable

Hysteresis High and low limit alarm: 0.0 to 5.0% of the span (common to all channels)
Difference high and low limit alarms: 0.0 to 5.0% of the span (common to all channels)

Display Displays the status on the respective operation screen and an alarm icon on the status display 
section when an alarm occurs.
Display operation: Hold or not hold the display until the alarm acknowledge operation.

Alarm hide function (alarm no logging function)
Not display alarms nor record to the alarm summary (for each channel)

Alarm information Displays a log of alarm occurrences on the alarm summary.
Alarm Annunciator function (release number 3 or later)

Alarm displays and relay output operations can be made to follow an alarm sequence.
There are three supported alarm sequences: ISA-A-4, ISA-A, and ISA-M.
First-out display function: none

13.1  Signal Input and Alarm
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13.2 Display Function

Display
Item Specifications
Display* 10.4-inch TFT color LCD (640 × 480 dots)
Brightness 6 levels
Backlight saver function Dim or turn off the LCD backlight if there is no key operation for a specified time.
*  A section of the LCD monitor may contain pixels that are always on or off. The brightness of the LCD may also not be uniform 

due to the characteristics of the LCD. This is not a malfunction.

Displayed Information
Item Specifications
Display groups Assign channels to groups on the trend display, digital display, and bar graph display and display.
Number of groups 36
Number of channels that can be assigned to each group

Up to 10
Display color Channel: Select from 24 colors

Background: Select white or black (excludes the Overview, Alarm annunciator, and Custom 
displays. See the item on the Historical trend display for information on that 
display.) 

Trend display (T-Y display)
Waveform line width Select from 1, 2, and 3 dots
Display method Orthogonal axis display with time axis (T) and measured value axis (Y)

Layout: Vertical, horizontal, wide, or split
Trend interval: 5 s, 10 s (release number 3 or later), 15 s, 30 s, 1 min, 2 min, 5 min, 10 min, 15 

min, 20 min, 30 min, 1 h, 2 h, 4 h, and 10 h/div for the DX2004 and DX2008. 
15 s (only in fast sampling mode; release number 3 or later), 30 s, 1 min, 2 min, 
5 min, 10 min, 15 min, 20 min, 30 min, 1 h, 2 h, 4 h, and 10 h/div for the DX2010, 
DX2020, DX2030, DX2040, and DX2048.

Switchable to the secondary trend interval.
Scale Display a scale for each channel.

Current value bar graph, color scale band, and alarm point marks can be displayed on the scale.
Others Grid (divisions: 4 to 12), trip line (line width: 1, 2, or 3 dots), message, zone display, partial 

expanded display, auto zone display (release number 3 or later), fine grid (release number 3 or 
later), and tag detail display (release number 3 or later)

Trend display (circular display)
Display method Time axis: Circle, Measured value axis: Perimeter

Time per revolution:  Select from the available settings between 20 min and 4 weeks (20 min 
available only on the DX2004 or DX2008).

Display format: Full circle display and quarter cycle display
Digital Display Displays measured values numerically
Update rate 1 s (scan interval if the scan interval is greater than 1 s)
Bar graph display Displays the measured value on a bar graph

Direction Vertical or horizontal
Base position End or center
Update rate 1 s (scan interval if the scan interval is greater than 1 s)
Scale Display a scale for each channel

Color scale band, and alarm point marks can be displayed on the scale.
Historical trend display (T-Y display) 

Redisplays the display data or event data in the internal memory or external storage medium.
Display format All screen or half screen (only when the display data is being redisplayed)

Top channel (release number 3 or later): Displays the specified channel in front of all the others.
Auto span display (release number 3 or later): Automatically adjusts the display span of the 
specified channel.
Auto zone display (release number 3 or later): Displays channels in different zones.

Time axis operation The time axis can be reduced or expanded, and data can be displayed continuously. The time 
display can be switched from absolute to relative time (release number 3 or later).

Add message Messages can be added.
Background color Select from white, cream, black, or light gray.
Data search Waveforms from the internal memory can be displayed through the specification of a date and time 

(release number 3 or later).
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Item Specifications
Historical display (circular display)

Display format Full circle display and quarter cycle display
Others Same as the historical trend display (T-Y display)

Overview Display Displays the measured values of all channels and the alarm statuses (if the number of channels 
exceeds 261, the measured values are not displayed.).

Information display
Alarm summary display Displays a log of up to 1000 alarms.

Specify an alarm with the cursor and jump to the corresponding section on the historical trend 
display.

Message summary display
Time and content of up to 450 messages (including 50 add messages)
Specify a message with the cursor and jump to the corresponding section on the historical trend 
display.

Memory summary display Displays the information of the data in the memory.
Specify a file with the cursor and jump to the corresponding section on the historical trend 
display.
Save the data in the internal memory to the external storage medium using keys.

Report (/M1 and /PM1) Displays the report data residing in the internal memory.
Stacked bar graph (/M1 and /PM1; Release number 3 or later)

Displays the report data of each report group in a stacked bar graph.
Display formats:  H+D (hourly data is used for the display), Day+Week (daily data is used for 

the display), D+M (daily data is used for the display)
Report groups:  Report channels are arranged in groups of sixes starting with the first 

channel (R001). The group arrangements are fixed.
Scale/grid: Fixed at four divisions
Update interval: 1 s
The report data of the channels in the specified group is displayed in a stacked bar graph.
 However, only channels that have the same unit of measurement as the first channel in the 
group are displayed.

Status Display Relay status display: Displays the ON/OFF status of the alarm output relay and internal 
switch.

Modbus client status: Displays the communication status on the Modbus client
Modbus master condition: Displays the communication status on the Modbus master
Event switch display 
(release number 3 or later):

 
Displays the status of the event level switches.

Log display Displays the login log (only for the DX without /AS1), error log, communication log, FTP log, Web 
log, e-mail log, SNTP log, DHCP log, Modbus log, operation log (/AS1 option; release numbers 4 
and later), and change settings log (/AS1 option; release numbers 4 and later).

Four panel display Divides the screen into four sections and displays four different display formats.
Four combinations of screens can be registered.

Alarm annunciator display (release number 3 or later)
Display windows: 80 max. 
Display window label characters: 32 characters × 5 lines max. Comment text blocks are used.

Custom display Through operations such as size adjustments and attribute configurations, display components 
(such as the trend, digital, and bar graph displays) can be arranged to create a custom display. 
The display data that is created can be saved to internal memory or to an external medium (CF). 
The saved data can be loaded and displayed.
Number of displays: 28 (3 in the internal memory and 25 in a CF card)

System information display Displays the number of measurement and computation channels, options, remote controller ID, 
MAC address, firmware version, and internal memory capacity.

Network information display Displays the DX network setup information.

13.2  Display Function



13-5IM 04L42B01-01E

Specifications

1

2

3

4

5

6

7

8

9

10

11

12

13

App

Index

Other Displayed Information
Item Specifications
Tag display Tag numbers and comments can be displayed.

Tag numbers (release number 3 or later)
 Up to 16 characters
 Displayable characters: Alphanumeric characters
 Tag numbers can be enabled or disabled.
Tag comments 
  32 characters on a DX with a release number of 3 or later. 16 characters on a DX with 

a release number of 2 or earlier. 
Displayable characters: Alphanumeric characters

Message Write messages to the trend display.
Number of messages 100
Maximum number of saved messages

400
Character Up to 32 alphanumeric characters
Write method Write a preset message or write an arbitrary message on the spot.
Write destination Select only the displayed group or all groups.
Auto message Write a message when the DX recovers from a power failure while memory sampling is in 

progress.
Write a message when the trend interval is switched during memory sampling.

Add message Write messages to the past data positions.
Message The same as the “Message” item above
Maximum umber of saved messages

50
Status display section Displays the DX status at the upper section of the display.

Displayed contents Year, month, day, time, displayed group name/display name, user name (when using the login 
function), batch name (when using the batch function), internal memory status, external storage 
medium status, alarm status, and function usage status (key lock , computation function, and 
e-mail)

Auto switching of displayed groups
Switches the display group at a given interval.
Interval: Select from the available settings between 5 s and 1 min.

Default display Specify the display to be shown automatically when keys are not operated.
Time until the display switches: Select from the available settings between 1 min and 1 h.

Favorite display Register frequently used displays to the Favorite key and show them through simple operation.
Up 8 displays can be registered.

Language Select English, Japanese, German, French, or, Chinese.
Display selection menu customization

Show/hide and change the positions of each item in the display selection menus and sub menus
Insert/delete separators.

FUNC key menu customization
Show/hide and change the display positions of each item.

Comments display (release number 3 or later)
Displays comments (from a comment text block) when events occur.

Comment text blocks 100
Comment text block contents

Comment text blocks consist of 5 comment text fields.
Comment text fields 200

Characters: up to 32 characters
Displayable characters: Alphanumeric characters

13.2  Display Function
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13.3 Data Saving Function

Configuration
Item Specifications
Internal memory Temporarily saves various types of data.

Medium Flash memory
External storage medium

Medium CF card (up to 2 GB)
Format FAT32 or FAT16

Data Type
Item Specifications
DX data types and file extensions
Data Type Extension Notes
Display data .DAD

.DSD /AS1, release numbers 4 and later
Event data .DAE

.DSE /AS1, release numbers 4 and later
Manual sampled data .DAM
Screen image data .PNG
Setup data .PDL

.PEL /AS1, release numbers 4 and later
Report data .DAR /M1 and /PM1

.xml /M1 and /PM1, release numbers 4 and later
Custom display setup data .CDC Release numbers 3 and later
Change settings log data .TXT /AS1, release numbers 4 and later

Display Data and Event Data
Item Specifications
Internal memory

File storage capacity 400 MB (standard memory; release numbers 4 and later)
Number of files Up to 400
Operation FIFO (First In First Out)

Display data
Target Measurement/computation/external input channel
Sampling interval Synchronized to the trend interval.
Description Maximum or minimum value per sampling interval
Data size Measurement/External input channel data: 4 bytes/data value. Computation channel data:  

8 bytes/data value.
File size Up to 8 MB
Data format Binary
Recording Records data at all times.

Event data
Target Measurement/computation/external input channel.
Sampling intervals Determined by the sample rate.

25 ms, 125 ms, 250 ms, 500 ms, 1 s, 2 s, 5 s, 10 s, 30 s, 1 min, 2 min, 5 min, 10 min, 15 min, 20 
min and 30 min (15 min, 20min, and 30min are only available on releases 3 and later)
An interval that is shorter than the scan interval cannot be set.

Description Data per sampling interval
Data size Measurement/External input channel data: 2 bytes/data value. Computation channel data:  

4 bytes/data value.
File size Up to 8 MB
Data format Binary
Mode Free: Records data at all times.

Trigger: Starts recording data when a certain event occurs and records for the specified interval.
Combinations of saved data Display data only, event data only, or display data and event data
File size See appendix 1.
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Manual Sampled Data
Item Specifications
Item Measured value at an arbitrary time

Specify up to 120 channels when external input channels (/MC1) are used.
Maximum number of data values that 
the internal memory can store

400

Data format Text

Report Data (/M1 and /PM1)
Item Specifications
Item Report at each scheduled time of report
Maximum number of reports that the 
internal memory can store

100

Data format Text or XML spreadsheet (release numbers 4 and later)

Snapshot Data
Item Specifications
Item Displayed screen image data
Data format PNG
Output destination CF card or communication output

Saving Data to the External Storage Medium
Item Specifications
Data Saving Saves the data in the internal memory to the external storage medium.

Manual save Saves when the external storage medium is inserted with a key operation.
Auto save Display data: Every file save interval

Event data: Every data length
Manual sampled data: When manual sampling is executed.
Report data: When report is created.
Snapshot data: When a snapshot is taken

Auto save operation Select “save data only if there is sufficient free space on the CF card” or “constantly 
retain the most recent data files in the CF card (media FIFO)” (release number 2 or later).

File name Select from “sequence number+user-assigned string+date,” “sequence number+user-
assigned string,” or “sequence number+batch name.”

Save destination Auto save: CF card. Manual save: CF card or USB flash memory (/USB1)
Directory name: Specify using up to 20 characters.

Change Settings Log Data (/AS1; release numbers 4 and later)
Item Specifications
Item Log of setting changes
Maximum number of data values that 
the internal memory can store

200

Data format Text
Output destination (auto save) SET0 directory on the CF card

A file name that includes the execution date is automatically attached.

Setup Data
Item Specifications
Item DX setup data
Data format Binary
File name Specify using up to 32 characters.
Output/read destination (for saving/loading)

CF card or USB flash memory (/USB1)
Output destination (auto save; when the settings are changed on a DX with the /AS1 option)

SET0 directory on the CF card
A file name that includes the execution date is automatically attached.

13.3  Data Saving Function
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Custom Display Setup Data
Item Specifications
Contents Custom display layout settings
Format Text
File name Up to 32 characters
Save to/Load from CF card

Data File Loading
Item Specifications
Function Load and show the display data or event data in a CF card or USB flash memory (/USB1).

Miscellaneous
Item Specifications
Header comment Add up to 50 characters of comment to display data, event data, manual sampled data, or report 

data file.

13.3  Data Saving Function
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13.4 Other Standard Functions

Event Action Function
Item Specifications
Event action Execute a specified operation when a given event occurs.
Number of settings 40
Events Remote control input, etc.

Timer Number of timers: 4
Match time timer Number of timers: 4

Action Specify memory start/stop, alarm ACK, etc.
There are limitations on the combinations of events and actions.

Security Function
Item Specifications
Key lock function Limitations to key operation, access to the external storage medium, and various operations
Login function Only registered users can operate the DX.

System administrators 5 administrators
Users 30 users

Time Related Functions
Item Specifications
Clock With a calendar function

Accuracy ±10 ppm (0 to 50°C), excluding a delay (of 1 second, maximum) caused each time the power is 
turned on.

Time setting Using key operation, communication command, event action function, or SNTP client function
Time adjustment method

While memory sampling Corrects the time by 40 ms for each second.
Limit in which the time is gradually adjusted: Select from the available settings between 10 s and 
5 min.
If the time is outside the limit, the time is immediately corrected.
Cannot be used after hour 0 on January 1st, 2038.

While memory is stopped Immediately change the time.
DST The date/time for switching between standard time and DST can be specified.
Time zone Sets the time difference from GMT.
Date format Select YYYY/MM/DD, MM/DD/YYYY, DD/MM/YYYY, or DD.MM.YYYY.

Types of Characters That Can Be Handled
Item Specifications
Characters Alphabet characters, numbers, and symbols (limitation exists)

Miscellaneous
Item Specifications
Decimal point type (release number 3 or later)

Period or comma
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Communication Functions
Item Specifications
Electrical and mechanical specifications

Conforms to IEEE 802.3 (Ethernet frames conform to the DIX specification).
Medium Ethernet (10BASE-T)
Implemented protocols TCP, IP, UDP, ICMP, ARP, DHCP, HTTP, FTP, SMTP, SNTP, Modbus, and DX-dedicated protocols
E-mail client Automatically send e-mail at specified times.
FTP client Automatically transfer data files to the FTP server.

Applicable files: Display data, event data, screen image data, and report data
FTP Server Transfer files, delete files, manipulate directories, and output file lists of the DX.
Web server Shows the DX display on a Web browser.
SNTP client Inquires the time to the SNTP server and sets the DX.

Cannot be used after hour 0 on January 1st, 2036.
SNTP server Outputs the DX time.

Time resolution: 5 ms
Cannot be used after hour 0 on January 1st, 2036.

DHCP client Automatically obtain the network address settings from the DHCP server.
Modbus client Reads data from another device and writes to the registers.
Modbus server Loads measurement and computation channel data

Loads and writes external input channel data
Loads and writes communcation input data
Some control commands such as memory start
Modbus client register access limitations

Setting/Measurement server
Operate, set, and output data of the DX using a dedicated protocol.

Maintenance/test server Outputs connection information and network information.
Instrument information server

Outputs information (serial number, model name, etc.) of the connected DX.
EtherNet/IP server Can join an EtherNet/IP network as an adapter (server)

Loads measurement and computation channel data
Loads and writes external input channel data
Loads and writes communcation input data

Batch Function
Item Specifications
Function Data management using batch names. Enter text fields and batch comments in the data file.
Batch name Added to the file name of the display data and event data.

Structure Batch number (up to 32 characters) + lot number (up to 8 digits)
Text field  Adds text to the display data and event data. There are 24 available text fields for release numbers 

3 and later. There are 8 available text fields for release numbers 2 and earlier. Up to 20 title 
characters and 30 other characters can be entered per field.

Batch comment Adds text to the display data and event data.

13.4  Other Standard Functions
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13.5 Options

Alarm Output Relay (/A1, /A2, /A3, /A4, and /A5)
Item Specifications
Action Outputs relay contact signals from the terminals on the rear panel when alarms occur.
Number of outputs 2 outputs (/A1), 4 outputs (/A2), 6 outputs (/A3), 12 outputs (/A4), and 24 outputs (/A5)
Relay contact rating 250 VAC (50/60 Hz)/3 A, 250 VDC/0.1 A (for resistance load)
Output format NO-C-NC
Relay operation Energized/deenergized, AND/OR, hold/non-hold, and reflash settings are selectable.

RS-232 Interface (/C2) and RS-422/485 Interface (/C3)
Item Specifications
Connection EIA RS-232(/C2) or EIA RS-422/485(/C3)
Protocol Dedicated protocol or Modbus protocol
Synchronization Start-stop synchronization
Transmission mode (RS-422/485)

Four-wire half-duplex multi-drop connection (1:N (N = 1 to 32))
Data rate 1200, 2400, 4800, 9600, 19200, or 38400 bps
Data length 7 or 8 bits
Stop bit 1 bit
Parity Odd, even, or none
Handshaking Off:Off, XON:XON, XON:RS, and CS:RS
Communication distance (RS-422/485)

1200 m
Modbus communication Operation modes: Master or slave

VGA Output (/D5)
Item Specifications
External display Resolution: 640 × 480 dots (VGA)

Connector: 15-pin D-Sub

FAIL/Status Output Relay (/F1)
Item Specifications
Relay operation assignment You can select which operations to assign to the two relays (release numbers 4 and later).
FAIL output Relay contact output on CPU error

Relay operation Energized during normal operation and de-energized on system error.
Status output Output a relay contact signal when a selected condition occurs.

A combination of the following conditions can be selected:
 Low memory, memory failure, media error, A/D hardware error, burnout detection, communication 
error (Modbus master or client communication error), alarm occurrence

Relay operation Relay is energized when a condition occurs.
Relay contact rating 250 VAC (50/60 Hz)/3 A, 250 VDC/0.1 A (for resistance load)

FAIL/Alarm Output Relay 22 Outputs (/F2)
Item Specifications
FAIL/status output Same as /F1
Alarm output relay Number of outputs: 22. Same as /A[ ] for other specifications.

Clamped Input Terminal (Detachable) (/H2)
Item Specifications
Input terminal Make the input section clamp input terminals (detachable).

Recommended wire size: 0.08 to 1.5 mm2 (AWG 28 to 16)
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Desktop Type (/H5[ ])
Item Specifications
Construction With carrying handle.

/H5D, /H5F, /H5R, /H5J, /H5H: Power Inlet connector. With a power cord.
/H5: Can only be specified when /P1 is simultaneously specified. Screw type power terminal. 
Without power cord.

Computation Function (including the report function) (/M1)
Item Specifications
Number of computation channels

DX2004 and DX2008: 12 channels (101 to 112)
DX2010, DX2020, DX2030, DX2040, and DX2048: 60 channels (101 to 160)

Operation General arithmetic operations: Four arithmetic operations, square root, absolute, common 
logarithm, natural logarithm, exponential, and power

Relational operations: <,	≤,	>,	≥,	=,	and	≠
Logic operations: AND, OR, NOT, and XOR
Statistical operations: TLOG or CLOG
Special operations: PRE, HOLD, RESET, and CARRY
Conditional operation: [a?b:c]

Computation accuracy Double-precision floating point
Data that can be used

Channel data Measurement, computation, and external input channels (/MC1)
Constants 60 constants
Communication input data 60
Remote control input status 0/1 (/R1)
Pulse input Counts the number of pulses (/PM1)
Status input Internal switch, alarm output relay (/A[ ]), flags, and recording (memory sampling) status (release 

number 3 or later)
Rolling average Performs moving average on the computed results.
Measurement range –9999999 to 99999999

Decimal place: 0 to 4 digits to the right of the decimal point
Alarms High limit, low limit, delay high limit, and delay low limit

Hysteresis: High and low limit alarm: 0.0% to 5.0% of the span.
Display Same as the measurement channels
Data saving Same as the measurement channels
Report function Number of report channels: 12 or 60 (same as the number of computation channels)

Computation types: Average, maximum, minimum, sum, or instantaneous value
Report types: Hourly, daily, hourly + daily, daily + weekly, daily + monthly
Report templates (report output according to templates in XML spreadsheet format; release 
numbers 4 and later). Templates (xml files) are available on Excel 2003 or later.

13.5  Options
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Cu10, Cu25 RTD Input/3 Leg Isolated RTD Input (/N1)
Item Specifications
Function In addition to the standard input, the DX can also receive Cu10 and Cu25 input.

On the DX2010, DX2020, DX2030, DX2040, and DX2048, all the RTD input terminals (A, B, 
and b) are isolated on each channel.

Measurement/display accuracy Under standard operating conditions

Input Type
Measurement

Range
Setting

Accuracy
Guaranteed

Range

Measurement Accuracy Max.
ResolutionA/D integration time:

16.7 ms or more
A/D integration time:

1.67 ms
Cu10 (GE)
Cu10 (L&N)
Cu10 (WEED)
Cu10 (BAILEY)
Cu10:α=0.00392 at 20°C
Cu10:α=0.00393 at 20°C
Cu25:α=0.00425 at 0°C

Cu1
Cu2
Cu3
Cu4
Cu5
Cu6
Cu25

–70.0 to 170.0°C
–75.0 to 150.0°C
–200.0 to 260.0°C

–200.0 to 300.0°C

–200.0 to 300.0°C

* Measuring current i = 1 mA

±(0.4% of rdg + 1.0°C)

±(0.3% of rdg + 0.8°C)

±(0.8% of rdg + 5.0°C)

±(0.5% of rdg + 2.0°C)

0.1°C

Input source resistance 1	Ω	or	less	per	wire	(The	resistance	of	all	three	wires	must	be	equal).
Ambient temperature influence (applies when the A/D integration time is 16.67 ms or greater, with temperature variation of 10°C)

±(0.2% of range + 2 digits) or less
Input source resistance With	variation	of	1	Ω	per	wire	(resistance	of	all	three	wires	must	be	equal):	±(0.1%	of	rdg	+	1	

digit) or less
With	maximum	difference	of	40	mΩ	between	wires:	Approx.	1°C

13.5  Options
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3 Leg Isolated RTD Input (/N2)
Item Specifications
Input terminal All the RTD input terminals (A, B, and b) are isolated on each channel.

Applies to DX2010, DX2020, DX2030, DX2040, and DX2048
Note:  On the DX2004 and DX2008 standard models, all the terminals (A, B, and b) are already 

isolated on each channel.

Extended Input Type (/N3)
Item Specifications
Measurement/display accuracy

Under standard operating conditions

Kp vs Au7Fe 0.0 to 300.0K

PLATINEL 0.0 to 1400.0°C

PR40-20 0.0 to 1900.0°C

NiNiMo 0.0 to 1310.0°C
W/WRe26 0.0 to 2400.0°C

Type N(AWG14) 0.0 to 1300.0°C
XK GOST*2 –200.0 to 600.0

Pt50 –200.0 to 550.0°C
Ni100(SAMA) –200.0 to 250.0°C
Ni100(DIN) –60.0 to 180.0°C
Ni120 –70.0 to 200.0°C
J263*B 0.0 to 300.0K

Cu53 –50.0 to 150.0°C
Cu100 –50.0 to 150.0°C
Pt25 –200.0 to 550.0°C
Pt100GOST*2 –200.0 to 600.0°C
Cu100 GOST*2 –200.0 to 200.0°C
Cu50 GOST*2 –200.0 to 200.0°C
Cu10 GOST*2 –200.0 to 200.0°C
Pt46 GOST*2 –200.0 to 550.0°C

*1  Measuring current i = 1 mA
*2  Available for release numbers 3 and later.
*3 Available for release numbers 4 and later. Double the resistance of a 100 ohm Platinum (TCR = .003902 ohms/ohm/°C) 
 Curve A resistor made by Weed Instrument.

Measurement
Range

Measurement Accuracy
Max.

Resolution
Input Type

Thermocouple

RTD*1

0 to 20 K Within ±4.5 K
20 to 300 K Within ±2.5 K
±(0.25% of rdg + 2.3°C)
0 to 450°C Accuracy not guaranteed
450 to 750°C ±(0.9% of rdg + 3.2°C)
750 to 1100°C ±(0.9% of rdg + 1.3°C)
1100 to 1900°C ±(0.9% of rdg + 0.4°C)
±(0.25% of rdg + 0.7°C)
0 to 400°C ±15.0°C
400 to 2400°C ±(0.2% of rdg + 2.0°C)
±(0.2% of rdg + 1.3°C)
–200 to –100°C ±(0.25% of rdg +1.0°C)
–100 to 600°C ±(0.25% of rdg + 0.8°C)
±(0.3% of rdg + 0.6°C)
±(0.15% of rdg + 0.4°C)
±(0.15% of rdg + 0.4°C)
±(0.15% of rdg + 0.4°C)
0 to 40 K Within ±3.0 K
40 to 300 K Within ±1.0 K
±(0.15% of rdg + 0.8°C)
±(0.2% of rdg + 1.0°C)
±(0.15% of rdg + 0.6°C)
±(0.15% of rdg + 0.3°C)
±(0.15% of rdg + 0.3°C)
±(0.4% of rdg + 0.5°C)
±(1.5% of rdg + 3.0°C)
±(0.3% of rdg + 0.8°C)

Within ±13.5 K
Within ±7.5 K
±(0.25% of rdg + 8.0°C)
Accuracy not guaranteed
±(0.9% of rdg + 15.0°C)
±(0.9% of rdg + 6.0°C)
±(0.9% of rdg + 3.0°C)
±(0.5% of rdg + 3.5°C)
±30.0°C
±(0.4% of rdg + 4.0°C)
±(0.5% of rdg + 7.0°C)
±(0.5%of rdg +5.0°C)
±(0.5%of rdg +4.0°C)
±(0.6% of rdg + 3.0°C)
±(0.3% of rdg + 2.0°C)
±(0.3% of rdg + 2.0°C)
±(0.3% of rdg + 2.0°C)
Within ±9.0 K
Within ±3.0 K
±(0.3% of rdg + 4.0°C)
±(0.4% of rdg + 5.0°C)
±(0.3% of rdg + 3.0°C)
±(0.3% of rdg + 1.5°C)
±(0.3% of rdg + 1.5°C)
±(0.8% of rdg + 2.5°C)
±(3.0% of rdg + 15.0°C)
±(0.6% of rdg + 4.0°C)

0.1K

0.1°C

0.1K

0.1°C

A/D integration time: 16.7 ms or more A/D integration time:
1.67 ms

Pt200 (WEED)*3 –100.0 to 450.0°C ±(0.3% of rdg + 0.6°C) ±(0.6% of rdg + 3.0°C)

Input source resistance Thermocouple input: 2	kΩ	or	less
RTD	input:1	Ω	or	less	per	wire	(The	resistance	of	all	three	wires	must	be	equal).

Ambient temperature influence (applies when the A/D integration time is 16.67 ms or greater, with temperature variation of 10°C)
TC input ±(0.1% of rdg + 0.05% of range) or less, excluding the error of reference junction compensation
RTD input ±(0.2% of range + 2 digits) or less

Input source resistance
TC input With	variation	of	+1	kΩ: ±10 µV or less
RTD input With	variation	of	1	Ω	per	wire	(resistance	of	all	three	wires	must	be	equal): 

±(0.1% of rdg + 1 digit) or less
With	maximum	difference	of	100	mΩ	between	wires:Approx.	1	°C

13.5  Options
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Remote Control (/R1)
Item Specifications
Number of input terminals 8
Input type Isolated from the main circuitry through a photocoupler, built-in isolated power supply for the input 

terminals, and shared common.
Input type and signal level

Voltage-free contact Contact	closed	at	200	Ω	or	less	and	contact	open	at	100	kΩ	or	greater.	The remote contact input 
operation can be set to normal open or normal close (release number 3 or later)

Open collector ON voltage: 0.5 V or less (sink current 30 mA or more), leakage current when OFF: 0.25 mA or less
Allowable input voltage 5 VDC
Signal type Level or edge (250 ms or more)
Action Executes a specified action by applying a given signal to the remote signal input terminal.

Action assignment: Set using the event action function

24 VDC Transmitter Power Supply (/TPS4 and /TPS8)
Item Specifications
Number of loops 4 (/TPS4) or 8 (/TPS8)
Output voltage 22.8 to 25.2 VDC (under rated load current)
Rated output current 4 to 20 mADC
Max. output current 25 mADC (overcurrent protection operation current: approx. 68 mADC)
Allowable conductor resistance

RL	≤	(17.8	–	minimum	transmitter	operation	voltage)/0.02	A
where 17.8 V is the result obtained by subtracting the maximum drop voltage of 5 V when the 
load	shunt	resistance	is	250	Ω	from	the	minimum	output	voltage	of	22.8	V

Max. length of wiring 2 km (when using the CEV cable)
Insulation resistance 20	MΩ	or	more	at	500	VDC	between	output	terminal	and	ground
Dielectric strength 500 VAC (50/60 Hz, I = 10mA) for one minute between output terminal and ground

500 VAC (50/60 Hz, I = 10mA) for one minute between output terminals

Easy Text Entry (/KB1 and /KB2)
Item Specifications
Remote control terminal (438227)

Operating temperature range
0 to 40°C

Operation humidity range 20% to 80% RH (at 5 to 40°C no condensation)
Power supply 3 VDC AA dry batteries × 2
Weight Approx. 60 g (excluding the batteries)
External dimensions 170 (H) × 50 (W) × 23.7 (D) mm
Signal Infrared

Combination with the DX
Number of units that can be controlled individually

Up to 32 units by setting the ID number
Communication distance Up to 8 m from the front of the light receiving section of the DX (reference value)*
Directional characteristics

See the figure below (reference characteristics)*
* Varies depending on the operating environment such as the battery voltage and the presence 

or absence of external light.
Standard accessories (/KB1)

Remote control unit, two alkaline dry batteries, and ID number label

Distance (m)

Horizontal Vertical
0

0 0

30

15 1510 105 51 1

-30
-45

-60

45

60

90-90

Distance (m)

0
30
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-30
-45

-60
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90-90

(+)
(+)

(-) (-)
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USB Interface (/USB1)
Item Specifications
USB port Complies with Rev. 1.1 and host function
Number of ports 2 (one each on the front panel and rear panel)
Power supply 5 V ± 10% , 500 mA (per port)

Devices which need more than 500 mA total bus power for 2 ports can not be connected at the 
same time.

Connectable devices Only connect the devices listed below to prevent damage to the devices.
Keyboard Complies with HID Class Ver. 1.1

1104 keyboard/89 keyboard (US) and 109 keyboard/89 keyboard (Japanese)
Number connectable units: 1

External medium USB flash memory (up to 2 GB)
Does not guarantee the operation of all USB flash memories.
External medium such as a hard disk, ZIP, MO, and optical discs are not supported.
Number connectable units: 1

Barcode reader (release number 3 or later)
USB HID Class Ver. 1.1 compatible
English (U.S.) standard USB keyboard compatible

Pulse Input (/PM1)
Item Specifications
Pulse input

Number of inputs 3 (8 when using the remote control input terminals)
Input type Isolated from the main circuitry through a photocoupler and built-in isolated power supply for the 

input terminals.
Shared common for pulse inputs.

Input type and signal level Voltage-free contact Contact	closed	at	200	Ω	or	less	and	contact	open	at	100	kΩ	or	greater

Open collector ON voltage: 0.5 V or less (sink current 30 mA or more), leakage current when

 OFF: 0.25 mA or less
Counting Counts the rising edges of pulses.

For voltage-free contact input: Contact open to contact close
For open collector: Voltage level of the terminal H from high to low

Allowable input voltage 30 VDC
Max. sampling pulse period 100 Hz
Minimum detected pulse width

5 ms or more for both low (closed) and high (open)
Pulse detection period Approx. 3.9 ms (256 Hz)
Pulse measuring accuracy ±1 pulse
Pulse count interval Scan interval or 1 s
Miscellaneous Pulse input terminals can be used as remote control input terminals, isolated from remote control 

input terminals
Remote control Number of inputs: 5. Same as remote control (/R1) for the other specifications
Computation function Same as the computation function (/M1)

Calibration Correction (/CC1)
Item Specifications
Calibration correction method Corrects the measured value of each channel using segment linearizer approximation.

Number of segment points: 2 to 16 (including the start and end points)
Calibration management A function to make sure that calibration is performed regularly (release numbers 4 and later).

External Input Function (/MC1)
Item Specifications
Function Loads data from other instruments using the Modbus client or Modbus master function and 

displays, records, and saves the data.
Number of channels 240 channels (201 to 440)
Display Same as the measurement channels
Data saving Same as the measurement channels
Manual sample Specify up to 120 channels from measurement, computation, and external input channels.

13.5  Options
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DC/AC 24 V Power Supply (/P1)
Item Specifications
Rated supply voltage 24 VDC and 24 VAC (50/60Hz)
Allowable power supply voltage range

21.6V to 26.4 VDC/AC
Insulation resistance Between	power	terminal	and	earth:	20	MΩor	greater	at	500	VDC.
Withstand voltage Between power terminal and earth: 500 VAC at 50/60 Hz for one minute
Rated power supply frequency (for AC)

50/60 Hz 
Allowable power supply frequency range (for AC)

50 Hz±2%, 60 Hz±2%
Power supply fluctuation (for AC)

With variation within 21.6 to 26.4 VDC/AC: ±1digit or less
With variation of ±2 Hz from rated power supply frequency (at 24 VAC): ±(0.1% of rdg+1digit) or 
less

Rated power consumption 45 VA (for DC), 70 VA (for AC)

Power consumption Supply voltage LCD backlight off Normal Maximum
24 VDC 12 VA 20 VA 45 VA
24 VAC (50/60Hz) 20 VA 34 VA 70 VA

Multi Batch Function (/BT2; release number 3 or later)
Item Specifications
Function Individual recording start/stop and file generation operations can be performed for each batch.

Equippable models: DX2010, DX2020, DX2030, DX2040, and DX2048
Number of batches 2 to 12
Batch single operations Recording start/stop, computation reset, message write
Batch overview operations Computation start/stop, report start/stop, manual sampling, setup data save/load
Scan interval Maximum speed of 1 s in normal mode only (same for all batches)
Data type Display or event data only. Trigger mode cannot be used for event data.
Data recording interval Same for all batches
Data files Can be displayed or made into an event data file separately for each batch
Number of display groups Up to twelve per batch

The maximum number of channels per group is ten.
Channels in a display group are sampled for display or event data.

Timers and match time timers 12 max.
Batch single settings Group, trip line, file header, data file name, text field, batch number, and lot number

PROFIBUS-DP (/CP1 option; release number 3 or later)
Item Specifications
Function A PROFIBUS-DP master device can access internal data in the following ways:

Load measurement channel data
Load computation channel data
Write to communication input data (for up to 32 channels)

Data mapping
Buffer Description Maximum Size
Input Measurement channels are arranged at the start of the buffer. As 

many computation channels as can be placed into the buffer are 
inserted after the measurement channels.

128 bytes

Output Up to 32 communication input data values is arranged. 128 bytes
Node address 0 to 125
Interface PROFIBUS-DP-V0 Slave
Transmission medium Two dedicated cables (one for each signal line)
Transmission speed/distance 9.6 kbps/1200 m to 12 Mbps/100 m
Terminator No internal terminator (must be terminated externally)

13.5  Options
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Advanced Security Function (/AS1; release numbers 4 and later)
Item Specifications
Login function Only registered users can operate the DX.

Administrators 5 administrators
Users 90 users
User identification User name, user ID, and password

Password management function Password management feature that uses Windows Server 2003 or 2008 Active Directory 
feature
Supports login authentication through a Kerberos authentication server

Audit trail function
Operation log storage The operation history from the previous memory stop to the current memory stop is attached 

to a data file.
Maximum operation logs: 2000

Change settings log and setup file storage
A setup file and change settings log are saved to the CF card when the settings are 
changed.

Signature function (digital signature) Attaches approval information to measured data files.
Information that can be attached User name, date and time, pass/fail, comment
Number of signatures Up to 3 per file
Signature record Can be set for each user

The attached approval information cannot be deleted or changed.
Applicable files Display data files and event data files in the internal memory

When the process type is “Batch”: Undivided data files (one data file per batch)
When the process type is “Continue”: Each data file

Measured Data File Protection Measured data files are protected through operation logs, setup file storage, and encryption.
Data Formats and Extensions Files that use this function have special extensions.

Display data: .DSD, event data: .DSE, setup data: .PEL, change settings log data: .TXT
Miscellaneous (main differences from DXs without the /AS1 option)

Data types Display or event data only. Trigger mode cannot be used for event data.
Individual alarm ACK ACK operations can be performed on individual alarms.
Alarm delay time Up to 24 h
Event Action The “PnlLoad” action is not available
Key lock No
Deletion of external storage medium files

Not allowed.
Formatting of external storage media

Not allowed.
Loading of setup files You can choose whether or not to load login information.
FAIL/status output relay (/F1 and /F2 options)

You can choose from five operations to assign to the two output relays.
Automatic messages A message is written when the setting mode setup items are changed during memory 

sampling.
Logs There is no login log. There is an operation log and a change settings log.

13.5  Options
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13.6 General Specifications

Construction
Item Specifications
Mounting Flush panel mounting (on a vertical plane) (excluding the desktop type)
Mounting angle Inclined backward up to 30 degrees from a horizontal plane.
Allowable panel thickness 2 to 26 mm
Material Case: Metal plate

Bezel and display cover: Polycarbonate
Color Case: Grayish blue green (Munsell 2.0B5.0/1.7 or equivalent)

Bezel: Charcoal gray light (Munsell 10B3.6/0.3 or equivalent)
Front panel Water and dust proof: Complies with IEC529-IP65 and NEMA No.250 TYPE 4 (except External 

Icing Test) (Style number 2 or later), except for side-by-side mounting
External dimensions 288(W) × 288(H) × 226(D) mm (D: depth from the panel mounting plane)
Weight DX2004 and DX2010: Approx. 6 kg. DX2008 and DX2020: Approx. 6.3 kg. DX2030: Approx. 6.9 

kg, DX2040 and DX2048: Approx. 7.3 kg excluding options

Normal Operating Conditions
Item Specifications
Supply voltage 90 to 132, 180 to 250 VAC
Power supply frequency 50 Hz ± 2%, 60 Hz ± 2%
Ambient temperature 0 to 50°C
Ambient humidity 20 to 80%RH (at 5 to 40°C), 10 to 50% (at 40 to 50°C)
Vibration 10 to 60 Hz, 0.2 m/s2

Shock Not allowed
Magnetic field 400 A/m or less (DC and 50/60 Hz)
Noise Normal mode (50/60 Hz)

DC voltage The peak value including the signal must be less than 1.2 times the measuring range.
Thermocouple The peak value including the signal must be less than 1.2 times the measuring thermal electromotive force.
RTD 50 mV or less
Common mode noise 250 VACrms or less for all ranges (50/60 Hz)
Maximum noise voltage between channels

250 VACrms (50/60 Hz) or less
Mounting position Can be inclined up to 30 degrees backward. Left and right horizontal.
Warm-up time At least 30 minutes after power on
Installation location Indoors
Operating altitude 2000 m or less

Power Supply
Item Specifications
Rated supply voltage 100 to 240 VAC
Allowable power supply voltage range

90 to 132, 180 to 264 VAC
Rated power supply frequency 50 Hz to 60 Hz
Power consumption Supply voltage LCD backlight off Normal Maximum

100 VAC 28 VA 42 VA 74 VA
240 VAC 38 VA 54 VA 100 VA

Allowable interruption time Less than 1 cycle of the power supply frequency

Isolation
Item Specifications
Insulation resistance Between	the	Ethernet,	RS-422/485,	and	insulation	terminals	and	earth:	 20	MΩ	or	greater	at	500	VDC
Withstand voltage Between the power terminal and earth: 2300 VAC at 50/60 Hz for one minute

Between the contact output terminal and earth: 1600 VAC at 50/60 Hz for one minute
Between the measurement input terminal and earth: 1500 VAC at 50/60 Hz for one minute
Mutually between measurement input terminals:  1000 VAC (50/60 Hz) for one minute (excluding the 

RTD input terminal of DX2010, DX2020, DX2030, 
DX2040, and DX2048) 

Between the remote input terminal and earth: 1000 VDC for one minute
Between the pulse input terminal and earth: 1000 VDC for one minute

Ground Grounding resistance: 100	Ω	or	less
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Transport and Storage Conditions
Item Specifications
Ambient temperature –25 to 60°C
Ambient humidity 5 to 95%RH (no condensation)
Vibration 10 to 60 Hz, 4.9 m/s2 maximum
Shock 392 m/s2 maximum (in packaged condition)

Supported Standards
Item Specifications
CSA CSA22.2 No.61010.1, installation category II*1, and pollution degree 2*2, measurement category II*3

UL UL61010-1 (CSA NRTL/C)
CE

EMC directive EN61326-1 compliance, Class A Table 2
EN61000-3-2 compliance
EN61000-3-3 compliance
EN55011 Class A Group 1

Low voltage directive EN61010-1, installation category II*1, and pollution degree 2*2, measurement category II*3

C-Tick EN55011 compliance, Class A Group 1
*1 Installation category (overvoltage category) II: Describes a number which defines a transient overvoltage condition. Iimplies the regulation for 

impulse withstand voltage. “II” applies to electrical equipment which is supplied from the fixed installation like a distribution board.
*2 Pollution degree 2: Describes the degree to which a solid, liquid, or gas which deteriorates dielectric strength or surface resistivity is adhering. “2” 

applies to normal indoor atmosphere. Normally, only non-conductive pollution occurs.
*3 Measurement category II: Applies to measuring circuits connected to low voltage installation, and electrical instruments supplied with power 

from fixed equipment such as electric switchboards.

13.6  General Specifications
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Standard Performance
Item Specifications
Measurement/display accuracy

Standard operating conditions: 
Temperature: 23 ± 2°C
Humidity: 55% ± 10%RH
Power supply voltage: 90 to 132 or 180 to 250 VAC
Power supply frequency: 50/60 Hz ± 1%
Warm-up time: At least 30 minutes.

Other ambient conditions such as vibration should not adversely affect the operation.
Input Type 

20 mV
60 mV
200 mV

2 V
1-5 V
6 V
20 V
50 V

R

S

B

K

E
J
T
N

W
L
U

WRe

Pt100
JPt100
Voltage
Contact

A/D integration time: 16.7 ms or more
±(0.05% of rdg + 12 digits)

±(0.05% of rdg + 3 digits)

±(0.05% of rdg + 12 digits)

±(0.05% of rdg + 3 digits)

±(0.15% of rdg + 1°C)
R, S 0 to 100°C: ±3.7°C, 
 100 to 300°C: ±1.5°C
B 400 to 600°C: ±2°C, 
 Accuracy not guaranteed for 
 values less than 400°C 
±(0.15% of rdg + 0.7°C)
–200 to –100°C: ±(0.15% of rdg + 1°C)
±(0.15% of rdg + 0.5°C)
–200 to –100°C: ±(0.15% of rdg + 0.7°C)

±(0.15% of rdg + 0.7°C)
–200 to 0°C: ±(0.35% of rdg + 0.7°C)
Accuracy not guaranteed for values less
than –200°C.
±(0.15% of rdg + 1°C)
±(0.15% of rdg + 0.5°C)
–200 to –100°C: ±(0.15% of rdg + 0.7°C)
±(0.2% of rdg + 2.5°C)
0 to 200°C: ±4.0°C

±(0.15% of rdg + 0.3°C)

Threshold level (Vth=2.4 V) accuracy ± 0.1 V

1 kΩ or less: 1 (ON), 100 kΩ or more: 0 (OFF) (parallel capacitance of 0.01 μF or less)

A/D integration time: 1.67 ms
±(0.1% of rdg + 40 digits)

±(0.1% of rdg + 15 digits)

±(0.1% of rdg + 40 digits)

±(0.1% of rdg + 15 digits)

±(0.2% of rdg + 4°C)
R, S 0 to 100°C: ±10°C, 
 100 to 300°C: ±5°C
B 400 to 600°C: ±7°C, 
 Accuracy not guaranteed for  
 values less than 400°C
±(0.2% of rdg + 3.5°C)
–200 to –100°C: ±(0.15% of rdg + 6°C)
±(0.2% of rdg + 2.5°C)
–200 to –100°C: ±(0.2% of rdg + 5°C)

±(0.3% of rdg + 3.5°C)
–200 to 0°C: ±(0.35% of rdg + 0.7°C)
Accuracy not guaranteed for values less
than –200°C.
±(0.3% of rdg + 7°C)
±(0.2% of rdg + 2.5°C)
–200 to –100°C: ±(0.2% of rdg + 5°C)
±(0.3% of rdg + 10°C)
0 to 200°C: ±18.0°C

±(0.3% of rdg + 1.5°C)

DC voltage 

Thermocouple
• Not including 
 the accuracy 
 of reference 
 junction 
 compensation
• With burnout 
 detection 
 function OFF

RTD

DI

 Max. Resolution of 
Digital Display

1 µV
10 µV
10 µV

100 µV
1 mV
1 mV
1 mV

10 mV

0.1°C

Measurement Accuracy (Digital Display) Range

13.6  General Specifications
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Item Specifications
Measuring accuracy in case of scaling

Accuracy during scaling (digits) = measurement accuracy (digits) × multiplier + 2 digits (rounded up)
* Fractions rounded up

where the multiplier = scaling span (digits)/measuring span (digits).
Example For 1-5 V range (A/D integration time is 16.7 ms or more), measurement span of 1.000 to 

5.000 V, and scaling span of 0.000 to 2.000
The measuring accuracy for 5 V input is as follows.
Measuring accuracy (1-5 Vrange) = ±(0.05% × 5 V + 3 digits) = ±(0.0025 V [3 digits] + 3 

digits) = ±6 digits
Multiplier = {2000 digits (0.000 to 2.000)}/4000 digits (1.000 to 5.000) = 0.5
Thus, accuracy during scaling = ±(6 × 0.5 + 2) digits = 5 digits (rounded up)

Reference junction compensation accuracy
When measuring temperature greater than or equal to 0 °C and when input terminal temperature is balanced
Type R, S, W, WRe: ±1.0°C
Type K, J, E, T, N, L, and U: ±0.5°C. Type B: Internal reference compensation is fixed to 0°C

Maximum input voltage ±60 VDC (continuous)
Input resistance 200	mV	range	or	less	and	TC:	10	MΩ	or	more

2	V	range	or	higher:	Approx.	1	MΩ
Input source resistance

Volt, TC 2	kΩ	or	less
RTD input 10	Ω	or	less	per	wire	(The	resistance	of	all	three	wires	must	be	equal).

Bias current 10 nA or less (except when burnout detection function is enabled)
Maximum common mode noise voltage

250 VACrms (50 Hz/60 Hz)
Maximum noise voltage between channels

250 VACrms (50 Hz/60 Hz)
Interference across channels

120	dB	(when	the	input	source	resistance	is	500	Ω	and	the	input	to	other	channels	is	60	VDC)
Common mode rejection ratio

When the A/D integration time is 20 ms
120	dB	(50	Hz	±	0.1%,	500	Ω	unbalanced,	between	the	minus	terminal	and	ground)

When the A/D integration time is 16.7 ms
120	dB	(60	Hz	±	0.1%,	500	Ω	unbalanced,	between	the	minus	terminal	and	ground)

When the A/D integration time is 1.67 ms
80	dB	or	higher	(50/60	Hz	±	0.1%,	500	Ω	unbalanced,	between	the	minus	terminal	and	ground)

Normal mode rejection ratio
When the A/D integration time is 20 ms

40 dB or more (50 Hz ± 0.1%)
When the A/D integration time is 16.7 ms

40 dB or more (60 Hz ± 0.1%)
When the A/D integration time is 1.67 ms

Not reject 50/60 Hz

Effects of Operating Conditions
Item Specifications
Ambient temperature (applies when the A/D integration time is 16.7 ms or greater, with temperature variation of 10°C)

DC voltage, TC range ±(0.1% of rdg + 0.05% of range) or less
* Excluding the error of reference junction compensation

RTD range ±(0.1% of rdg + 2 digits) or less
Power supply fluctuation With variation within 90 to 132 V and 180 to 250 VAC (50/60 Hz):

Accuracy specifications are satisfied.
With variation of ±2 Hz from rated power frequency (power supply voltage 100 VAC):

Accuracy specifications are satisfied.
Magnetic field AC (50/60 Hz) and DC 400 A/m fields:±(0.1% of rdg + 10 digits) or less
Input source resistance

DC voltage range With	variation	of	+1	kΩ:
200 mV range or less: ±10 µV or less
2 V range or higher: ±0.15% of rdg or less

TC range With	variation	of	+1	kΩ:	 ±10	µV	or	less
RTD range (Pt100) With	variation	of	10	Ω	per	wire	(resistance	of	all	three	wires	must	be	equal):	±(0.1%	of	rdg	+	1	digits)	

or less
With	maximum	difference	of	40	mΩ	between	wires:	 Approx.	0.1	°C

Effects of vibration Effects from a sinusoidal vibration along all three axis at a frequency between 10 to 60 Hz and an 
acceleration of 0.2 m/s2: ±(0.1% of rdg + 1 digit) or less

13.6  General Specifications
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13.6  General Specifications

Miscellaneous
Item Specifications
Memory backup A built-in lithium battery backs up the settings and runs the clock

Battery life: Approximately 10 years (at room temperature)
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13.7 External Dimensions

See the DX2000 Operation Guide (IM04L42B01-02E).
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Appendix 1 File Size of Display Data and Event Data

This section explains how to calculate the file size of display data files and event data 
files. The calculation examples are given for the display data only and event data only 
cases. If you are recording both display and event data, calculate the data size of each 
and add them together.
Use the calculated file size as a rough guide.
These calculation examples only apply to DXs that do not have the /AS1 advanced 
security option.

File Size
A file consists of the following data.
 Information other than the sampled data + the sampled data

Size of Information Other Than the Sampled Data
Item Size [Bytes]

File header 216
Channel information 88×N + 32
Group information 96×36 + 32 = 3,488
Message information 104*50 + 32 (an add message area is reserved by default)
Batch information 832
Sampled data header 80 + 32 + N×8 + 16 + 2
Alarm information 
header

24 + 8 (add the size of this item even if there is no alarm)

Message information Up to 104×1050 (varies depending on the number of messages)
Alarm information Up to 32×5000 (varies depending on the number of alarms)
Release number 3 
expansion information

1696 + 80×N
Expansion information is always stored.

N is the number of channels (measurement channels + external input channels + computation 
channels).

 Example 1: If display data of 12 measurement channels and 24 computation 
channels is recorded. There are no messages or alarms.

 216 + (88×280 + 32) + 3,488 + (104×50 + 32) + 832 + (80 + 32 + 280×8 + 16 + 2) + (24 
+ 8) + 24,096

 = 60,938 bytes

Sampled Data Size
• Data Size of Display Data and Event Data

Channel Display Data Event Data
Measurement channel 4 bytes/channel 2 bytes/channel
External input channel 4 bytes/channel 2 bytes/channel
Computation channel 8 bytes/channel 4 bytes/channel

 Time data common to all channels is added for each sample.
Time data 8 bytes/sample

Appendix
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• Data Size per Sample
 Display Data
 (Number of measurement channels×4 bytes) + (Number of external input channels×4 

bytes) + (number of computation channels×8 bytes) + 8 bytes (time data)

 Event Data
 (Number of measurement channels×2 bytes) + (Number of external input channels×2 

bytes) + (number of computation channels×4 bytes) + 8 bytes (time data)

• Sampled Data Size per File
 Display Data

Data size per sample × file save interval/sampling interval
 The sampling interval is determined by dividing the trend interval (in seconds) by 30 (40 

if the trend interval is 5 or 10 s).

 Example 2: If the display data of 30 measurement channels, 240 external input 
channels, and 10 computation channels is recorded with a trend interval of 30 min/div 
(the sampling interval of display data is 60 s) and a file save interval of 1 day (24 h)

 (30×4 bytes + 240×4 bytes + 10×8 bytes + 8 bytes)×24 h×60×60/60 s
 = 1,168 bytes×24 h×60×60/60 s
 = 1,681,920 bytes

 Event Data
 Data size per sample×data length/sample rate

 Example 3: If the display data of 30 measurement channels, 240 external input 
channels, and 10 computation channels is recorded with a sample rate of 1 s and data 
length of 2 h

 (30×2 bytes + 240×2 bytes + 10×4 bytes + 8 bytes)×2 h×60×60/1 s
 = 588 bytes×2 h×60×60/1 s
 = 4,233,600 bytes

Size per File
The size per file is the sum of the size of information other than the sampled data and the 
size of the sampled data.
 Display Data
 Example 4: If recording under the conditions of examples 1 and 2
 From examples 1 and 2, we obtain 60,938 + 1,681,920 = 1,742,858 bytes = 1.662 M 

bytes

 Event Data
 Example 5: If recording under the conditions of examples 1 and 3 
 From examples 1 and 3, we obtain 60,938 + 4,233,600 = 4,294,538 bytes = 4.096 M 

bytes

Appendix 1  File Size of Display Data and Event Data
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Save Duration to the CF Card
We will estimate the duration over which measured data can be saved to a CF card when 
measured data is being saved automatically.
Display Data
 Save duration to the CF card (estimate) = (Size of the CF card/size of a file)×[file save 

interval]
 Example 6: We will estimate the save duration to the CF card under the conditions 

of examples 1 and 2. In this example, the size of the CF card is assumed to be 256 M 
bytes.

 256 M bytes/1.662 M bytes×24 h
 = 3,696 h
 = 154 days

Event Data
 Save duration to the CF card (estimate) = (Size of the CF card/size of a file)×[data 

length]
 Example 7: We will estimate the time until the CF card needs to be replaced 

under the conditions of examples 1 and 3. In this example, the size of the CF card is 
assumed to be 256 M bytes.

 256 M bytes/4.096 M bytes×2 h
 = 125 h
 = 5.2 days

Note
If you format a 256-MB CF card, you will be able to use approximately 246 MB.

Time until the Internal Memory Becomes Full
If you are manually saving the measured data in the internal memory, old data is 
overwritten when the internal memory is full. You must save the measured data to the CF 
card before the data is overwritten.
Display Data
 Time until the internal memory becomes full (estimate) = (Size of the internal memory/

size of a file)×[file save interval]
 Example 8: We will estimate the time until the internal memory becomes full under 

the conditions of examples 1 and 2. The size of the internal memory is 400 M bytes.

 400 MB/1.662 M bytes×24 h
 = 5,776 h = 240 days

Event Data
 Time until the internal memory becomes full (estimate) = (Size of the internal memory/

size of a file)×[data length]
 Example 9: We will estimate the time until the internal memory becomes full under 

the conditions of examples 1 and 3. The size of the internal memory is 400 M bytes.

 400 MB/4.096 MB×2 h
 = 195 h
 = 8.13 days

Appendix 1  File Size of Display Data and Event Data



App-4 IM 04L42B01-01E

Appendix 2 Types of Data Files That the DX Can 
Create and Their Application

This section explains the types of data files that the DX can create and their application.
Data Type Extension Format Display Method*1

DX DAQ Application
Display data DAD Binary (undisclosed) Yes Yes Yes*2, *3

DSD Yes Yes Yes*2, *3

Event data DAE Binary (undisclosed) Yes Yes Yes*2, *3

DSE Yes Yes Yes*2, *3

Report data DAR Text (see appendix 3) - Yes Yes
xml XML spreadsheet - - Yes

Manual sampled data DAM Text (see appendix 3) - - Yes
Setup data PDL Binary (undisclosed) - - -

PEL - - -
Snapshot data PNG PNG (general format) - - Yes
Custom display setup data CDC Text - - -
Change settings log TXT Text - - Yes
*1 DX: DX main unit, DAQ: DAQSTANDARD, Application: Software application
*2  The data format can be converted on DAQSTANDARD and displayed on a software application 

such as Microsoft Excel.
*3  The data can be retrieved from the DX using the communication function and displayed on a 

software application.
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Appendix 3 Text File Data Format

This section explains the format of text files. The text files that the DX can create are 
manual sampled data files and report files.
In the explanation below, CRLF represents a terminator.

Format of the Manual Sample Data File
• The manual sampled data is output using numerical values and strings in text format 

delimited by tabs.
• Values of measurement channels set to Skip and computation and external input 

channels set to Off are not output.
• The data is appended to the file each time manual sample operation is performed.

Format

YRECCRLF

Manual Sample Data Version 1.02.00 CRLF

Model DX2000 CRLF

Language Code shift-JIS CRLF

File Status ffffffff CRLF

Serial No. III•••I CRLF

File Header HHH•••H CRLF

Ch ccccc ccccc ••• ccccc CRLF

Ch Id ddd•••d ddd•••d ••• ddd•••d CRLF

Tag ttt•••t ttt•••t ••• ttt•••t CRLF

Unit uuuuuu uuuuuu ••• uuuuuu CRLF

yyyy/mo/dd hh:mi:ss nnn•••n nnn•••n ••• nnn•••n CRLF
*  Ch Id is only output when Tag numbers are being used, on DXs with release number 3 or 

later.

ffffffff File status (8 characters)
Complete  Completed. (A file with 100 manually sampled 

data acquisitions that is now complete.)
Progress  Data is being added. (An incomplete file that 

does not yet have 100 manually sampled data 
acquisitions.)

Decrease  The file is defective. (A file that is missing some 
of the manually sampled data that was stored 
on it.)

III•••I Serial number of the DX (16 characters)
HHH•••H File header (50 characters)
ccccc Channel number (5 characters)
ddd···d Tag number (16 characters)
ttt•••t Tag comment (32 characters)
uuuuuu Unit (6 characters)
yyyy/mo/dd hh:mi:ss Sampling year, month, day, and time (19 characters)
nnn•••n Measured value (13 characters)
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File Output Example
Below is a manual sample data example of channels 1, 2, 3, and 4.

YREC

Manual Sample Data Version 1.02.00

Model DX2000

Language Code shift-JIS

File Status Progress

Serial No. S5E701600

File Header 

Ch CH001 CH002 CH003 CH004

Ch Id TI-101 OUT-102 FI-103 VA-204

Tag TI-101 OUT-102 FI-103 VA-204

Unit °C V m3/h %

2005/10/01 08:57:22 213.8 0.517 368.4 68.9

2005/10/01 08:57:28 208.6 0.494 363.0 68.1

Note
• Output when error data, overrange data, or computation overflow data is detected

Channel Data Output
Measurement channels, Error (Space)
external input channel +over range (includes burnout detection) 99999

–over range (includes burnout detection) –99999
Computation channel Error 999999999

Positive computation overflow 999999999
(when the value exceeds 99999999)
Negative computation overflow –999999999
(when the value falls below –9999999)
The decimal place that was specified when the span for 
the channel was specified applies to the output values. For 
example, if the span setting of the channel is “200.0,” then 
“999999999” is output when the value exceeds “9999999.9” 
and “–999999999” is output when the value is below “–
999999.9.”

• A new manual sampled data file is created in the following cases.
• A measurement channel is changed to Skip from a range other than Skip.
• A measurement channel is changed from Skip to a range other than Skip.
• A computation or external input channel is changed from On to Off or Off to On.
• The unit is changed.

Appendix 3  Text File Data Format
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Report File Format
• The hourly, daily, weekly, and monthly reports are output using numeric values and 

strings in text format delimited by tabs.
• Values of measurement channels set to Skip and computation and external input 

channels set to Off are not output.
• The data is appended to this file every time a report is created.

Format
YRECCRLF

Report Data Version 1.02.00 CRLF

Model DX2000 CRLF

Language Code shift-JIS CRLF

File Status ffffffff CRLF

Serial No. III•••I CRLF

File Header HHH•••H CRLF

Report Set RRR•••R CRLF

File Data rrr•••r CRLF

Math Set MMM MMM MMM MMMM CRLF

Start Time YYYY/MO/DD HH:MI:SS   CRLF

Ch ccccc ccccc ••• ccccc CRLF

Ch Id ddd•••d ddd•••d ••• ddd•••d CRLF

Tag ttt•••t ttt•••t ••• ttt•••t CRLF

Unit uuuuuu uuuuuu ••• uuuuuu CRLF

Data Type sss•••s CRLF

Time yyyy/mo/dd hh:mi:ss CRLF

Status eeeeeeeeee CRLF

Ave nnn•••n nnn•••n ••• nnn•••n CRLF

Max nnn•••n nnn•••n ••• nnn•••n CRLF

Min nnn•••n nnn•••n ••• nnn•••n CRLF

Sum nnn•••n nnn•••n ••• nnn•••n CRLF
*  Ch Id is only output when Tag numbers are being used, on DXs with release number 3 or 

later.

ffffffff File status (8 characters)
 Complete  Completed. (A file with the necessary number of 

acquisitions for its report type, for example one 
acquisition for an Hourly report type, that is now 
complete.)

 Progress  Data is being added. (An incomplete file that does 
not yet have the necessary number of acquisitions 
for its report type.)

 Decrease  The file is defective. (A file that is missing some of 
the report data that was stored on it.)

III•••I Serial number of the DX (16 characters)
HHH•••H File header (50 characters)
RRR•••R Report setting (setting on the DX) (13 characters)
 Hourly 

 Daily 

 Hourly+Daily 

 Daily+Weekly 

 Daily+Monthly 

Appendix 3  Text File Data Format



App-8 IM 04L42B01-01E

rrr•••r Contents of the report file (13 characters)
 Hourly 

 Daily 

 Hourly+Daily 

 Daily+Weekly 

 Daily+Monthly 

 Example: When the DX is set to Hourly+Daily and   
  Combine, Hourly+Daily is output.
  When the DX is set to Hourly+Daily and   
  Separate, the hourly report is output as Hourly,  
  and the daily report as Daily.
MMMM Report items (16 characters (including tabs that are counted 

as one character each), up to four types)
 Ave 

 Max 

 Min 

 Sum 

 Inst Instantaneous value
YYYY/MO/DD HH:MI:SS Report start year, month, day, and time (19 characters)
ccccc Channel number (5 characters)
ddd···d Tag number (16 characters)
ttt···t Tag comment (32 characters)
uuuuuu Unit (6 characters)
eeeeeeeeee Status (output the events that occurred while creating report  

data) (10 characters)
 Bo Burn out detected
 Er Error (error detection)
 Ov Over (overrange/computation overflow detection)
 Pw Power failure (power failure occurrence)
 Cg Change (time change present) 
SSS•••S Report type (7 characters)
 Hourly 

 Daily 

 Weekly 

 Monthly 

yyyy/mo/dd hh:mi:ss Report year, month, day, and time (19 characters)
nnn•••n Average, maximum, minimum, sum, or instantaneous value  

(13 characters)

Appendix 3  Text File Data Format
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File Output Example
Below is an example of an hourly report of 4 channels while creating hourly and daily 
reports and saving each type of report to a separate file.

YREC

Report Data Version 1.02.00

Model DX2000

Language Code shift-JIS

File Status Complete

Serial No. S5E701600

File Header 

Report Set Hourly+Daily

File Data Hourly

Math Set Ave Max Min Sum

Start Time 2005/10/01 08:10:56

Ch CH001 CH002 CH003 CH004

Ch Id TI-101 OUT-102 FI-103 VA-204

Tag TI-101 OUT-102 FI-103 VA-204

Unit °C V m3/h %

Data Type Hourly

Time 2005/10/01 09:00:00

Status

Ave 91.5 -0.039 241.1 48.6

Max 259.8 0.726 416.5 76.6

Min -59.9 -0.727 83.4 23.3

Sum 3.293636E+05 -1.392980E+02 8.680871E+05 1.748983E+05

Appendix 3  Text File Data Format
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Note
• When the channel data is in the condition shown in the table below, the Er, Ov, or Bo status 

is output to a report.
Data Condition Status
Error Er
Measurement and external input channels

Positive over range Ov
Negative over range Ov
Burn out detection Bo

Computation channels
Positive computation overflow (when the value exceeds 1.79E + 308) Ov
Negative computation overflow (when the value falls below –1.79E + 308) Ov

• The report output value of Ave, Max, Min, Sum, and Inst varies depending on the channel 
data condition as shown in the table below.
Item Data Condition of Measurement/ Report 

External Input Channels Output Value
Ave When all of the data are errors or over range (Space)
Max, • When all of the data are errors (Space)
Min, • For +over range (includes burnout detection) 99999
Inst • For –over range (includes burnout detection) –99999
Sum • When all of the data are errors or over range (Space)

• When the sum value exceeds approx. 3.4E + 38 9.999999E+99
• When the sum value is below approx. –3.4E + 38 –9.999999E+99

Item Data Condition of Computation Channels Report
Output Value

Ave When all of the data are errors or computation overflow (Space)
Max, • When all of the data are errors (Space)
Min, •  When the maximum value or instantaneous value 

exceeds 99999999
999999999

Inst •  When the minimum value or instantaneous value is less 
than –9999999

–999999999

Sum •  When all of the data are errors or computation overflow (Space)
• When the sum value exceeds approx. 3.4E + 38 9.999999E+99
• When the sum value is below approx. –3.4E + 38 –9.999999E+99

* The decimal place that was specified when the span for the channel was specified 
applies to the maximum and minimum values or the instantaneous values. For example, 
if the span setting of the channel is “200.0,” then “999999999” is output when the value 
exceeds “9999999.9” and “–999999999” is output when the value is below “–999999.9.”

Appendix 3  Text File Data Format
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Format of the Change Settings Log (/AS1 option)
• The change settings log is output as a tab-separated text file.
• Each time a report is created, data is added to the file.

Format
YRECCRLF

Setting Change Data Version 1.00.00CRLF

File Status ffffffffCRLF

Serial No. III•••ICRLF

Changed yyyy/mo/dd hh:mi:ssCRLF

Contents ccc•••cCRLF

File Info ddd•••d nnn•••nCRLF

User Info ppp•••p ttt•••t uuu•••uCRLF

ffffffff File status (8 characters)
 Complete Completed (A file with 100 change settings  

  log entries that is now complete.)
 Progress Data is being added. (An incomplete file that  

  does not yet have 100 change settings log  
  entries.)

III•••I Serial number (up to 16 characters)
yyyy/mo/dd hh:mi:ss Year, month, day, and time when the setting change was 

executed (19 characters)
ccc•••c The following are connected with pluses (16 characters).

Eng Changing of setting mode settings
Sys Changing of basic setting mode settings
Login Changing of login information

ddd•••d File serial number (10 characters)
nnn•••n File name (12 characters)
ppp•••p Type of setting change (10 characters)

Manual Settings changed by the user
ttt•••t Input method (8 characters)

Key   Settings changed by the user
Communication Settings changed by the user

uuu•••u User name (20 characters)

1
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File Output Example
Below is an example of a change settings log file with two change settings log entries.

YREC

Setting Change Data Version 1.00.00

File Status Progress

Serial No. S5H907377

Changed 2010/04/01 00:55:44

Contents Sys

File Info 209 40100550.PEL

User Info Manual KEY

Changed 2010/04/02 00:56:18

Contents Login

File Info 210 40100560.PEL

User Info Manual KEY Admin1

Appendix 3  Text File Data Format
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Symbol
** .......................................................................................... 9-6
+Over ................................................................................. 1-15
-Over .................................................................................. 1-15
[a?b:c] ................................................................................ 9-10
1/4 circle ............................................................................ 5-27
24 VDC transmitter power supply .................................... 13-15
24 V power supply ........................................................... 13-17
3 leg isolated RTD input .................................................. 13-14

A
A/D integration time ............................................................. 3-1
ABS ..................................................................................... 9-6
absolute time ..................................................................... 4-21
absolute time mode ........................................................... 1-40
action ................................................................................. 1-41
added messages ............................................................... 1-18
administrator .............................................................. 1-45, 8-5
advanced security function .................................... 1-58, 13-18
advanced security option ................................................... 6-13
alarm.......................................................................... 1-4, 13-2
alarm ACK ................................................................. 1-7, 3-15
alarm acknowledge.............................................................. 1-7
alarm acknowledge operation............................................ 3-15
alarm annunciator ...................................................... 1-8, 3-21
alarm color ........................................................................... 1-5
alarm delay time ........................................................ 3-14, 9-3
alarm display reset ............................................................ 3-23
alarm hide function .................................................... 1-6, 3-10
alarm indication ................................................................... 1-5
alarm level ........................................................................... 1-5
alarm mark indication ........................................................ 5-17
alarm output relay ............................................ 1-6, 3-8, 13-11
alarm settings .................................................................... 3-11
alarm summary ........................................................ 1-21, 4-31
alarm value ........................................................................ 3-13
all channel display ..................................................... 4-6, 4-19
all data display ................................................................... 4-14
AND ..................................................................................... 9-7
AND/OR ............................................................................... 1-7
annunciator sequence ....................................................... 3-25
assigning relay operations ................................................. 2-11
auto increment ..................................................................... 6-7
auto logout ......................................................... 1-45, 8-5, 8-8
automatic message writing ................................................ 1-12
auto save ................................................................... 1-33, 6-5
auto scroll ............................................................................ 4-6
auto span ........................................................................... 4-22
auto zone ......................................................... 1-13, 4-6, 4-19

B
background color ..................................................... 1-27, 5-32
background color (historical trend) .................................... 4-24
backlight saver........................................................... 1-27, 2-8
barcode reader .................................................................. 2-22
bar graph display ....................................................... 1-16, 4-4
base position (bar graphs) ................................................. 5-21
basic setting mode............................................................. 2-27
batch comment .......................................................... 1-38, 6-7
batch function .................................................. 6-6, 6-7, 13-10
batch name .......................................................................... 6-7
brightness .................................................................. 1-27, 2-8

burnout ...................................................................... 1-15, 3-2
burnout detection ................................................................. 1-2

C
calculate the file size .......................................................App-1
calendar ............................................................................. 4-18
calibration ................................................................ 12-2, 12-3
calibration correction ..................................... 1-3, 3-16, 13-16
calibration due date ........................................................... 3-32
calibration notification screen ............................................ 3-31
CARRY .............................................................................. 9-10
change message ................................................................. 5-7
change settings log.................................................. 4-42, 13-7
changing settings during recording.................................... 6-13
channel (computation) ....................................................... 1-46
channel display colors ....................................................... 5-11
channel number ................................................................... 5-3
circular display ......................................................... 1-19, 5-24
clamped input terminal .................................................... 13-11
clears the entire waveform (circular) ................................. 5-26
CLOG computation .............................................................. 9-9
color scale band ................................................................ 5-17
comma ............................................................................... 2-26
comment text block............................................................ 5-43
comment text field ............................................................. 5-43
communication application errors ...................................... 11-9
communication errors ...................................................... 11-15
communication functions ................................................. 13-10
communication log............................................................. 4-39
computation channel ........................................................... 9-1
computation data dropout ........................................ 1-49, 9-14
computation error ................................................................ 9-4
computation function ............................................. 1-46, 13-12
computation types ............................................................. 1-46
conditional expression ....................................................... 9-10
configuration (storage)....................................................... 13-6
construction (DX) ............................................................. 13-19
continuing data .................................................................. 4-13
conventions ...........................................................................vii
count (moving average) ....................................................... 3-6
Cu10, Cu25 RTD input .................................................... 13-13
current value display.......................................................... 5-15
cursor (circular) .................................................................. 5-29
cursor (historical trend) ...................................................... 4-13
cursor time ......................................................................... 4-21
cursor value ....................................................................... 4-21
custom display ................................................................... 1-58
custom display setup data ............................. 1-28, 1-37, 13-8
customizing the display selection menusmenu ................. 5-38
customizing the FUNK key menus .................................... 5-38
customizing the menus .............................................. 1-27, 4-3

D
data display section ............................................................. 1-9
data file loading ................................................................. 13-8
data files that the DX can create .....................................App-4
data kind .............................................................................. 6-2
data length ........................................................................... 6-3
data save mode ....................................................... 2-25, 4-35
data that can be used in equations.................................... 1-48
data type ............................................................................ 13-6
date/time .............................................................................. 2-1
date format ................................................................ 1-56, 2-4
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de-energize.......................................................................... 1-7
decimal point type.............................................................. 2-26
delay high limit alarm ........................................................... 1-4
delay low limit alarm ............................................................ 1-4
deleting a file ..................................................................... 6-18
desktop type .................................................................... 13-12
detect (alarm hide function) ............................................... 3-14
DHCP log ........................................................................... 4-41
differece computation .......................................................... 1-3
difference lower limit alarm .................................................. 1-4
difference upper limit alarm ................................................. 1-4
digit (scale value)............................................................... 5-15
digital display ............................................................. 1-15, 4-4
directory (data save) .......................................................... 1-33
display (LCD) ..................................................................... 13-3
display color (channels) ..................................................... 5-11
display color (messages) ................................................... 5-10
display data ............................................1-281-58, 1-30, 13-6
display direction (bar graphs) ............................................ 5-21
display direction (messages) ............................................. 5-20
display direction (trend) ..................................................... 5-20
displayed information......................................................... 13-3
displayed language............................................................ 1-57
display group ....................................................................... 5-1
display menu ............................................................. 4-1, 5-40
display positions ................................................................ 3-24
display selection menu .............................................. 4-1, 5-40
display the text................................................................... 5-42
display window .................................................................. 3-24
display zone....................................................................... 5-12
divided (report file) ............................................................. 9-16
division (scale) ................................................................... 5-14
DNS server .......................................................................... 2-6
domain name ....................................................................... 2-6
DST (daylight saving time) ........................................ 1-56, 2-1

E
e-mail log ........................................................................... 4-40
easy text entry ....................................................... 1-57, 13-15
edge................................................................................... 1-39
effects of operating conditions ......................................... 13-22
energize ............................................................................... 1-7
EQ ....................................................................................... 9-6
error codes ........................................................................ 11-1
error data ........................................................................... 1-52
error log ............................................................................. 4-39
error messages.................................................................. 11-1
errors related to parameter settings .................................. 11-1
event .................................................................................. 1-39
event action ..................................................... 1-39, 7-1, 13-9
event data ...................................................... 1-28, 1-30, 13-6
event data (circular) ........................................................... 5-31
event level switch status .................................................... 1-25
event level switch status display........................................ 4-30
EXP ..................................................................................... 9-6
expanding .......................................................................... 4-44
expressions (computation) .................................................. 9-5
extended input type ......................................................... 13-14
external dimensions......................................................... 13-24
external input channels............................................ 1-58, 10-1
external input function ..................................................... 13-16
external storage medium ................................................... 1-33

F
FAIL/alarm output relay 22 outputs.................................. 13-11
FAIL/status output relay ................................................... 13-11
FAIL output .............................................................. 1-54, 2-13

fast sampling mode ............................................................. 1-1
favorite key .............................................................. 1-27, 5-35
file header ............................................................................ 6-5
file name ............................................................................ 1-35
file size.............................................................................App-1
fine grid ...................................................................... 4-6, 4-20
firmware version .................................................................. 2-5
first weekday...................................................................... 4-18
fixed (alarm mark) .............................................................. 5-17
flag ..................................................................................... 1-48
flow of data recording and storage .................................... 1-29
format of text files ............................................................App-5
format of the change settings log ..................................App-11
formatting........................................................................... 6-18
format type......................................................................... 6-18
four arithmetic operation ...................................................... 9-6
four panel display .................................................... 1-26, 4-43
free (event data) ........................................................ 1-31, 6-3
free messages ......................................................... 1-12, 5-10
free space .......................................................................... 6-18
FTP log .............................................................................. 4-39
full circle action .................................................................. 5-26
FUNC key menu ........................................................ 4-2, 5-39

G
GE ....................................................................................... 9-6
gradually correcting the internal clock ............................... 1-56
graph display ....................................................................... 1-9
grid..................................................................................... 5-20
groups.................................................................................. 5-1
group set.............................................................................. 5-1
GT ........................................................................................ 9-6

H
historical trend display ............................................. 1-17, 4-10
HOLD................................................................................. 9-10
hold (alarm indication) ......................................................... 1-5
hold (alarm output relay)...................................................... 1-7
host name ............................................................................ 2-6
hysteresis .................................................................... 1-4, 3-9

I
identified strings................................................................... 6-5
ID number .......................................................................... 2-15
indicator ............................................................................... 3-7
individual alarm ACK ........................................................... 1-7
individual alarm ACK operation ......................................... 4-26
information on the displayed measured data..................... 4-24
initialize .............................................................................. 2-10
input calibration interval ..................................................... 3-30
input processing .................................................................. 1-2
input range........................................................................... 3-3
input type ..................................................................... 1-1, 3-4
integration time .................................................................... 1-1
internal memory ................................................................. 1-29
internal switch .................................................... 1-8, 1-39, 3-8
interval (rate-of-change alarm) .................................... 1-4, 3-7
invalid keys ........................................................................ 2-21
invalid user relay................................................................ 1-54
IP address ........................................................................... 2-6
ISA-A ................................................................................. 3-27
ISA-A-4 .............................................................................. 3-25
ISA-M ................................................................................. 3-29
isolation ........................................................................... 13-19
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J
jump default display ........................................................... 5-34

K
keyboard ............................................................................ 2-20
key lock...................................................................... 1-44, 8-1
keywords ........................................................................... 9-19

L
LE ........................................................................................ 9-6
level ................................................................................... 1-39
level and edge ................................................................... 1-43
limitations (expressions) ...................................................... 9-5
linear scaling........................................................................ 1-3
line width of the trend ........................................................ 5-20
list of files ........................................................................... 6-17
LN ........................................................................................ 9-6
loading a file ...................................................................... 6-19
loading a template file........................................................ 6-24
loading setup data ............................................................. 6-23
LOG ..................................................................................... 9-6
log display.......................................................................... 1-25
logging in ............................................................................. 8-7
logging out ........................................................................... 8-7
logical computation .............................................................. 9-7
login function ............................................................. 1-45, 8-5
login log ............................................................................. 4-38
log into the DX ..................................................................... 8-7
lot-No. digit .......................................................................... 6-7
lot number.......................................................................... 1-38
low-cut ......................................................................... 1-3, 3-5
LT ......................................................................................... 9-6

M
MAC address ....................................................................... 2-5
maintenance ...................................................................... 12-1
maintenance and test communication command errors .. 11-15
manuals ....................................................................................i
manual sample .................................................................. 6-14
manual sampled data .................................... 1-28, 1-32, 13-7
manual sampled data (format).........................................App-5
manual save ...................................................................... 1-34
match time timer ........................................................ 1-39, 7-4
math start action ................................................................ 9-13
measurement channel ......................................................... 1-1
measurement input ............................................................ 13-1
measure soft key ............................................................... 3-16
media FIFO................................................................ 1-34, 6-5
memory backup ............................................................... 13-23
memory sample ................................................................... 6-2
memory sample relay ........................................................ 1-54
memory start ...................................................................... 6-10
memory stop ...................................................................... 6-11
memory summary .................................................... 1-23, 4-34
message colors ................................................................. 5-10
message display ........................................................ 4-6, 4-21
message display method ................................................... 1-13
message display methods ................................................. 4-33
messages .................................................................. 1-12, 5-8
messages (errors, status, etc) ........................................... 11-1
message summary .................................................. 1-22, 4-33
modbus client status display.............................................. 1-25
modbus master status display ........................................... 1-25
modbus status display ....................................................... 4-29
modbus status log ............................................................. 4-41
mode (input range) .............................................................. 3-3

moving average ........................................................... 1-2, 3-6
multi batch function................................................ 1-58, 13-17

N
name of a four panel display ............................................. 4-44
NE........................................................................................ 9-6
network information ............................................................. 2-5
next soft key ........................................................................ 4-2
no logging .......................................................................... 3-10
non-hold (alarm indication) .................................................. 1-5
non-hold (alarm output relay) .............................................. 1-7
normal operating conditions ............................................ 13-19
NOT ..................................................................................... 9-7
number of pulses per minute ............................................. 3-18
numeric display.......................................................... 1-15, 4-6

O
OFF events ........................................................................ 1-39
offset time .......................................................................... 5-26
ON events.......................................................................... 1-39
operating event switches ..................................................... 7-5
operation errors ................................................................. 11-7
operation log ...................................................................... 4-42
operation logs .................................................................... 4-38
operations that can be carried out when logged out.......... 1-45
OR ....................................................................................... 9-7
order of precedence (computation) ..................................... 9-5
overflow data ............................................................. 1-52, 9-4
overview display ...................................................... 1-20, 4-25

P
parameters ........................................................................ 9-21
partial expanded display .......................................... 1-14, 5-18
parts replacement .............................................................. 12-1
password (key lock) ............................................................. 8-1
password (login function)..................................................... 8-5
password change ................................................................ 8-8
point ................................................................................... 2-26
power-fail message ........................................................... 5-37
power computations ............................................................ 9-6
power failure operation ...................................................... 1-52
power supply ................................................................... 13-19
power supply for transmitter .............................................. 1-57
PRE ................................................................................... 9-10
preset display .................................................................... 5-34
pretrigger ........................................................................... 1-31
processing order of computation ....................................... 1-48
PROFIBUS-DP ................................................................ 13-17
progress of the save operation .......................................... 4-36
pulse input ............................................................... 1-3, 13-16
pulse sum value................................................................. 3-17

Q
quarter cycle display .......................................................... 5-27

R
range (input range) .............................................................. 3-4
rate-of-change alarm ........................................................... 1-4
recommended replacement periods for worn parts ........... 12-1
recording conditions (display data) .................................... 1-30
recording conditions (event data) ...................................... 1-31
ref. CH ................................................................................. 3-5
reference channel ................................................................ 3-5
reference junction compensation................................. 1-2, 3-2
reflash .......................................................................... 1-7, 3-7
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relational computation ......................................................... 9-6
relative time ....................................................................... 4-21
relative time mode ............................................................. 1-40
relay action ........................................................................ 2-12
relay status display .................................................. 1-25, 4-29
release number....................................................................... iii
releasing the key lock .......................................................... 8-2
remote contact input operation .......................................... 7-10
remote control...................................................................... 7-1
remote control (/R1)......................................................... 13-15
remote control function .............................................. 1-39, 7-1
remote control input signal ................................................ 1-43
remote controller ID ................................................... 2-5, 2-14
remote control terminal ...................................................... 2-15
repeat (event data) ............................................................ 1-31
report ................................................................................. 9-15
report channel.................................................................... 9-17
report data ........................................... 1-24, 1-28, 1-32, 13-7
report data keyword examples .......................................... 9-22
report data keywords ......................................................... 9-20
report display ..................................................................... 4-28
report file (format) ............................................................App-7
report function.................................................................... 1-51
report group ....................................................................... 9-17
report template .............................................. 1-53, 6-24, 9-16
report template examples .................................................. 9-18
report template file ............................................................. 6-26
RESET ............................................................................... 9-10
reset (TLOG) ..................................................................... 1-50
resets the computed result (Rst+St) .................................. 9-13
reset the sum value ........................................................... 3-18
resetting the computed results .......................................... 9-14
resetting the match time timer ............................................. 7-5
resetting the relative timer ................................................... 7-5
revisions ..................................................................................ii
rolling average ........................................................... 1-49, 9-4
RS-232 interface.............................................................. 13-11
RS-422A/485 interface .................................................... 13-11

S
sample rate .......................................................................... 6-3
save directory ...................................................................... 6-5
save duration to the CF card ...........................................App-3
save interval ........................................................................ 6-2
save interval (circular) ....................................................... 5-26
saving a template file ......................................................... 6-25
saving data to the external storage medium............ 1-33, 13-7
saving measured data (automatically) ............................... 6-10
saving measured data (manually) ..................................... 6-11
saving setup data .............................................................. 6-20
saving the data .................................................................. 4-35
scale ................................................................ 4-6, 4-19, 5-13
scale lower........................................................................... 3-4
scale marks (circular) ........................................................ 5-31
scale upper .......................................................................... 3-4
scan interval ................................................................ 1-1, 3-1
screen image data ................................................... 1-28, 6-16
scroll time .......................................................................... 5-33
search for measured data.................................................. 4-16
second interval ............................................................ 5-7, 6-2
security ................................................................................ 8-5
security function................................................................. 13-9
selecting a bar ................................................................... 4-47
separators.......................................................................... 5-39
setup data ...................................................... 1-28, 1-37, 13-7
simplified historical trend ................................................... 5-28
single (event data) ............................................................. 1-31

single graph/dual graph, stacked bar graph ...................... 4-46
Snapshot ........................................................................... 13-7
snapshot ............................................................................ 6-16
snapshot data .......................................................... 1-28, 1-37
SNTP log ........................................................................... 4-41
sort item ................................................................... 4-31, 4-33
span lower ........................................................................... 3-4
span upper........................................................................... 3-4
Special computation .......................................................... 9-10
special data ....................................................................... 1-52
special keywords ............................................................... 9-20
SQR ..................................................................................... 9-6
square root computation ...................................................... 1-3
stacked bar graph .................................................... 1-24, 4-45
standard display soft key ................................................... 5-34
standard performance ..................................................... 13-21
standards ......................................................................... 13-20
standard temperature device ............................................. 12-2
starting the computation .................................................... 9-13
start the recording.............................................................. 6-10
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